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About this manual
This manual is intended to get you started learning and using ER Mapper. It 
provides simple step-by-step lessons that give you hands-on practice using the 
basic features of the software, and using more advanced features as well. Please 
read the following important information before beginning.

• Chapter contents

• Setting up practice images

• Typographical conventions used in this document

This manual is not intended to cover all ER Mapper functionality in depth. Please 
refer to the ER Mapper User Guide and other manuals for more detailed 
information as needed.

Note: The hands-on exercises in this workbook require that the sample images and 
algorithms supplied on the ER Mapper CD-ROM be installed and accessable.  
Please refer to Appendix A “System setup” in this manual for more information. 

Chapter contents
The chapters in this manual give you extensive hands-on experience using the 
ER Mapper software through a series of specially designed lessons.  Most lessons 
have two basic sections: 

• an overview of key concepts

• a series of step-by-step hands-on exercises
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  ●  Setting up practice images
It is recommended that you start at the beginning and proceed through the chapters 
in order because the later chapters build on concepts learned in earlier ones. 
However, each chapter is independent of the others, so you can refer to a specific 
chapter at any time for a quick procedural overview or refresher course. 

The emphasis of this manual is on learning and using the ER Mapper software, not 
on teaching remote sensing concepts and applications.  For more detailed 
information on the principles of image processing or remote sensing for specific 
applications, please refer to the ER Mapper Applications Manual, or any of the text 
books available (some examples are listed in Appendix B “Reference texts” in this 
manual). 

Setting up practice images
The exercises in this manual assume that ER Mapper is installed and licensed, and 
that you will use the default ER Mapper ‘tutorial’ directory to save sample 
processing algorithms and other files during the lessons.  In addition, some chapters 
require that copies of the ER Mapper sample image files be placed into the 
‘tutorial’ directory. For information on configuring your system for these exercises, 
please refer to Appendix A “System setup” in this workbook.  

Typographical conventions 
The following typographical conventions are used throughout this document: 

• ER Mapper menus, button names and dialog box names are printed in boldface 
Helvetica type, for example: 

“Select Print from the File menu to open the Print dialog box.”

• Where you are asked to click the mouse on an icon button in the user interface, both 
the button and its formal name are indicated in the text. For example:

“Click on the Open Transform editor  button.”

• Text to be typed in a dialog box text field is shown in boldface Courier typeface, for 
example: “Type vegetation_index in the text field.” 
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1

Introduction to
ER Mapper

This chapter provides a brief overview of general image processing concepts, the 
types of data you can process, and typical ER Mapper applications in the earth 
sciences. It also provides an overview of how the ER Mapper software works, and 
advantages it provides over other image processing systems.

Image processing concepts
The term digital image processing refers to the use of a computer to manipulate 
image data stored in a digital format. The goal of image processing for earth 
science applications is to enhance geographic data in digital format so as to make it 
more meaningful to the user, extract quantitative information, and solve problems.

A digital image is stored as a two-dimensional array (or grid) of small areas called 
pixels (picture elements), and each pixel corresponds spatially to an area on the 
earth’s surface. This array or grid structure is also called a raster, so image data is 
often referred to as raster data. The raster data is arranged in horizontal rows called 
lines, and vertical columns called samples. Each pixel in the image raster is 
represented by a digital number (or DN). 
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Chapter 1 Introduction to ER Mapper ●  Image processing concepts
These image DNs can represent many different types of data depending on the data 
source. For satellite data such as Landsat and SPOT, the DNs represent the intensity 
of reflected light in the visible, infrared, or other wavelengths. For imaging radar 
(Synthetic Aperture Radar - SAR) data, the DNs represent the strength of a radar 
pulse returned to the antenna. For digital terrain models (DTMs), the DNs represent 
terrain elevation. No matter what the source, all these types of data can be stored in 
a raster format. 

By applying mathematical transformations to the digital numbers, ER Mapper can 
enhance image data to highlight and extract very subtle information that would be 
impossible using traditional manual interpretation techniques. This is why image 
processing has become such a powerful tool for all types of earth science 
applications. The exercises in this manual provide many examples that illustrate 
how image processing is typically used to enhance image data and extract 
information.

Many image datasets have multiple bands (or layers) of data covering the same 
geographic area, each containing a different type of information. For example, a 
SPOT HRV-XS satellite image has three bands of data, each recording reflectance 
from the earth’s surface in a different wavelength of light. Since each band records 
reflectance in a different part of the spectrum, this type of data is often called 
multispectral data. Many powerful image processing techniques have been 
developed to combine various bands from multispectral images to highlight 
specific types of earth science information such as vegetation abundance, water 
quality parameters, or the types of minerals present at the earth’s surface.

columns
(samples)

rows
(lines)

individual cells or
pixels in raster array
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Chapter 1 Introduction to ER Mapper ●  Image processing applications
Image processing applications
Image processing has become an important tool for a wide range of earth science 
mapping, analysis, and modelling applications. Following are just a few of the 
many applications for which image processing is commonly used:

• land use/land cover mapping and change detection

• agricultural assessment and monitoring

• coastal and marine resource management

• mineral exploration

• oil & gas exploration

• forest resource management

• urban planning and change detection

• telecommunications siting and planning

• physical oceanography

• geology and topographic mapping

• sea ice detection and mapping

Traditional image processing
Image processing was first developed on large mainframe computers in the 1960’s 
to process images from planetary satellites. To process an image, you specified the 
name of the file to process, the type of operation you wanted to perform, then 
waited for the system to process the data and write the results to a new image file 
on disk (shown in the diagram below). You then used a separate display program to 
view the output file and evaluate your results. 

With traditional systems, the changes resulting from the image processing 
operation are saved in a separate output raster file. 

With the introduction of powerful workstations in the 1980’s, processing of large 
images could now be performed on the desktop. Surprisingly, nearly all image 
processing products on the market today are still designed around this 
“disk-to-disk” approach from the 1960’s. This means that to perform a processing 
operation that requires several steps, you need to write an intermediate file to disk 

RASTER
FILE1

RASTER
FILE2

Image processing
operation
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Chapter 1 Introduction to ER Mapper ●  ER Mapper image processing
for each step. Only when the final file is created can you view your desired results. 
This approach can consume tremendous amounts of time and disk space, and if the 
result is not what you intended, you must often start all over again. 

ER Mapper image processing
Recognizing the restrictions inherent in traditional image processing software, the 
creators of ER Mapper developed an entirely new approach. Instead of writing a 
file to disk for each processing step, ER Mapper lets you combine many processing 
operations into a single step, and render the results directly to your screen display 
in near real-time. (In most cases, no processed copies of your original data are 
written to disk unless you request to do so.) The set of processing steps you apply 
to your data is called an “algorithm” in ER Mapper. 

With ER Mapper, you can save only a description of the processing steps you wish 
to apply to the data (the algorithm), not separate processed copies of the original 
raster data file. By storing the processing steps separately from the actual data, 
image processing becomes faster, easier to learn, and more interactive. If required, 
you can save the processed image in a number of formats including ER Mapper 
Raster Dataset (.ers).

In ER Mapper, algorithms can be used for simple viewing of data, or for very 
complex processing and modelling operations involving many images, 
transformations of the data, and overlays of other types of data. Examples of 
common image processing operations that become much easier using algorithms 
include image merging (data fusion), image mosaicing, and any type of 
mathematical transformations such as band ratios, Principal Components, Tasseled 
Cap transforms, and others.

The algorithms design also allows ER Mapper to handle the next generation of very 
high resolution satellite imagery much more efficiently than traditional systems. 
These one to three meter spatial resolution datasets will have large file sizes for the 
area of coverage, so reducing the need to write processed copies of the data to disk 
is a very important consideration.

RASTER
FILE

IMAGE
DISPLAY

processing “algorithm”
- formulas (ratios, PCs etc.)
- filters (smooth, sharpen etc.)
- contrast / brightness
- more
Comprehensive ER Mapper Training Workbook 27



Chapter 1 Introduction to ER Mapper ●  Image processing tasks
Image processing tasks
A flowchart of typical image processing tasks is summarized in the following 
diagram, from data import through processing to final output:

Data

Image

Image

Image

Image

Read external data from tape, CD-ROM, etc.

View image data on a PC monitor to evaluate

Geometrically align images (register) or

Assemble two or more overlapping images

Digitally process image data to aid visual

read/import

display

geocoding

mosaicing

enhancement

Dynamic

Annotation

Data save/export

Links
overlays

& map
composition

& hardcopy
printing

and, if necessary, convert for use and processing in
ER Mapper (Raster image data or vector line data.)

quality or area coverage, or display statistical
information such as histograms or cell values.

geometrically correct images to correspond
to geodetic coordinate systems (rectify or orthorectify).

to create a continuous representation of
the entire area covered (a mosaic).

interpretation or highlight specific information
(contrast enhancement, filtering, ratios, etc.).

Link directly to raster, vector, or tabular data

Setup a map page, and annotate images with

Save/export processed data to external file formats,

in external products or files and display the
data over raster images (without file translation).

text, lines, shaded polygons, legends, scale
bars, coordinate grids and other map objects.

and print images and maps on over 200
hardcopy devices and any Windows printer.
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Chapter 1 Introduction to ER Mapper ●  Image processing tasks
Data read/import
The first step in image processing is reading the data you want to use into 
ER Mapper. Typically the data might be stored on magnetic tape, CD-ROM, or 
other media. There are two primary types of data you may want to read into 
ER Mapper: raster and vector.

Raster image data is the type used as input to image processing operations. Typical 
sources include satellite images, digitized aerial photographs, digital terrain models 
(DTMs), and geophysical and seismic survey data. ER Mapper can directly read 
image data in the following formats:

• ER Mapper Raster Dataset (.ers)

• ER Mapper compressed image (.ecw)

• ESRI BIL and GeoSPOT (.hdr)

• Windows BMP (.bmp)

• GeoTIFF/TIFF (.tif)

• JPEG (.jpg)

• USGS Digital Ortho Quad (.doq)

• RESTEC/NASDA CEOS (.dat)

You have to import image data that is not in one of the formats listed above. When 
you import a raster image file (using ER Mapper’s import utility programs), 
ER Mapper converts the data into ER Mapper Raster Dataset format by creating 
two files:

• a binary data file containing the raster data, in band interleaved by line (BIL) format

• a corresponding ASCII header file with a “.ers” file extension

Vector data is stored as lines, points, and polygons. Many geographic information 
system (GIS) products use vector data structures because it is more efficient for 
representing discrete spatial objects like roads (lines), sample locations (points), or 
political boundaries (polygons). In an image processing product, it is often helpful 
to overlay vector data on top of a raster image backdrop, for example overlay a 
network of known roads on a satellite image. When you import a vector file (using 
ER Mapper’s import utility programs), ER Mapper converts the data and creates 
two files:

• an ASCII data file containing the vector data

• a corresponding ASCII header file with an “.erv” file extension
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Image display
After importing the data, the next step is usually to display the image on your 
monitor to evaluate the data quality and geographic area of coverage. If the data is 
of poor quality or does not cover your area of interest, you might decide not to 
proceed any further and try to obtain better data.

There are several ways in which data can be viewed, including simple black and 
white or pseudocolor displays, and red-green-blue (RGB) or hue-saturation-
intensity (HSI) color composite displays. The way in which you choose to display 
your raster data is called the “Color Mode” in ER Mapper. 

In addition to displaying the data, you may want to view statistical information 
about it. Statistics are often good indicators of image quality. You may want to 
calculate statistics for the image, such as the mean value in each band, and view 
them in a tabular format. Or you may want to view statistical information in a 
graphical format using tools like histograms, scattergrams, and traverse profiles. 

Image geocoding
Many times, raster image data is supplied in a “raw” state and contains geometric 
errors. Whenever accurate area, direction, and distance measurements are required, 
raw image data must usually be processed to remove geometric errors and/or 
rectify the image to a real world coordinate system.

• Registration is the process of geometrically aligning images to allow them to be 
superimposed or overlaid.

• Rectification is the process of geometrically correcting raster images so they 
correspond to real world map projections and coordinate systems (such as Latitude/
Longitude or Eastings/Northings).

• Orthorectification is a more accurate method of rectification because it takes into 
account terrain and sensor (camera) calibration details. Advanced orthorectification 
also uses platform position information.

If your application requires that your images be registered to one another or 
rectified to a map projection, you will use ER Mapper’s Geocoding Wizard to do 
this.

Image mosaicing
A mosaic is an assemblage of two or more overlapping images used to create a 
continuous representation of the area covered by the images. ER Mapper automates 
the building of image mosaics because co-registered images referenced in the same 
processing algorithm are automatically displayed in their correct geographic 
positions relative to each other. This means that you can work with each image file 
in the mosaic as a separate entity, and you are not required to write all images to 
one large file on disk in order to process and enhance them. 
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Image enhancement
Image enhancement refers to any one of many types of image processing 
operations used to digitally process image data to aid visual interpretation or extract 
quantitative information meaningful to the user. Image enhancement is what many 
people commonly think of as “image processing.”

In ER Mapper, image enhancement operations are greatly simplified by the 
“algorithms” processing concept. Nearly all types of image enhancement 
operations can be applied and displayed in real time to provide truly interactive 
control without writing temporary files to disk. 

Typical image enhancement operations include:

• Image merging (data fusion)–Combine images with different qualities to aid 
interpretation. For example, merge Landsat TM and SPOT Pan to combine TM 
spectral information with SPOT Pan spatial detail.

• Colordraping–Drape one type of data over another to create a combined display 
allowing analysis of two or three variables. For example, drape a satellite-derived 
vegetation map over an airborne magnetics image of the same area, or overlap 
magnetics and radiometrics images to check for correlations.

• Contrast enhancements–Improve image presentation by maximizing the contrast 
between light and dark portions (or high and low data values) in an image. Or, 
highlight a specific data range or spatial area in an image.

• Filtering–Enhance edges, smooth noise, or highlight or suppress specific linear or 
spatial features in images. For example, apply a gradient directional filter to 
highlight linear features tending north-south in an image. ER Mapper also includes 
Fast Fourier Transformations for filtering in frequency domain space.

• Formula processing–Apply mathematical operations to combine multiple bands of 
image data or derive specific thematic information. Examples include thresholding, 
differencing, ratios, Principal Components Analysis, and spatial modeling.

• Classification–Statistically group or cluster image data values into thematic 
categories or feature classes. For example, classify a Landsat satellite image to yield 
a thematic map of land cover types. (Raster representations of the spatial cover types 
can also be converted to vector polygons for export to GIS systems.)

• Color balancing–Balance the colors of mosiaced airphoto images to create seamless 
joins between them.

Dynamic Link layers
Dynamic Links are a special ER Mapper feature that let you link to data in external 
products or file formats, and display the data on top of raster images without the 
need for importing the files. Dynamic Links can link to raster, vector, or tabular 
(point) datasets, so you can access and integrate all your geographic information. 
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ER Mapper provides Dynamic Links to several popular products and file formats. 
The procedure is fully documented so you can also create your own links to any 
other product or format you desire. 

Types of Dynamic Links include: 

• Links to GIS products–Extract and display vector data from GIS products such as 
ARC/INFO. GIS links are often used to overlay vector data such as road networks, 
political boundaries, or land use categories. 

Tip: You can display, edit, and save ARC/INFO coverage files directly in ER Mapper. 
See the ER Mapper User Guide for details.

• Links to database products–Extract and display tabular (point location) data from 
database products such Oracle. Tabular links are often used to overlay 
georeferenced point location symbols such as cities, well locations, or ground truth 
sample sites.

• Links to external file formats–Display specialized annotation, vector data, or other 
data stored in PostScript, DXF, DGN, or other standard file formats.

Map composition
You can use ER Mapper’s built-in Annotation and Map Composition tools to create 
top quality maps combining raster, vector, and tabular data. Annotation lets you 
draw directly on-screen using text, line, polygon, and other annotation tools, and 
specify fill color, shading, line styles, user-defined symbols, and group and move 
objects. Vector annotation files created in ER Mapper can also be exported to 
external file formats for use in other products.

You can layout and compose maps comprising multiple processed images, and size 
and scale map output as desired. All map objects are defined as full color 
PostScript, and you can easily add custom map objects such as company logos or 
special north arrows.

Data save/export and hardcopy
Once you have completed processing your data, ER Mapper lets you translate 
raster and vector image data to external standard file formats or print to over 200 
different hardcopy devices and any Windows printer. 

You can save raster images directly to the following formats:

• ER Mapper Raster Dataset (.ers)

• ER Mapper compressed format (.ecw)

• ER Mapper Virtual dataset (.ers)
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• ESRI BIL and GeoSPOT (.hdr)

• Windows BMP (.bmp)

• GeoTIFF/TIFF (.tif)

• JPEG (.jpg)

• UDF (.ers and .hdr)

UDF (Universal Data Format) saves the image with an ER Mapper (.ers) and ESRI 
BIL GeoSPOT (.hdr) file. This allows it to be directly read by a number of image 
processing applications.

You may also want export vector annotation or vectorized thematic data to a GIS 
product. 

The ER Mapper compressed format uses ECW (Enhanced Compressed Wavelet) 
compression to make the output image file size considerably smaller than the 
original with minimal loss in quality. The single .ecw file contains embedded 
georeferencing information that can be used by ER Mapper and external GIS 
applications.

Hardcopy printing is often the final goal of processing and annotating images, and 
ER Mapper provides unsurpassed hardcopy support and output to standard graphics 
file formats. ER Mapper also includes a built-in PostScript-compatible rendering 
engine, so you get PostScript-quality output (such as beautiful, smooth text) on any 
supported device, whether the device supports PostScript or not. 

You can also easily print at exact sizes and map scales, and automatically print 
large images in strips for mosaicing large image displays. Supported hardcopy 
devices include any Windows printer, film recorders, dye sublimation printers, 
inkjet printers, and electrostatic plotters. Graphics file formats include PostScript, 
TIFF, Targa, CGM, and CMYK and RGB color separations.

ER Mapper wizards
ER Mapper has a number of useful wizards which simplify and automate much of 
the image processing. These are described in the ER Mapper User Guide and 
summarized below:

Image Display and Mosaicing Wizard
This wizard allows you to enter the file names of raster and vector images, which it 
then displays and/or mosaics to your requirements.
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Image Compression Wizard
This wizard enables you to save an image in ECW compressed format. It provides a 
User Interface for you to specify a target compression ratio.

Color Balancing Wizard for Airphotos
This wizard automatically balances and clips the images in the currently active 
image window to produce seamless mosaics.

Change Projection/Datum/Cell Size Wizard
This wizard was designed to accommodate TIFF/TFW images that do not have 
Projection/Datum information. When the Projection and Datum of an image is 
unknown, ER Mapper defaults to RAW/RAW or WGS84/LOCAL, which may not 
be correct. Also, if the TFW file specifies the Cell Size to be in feet, ER Mapper 
will incorrectly assume it to be in meters.

This wizard modifies the ERS header file with the image with Projection, Datum, 
and Cell Size information you specify. It creates a new ERS header file if one does 
not exist. ER Mapper uses this information in preference to that included in a TFW 
file.

Ortho and Geocoding Wizard
This wizard geocodes images (including orthorectification) to remove distortion 
and set them to the correct spatial coordinates and rotation. 

Gridding Wizard
This wizard generates gridded raster images from point, line or polygon data.

3-D Algorithm Wizard
This wizard creates a single surface 3D algorithm from a raster and a height image 
which you specify.

Contouring Wizard
This wizard adds a contour layer to a display algorithm to generate contours 
directly from an image or algorithm file.
Comprehensive ER Mapper Training Workbook  34



Chapter 1 Introduction to ER Mapper ●  ER Mapper wizards
Landsat TM Wizard
This wizard creates one of several standard Landsat TM algorithms. You specify 
the Landsat TM image, and select the type of algorithm required.

Landsat Web Publishing Wizard
This wizard gives you a choice of algorithms that it can create using the Landsat 5 
or Landsat 7 image files that you specify. It also compresses the resultant images, 
and creates ready-to-use web pages for you to serve the images from an Image Web 
Server.

Common Geophysical Images Wizard
This wizard creates a selectable common type of magnetic and gravity image. You 
specify the image dataset to use.

Magnetics Fourier Wizard
This wizard applies a 1st Vertical Derivative or Reduce to Pole FFT formula on a 
single band of an image. You specify the input and output image, and select the 
band and FFT process to apply.

Page Setup Wizard
This wizard interactively leads you through setting up a page, including the 
addition of an optional vector layer.

Local Government Applications Wizard
This wizard automatically runs change detection algorithms on temporal aerial 
images. It also combines 1-Bit scanned mapping to aerial images, changing line 
colors and removing white areas to aid integration and visualization.

.tab file reader
This tool reads existing MapInfo table (.tab) files (image file only) and 
automatically creates ER Mapper .ers header files. This allows MapInfo users to 
view, mosaic and compress images with ER Mapper without needing to convert 
them manually. 
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Designing your own wizards
You can use the ER Mapper batch scripting language to design your own wizards to 
simplify regular tasks. You can even add an entry or button to the menu and 
toolbars. Refer to Part Six - Batch Scripting and Wizards, Chapters 26,27,28 in the 
Customizing ER Mapper manual for information on the batch scripting language.
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2

User interface
basics

This chapter introduces the basic use of the ER Mapper graphical user interface. It 
gives you practice using menus, toolbars, dialog boxes, and image windows, and 
loading and displaying image processing algorithms.

Note: In order to complete the exercises in this manual, you will need to access the 
sample images and algorithms supplied with ER Mapper. If needed, ask your 
system manager for the location of the ER Mapper software directory at your site. 

User interface components
This section provides a brief introduction to the main components of ER Mapper’s 
graphical user interface (GUI). You can perform nearly all operations by pointing 
and clicking with the mouse, and very little typing on the keyboard is required. The 
GUI is part of ER Mapper’s original design, so it is well integrated and easy to 
learn and use.
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Using mouse buttons
When using ER Mapper, use the left button on your mouse to perform operations 
like selecting items from menus, manipulating image windows, and drawing 
annotation. In this manual, all actions are performed with the left mouse button 
unless otherwise indicated. The following table explains terms used in this manual 
to describe actions you perform with the mouse.

The symbol representing the mouse pointer on the screen changes shape depending 
on what you are pointing to and the task you are performing.

Term Meaning

Point Position the mouse pointer on an item.

Click Point to an item, then quickly push and release the left mouse 
button.

Right-click Point to an item, then quickly push and release the right 
mouse button.

Double-click Point to an item, then quickly click the left mouse button 
twice.

Drag Point to an item. Then press and hold down the left mouse 
button as you move the pointer to a new location, then release 
the button.

Shift-click or
Ctrl-click

Hold down the Shift key or Ctrl key on your keyboard, then 
click.

Shift-drag or 
Ctrl-drag

Hold down the Shift key or Ctrl key on your keyboard, then 
drag the mouse.

Pointer Location on the screen Function

 Menu bars and buttons; or 
inside image window

Choose menu commands and click 
buttons; point to the image to see 
data values or coordinates.

 Text fields Type or select text, or reposition the 
insertion point.

Inside the current image 
window

Zoom the image within the image 
window.

Inside the current image 
window

Drag a box over an area to fill image 
window.
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The ER Mapper main menu
When you start ER Mapper, the main menu appears. The main menu has two 
primary components–the menu bar and rows of toolbar buttons.

Using ER Mapper toolbars
Toolbars give you quick access to many common functions, such as saving an 
image processing algorithm or printing a hardcopy. ER Mapper also provides 
optional toolbars for specific tasks and image processing applications. To hide or 
display various toolbars, use the Toolbar menu. To get short help for any toolbar 
function, point to the button and read the tool tips.

Inside the current image 
window

Pan the image within the image 
window.

 Inside inactive image 
windows

Select an inactive window to become 
the current window.

 In image windows when 
annotation tools are selected

Draw annotation and map 
composition objects.

Menu bar Lets you select commands used to carry out actions in 
ER Mapper. To select a command from the menu bar, 
click on the name of the menu to open it, then click the 
desired command name.

Toolbar buttons Shows groups of buttons to let you carry out common 
tasks quickly. To choose a function from a toolbar, click 
on the desired button. 

Tool tips Place the cursor on any toolbar button and within a 
couple of seconds the function of that toolbar button is 
displayed in a small text window just below the cursor

Title bar

Buttons

Toolbars

Menu bar
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ER Mapper provides toolbars for many common tasks, and also toolbars for 
building processing algorithms commonly used in remote sensing applications such 
as forestry, geophysics, and map generation. The functions of the Standard, and 
Common Functions toolbars are summarized below.

Using ER Mapper’s scripting language, you can also create your own customized 
toolbars for specific tasks and functions. For more information on creating custom 
toolbars, see the ER Mapper User Guide. 

Using dialog boxes
When you select menu commands or click toolbar buttons, dialog boxes often 
appear for you to choose options to control your image processing tasks. Some 
dialog boxes, such as the File Chooser, can disappear when you make your 
selection. Other dialogs can remain open for setting options for as long as you want 
to use them. 

To resize a dialog box, drag one of its corners or edges to the desired size. 
ER Mapper automatically resizes the dialog box intelligently, so that any central 
display areas are enlarged, and the layout of buttons remains the same. After 
resizing, the dialog retains your new size for the current ER Mapper session. 

Standard Provides quick access to standard commands for 
opening and saving algorithms, printing, starting and 
stopping algorithm processing, and changing the mouse 
pointer. Most functions are also available from the 
menu bar.

Common Functions Provides quick access to commonly used functions, 
such as creating general types of algorithms, viewing 
and editing components of an algorithm.

text fields
(click to
place cursor)

drop-down
list (click to
open)

click to load
file

close dialog
without action

display setup
options

access on-line
help for this
function
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Using the File Chooser dialog boxes
When you choose to open or save a dataset, algorithm, or other file, ER Mapper 
displays a File Chooser dialog box. The central window contains a list of 
directories, or files in the current directory.

To open a file or directory displayed in the scroll list window, either double-click 
on it, or click once to select it and click the OK or Apply button to open it. 

Tip: You can see two levels of directories and/or files by widening the file chooser 
dialog box (drag one of the sides).

current directory

scroll to view 
other items
in directory

click to view
comments

click to load and leave dialog open
click to load and
close dialog box

click to move up
and down one
directory level

menu bar to 
navigate and
mark directories

 

file types
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The File Chooser menus at the top have the following functions:

Using the on-line help system
ER Mapper provides an extensive on-line help system with both simple overviews 
and detailed descriptions of all features and functions. There are two ways to access 
help:

Typing text in text fields
To enter text for naming files or changing values in dialog boxes, ER Mapper 
provides text fields. When you point to a text field, the pointer shape changes to an 
I-beam. To enter text, click anywhere inside the text field to place the text cursor. 

To select existing text, you can drag through the desired portion, or double-click on 
a word or numeric value to select it. Text that is selected become reverse 
highlighted, and any subsequent typing replaces it. 

History menu Use to change the File Chooser’s current directory. 
The menu has two parts: the upper portion lists 
most recently visited directories, and the lower 
portion lists marked directories.

Special menu Use to change to your home directory, or to mark or 
unmark a directory (any directory may be marked 
for fast access using the History menu).

View menu Use to sort the contents of the current directory by 
name, date modified, or date created.

Volumes menu Use to access volumes or disk drives on your 
network.

Directories menu Use to change to any directory defined by your 
preferences settings.

ECW URL History List of the URLs of the most recently accessed 
image files from an Image Web Server. 

Help menu Lets you browse all the standard ER Mapper 
manuals on-line, and go between manuals and 
topics using hypertext links.

Help buttons The Help button inside dialog boxes gives you 
context-sensitive help. If needed, you can navigate 
to view more detailed information using the 
hypertext links.
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Hands-on exercises
The following hands-on exercises introduce you to the basic concepts of using 
menus and dialog boxes and managing image windows.

• Choose options from menus and toolbar buttons

• Display and hide toolbars

• Open an empty image window

• Open an image processing algorithm into a window

• Move and resize an image window

• Zoom and pan the image within the window

• Manipulate multiple image windows on the screen

• Close image windows

1: Using menus and toolbars

Move the ER Mapper main menu around the screen
1 Position the mouse pointer on the ER Mapper main menu title bar, then 

drag it to the lower-left part of the screen.

Pointing to the title bar and dragging is how you move dialog boxes and image 
windows around the screen.

2 Drag the main menu to the upper-right corner of the screen. 

This is the recommended position for the main menu for the exercises in this 
tutorial. 

Open a menu to display its commands, then close the menu
1 Click on the View menu button; a list of commands under the menu 

displays. 

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Objectives Learn to open and make selections from menus, use toolbars, and access on-line 
help.
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The small arrows next to Quick Zoom and Statistics indicate that they have 
additional commands under them.

2 Click on the Statistics command to display its submenu.

3 Click anywhere outside the main menu to close the open menus without 
making a selection.

Note: In the rest of this manual, selecting commands from menus is indicated as follows: 
“From the Edit menu, select Preferences...” (which means click on Edit in the 
menu bar, then click on the Preferences command).

Select the Print command from the menu bar
1 From the File menu, select Print.

The Print dialog box appears with options for printing hardcopy.

2 Click the Cancel button to close the dialog box.

Select the Print command from the Standard toolbar

1 On the Standard toolbar, click the Print  button. 

The same Print dialog box appears again. Using toolbar buttons is often a faster 
way to access many commands in ER Mapper.

2 Click the Cancel button to close the dialog box.

Tip: Many common commands on the menu bar, such as Print, are also available on the 
Standard toolbar. Use whichever is fastest or most comfortable.

Display and hide a toolbar
1 From the Toolbar menu, select Forestry.

A third row of toolbar buttons appears on the main menu below the Standard and 
Common Functions toolbars. This toolbar has buttons for common image 
processing techniques used in forestry applications. 

2 Point the cursor to any button on the toolbar.

A description of the button function displays in the small text field just below the 
cursor. 

3 From the Toolbar menu, select Forestry again.
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The Forestry toolbar buttons disappear from the main menu. Use the Toolbar 
menu to display or hide any toolbar. (It is recommended that you always display the 
Standard and Common Functions toolbars.)

2: Opening windows and algorithms
To display an image in ER Mapper, you first open an empty image window, then 
load and display an image processing algorithm. The algorithm references a raster 
data file on disk, and the processing steps ER Mapper uses to enhance and render 
the data on the screen display. (You will learn more about algorithms later.) You 
can have as many different image windows open on the screen as you need.

Open a new empty image window
1 From the File menu, select New.

An empty image window opens in the upper left corner of the screen. The window 
title bar reads “Algorithm Not Yet Saved” because no processing algorithm is 
associated with this image window yet.

Open and display an image processing algorithm
1 From the File menu, select Open....

The Open file chooser dialog box opens. 

2 From the Directories menu, select the path ending with the text \examples 
(The portion of the path name preceding it is specific to your site.)

3 Double-click on the directory named ‘Data_Types’ to open it.

4 Double-click on the directory named ‘Landsat_TM’ to open it. (Scroll if 
needed to view it first.)

The list of example algorithms for processing Landsat Thematic Mapper (TM) 
satellite imagery displays.

5 Double-click on the algorithm named ‘RGB_321.alg.’ (Scroll down if needed 
to view it first.)

ER Mapper runs the algorithm and displays an enhanced Landsat TM image of San 
Diego, California in the image window. This algorithm displays bands 3, 2, and 1 
of the Landsat image as an RGB color composite image, with band 3 in the red 
display channel, band 2 in the green, and band 1 in the blue. Notice also that the 
algorithm filename ‘RGB_321’ now appears in the title bar of the image window.

Objectives Learn to open image windows on your computer display, and open and run an 
image processing algorithm stored on disk.
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Use the toolbar to open a different processing algorithm

1 Click the Open  button on the Standard toolbar. 

The Open file chooser dialog box appears. (This toolbar button has the same 
function as selecting Open... from the File menu.)

The algorithm named ‘RGB_321’ in the ‘Data_Types\Landsat_TM’ directory is 
already highlighted since it is currently loaded into the image window. 

2 Double-click on the algorithm named ‘RGB_541.alg.’

ER Mapper runs the algorithm and displays a color composite of the same Landsat 
image, this time using bands 5, 4, and 1. Notice that the title bar also changes to 
show the filename of the new algorithm.

Note: By default, ER Mapper runs the algorithm automatically for you when you open it 
from disk. You can also reprocess the data at any time by clicking the Refresh 

 button. 

3: Resizing windows and zooming/panning

Move the image window on the screen
1 Point the mouse at the image window title bar, then drag it to another part of 

the screen.

2 Drag the image back to the upper-left part of the screen.

Like dialog boxes, dragging images by the title bar is how you move them around 
the screen.

Resize the image window
1 Move the mouse pointer directly over the lower-right corner of the image 

window–the pointer shape changes to a double ended arrow.

2 Drag the lower-right corner to make the window about twice its original size, 
then release.

Objectives Learn to move and resize image windows, zoom (magnify) part of an image, and 
pan (scroll) to other parts of an image.
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Dragging any side or corner of an image window lets you change the default 
window size as you desire. 

Note: When you resize a window, ER Mapper maintains the size of the image inside the 
window. Empty areas on the sides are filled with a cross-hatch pattern to indicate 
that no data is displayed there.

Set the mouse pointer to Zoom mode

1 On the Common Functions toolbar, click the Zoom Tool  button. 

This tells ER Mapper to use the mouse pointer for zooming when it is positioned 
inside an image window. Also notice that the Zoom Tool button becomes 
depressed to indicate that it is the active pointer mode.

2 Move the pointer inside the image window.

The mouse pointer displays as a magnifying glass icon.

Zoom in and out of the image with the mouse
1 Position the pointer in the center of the image, and click the left mouse 

button.

The image zooms in by 50%.

2 Position the pointer in the center of the image, hold down the Ctrl. key while 
clicking the left mouse button.

The image zooms out by 50%.

3 Position the pointer in the image, and then drag it up and down.

As you drag the pointer down the image is magnified, i.e you zoom into it. When 
you drag the pointer upwards, the image gets smaller, i.e you zoom out.

Set the mouse pointer to ZoomBox mode

1 On the Common Functions toolbar, click the ZoomBox Tool  button. 

This tells ER Mapper to use the mouse pointer for creating a zoom box when it is 
positioned inside an image window. Also notice that the ZoomBox Tool button 
becomes depressed to indicate that it is the active pointer mode.

2 Move the pointer inside the image window.

The mouse pointer displays as a magnifying glass and box icon.
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Zoom in (magnify) an area of the image with the mouse
1 Position the pointer near the upper-left center of the image, then drag to the 

lower-right to define a box.

When you release the mouse, ER Mapper runs the algorithm again and magnifies 
(or “zooms in”) on the area of the image you defined with the box. Dragging a 
zoom box is a fast way to magnify an area of interest. (There are other zooming 
functions you will learn about later.

Set the mouse pointer to Hand mode

1 On the Common Functions toolbar, click the Hand Tool  button. 

This tells ER Mapper to use the mouse pointer for panning when it is positioned 
inside an image window. Also notice that the Hand Tool button becomes 
depressed to indicate that it is the active pointer mode.

2 Move the pointer inside the image window.

The mouse pointer displays as a hand icon.

Pan (scroll) the image within the window with the mouse
1 Click on the image. and drag it to a new position in the image window.

The hand pointer will grab the image and move it (pan) to the new location.

Zoom back out to view the full image extents
1 From the View menu, select Quick Zoom and then select Zoom to All 

Datasets.

ER Mapper runs the algorithm again and zooms back out to display the full extents 
of the Landsat image data. The Quick Zoom submenu provides many options for 
zooming in or out to specific datasets, setting window geolinking, and other options 
you will learn more about later.

Zoom and pan using buttons for predefined options
In addition to using the mouse, ER Mapper also lets you zoom and pan using 
buttons to invoke predefined zoom and pan functions. 

1 From the View menu, select Geoposition....

The Algorithm Geoposition Extents dialog box appears.
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Note: You can also click on the Geoposition Window button  on the Algorithm 
window to open the Algorithm Geoposition Extents dialog box

2 In the row of options at the top, click on the Zoom option to turn it on.

The contents of the Algorithm Geoposition Extents dialog change to show 
sets of buttons for zooming and panning the image within the window.

3 In the buttons labelled ‘Zoom,’ click the Zoom out 50%  button. 

ER Mapper runs the algorithm and zooms out to 50% of the previous display 
resolution. 

Tip: For all icons on buttons under ‘Zoom’ and ‘Pan,’ the black square represents the 
current image, and the white box represents how the size or position of the image 
will change after the button is clicked.

4 In the buttons labelled ‘Set Extents To,’ click Previous.

ER Mapper zooms out to the previous image display extents.

5 Under ‘Zoom,’ click on the Zoom in 100%  button. 

ER Mapper magnifies the images to two times (100%) of the previous display 
resolution (and keeps the image center point constant).

6 Under ‘Pan,’ click on the Pan left  button. 

ER Mapper pans or scrolls the image 50% to the left (the previous center point is 
now on the far right side of the image).

7 Under ‘Pan,’ click on the Pan upper-right  button. 

ER Mapper pans the image 50% to the upper-right (the previous center point is now 
on the lower-left corner of the image).

8 Experiment with other buttons under Zoom and Pan to see their effect.

9 Under ‘Set Extents To,’ click the All Datasets button.

ER Mapper resets the image extents to fit the entire dataset in the image window.

10 Click Close on the Algorithm Geoposition Extents dialog to close it.
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4: Managing multiple image windows

Open a second image window
1 From the File menu, select New.

ER Mapper opens a new image window. As with all new image windows, it has no 
algorithm associated with it yet.

Open and display a processing algorithm in the new window
1 From the File menu, select Open....

The Open file chooser dialog box appears.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Data_Types’ to open it.

4 Double-click on the directory named ‘SPOT_Panchromatic’ to open it.

The list of example algorithms for processing SPOT Panchromatic satellite imagery 
displays.

5 Double-click on the algorithm named ‘Greyscale.alg.’

ER Mapper runs the algorithm and displays a SPOT Panchromatic satellite image 
the San Diego (the same geographic area covered by the Landsat image in the other 
window). The SPOT Pan data provides greater spatial detail than the Landsat data, 
but has only one spectral band which is displayed in greyscale. 

Move the SPOT window to overlap with the Landsat window
1 Drag the image window titled ‘Greyscale’ to the center of the screen until it 

partially overlaps with the Landsat ‘RGB_541’ image window. 

Objectives Learn to open a second image window, specify overlap priority between 
windows, activate an image window, and close image windows.
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Your windows should be similar to the following diagram:

Move one window in front of the other
1 Click on the title bar of the window with the algorithm description titled 

‘RGB_541.’ 

The Landsat window moves in front of the SPOT window where there is overlap.

2 Click on the title bar of the window with the algorithm description 
‘Greyscale.’

The SPOT window now moves in front of the Landsat window where there is 
overlap. Clicking on the title bar of a window or dialog box bar lets you choose 
which window or dialog box to display on top of others.

Select a window to be the active window
The “active” image window is the one you want to currently work with, such as 
zooming, loading a new processing algorithm, or editing the current algorithm.

1 Look at the title bar of the SPOT Panchromatic window and notice the three 
asterisks (***) on either side of the window title.

The three asterisks indicate that this is the active (or current) window of the two.

2 Move the pointer inside the image area of the window with the algorithm 
description titled “RGB_541.” 

The pointer shape changes to a pointing hand. (This happens whenever you move 
from the active window to any inactive image window.)

3 Click anywhere inside the Landsat image window or on the Title Bar. 

It now becomes the active window and three asterisks appear next to the title.

4 Click inside the SPOT window or on the Title Bar again to make it active.

Landsat TM
window

SPOT Pan
window
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Note: A window can be active and still be covered by another “inactive” window. To 
move the active window to the front, click on its title bar.

Close both image windows
1 Close one image window using the window system controls:

• Select Close from the window control-menu.

The window closes and disappears from the screen.

2 Close the other image window by repeating Step 1.

The window closes and disappears from the screen. Only the ER Mapper main 
menu is now open.

• Choose options from menus and toolbar buttons

• Display and hide toolbars

• Open an empty image window

• Open an image processing algorithm into a window

• Move and resize an image window

• Zoom and pan the image within the window

• Manipulate multiple image windows on the screen

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Creating an
algorithm

This chapter introduces the basic concepts involved in creating a simple image 
processing algorithm. You learn about the interface ER Mapper provides for 
creating and editing algorithms (the Algorithm window). As an application 
example, you learn how to create an algorithm that processes a Landsat TM 
satellite scene to render an image showing patterns of vegetation in the area (a 
“vegetation index” image). 

Note: This lesson is a “quick start” for creating a simple algorithm. You learn more about 
the concepts and procedures covered here in later chapters. 

About the algorithms concept
The goal of all image processing is to enhance your data to make it more 
meaningful and help you extract the type of information that interests you. To make 
this procedure faster and easier, Earth Resource Mapping developed a new image 
processing technique called “algorithms.” Understanding how to use algorithms is 
the key to understanding how to use ER Mapper effectively. 
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What is an algorithm?
An algorithm is a list of processing steps or instructions ER Mapper uses to 
transform raw data on disk into a final, enhanced image. In this sense, algorithms 
let you define a “view” into your data that you can save, reload, and modify at any 
time.

You use ER Mapper's graphical user interface to define your list of processing 
steps, and you can save the steps in an algorithm file on disk. An algorithm file can 
store any of the following information about your processing:

• Names of image dataset(s) to be displayed

• Subsets of the image dataset(s) to be processed (zoomed areas)

• Bands in the image dataset(s) to be processed

• Brightness and contrast enhancements (Transforms)

• Filtering to be applied to the data (Filters)

• Equations and combinations of bands or images used to create the output image 
(Formulae)

• Color mode used to display the data (Pseudocolor, Red Green Blue, or Hue 
Saturation Intensity)

• Any vector images, thematic color, or map composition layers to be displayed over 
the raster image data

• Definition of a page size and margins (used for positioning the image on a page for 
creating maps and printing)

By being able to apply a set of processing steps as a single entity, the complexity 
often associated with digital image processing is greatly reduced. In addition, you 
gain tremendous savings in disk space, since you do not need to store intermediate 
processed copies of your original data on disk.

Building Algorithms in ER Mapper
There are two primary ways to build a processing algorithm in ER Mapper:

• Use the Algorithm window to add the desired types of layers, load images, and 
specify processing steps for each layer.

• Click a toolbar button to have ER Mapper automatically create an algorithm for you. 
In this case, ER Mapper adds the appropriate layers to the Algorithm window, 
prompts you to load an image, and possibly other options as well.

The majority of exercises in this manual ask you to build algorithms from scratch 
so you become familiar with and thoroughly understand the basic concepts. 
However, you will also use the automatic algorithm creation toolbar buttons from 
time to time to understand how they work.
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Using Algorithms as Templates
Once you have saved your processing instructions as an algorithm file, you can use 
the algorithm as a “template” to easily apply the same processing to different 
images. Any algorithm can be used as a template, but ER Mapper also provides 
many template algorithms for common tasks. These include common display 
techniques (RGB, single band greyscale, etc.), writing processed image files to 
disk, and saving algorithms as “virtual datasets.” Using template algorithms saves 
time, and you will learn more about them in later lessons.

In addition, the toolbar buttons allow you to create various types of common 
algorithms very quickly. You will learn more about using toolbar buttons for these 
tasks later.

The Algorithm window
The Algorithm dialog is a special dialog box that serves as your “command 
center” for creating and editing algorithms in ER Mapper. To open the Algorithm 
dialog, you can select Algorithm... from the View menu or click the Edit 

Algorithm  toolbar button. The key components of the Algorithm dialog are 

labelled below and described in the table that follows.

Data structure diagram Shows a list of surfaces and layers contained in the 
current algorithm using a hierarchy or “tree” structure. 
Select (click on) a surface or layer change its options 
using the Tab pages.

process diagram
for selected
layer

menu to add
or change
layers/surfaces

tab pages to select categories of options for
layer or surface (Layer tab page is selected)

data
structure
diagram

list of layers
in surface

view mode (2D or 3D)

surface

panel
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Surface A group of raster and/or vector data layers that combine 
to create a view or image. A single algorithm can have 
multiple surfaces that become independent entities when 
viewed in 3D mode.

Layers Components of a surface that contain data used to 
construct an image. Different layer types can contain 
raster or vector data, and processing for each layer is 
controlled independently from the others.

View Mode Sets the manner in which data is displayed as two 
dimensions (2D) normal or page layout, or three 
dimensions (3D).

Tab pages Display categories of options for controlling the image 
display and processing techniques, such as Layer for 
options for the current layer, or Surface for options that 
apply to an entire surface.

Process diagram Used to control the processing operations applied to 
image(s) in the currently selected layer (displayed when 
Layer tab is selected).

The Process Diagram
When the Layer tab is selected, the horizontal row of buttons in the right-hand 
panel of the Algorithm dialog are called the process diagram. They are used to 
define your image processing operations for the currently selected data layer. Each 
button in the diagram controls a specific image processing function.

As the arrows indicate, the processing stream flows from left to right. Typically, 
you may specify an image to be used, the bands within the image to be processed, 
then apply processing using formulae, filters, transforms or other options to create 
your desired image. ER Mapper compiles all the processing steps you specified and 
renders the resulting image to the screen display. The name and function of the 
main processing stream buttons are as follows.

Button Function

Dataset Use to load an image from disk, or edit or view 
information or comments about an image. 

Band Selection Use to select one or more bands in the image for use 
in generating an image (a drop-down list). 

Formula Use to enter, load, or save a formula to perform image 
algebra and other arithmetic operations. 
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Note: A cross or “X” through the button indicates that the function is not active in the 
current data layer. In addition, there are other buttons for some layer types that you 
will learn about later in this manual.

Hands-on exercises
These exercises show you how to initially display an image, and how to build, save,
and reload a simple image processing algorithm. It also shows how you can easily
change the image to view it in 3D perspective.

Note: These exercises briefly introduce concepts and procedures that are explained in
more detail later in this workbook.

• Load a new image and choose which bands to display

• Use the Algorithm dialog to define a processing algorithm

• Change the color lookup table for an image

• Add a formula to an algorithm

• Add text labels and comments to an algorithm

• Save the processing algorithm to disk

• Reload and view the saved algorithm

Filter Use to add or delete one or more spatial filters. (There 
are both pre- and post-formula Filter buttons.) 

Transform Use to adjust image contrast and brightness. (There 
are both pre- and post-formula Transform buttons.) 

Sunshade Use to specify artificial illumination of the image to 
create shaded relief effects. 

What you will 
learn...

After completing these exercises, you will know how to perform the following
tasks in ER Mapper:

Button Function
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• Add a Height layer to view the image in 3D perspective

1: Loading and displaying images

(Part 1 shows you how to load an image from disk and display it on-screen for an 
initial look at the data. The image was previously imported from a magnetic tape or 
other media and now resides on the computer's hard disk. Details on importing data 
are discussed in the other ER Mapper manuals.)

Open an image window and the Algorithm window
1 From the View menu, select Algorithm....

A new empty image window opens in the upper-left corner of the screen, and the 
Algorithm window opens in the lower-right.

Note: ER Mapper remembers where you last positioned dialog boxes on your screen. 
Therefore the Algorithm window could be positioned differently to what is 
described above.

The Layer tab is usually already selected when you first open the Algorithm dialog 
box. Note that the Algorithm window shows one Pseudocolor layer (labelled 
“Pseudo Layer”) in the left of the dialog, with the red arrow pointing to it meaning 
that is the active layer.

If you open the Algorithm window when no image windows are currently open (as 
in this case), ER Mapper opens an empty image window for you automatically. 
This shortcut saves you the step of opening a window. 

Load a raster image into the Pseudocolor layer

1 In the Algorithm window, click the Load Dataset  button on the left side 
of the process stream diagram.

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to open an image window and the Algorithm window, load an image 
dataset, and display the image on-screen. You will also learn to display different 
bands in the image, and change the lookup table ER Mapper uses to assign colors 
to the image.
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The Raster Dataset file chooser dialog box appears.

2 From the Directories menu, select the path ending with \examples. 

The scrolling list in the center now shows a list of directories containing example 
images supplied with ER Mapper (such as ‘application...’ and others).

3 Double-click on the directory named ‘Shared_Data.’

A list of raster images is displayed. Note that each has a “.ers” file extension. This 
is the file extension associated with raster files in ER Mapper format. 

4 Scroll down to view the image named ‘Landsat_TM_year_1985.ers,’ then 
double-click on it to load it.

The file chooser dialog box closes, and the image is loaded into the Pseudocolor 
layer. Note that the layer now shows the name of the image loaded 
(‘Landsat_TM_year_1985’), and the button left of the name is now selected 
(indicating that the layer is turned on).

ER Mapper renders the image in the image window. The image is displayed in a 
range of colors because the color table named Pseudocolor is chosen. 

Note: ER Mapper remembers the last color table selected. Therefore, it might not be 
Pseudocolor as described above.

Also note that Band Selection drop-down shows the label ‘B1:0.485_um.’ This 
indicates that band 1 of the Landsat image is currently selected for the layer.

Select and display different bands in the Landsat image
Landsat Thematic Mapper (TM) satellite images usually contain seven spectral 
bands. You can choose to display any band (or a combination of bands) in a raster 
data layer.

1 In the Algorithm window, click on the Band Selection  drop-
down list in the process stream diagram.

A menu listing the seven different bands in the Landsat image displays.

2 Click on the band labelled B2:0.56_um. 

The menu closes and the new band appears in the Band Selection list button.

ER Mapper renders band 2 of the Landsat image in the image window. (The colors 
look different to those for band 1 because the range of data for band 2 is different 
than band 1. (You will learn about data ranges and how to adjust image brightness 
and contrast later.)
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3 From the Band Selection drop-down list, select the band labelled 
B7:2.215_um.

ER Mapper renders band 7 of the Landsat image in the image window.

4 From the Band Selection drop-down list, again select the band labelled 
B1:0.485_um.

ER Mapper renders band 1 of the Landsat image again.

Tip: The Stop Processing  button or Esc key can be useful when you make a 

mistake, or when you want to take a quick look at the results without waiting for 
processing of the entire image to finish. Change the Color Table (on Surface Tab). 

Press the Refresh Image  button for the processing to continue.

When you are using the Color Mode named Pseudocolor (as you are in this 
example), the Color Table controls the set of colors ER Mapper uses to display the 
image. 

5 In the Algorithm window, click on the Surface tab and then click on the Color 
Table drop-down list button.

A menu listing available color lookup tables appears.

6 Click on the lookup table named green.

ER Mapper renders the image using shades of green. Lower data values display as 
darker shades of green, and higher data values as lighter shades.

Note: When you change the color table, ER Mapper updates the image display 
automatically to apply the new set of colors. 

7 From the ColorTable drop-down list, select brown_green.

ER Mapper renders the image using shades of brown for low data values 
transitioning into shades of green for higher data values.

8 From the Color Table list, select greyscale.

ER Mapper renders the image using shades of grey. Lower data values display as 
darker grey shades, and high data values as lighter greys.

In Part 1, you have created the simplest type of algorithm: a Pseudocolor algorithm 
that displays a single band of data using a color lookup table to control the image 
coloring. You have not saved the algorithm yet because you will modify it later.
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2: Processing the image

Load a vegetation index formula into the layer
1 In the Algorithm window, click on the Layer tab and then click on Edit 

Formula  in the process stream diagram. 

The Formula Editor dialog box appears to let you use standard image processing 
formulas or create your own formulas. The menu bar at the top gives you fast 
access to many formulas. Note that the current formula simply reads ‘INPUT1.’ 
(You will learn more about formulas later.)

2 From the Ratios menu, select Landsat TM NDVI. 

A new formula replaces the original one, and its description appears at the top. 
(This formula is called the Normalized Difference Vegetation Index, or NDVI. It 
uses information in bands 3 (red) and 4 (near infrared) of the Landsat image to 
highlight information on vegetation location and abundance.)

All data is initially displayed as very dark shades of grey in the greyscale lookup 
table because the formula processing produces a narrow range of data values (-1 to 
+1). You will now enhance the image to increase its contrast.

3 Click the Close button to close the Formula Editor dialog.

Adjust the image contrast
1 In the Algorithm window, click on the Layer tab and then click on the right-

hand Edit Transform Limits  button (there are two, choose the one 
right of the Formula button). 

The Transform dialog box opens. Note that the field Actual Input Limits at the 
bottom shows a data range of about -1 to +0.6. This is the range of data values 
produced after the raw Landsat image data was processed through the NDVI 
formula. You need to tell ER Mapper to map the shades of gray in the lookup table 
to this range instead of the 0-255 default data range currently shown along the X or 
horizontal axis of the histogram.

2 From the Limits menu, select Limits to Actual.

The X axis data range changes to match the -0.8 to +0.6 limits of the data after the 
NDVI formula processing.

Objectives Learn to develop a simple processing algorithm using a formula to highlight 
vegetation in the image, and to modify the image contrast and brightness on the 
screen display.
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ER Mapper renders the image again, this time with enhanced contrast. In addition, 
a histogram showing the relative frequency of data values for the processed image 
appears in the center of the Transform dialog.

Areas of vegetation in the image are highlighted in light gray or white, and areas 
with little or no vegetation (such as water) appear very dark. You will increase the 
contrast between the light and dark areas even further. 

3 On the Transform dialog, click the Create autoclip transform  button. 

Contrast between the light and dark areas further increases. The lightest shades 
(densely vegetated areas) are now white and darkest shades (non-vegetated areas) 
are black, making the patterns of vegetation easier to interpret.

4 Click the Close button to close the Transform dialog box.

Note: You will learn more about histograms, data ranges and contrast enhancements later 
in this manual. 

3: Labelling and saving the algorithm

Enter a description for the Pseudocolor layer
1 In the Algorithm window, on the left side of the data structure highlight the 

layer and click on the description with the Pseudo Layer.

The pointer turns into a text cursor, indicating that the area is a text field.

2 Type the text NDVI in the text field, then press the Enter or Return key on 
your keyboard.

This text now becomes a visual description for the layer. 

Note: Layer descriptions are also used to specify labels for bands when you write an 
image to disk or save it as a Virtual Dataset. You will learn about this later.

Objectives Learn to specify description labels, titles, and comments for an algorithm, and 
save the algorithm processing steps to a file on disk for later use.
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Enter a description for the surface
1 In the Algorithm window, on the left side of the data structure highlight the 

surface and click on the "[Ps]: Default Surface" description.

The pointer turns into a text cursor, indicating that the area is a text field.

2 Type the text Surface 1 in the text field, then press the Enter or Return 
key on your keyboard.

This text now becomes a visual description for the surface. Note that the “[Ps]:” 
prefix remains, indicating that the surface Color Mode is Pseudocolor.

Enter a description for the entire algorithm
1 In the Algorithm window, select the text in the Description text field (it 

currently reads ‘No Description’).

(To select the text, either drag through it, or triple-click to select the entire line.)

2 Type the following text, then press Enter or Return on your keyboard:

San Diego vegetation index

This text now becomes a brief description for the entire algorithm.

Save the processing steps to an algorithm file on disk
1 From the File menu (on the main menu), select Save As....

The Save As... file chooser dialog box appears.

2 In the Files of Type: field, select ‘ER Mapper Algorithm (.alg)’.

3 From the Directories menu, select the path ending with the text \examples. 
(The portion of the path name preceding it is specific to your site.)

4 Double-click on the directory named ‘Miscellaneous’ to open it. 

5 Double-click on the directory named ‘Tutorial’ to open it. 

6 In the Save As: text field, click to place the cursor, then type in a name for 
the algorithm file. Use your initials at the beginning, followed by the text 
‘Landsat_NDVI,’ and separate each word with an underscore (_). For 
example, if your initials are “JC,” type in the name:

JC_Landsat_NDVI

7 Click the Apply button to save the algorithm and leave the dialog open.

Your Landsat NDVI algorithm is now saved to an algorithm file on disk.
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Add comments to the algorithm
1 Click the Comments... button.

A dialog box appears showing the algorithm file name with a text area for you to 
type comments about your algorithm. The cursor is already active in the upper-left 
corner.

2 Click Cancel on the Save Algorithm dialog to close it (you do not need it).

3 In the Comments dialog, type the following information about your 
algorithm:

This algorithm uses the Normalized Difference Vegetation
Index (NDVI) formula to highlight vegetation in a Landsat 
TM image of San Diego. Areas with abundant vegetation 
appear as lighter shades of grey.

4 Click the OK button to save your comments with the algorithm.

5 Click Cancel on the Save Algorithm dialog to close it.

(If you accidentally click OK, click Cancel when asked to overwrite the file. 
Otherwise your comments will not be saved with the algorithm file.)

4: Reloading and viewing the algorithm

Open a second image window

1 On the Standard toolbar (on the main menu), click on the New  button. 

ER Mapper opens a new image window (this is a shortcut for selecting New from 
the File menu). Drag the new window to the lower left part of the screen (so you 
can see all or part of the other image window). 

Open the processing algorithm you created earlier

1 On the Standard toolbar, click on the Open  button. 

The Open file chooser appears. (This is a shortcut for selecting Open... from the 
File menu.)

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Miscellaneous’ to open it. 

Objectives Learn to reload and display the algorithm you just created, and to view the text 
file on disk that defines the algorithm processing steps.
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4 Double-click on the directory named ‘Tutorial’ to open it.

Your Landsat NDVI algorithm should appear in the list.

5 Click once on your algorithm name to highlight it (do not double-click).

6 Click the Apply button to load and process the algorithm without closing the 
Open dialog box.

ER Mapper runs the algorithm and displays the processed Landsat image in the 
image window. It should look identical to the other image since they both use the 
same algorithm and input image. 

View the algorithm comments
1 On the Open dialog, click the Comments... button.

A dialog box opens showing the comments you entered for your algorithm. These 
comments can be very helpful to others who use or display your algorithm, and 
they are a good way to document the procedures you used to create it.

2 Click Cancel to close the comments dialog box. 

5: Viewing the image in 3D perspective

About 3D perspective viewing

Up until now you have viewed your images using conventional 2D planimetric
views. ER Mapper makes it very easy to view images in 3D perspective by simply
adding a height (or elevation) component to your algorithm. The following is a
very simple introduction to the 3D viewing features, and you will learn more about
them in later chapters.

Display the vegetation image in brown and green
1 In the Algorithm dialog, select the Surface tab.

2 From the Color Table drop-down list, select brown_green.

ER Mapper redisplays the image. Areas with no or little vegetation (such as ocean)
display as brown, and vegetated areas like parks and canyons are bright green.

3 In the Algorithm dialog, select the Layer tab again.

Objectives Learn to create a 3D perspective view of the vegetation index image by adding a
Height layer containing a digital elevation image.
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Add a Height layer to the algorithm
1 On the Algorithm dialog, open the Edit menu, select Add Raster Layer,

then select Height.

A second layer named ‘Height Layer’ is added to the algorithm. Height layers are
only valid in 3D view modes, so the layer is currently inactive (crossed out).

Load a digital elevation image into the Height layer

1 With the Height layer selected, click the Load Dataset button in the
process diagram.

The Raster Dataset dialog opens.

2 From the Directories menu (on the Raster Dataset dialog), select the path
ending with \examples.

3 Open the ‘Shared_Data’ directory, then double-click on the image
‘Digital_Terrain_Model.ers’ to load it.

The digital elevation model (DEM) image is loaded into the Height layer.

Select 3D perspective View Mode to view the image in 3D
1 From the View Mode menu (on the Algorithm dialog), select 3D 

perspective.

ER Mapper displays a message that the image is being processed, then displays a
3D perspective view of the image. The message “Regenerating Terrain” appears in
the image window as ER Mapper performs iterations to increase the resolution
(detail) in the 3D image.

The right-hand panel in the Algorithm dialog now has two additional tabs–3D 
View and 3D Properties. These contain controls specifically for 3D viewing of
images.

Turn off the 3D lighting option
1 In the Algorithm dialog, select the 3D View tab.

2 Turn off the Lighting option button.

The image redisplays without artificial lighting. (Although this is sometimes
desirable, it can also obscure subtle features.)
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Change the perspective viewing angle

1 Click on the Hand Tool button on the Standard toolbar, if it is not
already selected.

2 Point to the lower part of the 3D image, and drag down slightly to tilt the 3D
view (see following diagram).

The 3D image tilts downward, so you are now looking more from an overhead
viewpoint. You can use the mouse to manipulate the viewpoint, zoom in and out,
rotate the image, and other controls (discussed in detail later).

This is a simple 3D algorithm that lets you quickly see the relationship between
terrain features and vegetation in the San Diego area. You can see, for example, that
natural vegetation still occurs in the many of the narrow canyons and hillsides next
to developed areas.

Select 2D View Mode to view the image in 2D again
1 From the View Mode menu in the Algorithm window, select Normal.

ER Mapper redisplays the image in a two-dimensional planimetric view again.

Note: This 3D exercise was a simple introduction to show how easy it can be to view data
in 3D perspective in ER Mapper. You will learn more about the 3D capabilities and
controls later.

Close the image and Algorithm dialog windows
1 Close the image window using the window system controls:

• Click the Close button in the upper-right window corner.

The window closes and disappears from the screen.

point to this area and drag down slightly to tilt 3D model down
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2 Click Close on the Algorithm dialog.

Only the ER Mapper main menu is now open.

• Load a new image and choose which bands to display

• Use the Algorithm dialog to define a processing algorithm

• Change the color lookup table for an image

• Add a formula to an algorithm

• Add text labels and comments to an algorithm

• Save the processing algorithm to disk

• Reload and view the saved algorithm

• Add a Height layer to view the image in 3D perspective

What you 
learned...

After completing these exercises, you know how to perform the following tasks
in ER Mapper:
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Working with
data layers

This chapter introduces you to the concept of data layers in ER Mapper, and gives 
you practice using them. You will learn to load data into layers, turn layers on and 
off, specify layer priority during processing, and add, move, and delete data layers 
in an algorithm.

Note: This chapter focuses on the use of raster data layers for displaying and 
manipulating images. Use of vector layer types for displaying GIS data and 
annotation are covered later in this manual.

About data layers
In ER Mapper, you build your image display by creating one or more ‘layers’ of 
data in the Algorithm window. The various data layers combine to create a final 
image on your screen display or output to your hardcopy device.

To view process stream diagram of a layer click on the Layer Tab and select the 
layer from the left side of the Algorithm window. Each layer in an algorithm can 
have different processing and use different image datasets. The simple algorithm 
you developed in Chapter 3 had only one layer (a Pseudocolor layer), but other 
types of algorithms can have several data layers. For example, an image displayed 
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in RGB (red-green-blue) has three data layers–one for the red image component, 
one for the green, and one for the blue. Layers can also contain other types of data 
that you want to overlay on your image, such as GIS vector or tabular data, and 
annotation or map composition objects.

Each layer in your algorithm can be manipulated independently from the others 
using the process stream buttons associated with that layer. This flexibility is one of 
the key features in ER Mapper that makes it easy to build and fine tune complex 
image processing algorithms.

Typically, you build an algorithm by first defining one or more layers to display 
your raster image data, such as satellite images or digitized aerial photos. Then you 
can add additional layers to display vector data (such as a road network), tabular 
data (such as sample site locations), and layers to annotate your image with text, 
coordinate grids, and so on.

Layer controls
If you click on the layer tab, the process diagram of the current layer appears. Each 
layer in an algorithm has a common set of information and controls provided on the 
layer itself:

To turn a layer off, click on the Turn On/Off button  on the Algorithm 
window or click the right hand mouse button on the layer to display the Short-cut 
Menu and select Turn Off. .

About color modes 
ER Mapper uses a concept called the “Color Mode” that defines the manner in 
which layers containing raster data are displayed. To define a particular type of 
image display, you choose the appropriate types of layers and the appropriate Color 
Mode. Color Mode is located in the Surface tab on the Algorithm window. Click 
on the Surface tab and you will see the Color Mode, the Color Table and the 
Transparency(%) with a slide button. 

Load image dataset Select image bands Use formula
Transform -
Adjust contrast

Open filter
editor

Apply shaded
relief
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Color Mode options (in Surface Tab)
ER Mapper provides three Color Mode options in Surface Tab, and each is 
designed to display and manipulate raster image data in a different way. The Color 
Mode setting must usually correspond with the type of data layers you are using. 
For example, if you are working with Pseudocolor layers, your Color Mode must 
be set to Pseudocolor. The three Color Modes are:

About data layers
ER Mapper provides several types of data layers, each designed to display a 
particular format of data (raster, vector, tabular), or display raster image data in a 
particular way. In general, there are two types of layers:

• Raster layers display image or pixel datasets, and the displayed image is often the 
result of combining two or more types of raster layers (for example, red, green, and 
blue)

• Vector layers display GIS, line, tabular (point), and map composition data, and 
always cover raster data underneath them where there is overlap

Color Mode Function

Pseudocolor Designed to display a single layer of raster data; 
image colors are controlled by the current 
Lookup Table setting.

Red Green Blue Designed to display raster data in Red Green 
Blue (RGB) color space. The image colors are 
built using separate layers for the red, green, 
and blue color planes (or color guns) of the 
computer display.

Hue Saturation Intensity Designed to display raster data in Hue 
Saturation Intensity (HSI) color space. The 
image colors are built using separate layers for 
hue (color), saturation (color purity), and 
intensity (color brightness).
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Raster layer types
Many of the raster layer types are only valid with a certain Color Mode setting. If 
the layer is not valid with the current Color Mode, ER Mapper automatically dims 
that layer on the Algorithm window and does not use it during processing. The 
types of raster layers and the valid Color Modes associated with them are listed in 
the table below:

Raster layer Function Valid Color Modes

Pseudocolor Displays raster data, colors are 
controlled by the current Lookup 
Table

Pseudocolor

Red Displays raster data in the display’s 
red color channel

Red Green Blue

Green Displays raster data in the display’s 
green color channel

Red Green Blue

Blue Displays raster data in the display’s 
blue color channel

Red Green Blue

Hue Displays raster data; controls the 
“color” component (red, yellow, green, 
etc.) of the displayed image

Hue Saturation 
Intensity

Saturation Displays raster data; controls the 
“color purity” component (pastel or 
pure colors) of the displayed image

Hue Saturation 
Intensity

Intensity Displays raster data; controls the 
“brightness” component (lightness or 
darkness) of the displayed image

all

Height Controls the third dimension elevation 
(or “z-value”) of an image viewed in 
3-D perspective.

all

Class Display Displays a raster image created with 
ER Mapper’s Supervised or 
Unsupervised Classification functions

all

Classification Displays a solid color thematic overlay 
generated from raster data over other 
raster overlays

all
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Tip: You can quickly change any raster layer in an algorithm from one type to another 
by using the Layer Type drop-down list from Edit/Change Raster Layer menu or 
from the Short-Cut menu which appears after clicking the right mouse button on 
the highlighted layer.

Vector layer types
Vector layers are used to display map annotation and data from external products or 
vector file formats. All vector layers are always drawn on top of any raster layers, 
regardless of their position among other layers in the Algorithm window. Vector 
layers are not affected by the Color Mode setting (those apply to raster layers only). 
The following are the main types of vector layers:

Note: There are additional types of vector layers used less frequently; these are not 
covered in detail in this manual. You can add any of the Vector layer types from the 
drop down list which appears after clicking the Edit/Add Vector layer menu.

Selecting and Modifying Data Layers
To modify a data layer, you must first select it by clicking on it. A shaded box then 
appears surrounding the layer to indicate that it is selected. You must first select a 
layer before you can load a new image dataset into it or modify it’s process stream.

Note that a layer may become inactive if you change the Color Mode in the Surface 
Tab to an option that is not valid for that layer. When a layer becomes inactive, its 
text appears dimmed or “greyed out” on the Algorithms window. For example, if 

Vector layer type Function

Annotation/Map 
Composition

Create color annotation (lines, circles, text, etc.) and 
map composition objects (scale bars, north arrows, 
etc.). Also used to display files in ER Mapper vector 
format (with a “.erv” file extension). 

Region overlay Define region polygons (areas of interest) for a raster 
image, or display existing regions and names.

ARC/INFO overlay Display, edit, and save vector data stored in the native 
“coverage” format of the ARC/INFO GIS software.

Dynamic Links Display vector or tabular data from other software 
products or file formats such as DXF or PostScript.
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you change the Color Mode to Red Green Blue, any Pseudocolor overlays become 
inactive since Pseudocolor overlays are only valid with a Pseudocolor Color Mode. 
Inactive layers are ignored during processing (similar to being turned off).

Hands-on exercises
These exercises give you practice using and manipulating raster data layers in 
ER Mapper. Understanding how to work with layers is an important step in 
understanding how to build and use algorithms.

• Turn data layers on and off

• Load an image into one or several raster layers

• Add, delete, and move layers

• Change a raster layer from one type to another

1: Turning layers on and off

Open an image window and display a mosaic algorithm
1 From the File menu, select Open....

An image window and the Open file chooser dialog box appear.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Functions_And_Features’.

4 Double-click on the directory named ‘Data_Mosaic’.

5 Double-click on the algorithm named 
‘Interactive_mosaic_of_4_datasets.alg.’

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to turn data layers on to include them in processing and off to exclude them 
from processing. Also learn how the status of layers can change if the Color 
Mode changes. 
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ER Mapper opens and displays the algorithm.

This algorithm displays a mosaic of four separate image datasets that partially 
overlap with each other. Each image is loaded into its own Pseudocolor data layer, 
so it can be controlled independently from the other images. (You will learn more 
about creating mosaics of two or more images later.)

Open the Algorithm window to view the data layers
1 From the View menu, select Algorithm....

The Algorithm window appears showing four Pseudocolor data layers.

2 If needed, make the Algorithm window taller until all four layers are clearly 
visible at once. (Drag the top window border upward.)

Turn overlays off to exclude them from processing
1 In the Algorithm window, with the Layer tab selected, click on the left side 

of the layer containing the image named ‘Mosaic_TM’ to select it.

A dark border surrounds the layer, indicating that it is selected.

2 Click your right mouse button on the highlighted layer and the Short-Cut 
menu will appear. Turn the ‘Mosaic_TM’ layer off by selecting the Turn Off 
option from the Short-Cut menu.

The layer is now turned off, so ER Mapper will ignore it during processing. 

ER Mapper reprocesses the mosaic algorithm so that the data in the upper-right 
portion of the image window (a portion of a Landsat TM image) is not displayed. 
Since the layer containing the ‘Mosaic_TM’ image is turned off, its data no longer 
appears as part of the mosaic.

3 In the Algorithm window, click on the left side of the layer containing the 
image named ‘Mosaic_XS’ to select it.

4 Click the right mouse button on the selected layer and turn off the 
‘Mosaic_XS’ data layer from the Short-Cut menu. 

This time the data in the lower portion of the mosaic (a portion of a SPOT XS 
image) does not display since its layer is turned off.

Turn overlays on to include them in processing
1 In the Algorithm window, click to select the layer containing the image 

named ‘Mosaic_TM.’ 

2 Turn the ‘Mosaic_TM’ layer on again (click the right mouse button on the 
selected layer and select Turn On, from the Short-Cut menu). 
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The Landsat TM satellite data again displays in the upper-right portion of the image 
window since its layer is now turned on.

3 Click to select the layer containing the image named ‘Mosaic_XS.’

4 Turn the ‘Mosaic_XS’ layer on again. 

The SPOT XS satellite image again displays in the lower portion of the mosaic.

Change the Color Mode to see how it affects layers
1 In the Algorithm window, from the Surface Tab select Red Green Blue 

from the Color Mode drop-down list.

All four Pseudocolor layers display a hatched pattern (diagonal lines), indicating 
that they are no longer valid with the current Color Mode. 

Note: Whenever raster layers are not valid with the current Color Mode in the Surface 
Tab, they become hatched (inactive) on the Algorithm window. ER Mapper treats 
inactive layers as if they are turned off. 

2 On the Surface Tab from the Color Mode drop-down list, select 
Pseudocolor.

ER Mapper reprocesses the algorithm and displays the image with all the layers 
active.

2: Loading data into layers

Open a Red Green Blue (RGB) algorithm

1 On the ER Mapper Standard toolbar, click the Load  button. 

The Open file chooser appears.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Data_Types’

4 Double-click on the directory named ‘Landsat_TM.’

5 Double-click on the algorithm named ‘RGB_432.alg.’

Objectives Learn to load an image into a particular layer or set of layers in an algorithm. 
Also understand use of the OK, Apply, OK this layer only, and Apply this 
layer only buttons on the Raster Dataset file chooser dialog box.
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This algorithm displays bands 4, 3, and 2 of a 1985 Landsat TM satellite image of 
central San Diego as an RGB color composite image. Water areas appear dark, and 
shades of red indicate vegetation.

Load a new image into all three layers

1 With the ‘Layer’ tab selected, click on the Load Dataset  button in the 
process stream diagram. 

The Raster Dataset file chooser appears. Note that this dialog has OK this 
layer only and Apply this layer only buttons in addition to the OK and Apply 
buttons you see on all other file chooser dialogs.

Notice that the Raster Dataset file chooser shows files with “.ers” extensions. 
You can change file types (.ers, .alg, .hdr, .bmp, .tif, .sid) from the drop down list of 
the button of file types. Typically you load images into raster layers for processing, 
but you can also load an algorithm and use it as if it were an image dataset.

current directory

selected .ers file

click to view comments

load into selected
layer only, keep
dialog box open

load into all layers with same image,
keep dialog open

load into all layers with same
image, close dialog box

view information 
or edit image
header file

file types
(.ers, .alg, hdr

load into selected 
layer only, close
dialog box

click to move up
and down one
directory level

.bmp .tif .sid)
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Load a new image into all three layers
1 From the Directories menu, select the path ending with the text \examples.

2 Double-click on the directory named ‘Shared_Data.’

3 Click once on the image named ‘Landsat_TM_year_1991.ers.’

4 Click the Apply button.

ER Mapper loads the 1991 Landsat image into all three layers. Since all three 
layers previously contained the same image (the 1985 Landsat image), Apply 
replaced the image in all three layers at once.

Load a new image into only one layer
1 Click on the Green layer to select it.

2 In the scroll list on the Raster Dataset dialog, click on the image named 
‘Landsat_TM_year_1985.ers’ to select it.

3 Click the Apply this layer only button.

ER Mapper loads the 1985 Landsat image into only the Green layer.

4 Click on the Blue layer to select it.

5 In the Raster Dataset dialog, click on the image named 
‘Landsat_TM_year_1985.ers’ to select it.

6 Click the Apply this layer only button.

ER Mapper loads the 1985 Landsat image into the Blue layer.

Tip: The OK and OK this layer only buttons have the same function as the Apply and 
Apply this layer only buttons, but they close the dialog after performing the 
operation (while the others leave it open). Double-clicking on an image or 
algorithm name in the scroll list has the same effect as clicking OK.
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3: Adding and changing layers

Open a new RGB algorithm

1 On the ER Mapper Standard toolbar, click the Load  button. 

The Open file chooser appears. 

2 From the Directories menu, select the path ending with the text \examples

3 Double-click on the directory named ‘Data_Types’.

4 Double-click on the directory named ‘SPOT_XS’.

5 Double-click on the algorithm named ‘SPOT_XS_rgb_321.alg’.

This algorithm displays a SPOT XS (multispectral) satellite image of San Diego as 
an RGB color composite of bands 3, 2 and 1. (These bands are similar to Landsat 
TM’s bands 4, 3 and 2 but are imaged at higher resolution.)

Change the order of layers using buttons
1 On the Algorithm window, click on the ‘Green’ layer to select it.

2 Click the Move Up button .

The Green layer moves up one level to the top of the layer list. 

3 Click on the ‘Blue’ layer to select it.

4 Click the Move Down button .

The Blue layer moves to the bottom of the layer list. 

Change the order of layers by dragging
1 Point to any part of the Red layer, then drag down below the Blue layer and 

release.

The Red layer moves down to the bottom of the layer list. 

2 Drag the Green layer to move it below the Red layer.

It is often easier to move or reposition layers by dragging them rather than using the 
Move Up and Move Down buttons.

Objectives Learn to delete layers from an algorithm, add new layers, and move layers by 
using buttons and the mouse. Also, learn to change a raster layer from one type to 
another type (green to blue for example).
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Note: The order of layers can be important when building image mosaic algorithms that 
display more than one image (it sets the display priority of images where there is 
overlap, those on top having the highest priority). In this case, changing the order of 
the layers has no effect on the image display. 

Delete the Blue and Green layers
1 Click on the Blue layer to select it.

2 Click the Cut button  to delete the Blue layer from the list.

Tip: You can also cut the layer by selecting the cut option from the Edit menu or on the 
computer keyboard simply press and hold the Control button and type X “Ctrl+X”.

3 Click on the Green layer to select it.

4 Click the Cut button  to delete the Green layer from the list.

ER Mapper displays only the red component of the image (SPOT band 3 in this 
case) because the Blue and Green layers of the algorithm were deleted. 

Restore the Green layer by adding one and loading the image
1 From the Edit/Add Raster Layer drop-down menu, select Green.

A new Green layer is added to the algorithm. The new layer has no image loaded 
yet (indicated by NONE), so it is turned off. 

2 In the process stream diagram, click the Load Dataset  button. 

The Raster Dataset file chooser appears.

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Shared_Data.’

5 Click on the image named ‘SPOT_XS.ers.’ to select it, then click OK to load 
it and close the dialog.

ER Mapper loads the image into the new Green layer and turns it on. Also note that 
band 1 is loaded by default in the process stream diagram.
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Note: If you had wanted to load this image into only the Green layer, you could have 
clicked OK this layer only or Apply this layer only.

6 From the Band Selection  drop-down list, select B2:0.645_um. 

You have now created a new Green layer that contains the same image and band as 
the original green layer you deleted earlier.

Restore the Blue layer by duplicating the Green layer

1 With the Green layer still selected, click the Duplicate  button.

A second Green layer is added below the first one. The second Green layer is an 
exact copy of the first one, so it already has the ‘SPOT_XS’ image loaded.

2 Click your right mouse button on the highlighted Green layer and the Short-
Cut menu will appear. From the Short-Cut menu, select Blue. 

The Green layer changes to a Blue layer. 

3 From the Band Selection  drop-down list, select B1:0.545_um. 

The new Blue layer is now correctly set to display band 1 of the SPOT image.

Tip: When manipulating multiple layers, duplicating an existing layer with the desired 
image and changing its type is usually faster than adding a new layer and loading 
the desired image.

Note that the colors look slightly different to those in the original algorithm you 
opened at the start of this section. You need to adjust the transforms of the new 
Green and Blue layers.

Adjust the transforms of the Green and Blue layers
1 Select the Green layer, then click on the right-hand Edit Transform Limits 

 button in its process stream diagram. 

The Transform dialog box opens.

2 From the Limits menu, select Limits to Actual.

The X axis (input) data range changes to match limits of the band 2 data. 

3 Click the Move to next blue layer  button on the Transform dialog.
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ER Mapper automatically selects the Blue layer and displays its histogram. (You 
will learn more about moving between histograms of layers later.)

4 From the Limits menu, select Limits to Actual. 

ER Mapper reprocesses the algorithm using the actual data limits as the X (input) 
axis limits.

5 On the Transform dialog, click the Create autoclip transform  button. 

ER Mapper changes the transform line on the histogram to increase contrast of the 
blue data layer and redisplays the composite image automatically.

6 Click the Move to next green layer  button on the Transform dialog.

ER Mapper automatically selects the Green layer and displays its histogram. 

7 Click the Create autoclip transform  button.

ER Mapper changes the transform line to increase contrast of the green data layer 
and redisplays the image.

8 Click the Close button on the Transform dialog to close it.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Turn data layers on and off

• Load an image into one or several raster layers

• Add, delete, and move layers

• Change a raster layer from one type to another

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Viewing image
data values

This chapter shows you the options ER Mapper provides for viewing image data 
values and coordinate locations. These include cell values, neighborhoods, 
signatures, traverse extraction, and scattergrams. You also learn how to measure 
distances between two points on an image. 

About viewing data values
Viewing image data values is one of the fundamental ways to assess data quality 
and the particular characteristics of features in an image. Options for viewing data 
values and geographic locations in ER Mapper include:

Cell values The data value associated with each cell or pixel in the 
image, or the data values of that cell in each band of a 
multi-band image.

Neighborhoods An array of data values surrounding a pixel.

Signatures The data values of a pixel in all bands shown in a line 
graph format.

Traverse extraction A profile of data values occurring along a line or 
polygon drawn on the image. 
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Scattergrams An X-Y plot showing the relationship between data 
values in two bands of an image.

Histograms A plot showing the range of data values on the X axis 
and their relative frequency on the Y axis

Hands-on exercises
These exercises show you various ways of viewing data values, coordinate 
locations, and geographic distances between two points on an image.

• View image data values in text format

• View image data values in multiple bands as a signature

• View image data values in multiple bands along a profile line

• View two bands of image data values as a scattergram

1: Viewing values and signatures

Open and display an RGB algorithm
1 From the File menu, select Open....

An image window and the Open file chooser dialog box appear.

2 Double-click on the directory named ‘\examples\Data_Types\Landsat_TM’ 
to open it.

3 Double-click on the algorithm named ‘RGB_741.alg.’

This algorithm displays bands 7, 4, and 1 of the San Diego Landsat image as an 
RGB color composite image. 

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn to view image data values in a text format, neighborhood format, and 
signature (line graph) format.
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View cell values in the image for all bands
1 From the View menu, select Cell Values Profile....

The Cell Values Profile dialog box appears. Drag it by its title bar next to the 
image window. This dialog has three display windows, any of which can be turned 
on or off at any time.

2 By default, the Values option is selected. (If this has been changed, turn on 
Values and turn off Signature and Neighbors.)

3 On the main menu, click the Set Pointer mode  toolbar button.

Set Pointer mode tells ER Mapper that you want to use the mouse pointer to view 
data values. (The other modes set the pointer for use as a zoom and pan tool.)

4 Point inside the image window, and drag the mouse pointer through the 
image (or just click on any pixel).

The Cell Values Profile dialog displays the data values in all seven bands in the 
Landsat image for the current cell (pixel) location in the image. The data values are 
updated as you drag the mouse to new locations.

(If all seven bands are not shown, simply drag the lower edge of the dialog box to 
make it slightly larger.)

View a neighborhood of cell values
1 In the Cell Values Profile dialog, turn on the Neighbors option.

option to turn
window on/off

drag to resize
window areas

Values
window

Neighbors
window

Signature
window
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A second window is added to the Cell Values Profile dialog, with a drop-down 
menu to select an image band.

2 Point inside the image window, and drag the mouse pointer through the 
image (or just click on any pixel). 

A three-by-three neighborhood of cell values displays as you drag the mouse. The 
center pixel in the three-by-three array is the current pixel, and the surrounding 
eight pixels are its neighbors. This feature is useful for viewing the local variance 
or texture in various parts of an image.

3 From the Band drop-down list, select B4:0.83_um then drag again in the 
image.

The data values for band 4 of the Landsat image display in the three-by-three 
neighborhood.

View a signature of cell values for various features
1 In the Cell Values Profile dialog, turn on the Signature option.

A third window is added to the Cell Values Profile dialog, with a row of color 
buttons on top.

2 Make the Signature window larger by resizing the entire dialog box, or by 
turning off the Neighbors option. 

3 Click on the green color button above the Signature window.

4 Point to the image window, and drag through one of the green areas on the 
image (natural and man-made vegetation).

The data values in all seven bands display in a line graph format (sometimes called 
a signature) in green. The tick marks at the bottom indicate the number of bands in 
the image. In this case, you are using Landsat TM data, so you see the value in each 
of the seven bands as an individual measurement on the graph.

5 Click on the yellow color button above the Signature field.

6 Point to the image window, and click or drag on one of the bright white 
areas of the image (building roofs or barren land areas). 

A new signature for the bright areas appears in yellow.

7 Click on the green color button again to clear the signature.

When you click on a color button a second time, the existing signature (colored 
line) in the window is removed. 

8 Point to the image window, and drag through a green, vegetated area again 
to display a new signature.
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View an average signature for a feature
1 Click on the blue color button.

2 Turn on the Average option.

3 Point to the image window, and drag through one of the dark ocean areas 
surrounding the island near the bottom.

A third new signature appears in blue. Notice that the signature line gets thicker as 
you drag this time.

When using Average, the signature is an accumulated average of all the data 
values over the area where you dragged. You can add to the average signature by 
continuing to drag. This allows you to view the average signature over a broad 
feature area (instead of a single pixel at a time). 

4 Click the Close button on the Cell Values Profile dialog box to close it.

2: Viewing locations and distances

View geographic coordinates in the image
1 From the View menu, select Cell Coordinate....

The Cell Coordinates dialog appears. Drag it next to the image window.

The upper three fields of this dialog show the location of the current pixel in image 
column (X) and row (Y) coordinates, and the Eastings/Northings and Latitude/
Longitude coordinate systems.

2 Point to the image window, and drag the pointer through the image.

The image and geographic location of the current cell appear, and are updated as 
you drag the mouse.

Note: The Easting Northing and Latitude Longitude fields only display values if the 
image is registered to a map projection. 

Objectives Learn to view the geographic location of features in a image, and to measure the 
distance between two points in an image.
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View distances between points in the image
The lower three fields of the Cell Coordinate dialog show distance between the 
point where you first depress the mouse button and the point where you release it. 
Distances are shown as Imperial distance (feet and miles), Metric distance (meters 
and kilometers), and Dataset distance (number of pixels in the X and Y directions).

1 Point to the image window, and click on any point in the image.

The Imperial, Metric, and Dataset distance fields are cleared to zero values.

2 Pick out two features in the image, then drag the mouse between them.

This distance between those two points is displayed when you release the mouse 
button. Measuring the distance between two points is called mensuration.

3 Click the Close button on the Cell Coordinates dialog box to close it.

3: Viewing traverse profiles

Set up to draw traverse profile lines
1 From the View menu, select Traverse....

New Map Composition and Traverse dialog boxes appear.

2 On the New Map Composition dialog, be sure the Vector File option is 
selected, then click OK.

An ER Mapper warning dialog and the annotation Tools palette dialog appear. 
You will use the vector annotation tools to draw traverse lines on the image.

3 Click Close on the ER Mapper warning dialog to close it. (When using 
annotation tools for other purposes the default Fixed Page mode is not 
recommended, but it is fine for this exercise.)

Draw a traverse line on the image

1 On the Tools dialog, click the Annotation: Poly Line  button.

2 Inside the image window, define a straight line by clicking once at the start 
point, click once at the end point, then double-click to end the line definition.

Objectives Learn to view image data values for multiple bands as a profile along a line or 
polygon draw through the image (called traverse extraction).
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A profile line appears inside the ER Mapper Traverse dialog. This line displays 
the amplitude or change in the values of pixels underneath the traverse line you 
drew. By default, values for image dataset band 1 are shown as a black profile line.

View profiles for 3 image dataset bands

1 On the ER Mapper Traverse dialog, click the Bands:  button.

The Traverse Band Selection dialog appears.

2 Press the Ctrl key on your keyboard, then click on bands 1, 4 and 7 in the 
list to select them.

3 Click OK on the Traverse Band Selection dialog.

Profiles for all three bands appear in the ER Mapper Traverse dialog, with a 
legend in the upper-right indicating the line color assigned to each band. This type 
of display allows you to clearly see the relationship between data values in the three 
bands. (In this case you are viewing data values for the same bands displayed in the 
RGB image (7, 4 and 1), but you could also view profiles for bands not used to 
display the image.)

Draw a second traverse line on the image
1 Inside the image window, define a second line in a different area by again 

clicking once at the start point, click once at the end point, then double-click 
to end the line definition.

The three profile lines appears inside the ER Mapper Traverse dialog update to 
show the pixel values under the new line. You can draw as many different traverse 
lines on the image as you desire.

band/color
legendscale of

dataset
values

location
of profile

graphical
plot of change
in values
along traverse
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Alternate between the two traverse lines and modify them
1 On the annotation Tools dialog, click the Select and Edit Points Mode 

 button.

2 Inside the image window, click on the first traverse line you drew.

The line becomes selected and it’s corresponding profiles again appear in the 
ER Mapper Traverse dialog. You can view the profiles for any traverse line by 
simply selecting it as shown here.

3 On the annotation Tools dialog, click the Select and Move/Resize Mode 

 button.

4 Inside the image window, click once on one of the endpoints of the currently 
selected traverse line (the point become reverse highlighted).

5 Point to the reverse highlighted end point, and drag it to a new location.

When you release the mouse button, the revised line appears on the image and it’s 
corresponding profiles are updated in the ER Mapper Traverse dialog. You can 
modify the location and length of any traverse line by following these steps.

6 Revise one of your lines so it traverses across one of the dark ocean areas 
in the lower part of the image.

Notice the strong dip in data values in all three bands where the lines crosses the 
ocean. This is typical of Landsat TM data because water generally has much lower 
reflectance in these wavelengths of light than land areas.

7 Click Close on the ER Mapper Traverse dialog to close it, then click Close 
on the Tools dialog to close it also.

8 When asked to save the current annotation, click No.

Tip: If desired, you could save the current annotation layer and reload it later, and you 
can also save the traverse profiles to an XYZ format dataset on disk for export to 
other analysis software if desired. See the ER Mapper User Guide for more 
information.
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4: Viewing image scattergrams

A scattergram allows you to graphically see the correlation between the digital 
numbers in two image bands. Values for one band are plotted on the Y axis and the 
other on the X axis. These two digital numbers locate each pixel in the 
two-dimensional measurement space of the graph.

Open a Scattergram dialog box
1 From the View menu, select Scattergrams....

The Scattergram dialog box and New Map Composition dialog boxes open.

2 Click Cancel on the New Map Composition dialog to close it. (You do not 
need it for this exercise.)

The Scattergram dialog automatically references the image in the active image 
window (‘Landsat_TM_year_1985’). You could choose to view scattergrams for 
any other image, Virtual Dataset, or algorithm as well.

By default, a new scattergram plots band 1 of the image on the X (horizontal) axis 
and band 2 on the Y (vertical) axis, and the cluster of points is shown using various 
colors inside the scattergram window. The colors represent the accumulated 

Objectives Learn to view the relationship between image data values in two bands as a 
two-dimensional plot called a scattergram (or scatter diagram).
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frequency (or “density”) of data values in both bands. Areas of the scattergram with 
the highest densities of points are shown in colors in the upper part of the color bar 
(red and yellow), and low density areas in the lower colors (blue and magenta). 
Typically, high density areas will be a feature comprising a large number of pixels 
in both bands, such as a large area of water.

Change the image band combination
In the scattergram for bands 1 and 2, notice that the data points are tightly grouped. 
This indicates that there is a strong correlation between the data contained in these 
two bands (both visible wavelength bands), so they contain much redundant 
information.

1 In the Scattergram dialog, click the Setup... button.

The Scattergram Setup dialog opens to provide options for changing image 
bands, defining regions, and other functions. Move it so it does not cover the 
Scattergram dialog or image window.

2 Click on the drop-down list for the Y Axis field, and select B4:0.83_um.

ER Mapper redraws the scattergram, this time showing the data values from band 4 
on the Y axis.

3 Click the Limits to Actual button to set the X and Y axis limits to the actual 
data ranges of bands 1 and 4.

select image bands
for scattergram
Comprehensive ER Mapper Training Workbook 93



Chapter 5 Viewing image data values ●  4: Viewing image scattergrams
The scattergram enlarges to fill the window. The wide spread of points shows that 
the data in bands 1 and 4 are weakly correlated, so they provide different types of 
information. (Band 4 records reflectance in near infrared wavelengths.)

Change the axis limits to “zoom in” on part of the scattergram
Notice the small, dense grouping of points in the lower-left corner of the 
scattergram (shown in cyan, green and red). This indicates that there is a high 
frequency of data points in both bands in that area.

1 Point the mouse (without depressing it) at the areas surrounding the dense 
grouping.

Directly above the scattergram window, ER Mapper displays the position of the 
mouse pointer in the scattergram and data values in both bands. The first value is 
the X axis (band 1) value, and the second the Y axis (band 4) value. 

To focus more on this area of the scattergram, you can use the mouse to determine 
the approximate data limits of the dense cluster, and then reset the X and Y axis 
limits to “zoom in” on it.

2 In the Setup Scattergram dialog, turn on the Defer Display option. The 
Display button (greyed out before) is now active.

Defer Display tells ER Mapper to delay updating the scattergram until you finish 
changing the desired options (the axis limits in this case).

3 Edit the X (horizontal) axis maximum value to 120, and press Enter or 
Return to validate. 

4 Edit the Y (vertical) axis maximum value to 30, and press Enter or Return.

5 Click the Display button. 

ER Mapper redisplays the scattergram to “zoom in” on the dense cluster, so you 
can more clearly see the detail. 

6 In the Setup Scattergram dialog, click the Limits to Actual button, then 
click Display again. 

The scattergram zooms back out to the previous extents.

7 Turn off the Defer Display option.

8 Click Close on the Scattergram dialog to close it and the Setup 
Scattergram dialog.

Note: You will learn more about additional uses and options for scattergrams in other 
parts of this manual.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• View image data values in text format

• View image data values in multiple bands as a signature

• View image data values in multiple bands along a profile line

• View two bands of image data values as a scattergram

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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6

Enhancing
image contrast

This chapter explains how to modify raster image data to enhance contrast or color 
to improve visual interpretation. It introduces the basic concepts associated with 
contrast enhancement and color mapping, and gives you practice using 
ER Mapper’s Transform options.

About contrast enhancement
Adjusting image contrast (often called “contrast stretching”) is the most 
fundamental and often-used enhancement operation in digital image processing. 
The human eye is very good at interpreting spatial attributes in an image and 
picking out subtle features. However, the eye is poor at resolving such features 
when they are characterized by very subtle differences in color or brightness. 
Contrast enhancement techniques are useful for accentuating subtle differences in 
data values to improve visual interpretation.

Contrast enhancement is called a “point operation” in image processing because it 
applies a brightness or color transformation to each pixel in the image independent 
of all other pixels. By adjusting the “transform” that maps image data values to the 
display brightness or colors in a lookup table, you can enhance (or “stretch”) the 
contrast or highlight specific features to make your data easier to interpret and 
analyze.
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Chapter 6 Enhancing image contrast ●  About contrast enhancement
Two of the most common image display techniques are Pseudocolor and Red Green 
Blue (RGB). 

Displaying images with a color lookup table
When displaying an image using a color lookup table (CLUT) (Color Table menu 
on the Surface Tab in the Algorithm window), image data values are mapped to 
specific colors or “slots” in a table. In this case, changing the transform tells 
ER Mapper to adjust the mapping between the image data values and the colors in 
the CLUT used to display them. For example, you can transform the data to be 
displayed using all the colors, or shift or compress the data to map it to a particular 
color or range of colors.

Displaying images in RGB
A computer screen produces colors by illuminating red, green, and blue phosphors 
for each pixel. When you change the transform of an RGB image display, 
ER Mapper controls mapping between the image data values and the brightness of 
the red, green, or blue phosphors of the hardware display.

The Transform buttons
By default, most raster data layers in ER Mapper have two Transform buttons in the 
algorithm process stream diagram. One applies a transform before a formula (pre-
formula), and the other applies a transform after a formula (post-formula). You can 
also insert and append additional transforms in either location to create more 
complex contrast enhancements. 

The Transform dialog box
When you click on one of the Transform buttons in the process stream diagram or 
on the Edit Transform Limits toolbar button, ER Mapper opens the Transform 
dialog box. This dialog provides many interactive controls for enhancing contrast 
and modifying color mapping.

post-formula
transform

pre-formula
transform
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A key concept in using the Transform dialog is moving the transform line, 
because this is the feature that controls mapping of data values to display brightness 
or color. To move the line, simply drag it to a new location, or click buttons that 
automatically position the line for common transform techniques (such as 
histogram equalization).

Tip: For any algorithm, you can open the Transform dialog box from two places: using 
the Transform buttons in the process stream diagram on the Algorithm window, 
or using the Edit Transform Limits toolbar button. (Using the toolbar button lets 
you edit the transforms for any algorithm layers without having to open the 
Algorithm window first.)
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other layers
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other transforms
in current layer

click to choose
an automatic
transform option

choose X and Y
axis limits options

insert, delete,
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Hands-on exercises
These exercises introduce you to the basic features of the Transform dialog box, 
and how to use them to enhance image contrast and color mapping.

• Edit the transform for a particular raster data layer

• Apply linear and piecewise linear transforms

• Edit the input (data) and output (display) ranges for a transform

• Use the automatic transform options

• Work with multiple transforms in a layer

1: Viewing image histograms

Load and display an image in greyscale

1 On the Standard toolbar, click on the Edit Algorithm  button. 

An image window and the Algorithm dialog box appear.

2 In the process stream diagram on the Algorithm window, click on the Load 

Dataset  button. 

The Raster Dataset file chooser dialog opens.

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Shared_Data.’

5 Double-click on the image named ‘SPOT_Pan.ers.’

ER Mapper loads the SPOT Pan image into the Pseudocolor layer and displays it.

6 On the Surface Tab, from the Color Table drop-down list, select 
greyscale.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn to display the histogram for an image, view data values and display a 
coordinate grid over the histogram.
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ER Mapper redisplays the image in greyscale. This is a SPOT Panchromatic 
satellite image of the San Diego, California area. (The image is initially somewhat 
dark, and you will improve the contrast later.)

View the histogram for the SPOT Pan image

1 Click on the post-formula Edit Transform Limits  button in the process 
stream diagram.

The Transform dialog box opens. The histogram for the SPOT Pan image is 
displayed in the histogram window portion of the dialog.

A histogram is graphical display of the relative frequency distribution of values in 
an image. In this case, most of the data values occur in the lower part of the 0 to 255 
data range possible for SPOT Pan images. Peaks in the histogram show where there 
are many pixels with similar data values, and often indicate identifiable features in 
an image.

View the data values inside the histogram window
1 Point the mouse to any location inside the histogram window.

The X and Y axis data values at that point are displayed in the upper-left portion of 
the dialog (below Histogram Style). The X location (image data range) appears on 
the left, and the Y location (screen brightness or LUT value) is on the right.

2 Position the pointer in the lower-right portion of the histogram window.

You see a high X value because you are at the upper end of the data range, and a 
low Y value because you are at the lower end of the display or lookup table range.

3 Position the pointer in the upper-left portion of the histogram window.

You see a low X value because you are at the lower end of the data range, and high 
Y value because you are at the upper end of the display or LUT range.

Turn on a coordinate grid
1 Turn on the Grid option button.

A grid appears over the histogram window with a regular spacing between grid 
lines and the origin in the lower-left corner. This grid can help you quickly 
determine a specific X-Y data location in the histogram window.

2 Turn the Grid option off again.

The grid disappears from the histogram window.
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Close the Transform dialog and the Algorithm window
1 Click Close on the Transform dialog to close it, then click Close on the 

Algorithm window to close it.

2: Using linear transforms

Reopen the Transform dialog from the toolbar

1 On the ER Mapper main menu, click the Edit Transform Limits  button 
on the Common Functions toolbar. 

ER Mapper opens the Transform dialog box again. (This is a shortcut to access 
transforms for any displayed algorithm without using the Algorithm window.)

Apply a linear lightening effect to the image
Whenever you display data in a Pseudocolor layer, the colors in the lookup table 
(greyscale in this case) are shown in a color bar along the Y axis. This makes it easy 
to see how the position of the transform line affects the way LUT colors are used to 
display the image.

1 As shown in the diagram below, drag the circled part of the transform line 
up to the left along the left-hand vertical axis.

Objectives Learn to use simple linear transform adjustments to perform lightening and 
darkening of images, and increase or decrease image contrast. You also learn to 
open the Transform dialog from the Common Functions toolbar.
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ER Mapper applies the change and the image lightens. As shown in the right-hand 
diagram, you have adjusted the transform line to exclude values of about 0-100 on 
the display (vertical) axis, which correspond to the darker shades of grey in the 
greyscale lookup table. Now the entire 0-255 range of data on the X (horizontal) 
axis is mapped to only the lighter shades of grey in the greyscale lookup table, 
causing the image to appear lighter.

Also notice that a second unfilled histogram appears in the window. This is the 
output histogram, and it represents how your change affected the distribution of 
data on the display (or output) axis. 

2 Click on the Create default linear transform  button. 

ER Mapper returns the transform line to its default position and redisplays the 
image. (The default position is a straight linear transform, where the line’s X 
position is equal to its Y position. This also makes the output histogram the same as 
the input histogram, so it is no longer visible.) 

Apply a linear darkening effect to the image
1 As shown in the diagram below, drag the circled part of the transform line 

up to the right along the right-hand vertical axis.
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ER Mapper applies the change and the image darkens. As shown in the right-hand 
diagram, you have adjusted the transform line to exclude values of about 200-255 
on the display (vertical) axis, which correspond to the lighter shades of grey in the 
lookup table. Now the entire 0-255 range of data on the X (horizontal) axis is 
mapped to only the darker shades of grey, causing the image to appear darker.

Also notice that the linear darkening effect caused the output histogram to shift left 
of the input histogram (whereas the lightening effect it shifted it right). 

2 Click on the Create default linear transform  button. 

The transform line returns to its default position and the image redisplays.

Apply a linear contrast stretch to increase image contrast
1 Point to the far right-hand edge of the histogram (at the bottom of the 

slope).

Note that X value displayed in the upper-left shows about 160-170. Even though 
the upper limits of the image values are close to 255, there are very few values 
between about 170 and 255 (as indicated by the frequency shown in the histogram).

2 As shown in the following diagram, drag the circled part of the transform line 
up to the left along the horizontal axis.
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ER Mapper applies the change and the image contrast increases. Now the contrast 
between light and dark parts of the image is enhanced, making spatial features 
easier to visually interpret. In this case, you adjusted the transform line to map data 
values of about 170-255 on the horizontal axis to the lightest color in the lookup 
table (white), and spread the remaining data values (0-169) over the entire range of 
grey shades. 

This mapping better utilizes the dynamic range of grey shades in the lookup table, 
which improves image contrast. (This effect is often called histogram clipping 
because it clips the tail off the histogram.)

3 Click the Create default linear transform  button. 

ER Mapper returns the default transform line and redisplays the image.

3: Highlighting features

In contrast to the simple transform adjustments you used earlier, piecewise linear 
transforms break the transform line into several parts (or “pieces”). Each piece of 
the line can have a different slope (X-Y relationship), which lets you modify the 
mapping of that range of data differently from other pieces of the line. Piecewise 
linear transforms lets you create more complex types of contrast enhancements.

Objectives Learn to use piecewise linear transforms to create more complex contrast 
adjustments that highlight a specific range of values or a feature in an image.
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Adjust the transform to maximize contrast in the ocean areas
The image you are working with is a SPOT Panchromatic satellite image, which 
records the amount of light reflected from the earth’s surface (similar to an aerial 
photograph). Notice that the image histogram has two peaks that provide 
information about features in the image:

• One very tall, narrow peak on the left–these are primarily the ocean areas in the 
image. Ocean areas typically have low reflectance values that fall within a very 
narrow range (since the sea surface has little variation compared to the land). 

• Another smaller, wider peak to the right–these are primarily the land areas in the 
image. Land areas typically have higher reflectance values than ocean, and the 
values are spread out over a much wider range (since land areas are comprised of a 
variety of different cover types).

1 As shown in the diagram below, drag the transform line in two different 
places–once down the left edge of the ocean peak in the histogram, and 
another up to the top in line with the right edge of the ocean peak

The contrast in the ocean areas is enhanced, while most land areas are displayed as 
white. In this case, you adjusted the transform line to map the narrow range of data 
values 30-45 (ocean) over the entire range of grey shades in the lookup table. Data 
values lower than 30 are mapped to the lowest slot in the lookup table (black) and 
data values over 45 (mostly land) are mapped to the highest slot (white). The subtle 
reflectance patterns in the ocean areas are now easier to visually interpret because 
the entire grey shade range is used to represent them.

2 Click on the Create default linear transform  button. 
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Adjust the transform to maximize contrast in the land areas
1 As shown in the diagram below, drag the transform line in two different 

places–once down the left edge of the land peak in the histogram, and 
another up to the top in line with the right edge of the land peak.

The contrast in the land areas (data values between about 45 and 160) is enhanced, 
while the ocean areas (30-45) are displayed as pure black.

2 Click on the Create default linear transform  button. 

4: Modifying data and display ranges

Use Limits to Actual to set the X axis data range
Look at the “Actual Input Limits” field on the Transform dialog, and note that it 
shows values between approximately 22 and 254. ER Mapper records the actual 
range of data values it finds in the image and displays the results in the Actual Input 
Limits field.

1 From the Limits menu, select Limits to Actual.

The data range displayed on the horizontal axis changes to match the Actual Input 
Limits field. 

Objectives Learn to use the Limits menu options to specify exact ranges of data values and 
display values to modify image contrast and color mapping.
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ER Mapper recomputes the histogram and applies the transform only to the actual 
range of data in the image.

Note that the image actually darkens slightly. Since there was no data between zero 
and 24, Limits to Actual shifted the entire histogram slightly to the left on the X 
axis, so the data is mapped to slightly darker shades of grey on the lookup table.

Tip: Limits to Actual is a very commonly used option because it allows you to work 
with only the actual range of data in an image. This is especially useful for images 
that do not use an 8-bit (0-254) data range. Limits to Actual is very often the first 
step in adjusting contrast, followed by another adjustment such as one of the 
automatic transform options discussed later.

Set the input limits to 99% of the histogram range
1 From the Limits menu, select Input Limits to 99% Histogram.

The data range on the horizontal axis changes to approximately 34 to 151, and the 
histogram itself widens to fill the X axis range.

Input Limits to 99% Histogram clips off 1% of all data values in the image, 
taking 0.5% from the lower end, and 0.5% from the upper end. (The results of the 
clipping indicates that only 1% of the image data values fall in the ranges 24-34 and 
151-254.) 

The image lightens quite a bit since only the range of data where the most values 
occur is being mapped to the grey shades. (The 0.5% of data values at the upper and 
lower ends are mapped to white and black respectively.)

Note: Input Limits to 99% Histogram works from the range of data displayed in the 
current histogram, which can be different than the actual image limits if you have 
entered your own axis limits (as discussed later).

Set exact input limits to highlight the ocean data range
The two text boxes below the histogram window let you type in new values to 
define the lower and upper X axis limits.

1 Inside the histogram window, point to the right side of the tall, narrow peak 
in the histogram. 

As mentioned previously, this peak corresponds primarily to the ocean portions of 
the satellite scene. Note that the X value is about 50, so the ocean peak has a 
minimum value of about 34 and a maximum value of about 50.
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2 Select the text in the X axis maximum text box (currently about 154), and 
enter a value of 50. 

ER Mapper applies the new X axis limits and renders the image.

Now the ocean areas are mapped to the entire range of grey shades to highlight 
subtle features, while the land areas (values greater than 50) are mapped to white. 
This is another method to map a specific range of data to the entire display range. 
(Earlier you adjusted the transform line to accomplish the same enhancement.)

3 On the Algorithm window, change the Lookup Table to rainbow.

The ocean areas are displayed in many colors, while the land is displayed mostly in 
red (the last color in that lookup table).

Set exact output limits to use specific lookup table colors
1 From the Limits menu, select Limits to Actual. 

The X axis range changes to match the Actual Input Limits field.

ER Mapper recomputes the histogram and applies the transform.

2 Change the Y axis minimum value (currently zero) to 200. 

The entire image is displayed in shades of yellow, orange, and red because those 
colors occupy the upper slots in the rainbow lookup table.

Note: The color bar display does not change when the Y axis limits are changed because 
it is still desirable to see the entire range of available colors.

3 Change the Y axis minimum value to 50, and change the Y axis maximum 
value to 150. 

The entire image is now displayed in shades of cyan and green because those colors 
occupy the middle slots in the rainbow lookup table (slots 50-150).

Tip: You can also use the Y axis limits to rescale data. For example, to rescale the range 
of a target image dataset to match a source image dataset, edit the Y axis transform 
limits for the target image to match the input limits of the source image. You can 
then save as a Virtual Dataset or disk file for further processing.
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5: Using automatic transform options

The automatic transform buttons are displayed on the right side of the Transform 
dialog box. Any time you select one of these options, ER Mapper automatically 
updates the image display in real time.

Reset the image display to greyscale and the default transform
1 Change the Y axis minimum value back to 0, and change the Y axis 

maximum value back to 255. 

2 On the Algorithm window, change the Lookup Table to greyscale.

Apply an autoclip transform to the data

1 On the Transform dialog, click the Create autoclip transform  button. 

ER Mapper automatically repositions the transform line, and the image updates 
automatically with increased contrast.

Autoclipping clips off the “tails” of the histogram to map the more frequently 
occurring data values to the selected display range. By default, ER Mapper 
performs a 99% autoclip that clips 0.5% of the data at the high and low ends of the 
data range. Outlying data values on the low end of the data range are assigned zero 
in the display range (black in this case), and outliers on the high end are given the 
maximum value (usually 255, white in this case). (This is similar to the Input 
Limits to 99% Histogram used earlier, but the transform line is automatically 
adjusted rather than the data range.)

2 This time, double-click the Create autoclip transform  button.

A dialog box appears to let you enter any autoclip percentage. The default is 99%.

3 Enter the value 95, then click OK to close the dialog.

The transform line is repositioned closer to vertical to clip the outlying 5% of the 
histogram frequency distribution (2.5% of the data values from the high and low 
ends). The image displays with greater contrast between light and dark areas.

Objectives Learn to use the automatic transform options such as autoclipping, Histogram 
Equalization, Gaussian Equalization, level slicing, and others. 
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Tip: For best visual results, keep your autoclip percentages greater than 90%. Values 
around 99% are most commonly used, but lower percentages are sometimes a good 
alternative for enhancing images with many outlying values.

4 Double-click the Create autoclip transform  button again, enter the 
value 99, then click OK. 

A 99% autoclip transform is again applied an the image is updated.

Tip: The 99% Contrast enhancement  toolbar button is a fast way to perform 

all these operations with one click, so it is especially useful for contrast stretching 
images that produce narrow or negative data ranges (such as ratios, PCs, and 
others).

Apply a Histogram equalize transform to the data

1 On the Transform dialog, click the Histogram equalize  button.

ER Mapper creates a complex piecewise linear transform line and updates the 
image.

Histogram equalization (also called uniform distribution stretching) automatically 
adjusts the transform line so that image values are assigned to display levels based 
on their frequency of occurrence. More display values are assigned to the most 
frequently occurring portion of the histogram, so the greatest contrast enhancement 
occurs in the data range with the most values (peaks in the histogram). Histogram 
equalization usually creates an image with very strong contrast between dark and 
light areas. In some cases, it can also saturate light and dark areas which can 
obscure detail.

Apply a Gaussian equalize transform to the data

1 On the Transform dialog, click the Gaussian equalize button. 

ER Mapper creates a complex piecewise linear transform line (sometimes with 
slight stair steps) and updates the image.

Gaussian equalization automatically adjusts the transform line so that image values 
are assigned as needed to make the output (display) values occur with a Gaussian 
distribution. (A Gaussian, or “normal” distribution, is characterized as producing a 
bell-shaped histogram. Notice that the output histogram has a shape close to this.) 
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Gaussian equalization is useful when data is skewed in such a way that features 
could be abnormally dark or light if stretched linearly. This technique prevents 
saturation of light or dark areas, and most pixels have mid-range brightness values 
with only a few in the extreme dark or light display regions.

Tip: You can set the number of standard deviations used for the Gaussian equalize 
function by double-clicking on the button. Smaller values produce more contrast 
and higher values less contrast. The default is 3 standard deviations.

Apply a level slice transform to the data
Level slicing (or density slicing) divides the image into discrete colors and removes 
transitional colors between them. The resulting images appears to be divided into 
“slices,” each displayed in a specific color. This technique can be useful for looking 
at data in discrete intervals and colors.

1 On the Transform dialog, click the Create level-slice transform  
button. 

ER Mapper creates a stair-stepped transform line at regular intervals. 

2 Double-click the Create level-slice transform  button.

A dialog box appears to let you enter a number of steps for the transform line.

3 Enter the value 3, then click OK to close the dialog.

The transform line is divided into three steps and the image is updated.

The stair-stepped transform divides the image into three shades–black for mostly 
ocean areas, mid-grey for middle reflectance land areas (such as vegetation), and 
white for high reflectance land areas (such as roads, sand, and airport runways).

Apply a Logarithmic and Exponential transforms to the data
1 On the Transform dialog, click the Create default logarithmic transform 

 button. 

The transform line changes to a smooth curve pointing toward the upper-left corner 
of the histogram window, and the image becomes very light.

2 Drag the transform down line by its mid-point to flatten it slightly.

The line retains its smooth curve, and image becomes darker. 
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3 On the Transform dialog, click the Create default exponential transform 

 button.

The transform line changes to a smooth curve pointing toward the lower-right 
corner of the histogram window, and the image becomes very dark.

4 Drag the transform up line by its mid-point to flatten it slightly.

The line retains its smooth curve, and image becomes lighter.

Tip: The Logarithmic transform type is useful for specialized enhancement purposes, 
such as displaying data with a large dynamic range, or to reduce apparent darkness 
in an image while retaining the variation in brightness. The Exponential transform 
is useful for processing geophysical data with a small dynamic range to increase the 
contrast in the displayed image.

6: Working with multiple transforms

Open the Algorithm window

1 Click the Edit Algorithm  toolbar button. 

ER Mapper opens the Algorithm window. You can now view the process stream 
diagram (which is needed for this exercise).

Apply a 99% autoclip transform to the data

1 Click the 99% Contrast enhancement  button. 

ER Mapper applies a 99% autoclip transform to the image.

Insert a second transform before the current one
1 From the Edit menu on the Transform dialog, select Insert new transform.

A second transform (and button) is added to the process stream diagram on the 
Algorithm window (it is inserted before the previous one). Its contents, currently 
empty, are shown in the Transform dialog. 

Objectives Learn to insert, append, and delete transforms from the processing stream, and 
use multiple transforms. 
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Delete the new transform from the process stream
1 From the Edit menu on the Transform dialog, select Delete this 

transform.

The current transform (the new one you inserted) is deleted from the process stream 
diagram.

Append a second transform after the current one
1 From the Edit menu, select Append new transform.

A second transform (and button) is added to the process stream diagram (it is 
appended after the previous one). 

The histogram shows the data range (0-255) after it has been passed through the 
99% autoclip transform preceding it. 

Specify Gaussian equalization for the new transform

1 On the Transform dialog, click the Gaussian equalize  button.

ER Mapper creates a Gaussian equalization transform line and updates the image. 
The resulting image is created by applying two transforms–a 99% autoclip 
followed by a Gaussian equalization of the autoclipped result. This is an example of 
enhancing an image by combining the characteristics of two different types of 
transforms.

Move to the previous transform and histogram
1 On the Transform dialog, click the Move to previous transform in layer 

 button. 

The contents of the Transform dialog box change to show the previous transform 
in the process stream diagram (the one applying a 99% autoclip). Also note that the 
corresponding transform button in the process stream diagram is now depressed.

Note that the Y axis limits are zero to 255. The transform rescales the original data 
range (22-254) into the 0-255 range. The rescaled range is used as the input data 
range for the transform following it.

2 Click the Move to next transform in layer  button. 

The contents of the Transform dialog change to show the next transform (the one 
applying a Gaussian equalization). 

Note that the Actual Input Limits are zero to 255. These were created by setting 0 
and 255 as the output (Y axis) data range for the previous transform.
Comprehensive ER Mapper Training Workbook 113



Chapter 6 Enhancing image contrast ●  7: Using automatic contrast stretching
Note: Depending on the types of raster layers in your algorithm, the Transform dialog 
may display other buttons that allow you to move between transforms in those 
layers (such as red, green, and blue). 

3 Click Close on the Transform dialog to close it. 

7: Using automatic contrast stretching

Open an RGB algorithm

1 On the main menu, click the Open  toolbar button. 

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the ‘Data_Types’ directory to open it.

4 In the ‘Landsat_TM’ directory, open the algorithm ‘RGB_741.alg.’

ER Mapper displays bands 7, 4 and 1 of a Landsat TM image of the San Diego, 
California area.

Change the band combination to RGB=321
1 Using the Band Selection drop-down menu (in the Algorithm window), 

change the image band in the Red layer to B3:0.66_um.

2 Change the image band in the Green layer to B2:0.56_um.

ER Mapper reprocesses the RGB algorithm with the new bands.

Notice that the image displays in reddish hues (this band combination usually 
creates a brown-green image when contrast stretched appropriately). This is caused 
by the current transforms for the Red and Green layers still being set to the data 
limits for the previous bands (7 and 4) rather than the new bands you selected (3 
and 2).

Use the Refresh Image button to enhance the contrast

1 On the main menu, click the 99% Contrast Enhancement  button.

Objectives Learn to use the button that automatically enhances image contrast. This lets you 
quickly view various image band combinations without needing to manually set 
actual limits each time.
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ER Mapper performs some internal operations, then re-runs the algorithm to 
display the image with an appropriate contrast stretch.

The 99% Contrast Enhancement  button is actually a batch script that 

performs the following sequence of operations for you: runs the algorithm once to 
determine the actual limits of each band, sets the input (X) axis limits to the actual 
data limits, runs the algorithm again to generate the new histogram, applies a 99% 
autoclip transform, then runs the algorithm once more to the display the image 
onscreen.

Tip: The 99% Contrast Enhancement  button saves you the contrast 

enhancement steps of setting each layer to Limits to Actual and applying an 
autoclip transform. Therefore it is very useful for initially viewing new images, and 
when using formulas or filters that produce data ranges outside 0-255. View 
different image band combinations

2 Select B4:0.83_um for the Red layer, B3:0.66_um for the Green layer, and 
B2:0.56_um for the Blue layer.

3 Click the 99% Contrast Enhancement  button to automatically adjust 
the contrast and display the new band combination.

A contrast enhanced image of an RGB=432 band combination displays. Vegetation 
is shown in red, and urban areas in cyan and grey.

4 Select B5:1.65_um for the Red layer, and B4:0.83_um for the Green layer.

5 Click the 99% Contrast Enhancement  button.

A contrast enhanced image of an RGB=542 band combination displays. Vegetation 
is shown in green, and urban areas in magenta.

View a different image and bands

1 In the process stream diagram, click the Load Dataset  button.

The Raster Dataset file chooser dialog box opens.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the ‘Data_Types” directory to open it.

4 In the ‘Ers1’ directory, double-click on the image ‘Landsat_TM.ers’ to load it 
into all three layers.
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5 In the process stream diagram, click the post-formula Edit Transform 

Limits  button for the Red layer. The histogram and transform from the 
previous image is still displayed.

6 Click the 99% Contrast Enhancement  button and watch the transform 
dialog as ER Mapper automatically adjusts it.

The transform is automatically adjusted to account for the new image limits and the 
RGB=542 band combination is displayed. This image is a Landsat TM image of the 
Netherlands coastal area in Europe.

Note: To speed this operation, ER Mapper internally runs the algorithm at low resolution, 
then processes the final screen image at full resolution. Therefore the input (X) axis 
limits in the Transform dialog (calculated at low resolution) may not exactly 
match the Actual Input Limits field (calculated from the final processing). You can 
manually reset the limits at this point to fine tune the contrast, but usually this is not 
needed.

7 Try various band combinations such as RGB=741, RGB=321, and others, 

then click 99% Contrast Enhancement  to display the new composite 
image.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Edit the transform for a particular raster data layer

• Apply linear and piecewise linear transforms

• Edit the input (data) and output (display) ranges for a transform

• Use the automatic transform options

• Work with multiple transforms

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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7

Colordrape
algorithms

This chapter explains how to apply shaded relief effects to an image and create 
“colordrape” algorithms that drape color information over intensity (brightness) 
information. Shading and colordraping are two of the most powerful techniques for 
presentation and analysis of DEM and geophysical images (e.g. magnetics, gravity, 
seismic horizons, etc.).

Note: This chapter describes the detailed step by step process of creating a colordrape 
algorithm by hand. You can also use the Geophysics Wizard (located on the 
Minerals and Oil & Gas toolbars) to produce colordrape images even more quickly 
and easily.

About colordraping
The term colordraping refers to the technique of draping one set of image data in 
color over another set of data that controls the color brightness or intensity. This 
allows you to effectively view two (or more) different types of data or methods of 
processing simultaneously in a combined display. Colordraping is usually difficult 
and time consuming using traditional image processing products, but ER Mapper 
makes it very fast and interactive by providing the special Intensity layer type. 
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The colordraping technique has become a very popular and powerful tool for 
visualization of interpreted surfaces. For example, combining seismic two-way-
time images shown as both color and as structure lets you create a shaded relief 
image that enhances subtle faults and color-codes their placement relative to depth. 
From these types of images, far more useful information can be derived than from 
conventional visualization techniques. 

The Intensity Layer Type
ER Mapper provides a special Intensity layer that is the key to the colordraping 
technique. When you add an Intensity layer to an algorithm, the brightness (or 
intensity) of the image colors are automatically controlled by the data loaded into 
the Intensity layer. Low data values in the Intensity layer produce dark colors in the 
image, and high data values produce bright colors. 

The diagram above shows how algorithm Pseudocolor and Intensity layers are 
combined to create a single colordrape image. You will see for yourself how these 
techniques work in the following exercises.

Hands-on exercises
These exercises give you practice creating colordrape algorithms to display time 
surfaces as both shaded relief and color. You will also learn to drape data such as 
seismic amplitude over a shaded time surface to enhance analysis.

• Use Intensity layers to create shaded relief images that highlight structure

• Combine Pseudocolor and Intensity layers to create colordrape images

• Turn layers on (to process them) and off (to ignore them)

• Control the color and intensity components to modify image displays

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Pseudocolor layer color image

Intensity layer brightness image

combined
colordrape

image
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Note: Some of the following exercises repeat steps from the previous exercise to 
emphasize understanding of the fundamental concepts.

1: Using shading to highlight structure

Open an image window and the Algorithm window

1 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

Change the Pseudocolor layer to an Intensity layer
1 Click your right mouse button on the pseudo layer (on the Algorithm 

window). A short-cut menu will appear. Select Intensity on the short-cut 
menu.

The Pseudocolor layer changes to an Intensity layer. You will use this layer to 
create a greyscale shaded relief image.

Load the sample seismic image dataset into the Intensity layer

1 In the Algorithm window, click the Load Dataset  button on the left side 
of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

2 From the Directories menu, select the path ending with \examples. 

3 Double-click on the directory named ‘Shared_Data.’

A list of raster image datasets is displayed.

4 Scroll (if needed) to view the image named ‘Seismic3D.ers,’ then double-
click on it to load it.

The image is loaded into the Intensity layer.

Objectives Learn how to display a time image in an Intensity layer and apply sun angle 
shading to create shaded relief effects that highlight structure. 
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Use a formula to invert the image values

Note: Note that this step is usually only done with two way time or depth data. The reason 
for inverting the values is to make the deeper areas to appear lower than the 
shallower ones.

1 In the Algorithm window, click on the Edit Formula  button in the 
process stream diagram.

The Formula Editor dialog box appears.

2 In the Formula Editor dialog, click to place the text cursor before the “I” in 
“INPUT1,” then type a minus sign (-) on your keyboard. Your formula should 
now look like this:

-INPUT1

This formula tells ER Mapper to negate (invert) all values in the image.

3 On the Formula Editor dialog, click the Apply changes button.

The image appears as black initially because you need to adjust the transform to 
account for the new range of negative data values produced by the formula 

4 Click the Close button to close the Formula Editor dialog.

Adjust the color mapping (contrast) of the image
1 In the Algorithm window, click on the right-hand Edit Transform Limits 

 button in the process diagram (the one after the Formula button). 

The Transform dialog box opens showing the negative data range produced by the 
formula in the Actual Input Limits fields.

2 From the Limits menu (on the Transform dialog), select Limits to Actual.

The X axis data range changes to match the Actual Input Limits.

ER Mapper renders the image again, this time using the full range of grey shades to 
display the image. Since you inverted the data values with a formula, structural 
lows (larger two-way time values) are shown as dark greys transitioning into 
structural highs shown as lighter shades.

3 Click Close on the Transform dialog to close it.
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Turn on sun shading and display the shaded relief image

1 On the Algorithm window, click the Edit Realtime Sunshade  button in 
the process stream.

The Edit Sun Angle dialog box opens to let you specify shaded relief effects for 
the Intensity layer.

2 Turn on the Do sun-shading option.

Sun Angle shading is now active for the Intensity layer, and the Edit Realtime 

Sunshade button in the process diagram changes  to indicate this. 

Now the structural features of the time surface are clearly defined due to the sun 
angle shading. This feature allows you to apply artificial illumination from any 
direction to highlight very subtle structural features.

3 Make the image window about 50% larger by dragging lower-right corner of 
the window border.

4 Right-click anywhere on the image and select Zoom to All Datasets from 
the Quick Zoom menu.

ER Mapper redisplays the image to fit into the larger window size.

Change the sun azimuth
1 In the Edit Sun Angle dialog, drag the small sun icon (the circle) to the 

upper-left quadrant of the circular grid. 

The shading angle of the image changes in real time to show the shading effect as if 
the sun were shining from the northwest. 

click to turn
shading on/off

drag icon to
change sun
azimuth and
elevation

type in values
or click arrow
to increment

diagram showing
sun position
relative to horizon
(outer circle) or
overhead (center)
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The azimuth (compass direction) from which the sun shines highlights structural 
features normal to the sun angle. In this case, features trending in a northeast to 
southwest direction are now highlighted (since they are normal to the northwest sun 
angle).

2 Drag the sun icon to shade from different compass directions (azimuths).

Structural features normal to your new sun azimuths are highlighted.

Change the sun elevation
1 In the Edit Sun Angle dialog, drag the sun icon near the outer rim of the 

circular grid. 

The image becomes darker overall and with larger areas of shadows. 

The elevation from which the sun shines determines the length of shadows in the 
shaded relief image. In this case, the sun is shining from a very low sun angle (near 
the horizon), so you get longer shadows just as you would see right after sunrise or 
before sunset.

2 Drag the sun icon to the center of the circular grid.

Now the entire image has very little shadow, as if the sun is shining directly 
overhead during midday. This allows you to see terrain features without directional 
shadowing introduced by shading from a specific azimuth. (For example, you can 
see both sides of a fault.)

3 Experiment by dragging the sun icon until you create an image that 
highlights structural features of interest. (Setting the sun elevation at 45 
degrees or greater is usually recommended to reduce shadowing.)

Tip: You can also adjust the sun azimuth and elevation to exact values using the 
adjustment arrows next to the Azimuth and Elevation fields.

4 Click Close on the Edit Sun Angle dialog to close it.

Applications of sun angle shading
ER Mapper’s sun angle shading feature is a very powerful tool for rapid 
identification of subtle features in time surfaces. It is commonly used for many 
applications, including:

• identify small scale faulting

• identify subtle stratigraphic features (pinchouts, truncations, etc.)

• highlight data acquisition and/or processing artifacts
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• highlight quality issues related to interpretation

2: Draping color on the image

Duplicate the layer and change it to Pseudocolor
1 On the Algorithm window, select the layer that already contains the 

‘Seismic3D’ image and click the Duplicate  button to create a copy of it.

2 Click on the new (lower) layer with your right mouse button. A short-cut 
menu will appear. Select Pseudo from the short-cut menu.

The Intensity layer changes to a Pseudocolor layer. You will use this layer to 
display the time surface in color over the shaded relief image.

3 Click on the Surface tab, then select pseudocolor from the Color Table 
list.

Turn off sun shading for the Pseudocolor layer
1 Click on the Layer tab to select it.

2 With the Pseudo layer selected, click the Edit Realtime Sunshade  
button in the process stream.

The Edit Sun Angle dialog box opens. Since the layer was duplicated from the 
Intensity layer, sun angle shading is still turned on.

3 On the Edit Sun Angle dialog, turn off the Do sun-shading option.

Sun angle shading is now turned off, and the Edit Realtime Sunshade button in 

the process diagram has a cross through it  to indicate this.

Note: Sun angle shading is usually applied only to time surface images displayed in 
Intensity layers because two-way time describes structural features well. Sun 
shading is not normally applied to amplitude or attribute images which are 
generally displayed in color.

4 Click Close on the Edit Sun Angle dialog to close it.

Objectives Learn how to duplicate and modify the Intensity layer to create a Pseudocolor 
layer, and how to combine the two layers to create a colordrape image. 
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Note that by combining the two processing techniques into one image, you can 
simultaneously see structure as brightness relative to depth as color. In this case 
blues represents structural lows, and reds structural highs.

Tip: The colordrape technique you used here is one of the most important ER Mapper 
processing techniques used to visualize interpreted time surfaces. You should 
therefore practice and become comfortable with the steps used to create colordrape 
algorithms.

Try different color mapping transforms for the color layer
1 In the Algorithm window, click on the Pseudo layer to select it.

2 Click on the right-hand Transform  button in the process diagram 
(following the Formula button). 

The Transform dialog box opens showing the current lookup table and color 
mapping.

3 On the Transform dialog, click the Histogram equalize  button.

ER Mapper applies a histogram equalization transform to the data. Histogram 
equalization maximizes overall color contrast in the image at the expense of losing 
contrast in the structural highs and lows.

Note: Notice that the color mapping changes without affecting the shaded relief image in 
the Intensity layer. This shows how layers in an algorithm are independent of each 
other, and can be modified individually to affect to overall image they combine to 
create.

4 On the Transform dialog, click the Gaussian equalize  button.

ER Mapper applies a gaussian equalization contrast stretch to the data. This 
maximizes color contrast in the structural highs and lows, but tends to flatten out 
contrast in other parts of the image.

5 On the Transform dialog, click the Create default linear transform  
button. 

ER Mapper resets the color mapping back to a straight linear default.

6 Click Close on the Transform dialog to close it.
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Display the shaded relief and color images separately
1 Turn the Pseudocolor layer off by right-clicking on the layer name and 

selecting Turn Off from the drop-down menu.

Only the structural component of the image displays since the color component of 
the algorithm (the Pseudocolor layer) is turned off. 

2 Turn the Pseudocolor layer on again (activate the option button).

ER Mapper displays the combined colordrape image.

3 Turn the Intensity layer off by deactivating its option button.

ER Mapper displays the color image only.

By turning layers on and off, you can see them independently of each other to fine 
tune adjustments before adding them together again.

4 Turn the Intensity layer on again (activate its option button).

ER Mapper displays the combined colordrape image again.

3: Draping amplitude data in color

Add a second Pseudocolor layer to the algorithm
1 From the Edit/Add Raster Layer menu (on the Algorithm window), select 

Pseudo.

ER Mapper adds a new Pseudocolor layer to the algorithm. As with all new added 
layers, it has no image loaded yet.

Load the sample seismic image dataset into the new layer

1 In the Algorithm window, click the Load Dataset  button on the left side 
of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

2 Select the image named ‘Seismic3D.ers’ from the ‘\examples\Shared_Data’ 
directory by double-clicking on it.

The image is loaded into the new Pseudocolor layer, so all layers contain the same 
image.

Objectives Learn how to add a second Pseudocolor layer to drape amplitude (or other data) 
as color over the shaded time, and how to use multiple Pseudocolor (or other 
layer types) in the same algorithm.
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Tip: If you had wanted to load a different image into the second Pseudocolor layer, you 
would use either the OK this layer only or Apply this layer only button on the 
Raster Dataset dialog. Double-clicking on the image name is the same as 
clicking the OK button.

Change the image band for the new Pseudo layer
1 With the new (lower) Pseudo layer selected, click on the Band Selection 

drop-down list in the process diagram (it currently reads ‘B1:Two Way 
Time_ms’).

A list of two images displays. This image has two bands (or layers) of data covering 
the same geographic area–a two-way time band and a seismic amplitude band.

2 Click on the option labelled B2:Amplitude to select it as the band to be 
processed in that layer.

Note: When you first load an image into a layer, the first band is selected by default. You 
can then use the Band Selection drop-down list to choose any band in the image.

Label the two Pseudo layers to distinguish them
Since you now have more than one Pseudocolor layer, it is helpful to add labels to 
each so you can quickly distinguish between them.

1 Click in the text field on the left side of the lower Pseudo layer, and type the 
text Amplitude.

2 Click in the text field on the left side of the upper Pseudo layer, and type the 
text Inverted TWT.

Turn off the two-way time Pseudo layer
1 Turn off the Pseudo layer labelled ‘Inverted TWT’ by right-clicking on the 

layer name and selecting Turn Off from the drop-down menu.

The layer is now turned off and will be ignored during processing.

The data initially appears as red over the shaded time image–you need to adjust the 
transform (color mapping) to account for the data in the new layer.

Adjust the transform for the Amplitude color layer
1 Click on the Pseudo layer labelled ‘Amplitude’ to select it.
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2 Click on the right-hand Transform  button in the process diagram. 

The Transform dialog box opens. Notice that the actual input limits range from 
about -17000 to +30000.

3 From the Limits menu, select Limits to Actual.

The amplitude data now displays as various colors over the shaded time data. 

Note that the histogram for the amplitude data shows that most of the data values 
are clustered in the center (a normal distribution). This is why the data are 
displayed primarily in greens and yellows since these are the middle colors in the 
lookup table.

4 On the Transform dialog, click the Histogram equalize  button.

Histogram equalization increases the overall color contrast in the amplitude data. 
Areas of high amplitudes are shown as reds, and low amplitude areas are shown in 
blues.

This colordrape image lets you easily associate variations in amplitude with 
structural features shown by the shaded two-way time surface in the Intensity layer. 
Using this technique, you can drape virtually any type of data in color over the 
shaded time surface to aid interpretation of subtle relationships.

5 Click Close on the Transform dialog to close it.

Display the two-way time data again
1 Turn on the Pseudo layer labelled ‘Inverted TWT’ by right-clicking on the 

layer name and selecting Turn On from the drop-down menu.

2 Turn off the Pseudo layer labelled ‘Amplitude.’

The two-way time data again displays in color over the shaded relief data. You can 
now easily display either the time or amplitude data simply by turning on the 
desired layer.

Note: If you have more than one layer of the same type turned on, the layer on top has 
display priority over layers below it. In this case, for example, you would see the 
two-way time data if both the ‘Inverted TWT and ‘Amplitude’ layers were turned 
on. (Data in lower priority layers is only displayed where they do not spatially 
overlap with layers of the same type above them.)
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4: Saving the colordrape algorithm

Enter a description for the algorithm
1 In the Algorithm window, select the text in the Algorithm Description text 

field (it currently reads ‘No Description’).

2 Type the following text, then press Enter or Return on your keyboard:

Horizon KA time and amplitude colordrape

This text now becomes a brief description for the entire algorithm.

Save the processing steps to an algorithm file on disk
1 From the File menu (on the main menu), select Save As....

The Save As file chooser dialog box appears.

2 In the Files of Type field, select ER Mapper Algorithm (.alg).

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Miscellaneous’ to open it. 

5 Double-click on the directory named ‘Tutorial’ to open it. 

6 In the Save As: text field, type in a name for the algorithm file using your 
initials at the beginning followed by the text ‘Horizon_KA_colordrape.’ 
Separate each word with an underscore (_). For example, if your initials are 
“DH,” type in the name:

DH_Horizon_KA_colordrape

7 Click the Apply button to save the algorithm and leave the dialog open.

Your pseudocolor algorithm is now saved to an algorithm file on disk.

Add comments to the algorithm
1 Click the Comments... button.

A dialog box opens allowing you to type comments about your algorithm.

2 Click Cancel on the Save As dialog to close it (you do not need it).

3 In the comments dialog, type the following description information:

This algorithm drapes time or amplitude data in color over

a shaded time surface. Sun angle shading is applied to the

Objectives Learn to save and add comments to the colordrape algorithm.
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time data in the Intensity layer to highlight structural

features. Two Pseudocolor layers are added to display either

time or amplitude to create a combined color/shaded relief image.

4 Click the OK button to save your comments with the algorithm and close the 
dialog.

Your algorithm is now commented for future users.

Tips for Colordrape Algorithms
Generally the Intensity layer of a colordrape algorithm is used to show structural 
features derived from two-way time data, and the color layers are used to show 
amplitude, azimuth, isochrons, or any other derivative or attribute images you feel 
are useful. To use an existing algorithm as a “template” algorithm to apply the same 
processing to different images, simply load new images into the Intensity and 
Pseudocolor layers and adjust the transforms to account for the data ranges.

One colordrape variation some researchers use is to display a dip image in Intensity 
instead of shading from a specific compass direction. A dip image may delineate 
both sides of a fault more clearly, for example. (Generation of dip images is 
explained in the chapter on formulas.)

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Use Intensity layers to create shaded relief images that highlight structure

• Combine Pseudocolor and Intensity layers to create colordrape images

• Turn layers on (to process them) and off (to ignore them)

• Control the color and intensity components to modify image displays

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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HSI algorithms
This chapter explains how to create algorithms that allow you to display and 
manipulate data in the Hue Saturation Intensity (HSI) color space. Applying an HSI 
enhancement is an innovative analysis technique that goes one step beyond a 
colordrape display, so you can visualize three variables simultaneously. This is an 
advanced technique most commonly used to combine multiple seismic attribute 
horizons in a single image.

Note: HSI is also referred to as IHS, or Intensity Hue Saturation, in some circles. 

Note: Another common application of HSI processing is to improve the “look” of an 
RGB image (usually a satellite or airphoto image) by adjusting the image intensity 
or colour saturation (or both). This is described in exercise “4: Converting an RGB 
image to HSI” on page 143.

About the HSI Color System
In the Hue Saturation Intensity (HSI) color system, different colors are 
characterized by three measurable characteristics of a color: 

• Hue–The main attribute of a color that distinguishes it from other colors in the 
spectrum. Hues are what you see in a rainbow, and are what we commonly think of 
as “color” (red, yellow, green, and so on). 
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• Saturation–The amount of a particular color or color “purity.” Colors with high 
saturation (little grey) are said to be pure or vivid. Colors with low saturation (much 
grey) are pastel or dull colors. Completely desaturated colors are grey, no matter 
what the hue. 

• Intensity–The relative brightness of a color. Colors with high intensity are bright, 
and colors with low intensity are dark. 

The HSI color system is characterized as a “perceptual” color system because it 
provides a more intuitive means of manipulating color than the RGB (electronic) 
color system. ER Mapper implements the HSI color system by means of the Color 
Mode named Hue Saturation Intensity, and separate algorithm layer types for Hue, 
Saturation, and Intensity. 

HSI Color Mode
To display data in HSI, you set the algorithm Color Mode to Hue Saturation 
Intensity, then load data into Hue, Saturation, and Intensity layers. In order to 
produce color, all three layers types must be used and turned on. ER Mapper 
provides HSI template algorithms that let you quickly load and display data using 
the HSI color system.

Note: Computer monitors use the RGB color system to actually display data, so 
ER Mapper automatically performs an internal translation of colors specified in 
HSI to colors specified in RGB for the monitor.

The Hue Layer
In an HSI image display, The Hue layer controls the mapping of data values to 
colors in the spectrum. In a typical display, the range of data values from low to 
high is mapped through the progression of hues: red-yellow-green-cyan-blue-
magenta.

The Saturation Layer
In an HSI image display, The Saturation layer controls the mapping of data to the 
purity of colors in the image display (that is, the amount of grey in the colors). Low 
data values produce pastel or dull colors (much grey), and high data values produce 
pure or vivid colors (little grey).
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The Intensity Layer
In an HSI image display, The Intensity layer controls the mapping of data to the 
brightness of colors in the image display. Low data values produce dark color, and 
high data values produce white color.

The diagram above shows how algorithm Hue, Saturation and Intensity layers are 
combined to create a single HSI colordrape image. You will see for yourself how 
these techniques work in the following exercises.

Hands-on exercises
These exercises give you practice creating HSI colordrape algorithms and 
manipulating image display in HSI color space.

• Use the algorithm Color Mode named Hue Saturation Intensity

• Combine Hue, Saturation and Intensity layers to create HSI images

• Understand the basics for interpreting data displayed in HSI

• Control the hue, saturation and intensity components to modify image displays

• Improve the appearance of an RGB image by converting it to HSI.

Note: Some of the following exercises repeat steps from the previous exercises to 
emphasize understanding of the fundamental concepts.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Hue layer color image

Saturation layer color purity image

combined

Intensity layer brightness image

HSI
colordrape

image
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1: Creating the shaded relief image

Open an image window and the Algorithm window

1 On the Common Functions toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

Change the Pseudocolor layer to an Intensity layer
1 Click your right mouse button on the Pseudo layer (on the Algorithm 

window). A short-cut menu will appear. From the short-cut menu select 
Intensity.

The Pseudocolor layer changes to an Intensity layer. You will use this layer to 
create a greyscale shaded relief image.

Load the sample seismic image dataset into the Intensity layer

1 In the Algorithm window, click the Load Dataset  button on the left side 
of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

2 From the Directories menu, select the path ending with \examples. 

3 Double-click on the directory named ‘Shared_Data’.

4 Double-click on the image named ‘Seismic3D.ers’ to load it.

The image is loaded into the Intensity layer.

Use a formula to invert the image values
As before, it is often desirable to invert positive two-way time values, so larger time 
values are displayed as structural lows and smaller values as highs. (This is optional 
and may not be necessary with your images.)

1 In the Algorithm window, click the Edit Formula  button in the process 
stream diagram.

Objectives Learn how to create an HSI algorithm by opening a new image window, creating 
Hue, Saturation, and Intensity layers, and loading data into the H, S, and I layers. 
(The sample algorithm you will create displays two-way time as hues, amplitude 
as saturation, and shaded two-way time as intensity.) 
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The Formula Editor dialog box appears.

2 In the Formula Editor dialog, edit the text string “INPUT1” to add a minus 
sign (-) in front. Your formula should now look like this:

-INPUT1

This formula tells ER Mapper to negate (invert) all values in the image.

3 On the Formula Editor dialog, click the Apply changes button.

The image appears as black initially because you need to adjust the transform to 
account for the new range of negative data values produced by the formula 

4 Click Close on the Formula Editor dialog to close it.

Adjust the color mapping (contrast) of the image
1 In the Algorithm window, click on the right-hand Edit Transform Limits 

 button in the process diagram (the one after the Formula button). 

The Transform dialog box opens showing the negative data range produced by the 
formula in the Actual Input Limits fields.

2 From the Limits menu (on the Transform dialog), select Limits to Actual.

The X axis data range changes to match the Actual Input Limits.

ER Mapper renders the image again, this time using the full range of grey shades to 
display the image.

3 Click Close on the Transform dialog to close it.

Turn on sun shading and display the shaded relief image

1 On the Algorithm window, click the Edit Realtime Sunshade  button in 
the process stream.

The Edit Sun Angle dialog box opens to let you specify shaded relief effects for 
the Intensity layer.

2 Turn on the Do sun-shading option to turn on shading.

The structural features of the time surface are clearly defined due to the sun angle 
shading.

3 Drag the small sun icon (the circle) around the circular grid until you find a 
shade angle that highlights structural features of interest. (Keep the sun 
elevation above 45 degrees to reduce shadowing.)

4 Click Close on the Edit Sun Angle dialog to close it.
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Label the Intensity layer to identify it
1 Click in the text field on the left side of the Intensity layer, and type the text 

Shaded TWT.

(If desired, you could also add the shading angle, for example “NE shaded TWT”.)

2 Make the image window about 50% larger by dragging lower-right corner of 
the window border.

3 Right-click on the image and select Zoom to All Datasets from the Quick 
Zoom window.

You have now created the shaded relief image to highlight structure. Next you will 
add Hue and Saturation layers to drape other data in color.

2: Adding data in Hue and Saturation layers

Duplicate the Intensity layer and change it to Hue
1 On the Algorithm window, with the Layer tab selected, click the Duplicate 

 button to create a copy of the current Intensity layer that already 

contains the ‘Seismic3D’ image.

2 Click on the new (lower) layer with your right mouse button. A short-cut 
menu will appear. From the short-cut menu select Hue.

The Intensity layer changes to a Hue layer. You will use this layer to display the 
inverted two-way time data in color over the shaded relief image.

Note: Notice that the Hue layer has a red cross  over it – this indicates that the layer 

type in not valid with the current algorithm Color Mode. (In order to use Hue layers 
in an algorithm, you must also select the Color Mode named Hue Saturation 
Intensity).

Objectives Learn how to build on your shaded relief Intensity image to create an HSI 
algorithm by adding Hue and Saturation layers. (The sample algorithm you will 
create displays two-way time as hues, amplitude as saturation, and shaded two-
way time as intensity.)
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Change the Color Mode to Hue Saturation Intensity
1 In the surface tab, from the Color Mode drop-down menu (on the 

Algorithm window), select Hue Saturation Intensity.

The Hue layer now becomes active because the appropriate Color Mode is now 
selected.

Turn off sun shading for the Hue layer

1 With the Hue layer selected, click the Edit Realtime Sunshade  button 
in the process stream.

The Edit Sun Angle dialog box opens. Since the layer was duplicated from the 
Intensity layer, sun angle shading is still turned on.

2 On the Edit Sun Angle dialog, turn off the Do sun-shading option.

Sun angle shading is now turned off for the Hue layer (shading is not normally used 
on color layers).

3 Click Close on the Edit Sun Angle dialog to close it.

4 Enter a label for the Hue layer by typing the text Inverted TWT in the text 
field on the left side.

Add a Saturation layer and load the sample image
1 From the Edit/Add Raster Layer menu (on the Algorithm window), select 

Saturation.

ER Mapper adds a new Saturation layer to the algorithm. As with all new added 
layers, it has no image loaded yet. You will use this layer to display the seismic 
amplitude data.

2 In the Algorithm window, click the Load Dataset  button on the left side 
of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

3 From the Directories menu, select the path ending with \examples.

4 Double-click on the directory named ‘Shared_Data’.

5 Scroll up (if needed) to view the image named ‘Seismic3D.ers,’ then double-
click on it to load it.

The image is loaded into the new Saturation layer, so all layers contain the same 
image.
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Tip: In this case you added a new layer and loaded the image because you don’t want to 
use the formula in the other layers. (There is no need to invert the amplitude data.) 
An alternative is to duplicate the Hue layer, change its type to Saturation, and reset 
the formula back the default “INPUT1.”

Select the amplitude band and label the Saturation layer
1 With the new Saturation layer selected, click on the Band Selection drop-

down list in the process diagram, and select B2:Amplitude.

This tells ER Mapper to modify the saturation of colors in the final image 
according to variations in the amplitude data.

You now have an image similar to the colordrape that shows structure (shaded two-
way time) and depth (color-coded two-way time). Now you need to adjust the 
transform of the amplitude data to make it clearly stand out against the color and 
shading.

2 Enter a label for the Saturation layer by typing the text Amplitude in the 
text field on the left side.

Apply a Histogram equalization to the amplitude data
1 With the Saturation layer selected, click on the right-hand Edit Transform 

Limits  button in the process diagram. 

The Transform dialog box opens.

2 On the Transform dialog, select Limits to Actual from the Limits menu.

The complete histogram for the amplitude data appears.

3 On the Transform dialog, click the Histogram equalize  button.

The overall contrast in the amplitude data is increased, which appears as variations 
in color saturation throughout the image. Notice, for example, that the V-shaped 
uplifted fault block in the upper-left shows high amplitudes as vivid colors and low 
amplitudes as greyish colors.

You now have an image that shows three variables at once:

• Structure is shown as intensity (brightness) by applying sun angle shading to the 
two-way time data. 

• Relative depth is shown as color (hues), where red indicates the troughs progressing 
through yellow, green, cyan, and blue to magenta for the peaks in the time surface. 
Comprehensive ER Mapper Training Workbook 139



Chapter 8 HSI algorithms ●  2: Adding data in Hue and Saturation layers
• The event amplitude is shown by variations in the saturation of colors, where greyish 
or pastel colors indicate low amplitude progressing through to vivid or rich colors 
that indicate high amplitudes. 

This type of display has become a popular ER Mapper processing technique for 
combined analysis of two-way time and amplitude data, as well as other 
combinations of time and images derived from seismic images.

4 Click Close on the Transform dialog to close it.

Zoom in on upper-left portion of the image

1 On the Common Functions toolbar, click the ZoomBox Tool  button. 

2 Inside the image window, drag a zoom box around the V-shaped structure 
in the upper-left portion of the image (the uplifted fault block in red and 
magenta).

ER Mapper zooms in on the defined area. Notice that the image takes on a slightly 
jagged or blocky look when you zoom in closely. (You can begin to see the limits of 
the seismic data resolution, or the actual pixels that comprise the image.)

3 On the Algorithm window, turn on the Smoothing option.

Notice that the image becomes noticeably smoother. The Smoothing option applies 
a bilinear interpolation to the image screen display. This is often useful for reducing 
the jagged look and helps make overall features easier to interpret.

Also notice that you can now clearly see the pattern of low and high amplitudes in 
the uplifted block and surrounding areas. High amplitude areas have very rich 
colors, and low amplitudes occur along the faults (shown by the low saturation 
greyish colors in those areas).

4 From the View menu (on the main menu), select Quick Zoom, then select 
Zoom to All Datasets.

ER Mapper zooms back out to the full image extents.

Tip: The Smoothing option is most useful when you zoom in very closely on an area 
of interest, and can be turned on or off as desired. It usually has little noticeable 
effect until you zoom in close to the pixel resolution.
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3: Saving the HSI colordrape algorithm

Enter a description for the algorithm
1 Select the text in the Algorithm Description text field and type:

TWT and amplitude HSI enhancement

This text now becomes a brief description for the entire algorithm.

Save the algorithm to disk

1 On the Standard toolbar (on the main menu), click the Save As  button.

The Save As file chooser dialog box appears. (This toolbar button is a shortcut for 
selecting Save As... from the File menu.)

2 In the Files of Type: field, select ‘ER Mapper Algorithm (.alg)’.

3 Double-click on the ‘examples\Miscellaneous\Tutorial’ directory to open it. 

4 In the Save As: text field, type in a name for the algorithm file using your 
initials at the beginning followed by the text ‘Seismic_HSI_enhancement.’ 
Separate each word with an underscore (_). For example, if your initials are 
“TL,” type in the name:

TL_Seismic_HSI_enhancement

5 Click the Apply button to save the algorithm and leave the dialog open.

Your HSI algorithm is now saved to an algorithm file on disk.

Add comments to the algorithm
1 Click the Comments... button to add comments.

2 Click Cancel on the Save As dialog to close it (you do not need it).

3 In the comments dialog, type the following description information:

This algorithm displays time and amplitude data in hue

saturation intensity (HSI) color space. Sun angle shading is 
applied to the time data in the Intensity layer to highlight 
structure. Time is displayed as color in the Hue layer, and

event amplitude is displayed as variations in color saturation

in the Saturation layer.

Objectives Learn to save and add comments to the HSI colordrape algorithm.
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4 Click the OK button to save your comments with the algorithm and close the 
dialog.

Your algorithm is now commented for future users.

5 Close the image window.

Tips for HSI Algorithms
Displaying data in Hue Saturation Intensity color space is one of the newer 
techniques in the analysis of interpreted time surfaces. It is helpful to have basic 
understanding of the way the HSI color system works to help you interpret data 
presented in this way.

Using the previous HSI image as an example, color is used to indicate absolute 
depth, or the structural highs and lows in the time surface. The event amplitude is 
not related to any specific color or hue (red, blue, etc.), but to the saturation of the 
color. For example, areas of the time surface with similar amplitudes may have 
completely different colors, but will have the same degree of color saturation or 
purity.

This example used time in the hue layer and amplitude in the saturation layer, but 
you could just as easily substitute any other types of data instead. Shaded two-way 
time data is generally always used in the intensity layer.

The steps you followed in this exercise showed how to create an HSI algorithm 
from scratch, in part to illustrate the use of certain features in ER Mapper. When 
you learn to use ER Mapper, you can create these types of algorithms more quickly 
by using an existing algorithm as a template, or using a toolbar button to 
automatically create certain types of commonly used algorithms.
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4: Converting an RGB image to HSI

Certain types of image enhancements can be awkward or impossible to do by 
applying individual constrast stretches to the red, green, and blue channels 
separately. For example. if you want to brighten an RGB image, you cannot only 
adjust the transform for the Red layer because the image will then become more red 
in color. Changing the overall color saturation by adjusting the Red, Green and 
Blue layer transforms is even more difficult, if not impossible. On the other hand, 
you can independently increase the brightness and color saturation of an HSI image 
by merely adjusting the transforms for the Intensity and Saturation layers without 
affecting the color. 

This exercise shows you how to use a supplied template algorithm to convert an 
existing RGB algorithm to HSI and then to adjust the brightness and color 
saturation.

Open the template algorithm

1 Click on the Open  button on the Standard toolbar.

The Open file chooser dialog box appears.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Miscellaneous’ to open it.

4 Double-click on the directory named ‘Templates’ to open it.

5 Double-click on the directory named ‘Common’ to open it.

6 Double click on the file named ‘RGB_to_HSI_to_RGB.alg’ to open it.

A window displaying and image will open.

7 On the Common Functions toolbar, click on the Edit Algorithm  button 
to open the Algorithm window.

Notice that the algorithm is displaying the ‘ADAR_5000.ers’ image in an Intensity, 
Saturation and a Hue layer. You will now replace this image with an RGB 
algorithm and use the ‘RGB_to_HSI_to_RGB.alg’ as template for displaying it 
in HSI color mode.

Load the RGB algorithm
1 In the Algorithm window, click on the Intensity Layer to select it.

Objectives Learn to improve the appearance of an image by converting it from RGB to HSI.
Comprehensive ER Mapper Training Workbook 143



Chapter 8 HSI algorithms ●  4: Converting an RGB image to HSI
2 Click the Load Dataset  button on the left side of the process stream 
diagram.

The Raster Dataset file chooser dialog box appears.

3 Select ‘ER Mapper Algorithm (.alg)’ in the Files of Type: box.

4 From the Directories menu, select the path ending with \examples.

5 Double-click on the directory named ‘Data_Types’.

6 Double-click on the directory named ‘Landsat_TM’.

7 Double-click on the image named ‘RGB_321.alg’ to load it.

The ‘RGB_321.alg’ algorithm, consisting of a Red, Green and Blue layer is loaded 
into all three layers of HSI template algorithm. Notice that each layer of the 
template algorithm has the original Red, Green and Blue layers applied as input 
bands to a formula to produce the Hue, Saturation or Intensity layer 

The image should currently have a grey and blue appearance because the input 
bands are in the wrong order for the Hue Layer formula. The formulas applied to 
the Intensity and Saturation layers do not require the input bands to be in a specific 
order.

8 Select the Hue layer and change the order of the input bands to B3:Red, 
B2:Green and B1:Blue, as shown below:

The displayed image should become more brown and green in color.

9 With the Hue Layer selected, click on the Edit Formula  button in the 
process diagram.

The Formula Editor dialog box will open. Notice that the formula description is 
“RGB to Hue”, indicating that this formula uses the three RGB input bands to 
create a single Hue layer. The formula has been loaded into the template algorithm 
from the ‘Hue.frm’ file in the ‘formula\hsi’ directory. 

10 Click on the  button on the Formula Editor dialog box. 
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This causes the Formula Editor dialog to display the formula for the Saturation 
Layer. Notice that the selection in the Algorithm window also changes to the 
Saturation Layer. In this case the formula description is “RGB to Saturation”. The 
formula has been loaded from the ‘Saturation.frm’ file in the ‘formula\hsi’ 
directory.

11 Click on the  button on the Formula Editor dialog box. 

This causes the Formula Editor dialog to display the formula for the Intensity 
Layer. Notice that the selection in the Algorithm window also changes to the 
Intensity Layer. In this case the formula description is “RGB to Intensity”. The 
formula has been loaded from the ‘Intensity.frm’ file in the ‘formula\hsi’ directory.

12 Click on the Close button to close the Formula Editor.

Formulas will be discussed in more detail in Chapter 10, “Using Formulas”.

Adjust the image brightness
You can now adjust the brightness of the image by altering the post formula 
transform on the Intensity Layer.

1 With the Intensity Layer selected, click on the Edit Transform Limits  
button to the right of the Edit Formula button on the process diagram.

The Transform dialog will open.

2 On the Transform dialog, select the Create default logarithmic transform 

 or Create default exponential transform  button.

3 You can now increase or decrease the brightness of the image by dragging 
the transform line as shown below:

Increase
brightness

Decrease
brightness
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Adjust the color saturation
You can adjust the color saturation of the image by altering the post formula 
transform on the Saturation Layer.

1 On the Transform dialog, select the Saturation Layer post formula transform 

by clicking on the  button.

If the Transform dialog was not already open, you would have selected the 
transform from the Sakturation Layer process diagram in the Algorithm window.

2 On the Transform dialog, select the Create default logarithmic transform 

 or Create default exponential transform  button.

3 You can now increase or decrease (to greyscale) the color saturation of the 
image by dragging the transform line as shown below:

Note: While it is possible to adjust the Hue Layer transform in the same way as the 
Intensity and Saturation layers, this is not usually done because it causes the colors 
to change making the image difficult or impossible to interpret.

Increase
color

Decrease
color
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Use Intensity layers to create shaded relief images that highlight structure

• Combine Pseudocolor and Intensity layers to create colordrape images

• Turn layers on (to process them) and off (to ignore them)

• Control the color and intensity components to modify image displays

• Convert an RGB image to HSI to improve its appearance.

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Using spatial
filters

This chapter explains how to modify raster image data using spatial filtering to 
enhance edges, remove noise, highlight structural features, and perform other 
enhancements to improve visual interpretation. It introduces concepts associated 
with spatial filtering and gives you practice using ER Mapper’s Filter options. 

Note: For information on frequency domain filtering (Fourier Transforms), see the 
ER Mapper User Guide.

About spatial filtering
Spatial filtering is a common operation applied to raster image data to enhance or 
suppress spatial detail to improve visual interpretation. Common examples include 
applying filters to enhance edge detail in images, or to remove or decrease noise 
patterns in an image. Spatial filtering is called a “local operation” in image 
processing because it modifies the value of each pixel in the image according to the 
values of the pixels surrounding it. Filters work by removing certain spectral or 
spatial frequencies to enhance features in the remaining image. 
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Spatial frequency 
A characteristic common to all types of raster data is spatial frequency, which 
defines the magnitude of changes in data values per unit distance for any particular 
part of an image. Areas of an image with small changes or gradual transitions in 
data values over a given area are termed low frequency areas (such as a smooth lake 
surface). Areas with large changes or rapid transitions are termed high frequency 
areas (such as an urban area with dense road networks). Spatial filters can be 
divided into three broad categories: 

• Low pass filters emphasize low frequency detail to smooth out image noise or 
reduce spikes in the data. Since they de-emphasize detail in an image, low pass 
filters are sometimes called smoothing or averaging filters.

• High pass filters emphasize high frequency detail to enhance or sharpen linear 
features like roads, faults, and land/water boundaries. High pass filters are 
sometimes called sharpening filters because they are generally used to enhance 
detail without affecting low frequency portions of the image.

• Edge detection filters emphasize edges surrounding objects or features in an image 
to make them easier to analyze. Edge detection filters usually create an image with 
a grey background and black and white lines surrounding the edges of objects and 
features in the image.

How convolution kernels work 
Spatial filtering is accomplished by passing a two-dimensional rectangular array 
(or window) containing weighting values over the image data at each pixel location. 
The pixel in the center of the window is evaluated according to the surrounding 
pixels and weighting values defined for each cell in the array, then a new output 
pixel value is calculated. The window then shifts over to the next pixel and 
performs the same operation. This process of evaluating the weighted neighboring 
pixel values is called two-dimensional convolution, and the filter array is often 
called a convolution kernel.

The Filter Editor buttons 
By default, each raster layer in ER Mapper has two Filter editor buttons in the 
algorithm process stream. One applies a filter before a formula (pre- formula), and 
the other applies a filter after a formula (post-formula). You can also insert and 
append additional filters in either location to create more complex filtering 
operations. 

pre-formula
filter

post-formula
filter
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The Filter editor dialog box
To add a filter into the process stream, or create a new filter, click on the desired 
Filter button to open the Filter dialog box. ER Mapper provides a wide variety of 
standard spatial filters, including low and high pass filters, directional edge 
enhancement filters, and special filters for classification smoothing and for 
geophysical and seismic data. 

ER Mapper also lets you use filters that are written in C, and provides several C 
filters as examples. Using C allows you implement more complex or specialized 
filtering techniques that are not possible with simple convolution kernels. There is 
no limit to the dimensions of filters that can be defined and used in ER Mapper.

Hands-on exercises
These exercises give you practice applying filters in ER Mapper, and explain how 
to insert and delete filters in the process stream using the Filter buttons. You will try 
various types of filters to evaluate their results. 

• Insert and delete filters in the process stream diagram

• Apply different types of filters to see their results

• Edit the transform to enhance the contrast of filtered images

• Use filters to generate slope and aspect images from DEMs

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

click to view
previous or next
filter in current
layer

load and save
filters

add or delete
filters in layer

click to view
filters in other
layers

array of filter
weight values
(can be edited)
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• Apply filters in multiple raster layers

• Use multiple filters in the process stream

1: Adding filters to images

Open and display an existing algorithm

1 Click the Open  button on the Standard toolbar. 

An image window and the Open file chooser appear.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Data_Types’.

4 In the directory ‘SPOT_Panchromatic’, load the algorithm ’Greyscale.alg’.

ER Mapper displays a SPOT Panchromatic satellite image of the San Diego, 
California area in greyscale.

5 Drag the image window by its lower-right corner to make it about 50% 
larger.

6 Right-click on the image and select Zoom to All Datasets from the Quick 
Zoom menu.

ER Mapper redraws the image to fill the larger window size.

Apply a low pass (smoothing) filter to the image

1 Click on the Edit Filter (Kernel)  toolbar button on the main menu. 

The Filter dialog box appears. This dialog allows you to load standard filters 
supplied with ER Mapper, and create and save your own filters.

2 From the File menu, select Load.... 

The Load filter file chooser dialog box appears.

3 From the Directories menu, select the path ending with the text \kernel.

4 Double-click on the ‘filters_lowpass’ directory to open it.

Before you 
begin...

Make sure all image ER Mapper image windows and dialog boxes are closed. 
Only the main ER Mapper menu should be open.

Objectives Learn to apply several types of standard filters to an image, and adjust the 
contrast of filtered data.
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5 Double-click on the filter ’avg3.ker’ to load it.

The filter settings are displayed in the dialog box fields. The array (or matrix) of 
nine weighting values defining the 3 by 3 filter appear in the central scroll window 
(the “filter matrix window”).

The low pass filter creates a blurring or averaging effect. In general, low pass filters 
work by taking the average value of all pixels in the matrix and assigning it to the 
center pixel, thus smoothing out jumps or spikes in the data. Low pass filters can be 
useful for reducing periodic “salt and pepper” noise or speckling in an image to 
make it easier to interpret the major features.

Tip: The filter array window contains editable fields, so you can easily experiment and 
create your own filters with custom weighting coefficients and parameters and save 
them for later use.

Delete the low pass filter from the process stream
1 From the Edit menu (on the Filter dialog), select Delete this filter. 

The filter is deleted from the process stream and the image is rendered without the 
averaging filter, so it appears as it did before.

Apply a high pass (sharpening) filter to the image
1 From the File menu (on the Filter dialog), select Load.... 

2 From the Directories menu, select the path ending with the text \kernel.

3 Double-click on the ‘filters_high_pass’ directory to open it.

4 Double-click on the filter ’Sharpen2.ker’ to load it.

ER Mapper processes the algorithm to now include your high pass filter.

The filter settings are displayed in the dialog box fields. The array of nine 
weighting values defining the 3 by 3 filter appear in the filter matrix window.

The Sharpen2 filter enhances high frequency detail. In general, high pass or 
sharpening filters tend to increase the local contrast around edge features in the 
image, so the image appears sharper or crisper. Features like major roads and 
borders between urban and vegetated areas are therefore more clearly defined. 

Delete the high pass filter from the process stream
1 From the Edit menu (on the Filter dialog), select Delete this filter. 

The image is rendered without the sharpening filter, so it appears as it did before.
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Apply a directional gradient edge detection filter
1 From the File menu (on the Filter dialog), select Load.... 

2 From the Directories menu, select the path ending with the text \kernel.

3 Double-click on the ‘filters_sunangle’ directory to open it.

4 Double-click on the filter ’North_West.ker’ to load it.

ER Mapper processes the algorithm to now include your edge detection filter.

The filter settings are displayed in the dialog box fields.

The North_West filter is a non-linear filter designed to isolate and “raise” edge 
features in an image trending in a northeast to southwest direction. The data range 
produced by this filter is different from the previous image, so you need to adjust 
the transform to improve the contrast.

Adjust the contrast of the filtered image

1 Click the Edit Transform Limits  button on the Common Functions 
toolbar to open the Transform dialog box.

Note the Actual Input Limits are about -500 to +500. This is the new data range 
created by applying the edge detection filter to the original SPOT Pan image.

2 On the Transform dialog, select Limits to Actual from the Limits menu. 

The X axis limits change to match the Actual Input Limits.

The image contrast is enhanced and most pixels are assigned a mid-grey color in 
the greyscale lookup table.

3 Click the Create autoclip transform  button. 

ER Mapper redisplays the image with enhanced contrast. Edge features such as 
roads and land/water borders are highlighted in black and white, while features 
without sharp changes (such as ocean) are shown in grey.

This filter highlights edge features in an image as if a sun were shining from the 
northwest (upper-left) of the image. Therefore, edge features facing northwest are 
highlighted in bright, while opposite (southeast) facing edge features are dark. 
Edge enhancement filters are often used in geological applications to highlight 
faults and lineaments occurring in a specific compass direction.
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Note: As shown here, applying filters to your data often produces a different data range 
which initially creates a low contrast image. You will commonly need to adjust the 
transforms for each layer after applying a filter. (The first two filters you applied 
did not significantly change the original data range, so a contrast adjustment was 
not necessary in those cases.)

Apply a Northeast gradient edge detection filter
1 From the File menu (on the Filter dialog), select Load.... 

2 From the Directories menu, select the path ending with the text \kernel.

3 Double-click on the ‘filters_sunangle’ directory to open it.

4 Double-click on the filter ’North_East.ker’ to load it.

This time edge features facing northeast are highlighted in white (features trending 
in a northwest to southeast direction). Since the data range produced by applying 
the North_East filter is similar to that produced by the North_West filter, you do not 
need to adjust the contrast.

5 Click the Close button on the Filter and Transform dialogs to close them. 

2: Generating slope and aspect images

Open a greyscale DEM algorithm

1 On the main menu, click the Open  button. 

2 From the Directories menu (on the Open dialog), select the \examples 
path.

3 Open the ‘Data_Types’ directory, then open the ‘Digital_Elevation’ directory.

4 Double-click on the ‘Greyscale.alg’ algorithm to open it.

ER Mapper displays a digital elevation model (DEM) image on the San Diego, 
California area. The image is displayed with a greyscale color table, so low 
elevations are dark and high elevations are light.

Objectives Learn to add filters to generate slope and aspect images from a digital elevation 
model (DEM) image.
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Load a filter to generate a slope degrees image

1 Click on the Edit Filter (Kernel)  toolbar button on the main menu. 

2 On the Filter dialog, click the  button next to ‘Filter filename.’

3 From the Directories menu, select the \kernel path.

4 Open the ‘filters_DEM’ directory, then double-click on the filter 
’slope_degrees.ker’ to load it.

The filter settings are displayed in the dialog box fields. As indicated, this 3 by 3 
filter is written in C code.

5 Click the 99% Contrast enhancement  button.

After some internal calculations, ER Mapper displays an image showing steep 
slopes in light greys, and shallow slopes in dark greys. (The Refresh Image with 
99% clip on limits button automatically sets the appropriate transform limits for 
you.)

Slope is a measure of steepness of terrain, or the rate of change in elevation in the 
vicinity of a given part of the topographic surface. This slope filter generates data 
values in degrees from the horizontal, so the slope values range from 0 (flat terrain) 
to 90 degrees (vertical terrain). (ER Mapper also provides a filter to calculate slopes 
in percent named ‘slope_percent.ker.’)

Note: Since few geographic areas will have very steep slopes, the output data range will 
usually not occupy the entire possible data range of slope values. (In the previous 
example, the steepest slope was 71 degrees but 90 is possible.) If you want to force 
the color scale to be mapped to the entire possible range of slope values, you can 
manually set the transform X axis limits to 0-90 for the ‘slope_degrees’ filter and 0-
200 for ‘slope’ (percent) filter.

Load a different filter to generate an aspect image

1 On the Filter dialog, click the  button next to ‘Filter filename.’

2 Double-click on the filter ’aspect.ker’ to load it.

The filter settings are displayed in the dialog box fields. As indicated, this 3 by 3 
filter is also written in C code.

3 Click Close on the Filter dialog.

4 Click the 99% Contrast enhancement  button.
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ER Mapper displays an image showing different aspects of the elevation data in 
various shades of grey.

Aspect is a measure of the compass direction a topographic surface faces at a given 
point. Aspect is computed as a horizontal angle in degrees of azimuth from due 
north (which is zero degrees). The aspect filter generates aspect values ranging 
from 0 to 360 degrees (a value of 361 degrees is also generated for a flat surface 
with no aspect). East-facing slopes have an aspect of 90 degrees, south facing 
slopes 180 degrees, and west-facing slopes 270 degrees.

Change the color table to ‘azimuth’
1 On the Algorithm dialog, select the Surface tab.

2 From the ‘Color Table’ list, select azimuth.

The image redisplays in four main colors–one for each primary compass direction. 
Areas facing primarily north display in black, easterly in yellow, southerly in white, 
and westerly in blue.

Note: ‘Azimuth’ is a special “wrap around” color table that has the same color (black) at 
the top and bottom end of the color range. This type of color table is often used to 
display aspect images. (To see the color set, open the Transform dialog.) You can 
use any other multiple color lookup table as well to display aspect images.

3 On the Algorithm dialog, select the Layer tab again to display the process 
diagram.

3: Adding filters to multiple layers

Open and display an existing RGB algorithm

1 Click the Open  button on the Standard toolbar. 

The Open file chooser appears.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Data_Types’.

Objectives Learn to load a filter into several layers of data, for example to apply a filtering 
operation to the Red Green Blue layers of an RGB algorithm. Also learn to move 
between algorithm layers using buttons on the Filter dialog box.
Comprehensive ER Mapper Training Workbook  156



Chapter 9 Using spatial filters ●  3: Adding filters to multiple layers
4 In the directory named ‘SPOT_XS,’ load the algorithm 
’SPOT_XS_rgb_321.alg.’

ER Mapper displays a SPOT XS satellite image of the San Diego, California area 
as an RGB color composite of bands 3, 2 and 1.

Open the Algorithm window and Filter dialog box

1 Click on the Edit Algorithm  toolbar button. 

The Algorithm window appears. Notice that both the pre- and post-formula Filter 
buttons show a cross or “X” through the icon. This indicates that there is currently 
no filter loaded in the process stream.

2 On the Algorithm window, click on the post-formula Edit Filter (Kernel) 

 button in the process stream diagram. (There are two, click on the one 
right of the Formula button.)

The Filter dialog appears. 

Note that the Filter dialog has R, G and B buttons–these allow you to move 
between the Red, Green and Blue layers of the algorithm.

Apply a high pass filter to all three layers in the algorithm

1 In the Filter dialog, click on the Move to next Red layer in surface  
button. 

ER Mapper automatically selects the Red layer in the Algorithm window. (It may 
have been selected by default already.)

2 On the Filter dialog, click the Filter filename  chooser button to open 
the Load filter file chooser.

3 From the Directories menu, select the path ending with the text \kernel.

4 Double-click on the ‘filters_high_pass’ directory to open it.

5 Click once on the filter ’Sharpen2.ker’ to select it (do not double-click).

6 Click the Apply button.

ER Mapper loads the filter into the process stream of the Red layer.

7 In the Filter dialog, click on the Move to next Green layer in surface  
button. 

ER Mapper automatically selects the Green layer in the Algorithm window.
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8 In the Load filter file chooser, click the Apply button again (the Sharpen2 
filter is still selected).

ER Mapper loads the filter into the process stream of the Green layer.

9 In the Filter dialog, click on the Move to next Blue layer in surface  
button. 

ER Mapper automatically selects the Blue layer in the Algorithm window.

10 In the Load filter file chooser, click the OK button.

ER Mapper loads the filter into the process stream of the Blue layer, and closes the 
Load filter dialog.

11 ER Mapper processes the algorithm, which now includes your high pass 
sharpening filter in all three layers.

The high pass filter enhances high frequency detail to make the image appear 
sharper or crisper. This is the same effect you achieved earlier with a single layer of 
data, but this time you applied the filter to each layer of a color composite image.

4: Using multiple sequential filters

The following exercise assumes that the Algorithm window and Filter dialog box 
are still open on the screen.

Display a greyscale image

1 Click the Open  button on the Standard toolbar. 

The Open  file chooser appears.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the ‘Data_Types’ directory to select it.

4 In the directory named ‘SPOT_Panchromatic’, load the algorithm 
’Greyscale.alg.’

ER Mapper displays a SPOT Panchromatic satellite image of San Diego.

Objectives Learn how to insert and append multiple filters into the process stream to create a 
sequence of filters for more complex enhancements. Also learn to move between 
sequential filters in a layer using buttons on the Filter dialog box.
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Add a directional edge detection filter
1 On the Algorithm window, click on the post-formula Edit Filter (Kernel) 

 button in the process stream diagram. 

The Filter dialog opens. 

2 On the Filter dialog, click the Filter filename  chooser button to open 
the Load filter file chooser.

3 From the Directories menu, select the path ending with the text \kernel.

4 Double-click on the ‘filters_sunangle’ directory to open it.

5 Double-click on the filter ’North_West.ker’ to load it.

Append a high pass filter after the edge detection filter
1 From the Edit menu (on the Filter dialog), select Append new filter.

A second filter button is added to the process stream diagram on the Algorithm 
window (it is appended after the first one). Its contents, currently empty, are shown 
in the Filter dialog. 

2 From the File menu (on the Filter dialog), select Load... to open the Load 
filter file chooser.

3 From the Directories menu, select the path ending with the text \kernel.

4 Double-click on the ‘filters_high_pass’ directory to open it.

5 Double-click on the filter ’Sharpen2.ker’ to load it.

The filter settings are displayed in the dialog box fields. You now have two filters 
loaded into the process stream.

Adjust the contrast of the filtered image
1 ER Mapper processes the algorithm and generates a histogram of the 

filtered data.

2 Click the Edit Transform Limits  button on the process diagram in the 
Algorithm window.

3 On the Transform dialog, select Limits to Actual from the Limits menu. 

The X axis limits change to match the Actual Input Limits.

The image contrast is enhanced and most pixels are assigned a mid-grey color.

4 Click the Create autoclip transform  button. 
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ER Mapper redisplays the image with enhanced contrast. This image is the result of 
applying two filters–first a northwest filter to highlight northeast-southwest 
trending edge features, then a high pass filter to sharpen the high frequency detail 
around the edges. Note that you did not need to adjust the transform individually 
for each filter–you can adjust it once to account for the effects of both filters.

5 Click Close on the Transform dialog to close it.

Move between filters in the process stream
On the Filters dialog, note the two arrow buttons near the lower-right corner. 
These buttons let you easily move to view or edit the contents of any filter in the 
current raster data layer. 

1 On the Filters dialog, click the Move to previous Filter in layer  button 
until it becomes dimmed. 

The pre-formula Filter button in the process stream diagram is now slightly 
depressed to indicate that it is being edited. Since no filter is loaded in that position, 
the contents of the Filter dialog are empty. (The button becomes dimmed when 
there are no more filters previous to the current one.)

Note: By default, the process stream diagram usually shows both a pre-formula and a 
post-formula filter button, even if no filters are being used in that layer. These 
buttons act as placeholders, and you cannot delete these from the process diagram.

2 Click the Move to next Filter in layer  button. 

The contents of next filter button are displayed in the Filter dialog (the North_West 
edge filter), and the first of the two post-formula Filter buttons is depressed on the 
Algorithm window. 

3 Click the Move to next Filter in layer  button again. 

The contents of last filter in the process stream are displayed (the Sharpen2 filter), 
and the last of the two post-formula Filter buttons is depressed on the Algorithm 
window. 

Delete the sharpening filter from the process stream
1 From the Edit menu (on the Filters dialog), select Delete this filter. 
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The high pass sharpening filter is deleted from the process stream. Notice that 
ER Mapper automatically moves to the previous filter in the process stream, so the 
contents of the Filter dialog now show the North_West edge filter and that button 
is depressed in the process stream diagram.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Insert and delete filters in the process stream diagram

• Apply different types of filters to see their results

• Edit the transform to enhance the contrast of filtered images

• Apply filters in multiple raster layers

• Use multiple filters in the process stream

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Using Formulas
This chapter explains how to use formula processing in ER Mapper to perform 
mathematical operations on one or more bands of image data. You learn how to 
create and edit formulas, and use the standard formulas and functions provided in 
ER Mapper.

About formula processing
Formulas are commonly used in image processing to extract information that may 
reside in two or more bands (or channels) or data. Formula processing can range 
from simple subtraction or thresholding of data to complex “if-then-else” condition 
testing for raster spatial modelling and other tasks. 

Formula processing is a “point operation” in image processing because it applies a 
mathematical function to each pixel in the image. Common uses of formulas in 
earth science image processing include:

• reducing the dimensionality of multi-band data (for example, Principal Components 
Analysis);

• extraction of thematic information from multi-band data (for example, vegetation 
indices or iron oxide ratios);

• merging images with different characteristics (data fusion);

• processing the same data in different ways and combining them to isolate specific 
features (such as edge features or seismic azimuth);

• isolating specific data ranges or geographic areas of interest using thresholding, 
region (polygon) masking, and other functions;
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• corrections for atmospheric effects, sun angle, or vignetting on optical satellite or 
airborne data.

Formula processing in ER Mapper
Many common types of data transformations can be implemented in ER Mapper 
using formula processing. These include data thresholding, data merging (or 
fusion), image differencing and ratioing, Principal Components Analysis, Tasseled 
Cap transforms, derivatives, and many others. 

Since formulas are part of the algorithm processing stream, you can see the results 
in real time, and interactively modify the formula to quickly fine tune it. In contrast, 
conventional products must usually write formula processing results to a file on 
disk, making experimentation and fine tuning far more difficult.

ER Mapper provides a complete set of standard operators and functions you can 
reference in formula processing. You can also use image statistics, special 
functions, and functions defined with your own C user code. See the relevant 
sections and chapters in the ER Mapper User Guide for complete information.

The Formula dialog box
When you click on the Formula button in the process stream diagram or on the Edit 
Formula toolbar button, ER Mapper opens the Formula Editor dialog box. This 
dialog lets you create, edit, load, and save formulas, and it has the following 
components:

Generic formula
(type in text or

Relations area
(assign inputs to
bands, regions
to names, etc.)

Specific formula
(shows complete
formula to be
processed)

click to view
formulas for
other layers

load and save
formulas

reset formula or
change dialog
design

click to view
comments

menu bar to load
standard formulas

load from file)
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Tip: For any algorithm, you can open the Formula Editor dialog box from two places: 
using the Formula buttons in the process stream diagram on the Algorithm 
window, or using the Edit Formula toolbar button.

The formula relations concept
The key concept of relations is a very powerful feature that makes ER Mapper’s 
formula processing very flexible and interactive. When you enter or load a generic 
formula, you may include one or more generic specifications that refer to any 
arbitrary image band, region polygon, image, or variable. You then use the 
Relations window to choose relations between actual image band numbers, region 
names, etc. and the generic specifications in the formula. The actual assignment of 
references to image bands, region names, and so on is then shown in the Specific 
formula window. 

There are four types of generic specifications:

Formula inputs are also shown graphically in the process stream diagram. For 
example, the following process stream shows that two inputs are being used in the 
formula, and that they are assigned to image bands 3 and 2 respectively. As 
indicated, each band can be modified using filters and transforms before being 
piped through the formula processing. 

Reference Notation in generic formula Function

Input 
specifications

INPUTn, In (or lowercase) References any band in 
an image.

Region 
specifications

REGIONn, Rn (or lowercase) References any region 
polygon defined for a 
raster image.

Dataset 
specifications

DATASETn, Dn (or lowercase) References any raster 
image (an actual disk file 
with “.ers” extension).

Variable 
specifications

VARIABLEn, or any text not 
reserved for ER Mapper 
functions (for example “density” 
or “threshold”)

References any real 
number or value to be 
used as an equation 
variable.
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To select the specific bands to be used in a formula, you can either use the Band 
Selection drop-down list in the process stream diagram, or select bands inside the 
Relations window of the Formula dialog box.

Hands-on exercises
These exercises introduce you to the basic features of the Formula editing dialog 
box and procedures for creating and implementing simple formulas.

• Type and edit a formula, and test formula syntax

• Use generic references for inputs, variables, and regions in a formula

• Assign image bands, variables, and region names to generic references

• Save formulas to disk and enter comments

• Use formulas to process areas of interest (regions) in an image

• Use formulas to generate Principal Component images

1: Entering and testing a formula

Load a Pseudocolor algorithm with the default formula

1 Click the Edit Algorithm  toolbar button.

An image window and the Algorithm dialog box appear.

2 Click the Open  toolbar button. 

3 From the Directories menu, select the path ending with the text \examples

4 Double-click on the directory named ‘Applications’.

5 Double-click on the directory named ‘Mineral_Exploration’.

6 Double-click on the algorithm named ‘Magnetics_Pseudocolor.’

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how to enter simple formulas and test formula syntax.
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The algorithm displays an image of airborne magnetics data acquired in Australia. 
The data represents the strength of the magnetic field on this area of the earth's 
surface. Using the Pseudocolor lookup table, blues correspond to lower field 
strengths and yellows and reds to higher field strengths.

Enter a simple formula and test for syntax errors

1 Click on the Edit Formula  button in the process stream diagram. 

The Formula Editor dialog box opens.

Note that the generic formula window contains the text “I1” by default, and that I1 
(Input 1) is assigned to image dataset band 1 in the Relations window.

2 In the Generic formula window, edit the formula text to read:

input1 - input3

(This formula purposely has a syntax error to illustrate how to test for them.)

3 Click the Apply changes button to test the formula.

ER Mapper issues an error message warning that the formula has a syntax error. (In 
this case you tried to subtract an input number that was out of sequence; you must 
also have an “input2” before using an “input3.” 

Note: The Apply changes button automatically tests for syntax errors in the Generic 
formula. You must make any corrections before continuing.

Revise the formula to subtract a value
1 In the Generic formula window, edit the formula text to read:

input1 - 100

(This subtracts 100 from each pixel in the image band assigned to input1.)

2 Click the Apply changes button to test the formula.

The formula syntax is approved, and ER Mapper translates the generic formula into 
a specific formula (displayed in the lower window).

Delete the formula and test the syntax
1 In the Generic formula window, edit the formula to remove all text (select the 

existing text and press the Backspace or Delete key on your keyboard).

2 Click the Apply changes button to test the formula.
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ER Mapper issues an error message regarding the formula syntax.

Caution: ER Mapper considers no formula at all an error in syntax. At a 
minimum, the Generic formula window must always contain the text “I1” or 
“input1” to specify at least one input image band to be processed.

3 In the Generic formula window, edit the formula text to read:

input1

4 Click the Apply changes button to test the formula.

ER Mapper accepts the formula.

Tip: Under the Formula Editor’s Edit menu, you can select Clear to clear all text 
from the Generic formula window, or select Default the restore the default formula 
‘INPUT1.’

2: Creating a threshold formula

Enter a simple threshold formula
1 In the Generic formula window, edit the formula text to read:

if input1 > 100 then input1 else null

This formula tells ER Mapper “if the image value is greater than 100, then process 
it, else assign it a value of null.” (Any image pixel assigned a value of null is 
excluded from further processing and does not appear in the final image.)

2 Click the Apply changes button.

The formula syntax is approved, and ER Mapper translates the generic formula into 
a specific formula. Notice that band 1 of the image is substituted for both 
occurrences of “input1” in the generic formula window.

3 ER Mapper processes the algorithm, which now includes your threshold 
formula.

Objectives Learn how to enter a simple threshold formula and use boolean “if-then-else” 
logic in a formula. Also learn about null image values, and how to use a variable 
in a formula.
Comprehensive ER Mapper Training Workbook 167



Chapter 10 Using Formulas ●  2: Creating a threshold formula
Areas of the image with data values greater than 100 are displayed in color, while 
data values 0-100 display with no color (they appear black).

Process the formula and see how it affects the data range

1 Click on the post-formula Edit Transform Limits  button in the process 
stream diagram.

The Transform dialog box opens. Drag it to an open part of the screen.

Note that the Actual Input Data range is 101 to 255. This is expected since data 
values 0-100 are set to null (no value) by the formula and are thus excluded from 
further processing. The shape of the histogram also reflects the clipping of the data 
at the 100 level.

Substitute a variable for the value 100
1 In the Generic formula window, edit the formula text to substitute the word 

“variable1” for the value 100. Your formula should read:

if input1 > variable1 then input1 else null

Your formula now includes a variable that you can set in the Relations window.

2 Click the Apply changes button.

Two things change: the Variables button above the Relations window becomes 
active, and the value of “variable1” becomes zero in the Specific formula window.

3 Click the Variables button.

The Relations window shows that the value of “variable1” is set to zero.

4 Edit the value of “variable1” field to read 120 then press the Return or Enter 
key on your keyboard.

This time only areas with data values greater than 120 are processed.

5 Change the value of “variable1” to 80, press Return or Enter to view the 
new threshold image.

As you can see, using references to variables in your formula (instead of actual 
values) can speed experimentation.

Tip: You can have several different variables in a formula, and name them nearly 
anything (for example threshold, width, X, y, are all valid). Be sure the names do 
not conflict with text strings ER Mapper uses for standard functions.
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6 When finished, close the Transform, Formula Editor, and Algorithm 
dialog boxes by clicking Close on each one.

3: Creating and saving a formula

Open a template greyscale algorithm and load a new image

1 On the main menu, click the Open  button. 

2 From the Directories menu, select the path ending with \examples.

3 Double-click on the directory named ‘Miscellaneous’.

4 Double-click on the directory named ‘Templates’.

5 In the ‘Common’ directory, load the algorithm ‘Single_Band_Greyscale.alg.’ 

A Landsat satellite image of San Diego displays in greyscale. (You will use this 
algorithm as a template to display another image in greyscale.)

6 Click the Edit Algorithm  toolbar button to open the Algorithm window.

7 In the process stream diagram on the Algorithm window, click on the Load 

Dataset  button.

8 From the Directories menu, select the path ending with \examples.

9 Double-click on the directory named ‘Shared_Data’.

10 Load the image ‘LandsatTM.ers.’

Band 1 of a Landsat TM satellite image shows an area named Ebagoola in 
northeastern Australia displays. (You will adjust the image contrast to brighten it 
later.)

Enter a generic band ratio formula 

1 Click on the Edit Formula  button in the process stream diagram. 

The Formula dialog box opens and shows the default formula “INPUT1.”

2 In the Generic formula window, edit the formula text to read:

input1 / input2

Objectives Learn how to enter a band ratio formula, change the image bands assigned to 
input numbers in the generic formula, and save the formula to disk for later use.
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This formula tells ER Mapper to divide the image band assigned to input1 by the 
band assigned to input 2.

3 Click the Apply changes button.

When you enter a new multiple input formula, ER Mapper automatically assigns 
image band 1 to input 1, band 2 to input 2, and so on.

Assign image bands to create a vegetation index image
1 In the Relations window, select B4:0.83_um from the drop-down list next to 

“INPUT1,” and select B3:0.66_um from the “INPUT2” drop-down.

The generic reference “input1” is now assigned image band 4, and “input2” is 
assigned to band 3. When used with Landsat TM images, the 4/3 band ratio is a 
simple vegetation index formula.

The image initially appears black because of the small data range created by the 
band ratio formula. 

Display the vegetation index image and adjust the contrast 

1 Click the post-formula Edit Transform Limits  button in the process 
diagram.

Note the Actual Input Limits created by the formula (about zero to 5).

2 On the Transform dialog, select Limits to Actual from the Limits menu. 

Your enhanced vegetation index image shows vegetated areas (higher ratio values) 
in light grey, and non-vegetated areas in darker shades. This band combination 
takes advantage of high vegetation reflectance in TM band 4 (near infrared light) 
and low vegetation reflectance in band 3 (red light). This is a rather barren part of 
Australia, so vegetation (shown as light grey shades) occurs mainly in the stream 
beds as shown in the image.

Change the bands to create a clay minerals image
1 In the Relations window, select B5:1.65_um for “INPUT1” and select 

B7:2.215_um for “INPUT2.”

Using the same Generic formula, you have now chosen the appropriate TM band 
ratio (5/7) to create a simple clay minerals image. 

2 ER Mapper processes the algorithm, this time using bands 5 and 7. 

3 On the Transform dialog, select Limits to Actual from the Limits menu. 

4 On the Transform dialog, click the Create autoclip transform  button.
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Your contrast enhanced clay ratio image shows clay-rich rocks (higher ratio values) 
in light shades of grey, and clay-poor rocks in darker shades. This band 
combination takes advantage of strong absorption by clay minerals in TM band 7 
and high reflectance in TM band 5.

5 Close the Transform dialog box by clicking Close.

Add a description and comments for your formula
1 In the Formula Editor dialog, edit the “Description” text field to read:

Landsat TM clay minerals ratio

2 Click the Comments... button.

The Formula comments dialog box appears.

3 Type some comments about your formula, such as:

4 Click the OK button to save your comments and close the dialog.

Save the clay minerals ratio formula to disk
1 From the File menu (on the Formula Editor), select Save As....

2 Go to the directory named ‘Miscellaneous\Tutorial’ and double click on it to 
open it. 

3 Click to place the cursor in the Save As: text field, then type in a name for 
the formula file. Use your initials at the beginning of the file name, followed 
by the text ‘clay_ratio,’ and separate each word with an underscore (_). For 
example, if your initials are “RK,” type in the name:

RK_clay_ratio

4 Click the OK button to save your formula to a disk file.

Note: Since bands 5 and 7 of the image were chosen as inputs 1 and 2 when you saved the 
formula, they would be assigned as the default bands if you load the formula in the 
future. As shown, you can easily change the band assignments.

5 Click the Close button to close the Formula Editor dialog.

This formula is designed to process bands 5 and 7
of Landsat TM data to highlight clay-rich rocks.
It is based on strong absorption by clay minerals in
TM 7 and high reflectance in TM 5. Clay-rich rocks
produce high ratio values, clay poor rocks low values.
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4: Creating a polygon mask formula

Note: This exercise references regions in the sample image which have already been 
defined using ER Mapper's vector drawing tools. More information on defining 
regions is contained in the chapter on Supervised Classification later in this manual 
and in the chapters on Supervised and Unsupervise Classification in the 
ER Mapper User Guide.

Load the SPOT Panchromatic greyscale algorithm

1 On the main menu, click the Open  button. 

2 From the Directories menu, select the path ending with \examples.

3 Double-click on the directory named ‘Data_Types’.

4 In the ‘Landsat_TM’ directory, load the algorithm ‘Greyscale.alg.’ 

A Landsat TM satellite image of San Diego displays in greyscale.

5 From the View menu (on the main menu), select Quick Zoom, then select 
Zoom In.

ER Mapper zooms in 50% on the center point of the image.

Enter a formula using the “inregion” function

1 In the Algorithms window, click the Edit Formula  button. 

2 In the Generic formula window, edit the formula text to read:

if inregion(region1) then input1 else null

This formula tells ER Mapper “if the area of the image is within the boundaries 
defined by region1, then process it, else assign it null.”

3 Click the Apply changes button to verify the formula syntax.

The generic formula is converted to a specific formula. Also notice that the 
Regions button above the Relation window is now active.

Objectives Learn how to use ER Mapper’s “inregion” function to reference areas defined as 
vector polygons in an image for masking purposes
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Assign the “region1” argument to a region name
1 Above the Relations window, click on the Regions button. 

The contents of the Relations window change to show the REGION1 argument and 
its default assignment to a region named All (which is simply the extents of the 
entire image.)

2 From the REGION1 drop-down list, select Down_Town.

You have now selected the Down_Town region to be assigned to generic region1. 
(This region is simply a vector polygon previously drawn to define the boundaries 
of the San Diego downtown area in this image.)

Only the area inside the region named Down_Town is processed, and all other 
areas of the image are assigned null values (so they appear black). By using the 
inregion function in your formula, you have created a “mask” to process only data 
within a certain geographic part of the image. 

Display a different region in the image
1 From the REGION1 drop-down list, select Airport.

You have now selected the Airport region to be assigned to generic region1. 
(Airport is a vector polygon previously drawn to define the boundaries of the San 
Diego Lindbergh Field airport near downtown.)

Only the area inside the region named Airport is processed, and all other areas of 
the image are assigned null values (so they appear black). By using the drop-down 
list, you can easily change this formula to process any region defined in an image.

5: Generating Principal Components

Load the Landsat TM greyscale algorithm

1 On the main menu, click the Open  button. 

2 From the Directories menu, select the path ending with \examples.

3 Double-click on the directory named ‘Data_Types’.

4 In the ‘Landsat_TM’ directory, load the algorithm ‘Greyscale.alg.’ 

A Landsat satellite image of San Diego displays in greyscale. You will add a 
formula to this algorithm to perform Principal Components Analysis. 

Objectives Learn how to use and modify a formula to interactively compute Principal 
Components images.
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Load a formula to calculate Principal Component 1

1 In the Algorithm window, click the Open Formula editor  button. 

The Formula Editor dialog will open.

2 From the Principal Components menu (on the Formula Editor dialog), 
select Landsat TM PC1. ER Mapper loads the following formula into the 
Generic formula window:

SIGMA(I1..I6 | I? * PC_COV(I1..I6 | ,R1 I?, 1))

This formula tells ER Mapper to generate Principal Component 1 (PC 1) from 
Landsat TM bands 1-5 and 7. It uses some of the special functions and constructs 
ER Mapper provides, including the “SIGMA” summation construct and the 
“PC_COV” covariance principal component (eigenvector) value.

Principal Components Analysis is a statistical from of data compression often used 
to compress the information content of multiple image bands into just two or three 
“principal component” images. In this case, you are generating the first principal 
component of TM bands 1-5 and 7 (band 6 is usually not used for PC calculations 
because it contains thermal information). 

Adjust the contrast of the PC 1 image

1 Click the post-formula Transform  button in the process diagram.

Note that the data range create by the PC1 formula is about 40 to 520.

2 On the Transform dialog, select Limits to Actual from the Limits menu.

3 Click the Create autoclip transform  button.

The image is rendered with enhanced contrast. The first principal component 
usually contains most of the overall scene brightness or albedo information, so it 
shows large scale terrain features well. 

Edit the formula to calculate Principal Component 2
1 In the Generic formula window, edit the formula to change the last value 

from 1 to 2 as shown below:

SIGMA(I1..I6 | I? * PC_COV(I1..I6 | ,R1 ,I?, 1))

change to 2
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This formula tells ER Mapper to generate Principal Component 2 (PC 2) from 
Landsat TM bands 1-5 and 7. (The I1..I6 part of the formula tells ER Mapper to 
include six inputs in the calculation which are currently assigned to bands 1, 2, 3, 4, 
5, and 7.)

2 Click the Apply changes button to verify the formula syntax.

3 On the Standard toolbar, click the 99% Contrast enhancement  

button.

ER Mapper applies a 99% clip to the data limits created by the PC 2 formula to 
automatically create a contrast enhanced image. The second principal component 
shows very different information than PC 1. Note how vegetated areas appear very 
dark in the PC 2 image, and ocean areas appear relatively light.

Tip: The 99% Contrast enhancement  toolbar button is especially useful for 

automatically contrast stretching images that produce narrow or negative data 
ranges (such as ratios, PCs, and others).

Edit the formula to calculate PC1 of bands 1, 4 and 7
1 In the Generic formula window, edit the formula to change values as shown 

below:

These changes tell ER Mapper to generate Principal Component 1 from only three 
image bands instead of six. (Next you will choose which three bands to use.)

2 Click the Apply changes button to verify the formula syntax.

3 In the Relations window, change the INPUT to image band assignments as 
follows:

INPUT1 = B1:0.485_um

INPUT2 = B4:0.83_um

INPUT3 = B7:2.215_um

This tells ER Mapper to use bands 1, 4 and 7 as inputs to the Principal Components 
formula.

4 Click the 99% Contrast enhancement  on the Standard toolbar.

SIGMA(I1..I6 | I? * PC_COV(I1..I6 | ,R1 ,I?, 2))

change to 3 change to 1
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The image looks similar to the PC 1 image you created earlier, but is generated 
using only bands 1, 4 and 7 of the Landsat TM image. 

This example creates a simple greyscale image, but you can easily use the same 
formulas in RGB algorithms to create color composites of PC images.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Type and edit a formula, and test formula syntax

• Use generic references for inputs, variables, and regions in a formula

• Assign image bands, variables, and region names to generic references

• Save formulas to disk and enter comments

• Use formulas to process areas of interest (regions) in an image

• Use formulas to generate Principal Component images

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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11

Geolinking
images

This lesson explains how to use ER Mapper’s geopositioning controls to display 
images with exact geographic extents, and use the Geolinking controls to 
geographically link two or more image windows. Geolinking is a powerful 
visualization technique that can help you analyze the same geographic area using a 
variety of different images or processing techniques.

About Geopositioning
In ER Mapper, the term “geopositioning” refers to specifying the position and 
extents of an image in geographic coordinate space. This can be useful for creating 
maps that cover an exact area, for example. Once an image is registered to a map 
projection, its display can be controlled using ER Mapper’s geopositioning options. 
If the image is not rectified to a map projection, its extents can be controlled in 
terms of the row and column numbers of the image pixels. 

About Geolinking
In ER Mapper, the term “geolinking” refers to linking two or more image windows 
in geographic coordinate space. This can be useful for viewing the same 
geographic area with different types of images or processing algorithms, and other 
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applications. Once an image is registered to a map projection, it can be 
geographically linked with other image windows using ER Mapper’s geolinking 
options. ER Mapper provides the following geolinking modes:

Window Link two or more image windows to show the same 
geographic extents. Zooming or panning in one window 
triggers the same operation in other linked windows.

Screen Link image windows to one “master” image that acts like 
a virtual map sheet on the screen. Linked windows 
display the geographic extents of their images relative to 
the master window.

Overview Zoom Link image windows to one “master” overview control 
window. Defining a zoom box on the control window 
causes the other windows to zoom to the defined area.

Overview Roam Link image windows to one “master” control window. 
Dragging the mouse to pan in the control window causes 
other windows to pan (or “roam”) so their center point 
matches the mouse position in the control window.

The Algorithm Geoposition Extents Dialog Box
The Algorithm Geoposition Extents dialog box lets you precisely control the 
geographic extents and display resolution of images, and geographically link 
(geolink) two or more image windows together. The options shown in this dialog 
change depending on the mode selected in the row of option buttons at the top. The 
five modes and their functions are as follows:

Zoom Lets you use buttons to zoom or pan the image in the 
window by predefined amounts, or zoom to the extents 
of specific images, page extents, or page contents.

Geolink Lets you set up geolinking between two or more image 
windows, and set the window size and display resolution 
of any image window.

Extents Lets you view or specify geographic display extents for 
an image using Latitude/Longitude, Eastings/Northings, 
or image X (column) and Y (row) values.

Center Lets you view or specify the center point for the image 
display using Latitude/Longitude, Eastings/Northings, or 
image X (column) and Y (row) values.

Mouse info Shows quick help for using the mouse and keyboard keys 
to zoom and pan.
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Hands-on exercises
These exercises introduce you to many of the basic features of the Algorithm 
Geoposition Extents dialog box and how to use them to control image display 
extents and set up geolinking between windows.

Note: The images used in the following exercises were previously rectified to the same 
datum and map projection. This is a requirement when different images are to 
linked in Window, Screen, Overview Zoom, or Overview Pan modes.

• Display images with exact geographic extents and display resolutions

• Link image windows to show the same geographic extents

• Link image windows to a virtual map sheet window

• Control interactive image zooming and panning functions from a master window

1: Geopositioning images

Change the window size preference
1 Select Preferences... from the Edit menu.

2 On the Preferences dialog, select the General tab.

3 Make sure that the Adjust window size to image aspect option box is not 
checked.

4 Click on the Close button to invoke the change and close the Preferences 
dialog

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how to use the Geoposition controls to display an exact geographic area of 
an image, specify an image center point, and change window sizes and display 
resolutions.
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Load and display a Landsat image in RGB

1 On the Standard toolbar, click on the Open  button. 

An image window and the Open dialog box appear.

2 In the Files of Type: field, select ‘ER Mapper Algorithm (.alg)’.

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Applications’.

5 In the directory named ‘Land_Information,’ load the algorithm named 
‘Landsat_TM_23Apr85_rgb_541.alg’

This algorithm displays a Landsat TM image covering a large portion of the San 
Diego, California area as an RGB color composite of bands 5, 4 and 1. The image 
shows an area about 40 by 55 kilometers in size. The country of Mexico is located 
at the extreme lower part of the image.

6 Make the image window larger by dragging its lower-right corner until it fills 
the left half of the screen.

Note that the image does not expand to fill the enlarged window.

Open the Algorithm Geoposition Extents Dialog Box
1 From the View menu, select Geoposition....

The Algorithm Geoposition Extents dialog box appears. If needed, drag the 
dialog to the right side of the screen.

Display an exact area by entering geographic values
1 In the upper row of option tabs on the Algorithm Geoposition Extents 

dialog, select the Extents option.

The contents of the dialog change to show a group of text fields for entering 
coordinate values.

2 Edit the value in the Latitude field under the Size column to read 0:20. 
(ER Mapper fills out the text string to a full value of 0:20.0.0.)

3 Edit the value in the Longitude field under the Size column to read 0:20 
also.

4 Click the Apply button to apply your new extents values.

ER Mapper reprocesses the algorithm with your new image extents and attempts to 
display an area 20 minutes of Latitude by 20 minutes of Longitude in the image 
window. You should notice that the size of the window remains the same, an areas 
not covered by the image have a cross-hatch pattern.
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5 Select the Zoom tab, and click on the All Datasets button.

The ER Mapper will re-display the whole image, but the image window size will 
not change.

6 Once again select Preferences from the Edit menu, and click on the 
General tab.

7 Check the Adjust window size to image aspect option box, and click on 
the Preferences dialog Close button.

8 Edit the value in the Latitude field under the Size column to read 0:20. 
(ER Mapper fills out the text string to a full value of 0:20.0.0.)

9 Edit the value in the Longitude field under the Size column to read 0:20 
also.

10 Click the Apply button to apply your new extents values.

ER Mapper reprocesses the algorithm with your new image extents and resizes the 
image window to display an area 20 minutes of Latitude by 20 minutes of 
Longitude. The Adjust window size to image aspect option resizes the image 
window so that the required image area fits exactly.

Display an exact part of the image by entering cell values
1 Edit the contents of the four fields as listed below to display an exact portion 

of the image using cell X (column) and cell Y (row) values:

Cell X/Top Left = 800

Cell Y/Top Left = 1200

Cell X/Bottom Right = 1300

Cell Y/Bottom Right = 1800

2 Click the Apply button to apply your new values.

ER Mapper reprocesses the algorithm with your new image extents and displays an 
area 500 pixels (cells) wide by 400 pixels in height. The origin (upper-left corner) 
is at cell column (X) 800 and cell row (Y) 1200.

Center the image on an exact point
1 In the upper row of option buttons, select the Center option.

The contents of the dialog change to show a group of text fields for entering the 
center point of the image in geographic or image X and Y values.

2 Edit the value in the Easting field to read 507000 then press the Return or 
Enter key to validate the change. (Select all the existing text and type the 
new value; ER Mapper adds the “E” for you when you validate.)
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3 Edit the value in the Northing field to read 3609500 then press Return or 
Enter to validate the change. 

4 Click the Apply button to apply your new center point values.

ER Mapper reprocesses the algorithm and centers the image on the location you 
defined (the lake that was previously in the upper-right of the image). Centering 
can be useful for viewing the exact center point of an image, or for focusing on an 
exact feature of interest in an image.

Set an exact image display resolution
1 In the upper row of option buttons, select the Geolink option.

The contents of the dialog change to show geolink option buttons and text fields for 
defining window size and display resolution.

2 Edit the Dataset cells per pixel field to read 1 (the value one). 

3 Click the Apply button to apply your new display resolution.

ER Mapper reprocesses the algorithm at a “one to one” display resolution, so that 
every image cell in this part of the image is represented by one pixel on the screen 
display. (Values greater than one cause subsampling of the image cell values, and 
less than one cause supersampling.)

Set an exact size for the image window
1 Edit the Width in pixels field to read 400 then press the Return or Enter 

key to validate the change. 

2 Edit the value in the Height in pixels field to read 500 then press Return 
or Enter. 

3 Click the Apply button to apply your new window size.

ER Mapper resizes the window to 400 by 500 pixels and redisplays the image.
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2: Linking windows to common extents

Open an RGB algorithm

1 On the Standard toolbar, click on the Open  button. 

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Data_Types’.

4 In the ‘Landsat_TM’ directory, load the algorithm named “RGB_341.alg.’

This algorithm displays Landsat TM (30 meter resolution) image of San Diego. 
Bands 3, 4 and 1 are displayed as an RGB color composite, so vegetated areas 
appear green and urban areas are pink or grey.

Open a second window and algorithm

1 On the Standard toolbar, click the New  button. 

A second image window opens on the screen. 

2 On the Standard toolbar, click on the Open  button. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Data_Types’.

5 In the ‘SPOT_Panchromatic’ directory, load the algorithm named 
“Greyscale.alg’

This algorithm displays a SPOT Panchromatic (10 meter resolution) image of the 
same area of San Diego.

Objectives Learn to link image windows in Geolink “Window” mode, so each linked 
window displays the same geographic extents.
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Resize and position the two windows
1 Resize and reposition the two windows as shown in the following diagram. 

(You must able to view the contents of each window clearly.)

You should now have two image windows of about the same size next to each other 
in the upper part of the screen, and Geoposition dialog below them.

Set the TM image window to Geolink Window mode
1 On the Algorithm Geoposition Extents dialog, select Geolink in the row 

of options at the top. (It may already be chosen.)

The contents of the dialog show ‘Geolink mode’ option buttons on the left side.

2 Click inside the Landsat TM image window to activate it (three stars *** 
should appear next to the title).

3 In the Algorithm Geoposition Extents dialog, select the Window option 
button.

4 Click the Apply button. 

The window title indicates that it is now set to “WINDOW” geolink mode.

Set the SPOT image window to Geolink Window mode
1 Click inside the SPOT Pan image window to activate it.

2 Select the Window option button.

3 Click the Apply button. 

The SPOT Pan window is now linked to the Landsat TM window since both are set 
to Geolink Window mode. Any changes you make to the extents of one window 
will be automatically duplicated in the other.

Landsat TM
window

SPOT Pan
window

Geoposition
dialog box
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Zoom and pan in both images

1 On the main menu, click the Zoom Tool  button on the Common 
Functions toolbar.

The mouse is now set to perform zoom and pan functions in image windows.

2 Click inside the Landsat TM image window to select it, and then drag the 
pointer down to magnify the central portion of the image.

The images in both windows automatically zoom to share the same extents.

3 Shift click inside the SPOT Pan image window to change the pointer to a 
hand. Drag the image to the left. 

Both images pan to the right.

4 On the Algorithm Geoposition Extents dialog, select Zoom in the row of 
options at the top. 

5 Under ‘Pan,’ click the Pan upper-left  button. 

Both images pan 50% to the upper-left (the previous center point is now on the 
lower-right corner of the image).

6 Under ‘Set extents to,’ click the Raster Datasets button. 

Both zoom out to their full extents (which are the same for both images).
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3: Linking windows to the screen

.Set both windows to Geolink None mode
1 On the Algorithm Geoposition Extents dialog, select Geolink in the row 

of options at the top. 

The contents of the dialog show Geolink mode option buttons on the left side.

2 Click inside the Landsat TM image window to activate it.

3 In the Algorithm Geoposition Extents dialog, select the None option 
button.

4 Click the Apply button. 

The words “WINDOW:geolink” disappear from the window title, indicating that 
the window is no longer geolinked.

5 Click inside the SPOT Pan image window to activate it.

6 In the Algorithm Geoposition Extents dialog, select the None option 
button.

7 Click the Apply button. 

Tip: Image windows can also be geolinked and unlinked using the View/Quick Zoom 
menu on the main ER Mapper menu bar.

Resize and position the two windows

1 On the main menu, click the Hand Tool  toolbar button.

The mouse is now set as a hand. (This prevents accidentally panning or zooming 
when you click inside a window to activate it.)

Objectives Learn to link image windows in Geolink “Screen” mode, so a “master” image 
window becomes a virtual map sheet on the screen. The screen assumes the 
coordinate space of the “master” image window, and other windows display the 
geographic extents of their images relative to the master window.
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2 Resize and reposition the two windows as shown in the following diagram. 
(You must be able to view the contents of each window clearly.)

You should now have a smaller SPOT Pan ‘Greyscale’ window partially overlaying 
a larger Landsat TM ‘RGB_341’ window, and the Algorithm Geoposition 
Extents dialog in the lower-right corner.

Set the TM image window to Geolink Screen mode
1 Click inside the large Landsat TM image window to activate it.

2 In the Algorithm Geoposition Extents dialog, select the Screen option 
button.

3 Click the Apply button. 

The window title indicates that it is now set to “SCREEN” geolink mode. This is 
the first window assigned to Screen mode, it becomes the “master” window and the 
entire screen assumes its coordinate space (shown clearly later).

Set the SPOT image window to Geolink Screen mode
1 Click inside the SPOT Pan image window to activate it.

2 Select the Screen option button.

3 Click the Apply button. 

The SPOT Pan window is now linked to the “master” window, and it automatically 
redraws to show its portion of the TM master “map sheet” window. 

Landsat TM
“map sheet”

window
SPOT Pan

window

Geoposition
dialog box
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Move the SPOT Pan window over the TM master window
1 Drag the SPOT Pan window by its title bar to the lower-left portion of the 

larger Landsat TM window

The SPOT Pan image automatically redraws to show its new extents in the context 
of the Landsat “map sheet” window. By comparing the two images, you can clearly 
see the difference in detail provided by the higher resolution SPOT Pan data (10 
meter) over the lower resolution (30 meter) Landsat TM data.

Tip: It helps to think of the larger “master” window as a paper map sheet. Any other 
windows moved on top of the map sheet act like a viewing port into a different 
image or processing technique over the same geographic area.

Zoom in on the SPOT Pan window

1 On the main menu, click the ZoomBox  toolbar button.

The mouse is again set to perform zoom functions in image windows.

2 Inside the SPOT Pan image window, drag a zoom box to magnify part of the 
image.

The images in both windows automatically zoom in the same amount.

3 On the Algorithm Geoposition Extents dialog, select Zoom in the row of 
options at the top. 

4 Under Pan, click the Pan right  button. 

Both images pan 50% to the right (the previous image center point is now on the 
left side of the both windows).

5 Under Zoom, click the Zoom out 50%  button. 

Both images zoom out 50% from their previous magnification level.

6 Experiment by moving or resizing the SPOT Pan window to view the SPOT 
Pan data over corresponding areas of the Landsat TM data.

Close one window and unlink the other
1 Close the SPOT Pan window using the window system controls:

• Select Close from the window control-menu.

2 From the View menu (on the main menu bar), select Quick Zoom, then 
select Set Geolink to None.
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4: Using Overview Zoom mode

Open an RGB algorithm

1 Click the Open  toolbar button. 

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory named ‘Applications’.

4 In the ‘Land_Information’ directory, load the algorithm named 
‘Landsat_TM_23Apr85_rgb_541.alg.’

This algorithm displays the Landsat TM image of the San Diego, California area 
you used earlier in this chapter.

Open a second window with the Landsat algorithm

1 Click the New  toolbar button. 

A second image window opens. Drag it to the upper-right part of the screen.

2 Click on the Open  button. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Applications’.

5 In the ‘Land_Information’ directory, load the algorithm named 
‘Landsat_TM_23Apr85_rgb_541.alg.’

This is the same Landsat algorithm already loaded in the other window. Drag the 
second window to the right of the first one.

Tip: The Copy Window  toolbar button lets you quickly create a copy of the 

current window and algorithm. This can be very helpful if you want to modify the 
processing technique and compare it to the original, or for geolinking as in this 
example.

Objectives Learn to link image windows in Geolink “Overview Zoom” mode, so you can 
define an area of interest on an overview window, and other linked windows 
automatically zoom to the defined area.
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Open a third window and SPOT Pan algorithm

1 On the Standard toolbar, click the New  button. 

A third image window opens. Drag it to the lower-right part of the screen.

2 Click on the Open  button. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Applications’.

5 In the ‘Land_Information’ directory, load the algorithm named 
‘SPOT_Pan.alg.’

This algorithm displays a SPOT Panchromatic (10 meter resolution) image of the 
same area of San Diego as the two Landsat TM windows.

Resize and position the two windows
1 Resize and reposition the three windows as shown in the following diagram. 

Make the Landsat window on the left larger and taller, and move the other 
two windows to its right (without resizing them).

You should now have the two smaller image windows next to the larger window, 
and Geoposition dialog below them. The two smaller windows will be used as 
“zoom” windows to examine areas in more detail.

Set the large Landsat TM window to Overview Zoom mode
1 On the Algorithm Geoposition Extents dialog, select Geolink in the row 

of options at the top.
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2 Click inside the larger Landsat TM image window on the left side to activate 
it (three stars *** should appear next to the title).

3 In the Algorithm Geoposition Extents dialog, select the Overview Zoom 
option button.

4 Click the Apply button. 

The window title indicates that it is now set to “OVERVIEW ZOOM” mode.

Note: When one window is set to Overview Zoom mode, any other image windows 
containing images in the same map projection are automatically linked to become 
“zoom” windows for that window. (Windows containing images in different 
projections are not affected.)

Define an area of interest on the large TM window

1 On the main menu, click the ZoomBox Tool  button on the Common 
Functions toolbar.

The mouse is set to perform zoom functions in image windows.

2 Inside the large TM window image window on the left, drag a box to define 
an area of interest anywhere in the image.

Both of the smaller windows automatically zoom to show the same area you 
defined with the box. The larger window remains unchanged because it is the 
master control window.

3 Drag to define other areas of interest in the master TM image window.

Both of the smaller “zoom” windows automatically zoom to magnify the area of 
interest. You can clearly see the difference in spatial resolution between the 
Landsat TM (30m) and SPOT Pan (10m) images in their respective zoom windows.

Tip: Overview Zoom allows you quickly pick an area on an overview window and 
examine it in more detail in the zoom windows. This is an especially effective 
analysis technique when using different types, dates, or resolutions of imagery in 
the zoom windows. You can open as many zoom windows as you need.
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5: Using Overview Roam mode

Unlink the master Landsat TM window
1 Click inside the larger Landsat TM window on the left to activate it.

2 From the View menu (on the main menu bar), select Quick Zoom, then 
select Geolink None. (You could also choose the None option on the 
Algorithm Geoposition Extents dialog Geolink tab and click Apply to 
unlink the window.)

Load the Landsat TM algorithm into the SPOT Pan window
1 Click inside the image window containing the greyscale SPOT 

Panchromatic image to activate it.

2 Click on the Open  button. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Applications’.

5 In the ‘Land_Information’ directory, load the algorithm named 
‘Landsat_TM_23Apr85_rgb_541.alg.’

You now have the same algorithm loaded into all three windows.

Set different display resolutions for the two zoom windows
1 Click inside the smaller Landsat window on the upper-right to activate it.

2 Edit the Dataset cells per pixel field to read 1 (the value one). 

3 Click the Apply button to apply your new display resolution.

ER Mapper reprocesses the algorithm at a “one-to-one” display resolution. 

4 Click inside the smaller Landsat window on the lower-right to activate it.

5 Edit the Dataset cells per pixel field to read 0.33. 

6 Click the Apply button to apply your new display resolution.

ER Mapper reprocesses the algorithm at a higher display resolution, so the image is 
magnified three times greater than the image in the one-to-one resolution window 
above it. 

Objectives Learn to link image windows in Geolink “Overview Roam” mode, so you can 
drag the mouse to pan in an overview window, and other windows pan or “roam” 
so their center point matches the current mouse position the overview window.
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Set the large Landsat TM window to Overview Roam mode
1 Click inside the larger Landsat TM window on the left side to activate it.

2 In the Algorithm Geoposition Extents dialog, select the Overview Roam 
option button.

3 Click the Apply button. 

The window title indicates that it is now set to “OVERVIEW ROAM” mode.

Note: As with Overview Zoom, when one window is set to Overview Roam mode, any 
other image windows containing images in the same map projection are 
automatically linked to the master Overview Roam window. 

Point to an area in the large TM window and press the mouse

1 On the main menu, click the Hand Tool  button on the Common 
Functions toolbar.

The mouse is set to perform pan functions in image windows.

2 Inside the large TM master window, point to any feature of interest and 
depress the mouse button.

Both of the smaller windows automatically pan so that their center point is the same 
as the area you are pointing to in the master window. This allows you to “roam” 
through the overview image to easily view any area in detail. The master window 
remains unchanged because it is the control window. Notice that crosshairs appear 
over the master window to indicate the current mouse pointer location.

Drag slowly through the large TM window to pan
1 Inside the large TM master window, drag the mouse slowly from one part of 

the image to another.

As you drag, the smaller windows interactively pan so that their center point is the 
same as the current pointer position in the master window.

2 Click or drag to define other features of interest in the master window, such 
as lakes, urban areas, and so on.

Both of the smaller windows automatically roam to center on your feature of 
interest. By setting up your two smaller windows at different magnifications, you 
can see different levels of detail in your feature area.
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Tip: Overview Roam is an effective visualization technique for quickly analyzing 
many features in an image using different resolutions and/or types of imagery in the 
roam windows. You can open as many roam windows as you need.

Close all image windows and the Algorithm Geoposition Extents window
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm Geoposition Extents dialog to close it.

Only the ER Mapper main menu is now open.

• Display images with exact geographic extents and display resolutions

• Link image windows to show the same geographic extents

• Link image windows to a virtual map sheet window

• Control interactive image zooming and panning functions from a master window

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Writing images to
disk

This chapter explains how to send the processing results of an algorithm to a raster 
output file on disk instead of to the computer display. 

About Writing Images to Disk
Up until this point you have not needed to write image files to disk since you have 
been doing all processing interactively directly to the display (using ER Mapper 
algorithms). In general, processing your data interactively to the display is 
preferred since it is faster, easier, and takes full advantage ER Mapper’s flexibility 
and the processing power of your computer. However, there are times when you 
may want to save your processing results to a separate raster image file on disk. 

For example, if you are using very complex, compute-intensive algorithms, you 
may want to write a processed copy of the data to disk at some point so it does not 
need to be recomputed. Saving your processing as a dataset or image file can also 
be useful if you want to use the processed image in another software application.

To have ER Mapper send the output from an algorithm to a disk file, set up your 
algorithm with the appropriate layers and processing, then select Save As... from 

the File menu or click the Save As  toolbar button. 
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Raster layers in the Algorithm window can be combined when output, or they can 
be output to separate bands in the output image file. The layers in the Algorithm 
window are processed as follows:

• Non-Classification raster layers with no layer description or the same layer 
description are combined upon output. 

• Non-Classification raster layers with unique layer descriptions are written as a 
separate band in the output image. 

• All Classification raster layers are processed into a single band in the output image. 

Hands-on exercises
This exercise demonstrates the procedure for sending algorithm output to a file on 
disk rather than to the display. 

• Create an algorithm to send output to an image

• Specify output parameters and write the image to disk

• View information about the output image filet

1: Writing an image to disk

Load a Pseudocolor algorithm

1 On the Standard toolbar, click the Edit Algorithm  button.

An image window and the Algorithm dialog box appear.

2 On the Standard toolbar, click on the Open  button. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Data_Types’ directory to open it.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how to send algorithm processing output to a raster image dataset on disk. 
In this case, you will write three bands of a Landsat image subset to disk.
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5 In the ‘Landsat_TM’ directory, load the algorithm ‘Greyscale.alg.’

The algorithm displays band 1 of a Landsat TM image of San Diego as a greyscale 
image. You will zoom in to define a smaller portion of the image, and choose three 
of the seven images bands to write to disk.

Zoom in to define a subset of the image

1 Click the ZoomBox Tool  toolbar button to set the mouse for use as a 
zoom tool.

2 Position the mouse pointer in the upper-left corner of the image, then drag a 
zoom box to enclose the bay with the large island on its right side. (This 
should be about one-tenth of the image area.) 

Create layers for two other output image bands

1 In the Algorithm window, click the Duplicate  button twice.

Two additional Pseudocolor layers are added, and each already contains the 
‘Landsat_TM_year_1985’ image since they are duplicates.

Select bands 1, 4 and 7 and label the layers
1 Click on the first Pseudocolor layer to select it.

This layer already has image band 1 selected.

2 Click in the layer’s description text field with your left mouse button.The 
cursor will be placed in the text field. Type the text label TM band 1 then 
press Enter or Return to validate.

3 Click on the middle Pseudocolor layer to select it.

4 From the Band Selection drop-down list (in the process diagram), select 
B4:0.83_um.

5 Click in the layer’s description text field with your left mouse button.The 
cursor will be placed in the text field. Type the description label TM band 4 
for the middle layer, then press Enter or Return.

6 Click on the lowest Pseudocolor layer to select it.

7 From the Band Selection drop-down list, select B7:2.215_um.

8 Click in the layer’s description text field with your left mouse button.The 
cursor will be placed in the text field. Type the description label TM band 7 
then press Enter or Return.
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You have now created an algorithm that selects three bands from the original image 
(bands 1, 4, and 7) to be written to the new image on disk. By zooming in, you have 
defined a subsection of the image. The layer descriptions you specified will become 
the labels for each band in the output image.

Note: The order of layers in the algorithm determines the order of bands in the output 
image (the first layer becomes the first image band). In this case the layer labelled 
‘TM band 1’ will become band 1 in the output image, ‘TM band 4’ will become 
band 2, and ‘TM band 7’ will become band 3.

Specify a filename for the output image

1 On the Standard toolbar, click the Save As  button.

The Save As dialog box appears. This dialog lets you specify a path and name for 
your output disk file, and the type of file to be saved.

You can save the output image in any of the following formats:

• ER Mapper Algorithm

• ER Mapper Raster Dataset (.ers)

• ER Mapper Virtual Dataset (.ers)

• ESRI BIL and GeoSPOT (.hdr)

• Windows BMP (.bmp)

• GeoTIFF/TIFF (.tif)

• JPEG (.jpg)

• UDF (Universal Data Format)

The format in which you save the image depends on what you are going to do with 
it. If you intend opening the image in another application, use the format best suited 
to that application. If you intend using the image in ER Mapper then you should 
save it in ER Mapper Raster Dataset format. The Universal Data Format (UDF) 
allows you to use the image in ER Mapper and in other applications that use the 
ESRI BIL and GeoSPOT formats.

Note: If the image is very large, you may want to save it in ECW compressed format. You 
can do this by selecting Save as Compressed image... from the File menu.

In this exercise, we will save the image in ER Mapper Raster Dataset format.
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2 On the Save As dialog, select ‘ER Mapper Raster Dataset (.ers) in the 
Files of Type: field.

3 From the Directories menu, select the path ending with the text \examples. 

4 Double-click on the directory named ‘Miscellaneous’ to open it.

5 Double-click on the directory named ‘Tutorial’ to open it.

6 In the Save As: text field, type in a name for the disk file. Use your initials at 
the beginning, followed by the text ‘147_TM_subset,’ and separate each 
word with an underscore (_). For example, if your initials are "DH," type in 
the name:

DH_147_TM_subset

7 Click OK to close the file chooser dialog and open the Save As ER Mapper 
Dataset dialog.

Choose options for the output image
The other fields on the Save As ER Mapper Dataset dialog are:

Data Type is the data format for the new output image. For example, if your 
algorithm processing produces floating point data using a formula, choose one of 
the Real options to write output image dataset values as real numbers. 

Null Value specifies the value that is assigned to null cells. This is usually 0.

Width and Height specify the width and height of the new output image in pixels. 
You can enter any size and ER Mapper automatically subsamples or supersamples 
the original image data to fill the requested dimensions. 

Pixel Width X and Pixel Width Y specify the magnification in terms of the are of 
the image bounded by a pixel.

If image had been setup for a page, the Output What box would have allowed you 
to select either Current View or Entire Page. The Current View saves only the 
part of the image currently being displayed in the image window, while the Entire 
Page saves the whole page containing the image. Since the image being saved has 
not had a page setup, only the Current View can be saved.

1 Click the Defaults button. 

ER Mapper automatically fills in appropriate values in the Cells Across and 
Down fields by examining the extents of the area you zoomed on, and figuring the 
corresponding numbers of actual image pixels to be output. 
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Tip: To write one output image pixel for each input image pixel, use the Defaults 
button to set the output cells across and down to the correct values. Changing these 
values causes ER Mapper to supersample or subsample to the original data during 
output.

2 Select the Delete output transforms option.

Note: When writing images to disk, you should usually delete the output transforms for 
each raster layer to maintain the native data range of the input image. Otherwise, 
the output data may be scaled or clipped according to the current transform. (You 
can, however, use a transform to rescale the data if desired.)

Write the output disk file
1 Click OK on the Save As ER Mapper Dataset dialog.

ER Mapper asks you to confirm the path and name of the output file.

2 Click Yes on the output path dialog to proceed.

ER Mapper opens a dialog box to show the progress of the write to disk operation, 
and presents a confirmation dialog when the process is complete.

3 Click OK on the confirmation dialog to close it.

4 Click Close on the Save As ER Mapper Dataset dialog to close it.

Display the new image

1 Click the New  button on the Standard toolbar, then drag the new 
window below the first one.

2 On the Algorithm window, click on the Load Dataset  button in the 
process diagram. 

3 From the Directories menu, select the path ending with the text \examples.

4 In the ‘Miscellaneous\Tutorial’ directory, load your new image (it will have a 
‘.ers’ file extension).

ER Mapper displays band 1 of your new image.

5 Open the Band Selection drop-down list to see the three bands in your 
output image.
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Notice that the band labels are the same as the layer descriptions you entered 
previously.

View information on the new image

1 On the Algorithm window, click on the Load Dataset  button. 

2 On the Raster Dataset file chooser, click the Info... button.

Information on your new image displays, including the number of bands (3), 
dimensions, and file size. The new image also has the same datum and map 
projection information as the original image.

3 Click Cancel to close the Dataset Information dialog.

4 Click Cancel to close the Raster Dataset file chooser dialog.

Tip: This exercise showed you how to create an algorithm designed write an image to 
disk, but ER Mapper also provides several predefined “template” algorithms to 
make this easier. These algorithms are located in the 
‘examples\Miscellaneous\Templates’ directories, and all you need to do is load in 
the desired image dataset and follow the general procedure described previously.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Create an algorithm to send output to a raster image dataset on disk

• Specify output image parameters and write the image to disk

• View information about the output image

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Virtual datasets
This chapter explains how to create and use a special type of algorithm called a 
Virtual Dataset. Virtual datasets are an innovative ER Mapper feature that allow 
you to work with data in an intermediate processed state without actually needing 
to write the results to a file on disk. 

About virtual datasets
A Virtual Dataset (“VDS” for short) is a special type of algorithm that can be used 
as if it were a file on disk, except that the data is computed on demand so it takes no 
additional disk space. Virtual Datasets are an extension of the algorithms concept, 
so you can carry out processing on a raw image, then save the results as a “virtual” 
dataset for use as input for another algorithm. By saving processing results in a 
Virtual Dataset, you can define “views” into your data that can be used in 
subsequent processing as if they were real images on disk. 

Virtual Datasets offer many advantages: 

• Reduced data complexity–layers that process combinations of bands can become a 
single band of data in the virtual dataset. 

• Reduced disk storage–virtual datasets are computed on demand, so no extra disk 
storage is needed. 

• Virtual image mosaics–two or more adjacent images can be merged and processed 
as if they were a single image. 

• New types of data–image datasets with different characteristics can be merged to 
create hybrid virtual datasets.
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All of these types of operations can be saved as Virtual Datasets, thereby making 
the processing techniques used to create them transparent to the user.

Hands-on exercises
These exercises give you practice creating Virtual Datasets and understanding how 
to use them in subsequent image processing algorithms.

• Prepare an algorithm to be saved as a Virtual Dataset 

• Save and load a Virtual Dataset 

• Compute a Tasseled Cap formula transform on an image, and save the resulting 
images in a “virtual” Tasseled Cap dataset 

• Create a mosaic of three separate images, and save the algorithm as “virtual” image 
mosaic 

• Create a virtual dataset referencing images of different resolutions, and use it to 
merge the two images

1: Creating a Tasseled Cap VDS

About the Tasseled Cap transformation: The three Tasseled Cap formulas used 
in this example are designed to transform the original Landsat TM data into three 
separate images representing the scene brightness, vegetation greeness, and surface 
moisture (wetness). The Tasseled Cap (TC) transformation provides useful 
information for agricultural applications because it allows the separation of barren 
(bright) soils from vegetated and wet soils.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to create an algorithm that generates three “Tasseled Cap” images, then 
save the algorithm as a Virtual Dataset for later use. This example shows how 
Virtual Datasets can be used to reduce the complexity of manipulating image data 
and make it easier to use.
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Open a Tasseled Cap algorithm

1 Click the Edit Algorithm  toolbar button. 

An image window and the Algorithm window appear.

2 On the Standard toolbar, click on the Open  button to open the file 
chooser dialog. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Data_Types’ directory to open it.

5 In the directory ‘Landsat_TM,’ load the algorithm named 
‘Tasselled_Cap_Transforms.alg.’

This algorithm generates the three Tasseled Cap transformation images, each in its 
own Pseudocolor layer. The dataset is a Landsat TM image of the San Diego, 
California area. The Brightness image is initially displayed because its layer is 
turned on and the Wetness and Greeness layers are turned off.

Load a different TM image into the algorithm

1 In the Algorithm window, click the Load Dataset  button in the process 
stream diagram. 

The Raster Dataset file chooser opens.

2 From the Directories menu, select the path ending with the text \examples

3 Double-click on the ‘Data_Types’ directory to open it.

4 Double-click on the directory ‘Ers1’ to open it.

5 Double-click on the image ‘Landsat_TM.ers’ to load it into all three layers.

This dataset is Landsat TM image of the Netherlands that shows an area of coastal 
plains under various levels of cultivation.

View the different Tasselled Cap images
1 Turn the ‘Brightness’ layer off (by selecting Turn Off from the Short-Cut 

menu which appears after clicking the right mouse button on the 
‘Brightness’ layer), and turn the ‘Greeness’ layer on (by selecting Turn On 
from the Short-Cut menu).

The Greeness image is displayed showing the location and relative abundance of 
vegetation (light shades are vigorous vegetation). This is similar to the vegetation 
index images you generated in earlier exercises.

2 Turn the ‘Greeness’ layer off, and turn the ‘Wetness’ layer on.
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The displayed Wetness image is an indicator of surface moisture, so ocean areas are 
shown as light grey shades, and areas lacking moisture are shown as dark shades 
(barren land, beaches, and airport runways).

View the formulas used to create the TC images
1 Turn all three layers on.

2 Click on the ‘Brightness’ layer to select it.

3 Click the Edit Formula  button in the process diagram to open the 
Formula Editor dialog.

The formula used to generate the Tasselled Cap Brightness image displays. As 
indicated, this image is generated by multiplying bands 1-5 and 7 by weighted 
coefficients. (For best results in any particular area of the world, these coefficients 
should be adjusted for local conditions. However, the standard coefficients 
generally provide good indicators of the three parameters in most cases.)

4 Click the Move to next Pseudocolor layer  button on the Formula 
Editor dialog to display the formula used to generate the ‘Wetness’ image.

5 Click the Move to next Pseudocolor layer  button again to display the 
formula used to generate the ‘Greeness’ image.

When you save the algorithm as a Virtual Dataset, ER Mapper will perform these 
three sets of calculations automatically.

6 Click Close on the Formula Editor dialog to close it.

Note: Before saving an algorithm as a Virtual Dataset, make sure all algorithm layers are 
turned on. Layers that are turned off cannot be used in the Virtual Dataset.

Save the algorithm as a Virtual Dataset
1 From the File menu, select Save As....

The Save As dialog box appears.

2 In the Files of Type: field, select ‘ER Mapper Virtual Dataset (.ers).

3 From the Directories menu, select the path ending with the text \examples. 

4 Double-click on the directory named ‘Miscellaneous’ to open it.

5 Double-click on the directory named ‘Tutorial’ to open it.
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6 In the Save As: text field, type in a name for the Virtual Dataset file. Use 
your initials at the beginning, followed by the text ‘Tasseled_Cap_VDS,’ and 
separate each word with an underscore (_). For example, if your initials are 
"DB," type in the name:

DB_Tasseled_Cap_VDS

7 Click OK to save the Virtual Dataset and close the file chooser dialog.

Delete the transforms from all three algorithm layers
1 Click Yes in the ER Mapper query about deleting output transforms dialog.

This will make sure that the original data ranges created by the Tasselled Cap 
formulas are not rescaled in any way using a transform when the images are saved 
as a Virtual Dataset. (In this algorithm, each layer had a contrast stretch applied to 
enhance visual presentation.)

The Virtual Dataset is actually saved as a small ASCII text file on disk that 
describes the processing and image dataset in each layer (very similar to an 
algorithm). Because of this, it consumes almost no additional disk space.

Tip: It is often helpful to append the text “VDS” on the end of the name you assign to a 
Virtual Dataset. This helps you easily determine that the image is virtual, and not 
an actual dataset file on disk.

Open a template RGB algorithm to display your Virtual Dataset

1 On the Standard toolbar, click on the Open  button to open the file 
chooser dialog. 

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the ‘Miscellaneous’ directory and then on the ‘Templates’ 
directory.

4 In the directory ‘Common,’ load the algorithm named ‘RGB.alg.’

The template RGB algorithm with an airphoto image displays.

Load and display the Virtual Dataset

1 On the Algorithm window, click on the Load Dataset  button in the 
process diagram. 

2 From the Directories menu, select the path ending with the text \examples.
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3 In the ‘Miscellaneous\Tutorial’ directory, load your Tasselled Cap Virtual 
Dataset image (it will have a ‘.ers’ file extension).

4 In the process diagram, select the following bands for each layer: Blue = B1: 
Wetness, Green = B2:Greenness, and Red = B3:Brightness.

ER Mapper computes the Tasseled Cap calculations from the original TM data on 
disk. 

5 Open the Band Selection drop-down list in the process stream to see the 
three bands in your Virtual Dataset.

Note this Virtual Dataset has three bands: Brightness, Greeness, and Wetness. By 
saving the Tasseled Cap algorithm as a Virtual Dataset, you have reduced the 
complexity of the data, and no longer need to use the Tasseled Cap formulas in 
future algorithms to generate these images.

Adjust the transforms for the RGB layers to increase contrast

1 Click on the post-formula Edit Transform Limits  button.

2 From the Limits menu, select Limits to Actual.

ER Mapper sets the X axis (input) limits to match the data range created by the 
Tasseled Cap Brightness formula.

3 Click the Move to next Green layer  button, and select Limits to 
Actual from the Limits menu for the Green layer.

4 Click the Move to next Blue layer  button, and select Limits to Actual 

from the Limits menu for the Blue layer.

5 For each layer, click the Create autoclip transform  button. (Move 

between them using the ,  and  buttons.)

The resulting RGB color composite image shows information about the various 
states of cultivated fields in the image. Bright areas (sand, barren land) appear in 
red, crops under cultivation appear in green or cyan, fallow fields appear brownish, 
and water areas are bright blue. This is a traditional way of displaying the three 
Tasseled Cap images as an RGB color composite, and is especially useful for 
assessing the cultivated states of agricultural areas.

6 Click Close to close the Transform dialog box.

View information on the Virtual Dataset

1 On the Algorithm window, click on the Load Dataset  button. 
Comprehensive ER Mapper Training Workbook 209



Chapter 13 Virtual datasets ●  2: Creating a Virtual Mosaic
2 On the Raster Dataset file chooser, click the Info... button.

The Dataset Information dialog indicates that the image dataset is Virtual. Since 
it is not actually an image on disk, it cannot be edited using the dataset header 
editor.

3 Click Cancel to close the Dataset Information dialog.

4 Click Cancel to close the Raster Dataset file chooser dialog.

2: Creating a Virtual Mosaic

Open an RGB algorithm that displays three adjacent images

1 Click the Open  toolbar button. 

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the ‘Applications’ directory to open it.

4 Double-click on the ‘Airphoto’ directory to open it.

5 In the directory ‘3_Balancing’, load the algorithm named 
‘ADAR_mosaic.alg.’

This algorithm displays an RGB color composite of three separate ADAR 5000 
scenes covering a portion of the Del Mar, California area near San Diego. (This 
data is from the ADAR multispectral scanner system acquired by aircraft.)

6 Expand the image window by 50% downward to make it taller.

7 Right-click on the image and select Zoom to All Datasets from the 
Quick Zoom menu.

8 Scroll through the layers in the layer list on the Algorithm window.

Notice that there are nine layers in the algorithm because each of the images is 
displayed in its own set of RGB layers. Also, each layer has a description that 
indicates the band of image data loaded into it.

Save the algorithm as a Virtual Dataset
1 From the File menu, select Save As....

The Save Algorithm dialog box appears.

2 In the Files of Type: field, select ‘ER Mapper Virtual Dataset (.ers)’.

Objectives Learn how to save a mosaic of three images as a “virtual” mosaic that can used as 
if it were a single image.
Comprehensive ER Mapper Training Workbook  210



Chapter 13 Virtual datasets ●  2: Creating a Virtual Mosaic
3 From the Directories menu, select the path ending with the text \examples. 

4 Double-click on the directory named ‘Miscellaneous’ to open it.

5 Double-click on the directory named ‘Tutorial’ to open it.

6 In the Save As: text field, type in a name using your initials followed by the 
text ‘image_mosaic_VDS,’ and separate each word with an underscore (_). 
For example, if your initials are "SN," type in the name:

SN_image_mosaic_VDS

7 Click OK to save the Virtual Dataset and close the file chooser dialog.

8 Click No in the query dialog to remove output transforms.

The Virtual Dataset is actually saved as a small ASCII text file on disk that 
describes the processing and image dataset in each layer (very similar to an 
algorithm). Because of this, it consumes almost no additional disk space

Note: In this case, you did not delete the transform from each layer before saving the 
algorithm as Virtual Dataset. The contrast enhancement is desirable in this case 
because it serves to balance the brightness between the three images and makes 
seam lines less apparent.

Open a template algorithm to display your Virtual Dataset

1 Click the New  button on the Standard toolbar, then drag the new 
window below the first one.

2 On the Standard toolbar, click on the Open  button to open the file 
chooser dialog. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Miscellaneous’ directory and then on the ‘Templates’ 
directory.

5 In the directory ‘Common,’ load the algorithm named ‘RGB.alg.’

The template RGB algorithm with an airphoto image displays.

Load the Virtual Dataset into the RGB algorithm

1 On the Algorithm window, click on the Load Dataset  button in the 
process diagram.

2 From the Directories menu, select the path ending with the text \examples.
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3 In the ‘Miscellaneous\Tutorial’ directory, load your new image mosaic Virtual 
Dataset image (it will have a ‘.ers’ file extension).

The three images are displayed as if they were one, but the data is actually being 
computed from the three original ADAR images on disk.

4 Open the Band Selection drop-down list in the process stream to see the 
three bands in your Virtual Dataset.

The “virtual” band 1 references the band 1 data from each of the three original 
ADAR image files, and so on for virtual bands 2 and 3. You can now manipulate 
the three images as if they are a single image, for example to contrast stretch them, 
apply filters, and so on.

Note: In the original algorithm (open in the other window for reference), each of the Red 
layers displayed band 1 of their image. Since each Red layer had the same layer 
description (B1:0.850_um), ER Mapper merged them into a single “virtual” band 
with that label when the algorithm was saved as a Virtual Dataset. Any layers in an 
algorithm with the same layer description will be referenced as a single layer in a 
Virtual Dataset.

Close both image windows
1 Close both image windows using the window system controls:

• Select Close from the window control-menu.
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3: Creating a multiple image VDS

Open a window and template greyscale algorithm

1 Click the Open  toolbar button.

A new image window and the Open file chooser appear.

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the ‘Miscellaneous’ directory and then on the ‘Templates’ 
directory.

4 In the directory ‘Common,’ load the algorithm named 
‘Single_Band_Greyscale.alg.’

Load the SPOT XS image

1 On the Algorithm window, click on the Load Dataset  button in the 
process diagram.

2 From the Directories menu, select the path ending with the text \examples.

3 In the ‘Shared_Data’ directory, load the file ‘SPOT_XS.ers.’

This image is band 1 of a SPOT XS multispectral satellite image. (The contrast of 
the image is not relevant at this point so there is no need to adjust it.)

4 Open the Band Selection drop-down list in the process stream.

Note that the SPOT XS image has three spectral bands.

Delete the transform from the Pseudocolor layer

1 Click on the post-formula Edit Transform Limits  button.

2 From the Edit menu on the Transform dialog, select Delete this transform.

ER Mapper deletes the post-formula transform from the layer. (Since you will be 
performing computations on the Virtual Dataset later, you should delete the 
transform to prevent the original data from being rescaled.)

3 Click Close on the Transform dialog to close it.

Objectives Learn how to save and reference multiple images as single Virtual Dataset. In this 
case, you will save SPOT XS and SPOT Panchromatic satellite images in a VDS, 
and use it in a processing algorithm to merge the two images.
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Duplicate the Pseudocolor layer three times
1 On the Algorithm window, click the Duplicate button three times to create 

three copies of the original layer.

2 If needed, make the layer list window slightly larger until you can view all 
four layers together at once.

Select bands and enter labels for the lowest three layers
1 Click on the first (top) layer to select it.

2 Enter the layer description SPOT XS1 for the first layer. (It should already 
have band 1 chosen by default.)

3 Select the second layer, choose B2:0.645_um from the Band Selection 
drop-down list, and enter the layer description SPOT XS2.

4 Select the third layer, choose B3:0.84_um in Band Selection drop-down 
list, and enter the layer description SPOT XS3.

You should now have image bands 1, 2 and 3 loaded in the first, second and third 
algorithm layers respectively, and each layer should be labelled accordingly.

Load the SPOT Pan image into the fourth layer
1 Click on the fourth (lowest) layer to select it.

2 In the process diagram, click the Load Dataset  button to open the 
Raster Dataset chooser dialog.

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Shared_Data’ directory to open it.

5 Click once on the image ‘SPOT_Pan.ers’ to select it, then click the OK this 
layer only button.

ER Mapper loads the image into only the current Pseudocolor layer of the 
algorithm. (If you had used OK or Apply, the image would be loaded into all four 
layers which is not what you want in this case.)

6 Enter the description SPOT Pan for the fourth layer.

You have now prepared an algorithm for use in saving a Virtual Dataset that will 
have four bands. Virtual bands 1, 2 and 3 will reference bands 1-3 in a SPOT XS 
image, and band 4 will reference a separate SPOT Pan image. (The first layer in 
your algorithm becomes band 1 in the Virtual Dataset.)
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Save the algorithm as a Virtual Dataset

1 Click the Save As  toolbar button.

The Save As dialog box appears.

2 In the Files of Type: field, select ‘ER Mapper Virtual Dataset (.ers)’.

3 From the Directories menu, select the path ending with the text examples. 

4 Double-click on the directory named ‘Miscellaneous’ to open it.

5 Double-click on the directory named ‘Tutorial’ to open it.

6 In the Save As: text field, enter your initials followed by the text 
‘SPOT_XS_and_Pan_VDS,’ and separate each word with an underscore 
(_). For example, if your initials are “JM,” type in the name:

JM_SPOT_XS_and_Pan_VDS

7 Click OK to save the Virtual Dataset, and then Yes to deleting output 
transforms.

The two images are saved in a single Virtual Dataset, so they can now be referenced 
as if they are a single image on disk.

Tip: At this point, you may also want to save the layers you set up as a normal algorithm 
file (using File/Save As) so that you can use as a template for creating other 
SPOT XS and Pan Virtual Datasets in the future. This saves you the trouble of 
building and labelling the layers again.

Open a template RGB algorithm to process your Virtual Dataset

1 Click on the Open  toolbar button. 

2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the ‘Miscellaneous’ directory and then on the ‘Templates’ 
directory.

4 In the directory ‘Common,’ load the algorithm named ‘RGB.alg.’

Load the SPOT XS and Pan Virtual Dataset

1 On the Algorithm window, click the Load Dataset  button in the 
process diagram. 

2 From the Directories menu, select the path ending with the text \examples.
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3 In the ‘Miscellaneous\Tutorial’ directory, load your SPOT XS and Pan Virtual 
Dataset image (it will have a ‘.ers’ file extension). Double-click on the image 
name or use the OK or Apply buttons to load the image into all three layers 
at once.

4 Click the Band Selection button in the process stream diagram.

Notice that your Virtual Dataset has four bands. Bands 1-3 reference the bands in 
the SPOT XS image, and band 4 references the SPOT Pan image.

Enter a formula in the Red layer to merge the images
1 Click on the Red layer to select it.

2 Click on the Edit Formula  button in the process stream diagram to 
open the Formula Editor dialog box. 

3 In the Generic formula window, edit the formula text to read:

input1 * input2 / 255

This formula tells ER Mapper to multiply the image band assigned to input1 by the 
band assigned to input 2, and then divide the result by 255.

4 Click the Apply changes button to validate the formula.

5 In the Relations window, select B3:SPOT_XS3 for “INPUT1” and select 
B4:SPOT_Pan for “INPUT2.”

This simple formula will merge band 3 of the SPOT XS image with the SPOT Pan 
image to create a merged image with the color of the SPOT XS multispectral image 
and the high resolution of the SPOT Pan image.

Enter similar formulas in the Green and Blue layers

1 Click the Move to next Green layer  button.

2 Enter the same Generic formula (input1 * input2 / 255) and click the 
Apply changes button to validate it.

3 In the relations window, select B2:SPOT_XS2 for “INPUT1” and select 
B4:SPOT_Pan for “INPUT2.”

4 Click the Move to next Blue layer  button.

5 Enter the same Generic formula (input1 * input2 / 255) and click the 
Apply changes button to validate it.

6 In the relations window, select B1:SPOT_XS1 for “INPUT1” and select 
B4:SPOT_Pan for “INPUT2.”
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7 Click Close on the Formula Editor dialog to close it.

Adjust the transforms for the RGB layers to increase contrast

1 Click on the post-formula Edit Transform Limits  button.

2 For each layer in the algorithm, select Limits to Actual from the Limits 
menu.

3 For each layer in the algorithm, click the Histogram Equalize  button.

ER Mapper displays the final contrast stretched image, which is a merge of the 
SPOT XS multispectral image (20 meter resolution) and the SPOT Pan image (10 
meter resolution). 

This example shows how using Virtual Datasets lets you perform mathematical 
operations between two or more separate images without having to resample them 
to a common resolution and write them into a single image first. Multiple-image 
Virtual Datasets can help simplify processing techniques for many applications, 
including change detection, image merging, and more.

ER Mapper provides predefined algorithms you can use as templates to create 
common types of Virtual Datasets. These algorithms are stored in the 
‘\examples\Miscellaneous\Templates\Virtual_Datasets’ directory.

Tip: Occasionally you find it useful to edit a Virtual Dataset, for example change a 
formula, filter or other element. To do this, open the VDS back into it’s original 
algorithm using File/Open from Virtual Dataset. Then edit the algorithm as 
needed, and resave to a VDS using File/Save As Virtual Dataset.
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4: Creating a haze adjusted VDS

About haze correction and histogram adjustments
The shorter (visible) wavelength bands of optical satellite images such as Landsat 
TM and SPOT XS are affected by haze and atmospheric scattering, which tend to 
add brightness to the image in those bands. A result is that visible wavelength 
bands usually have much higher minimum values that do not occupy the lower end 
of the possible dynamic range of 0-255. When performing quantitative analysis of 
the data, it is usually desirable to first perform a “haze correction” adjustment to the 
brightness range in all bands.

When performing change detection between two images, this same type of 
correction should be performed on both images to normalize their brightness levels 
into a common range so they can be accurately compared. (Differences in the sun 
elevation, atmospheric conditions and other factors during the image acquisitions 
the two images cause them to have different ranges of values in each band.)

One simple way to do a haze correction is the histogram adjustment technique. This 
method assumes that the difference between the minimum possible value (zero) 
and the actual minimum value in each band is the contribution of atmospheric 
scattering. By subtracting the actual minimum value from each band, the 
histograms are shifted left so that zero values appear in the data, which somewhat 
minimizes the effects of atmospheric scattering. (See a reference remote sensing 
text for a more complete description and other more sophisticated and accurate 
atmospheric correction techniques.)

Note: See the section “Additional tips for Virtual Datasets” at the end of this chapter for 
more information on using a VDS for change detection.

Open a new window and load a Landsat TM image

1 On the main menu, click the New  button.

2 On the Algorithm dialog, click the Load Dataset  button in the process 
diagram. 

3 From the Directories menu, select the \examples path.

Objectives Learn how to perform a simple, first-order adjustment for haze and atmospheric 
scattering on a Landsat image, and save the adjusted image as a Virtual Dataset. 
This is a good example of creating a VDS that performs a pre-processing step, so 
it can be used as input to subsequent algorithms. 
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4 Open the ‘Shared_Data’ directory, then double-click on the image 
‘Landsat_TM_year_1991.ers’ to load it.

5 Band of a 1991 Landsat TM image of San Diego displays.

6 Click the Surface tab, then select greyscale from ‘Color Table’ list.

7 Click the Layer tab again.

View and analyze the band 1 histogram

1 On the Algorithm dialog, click the post-formula Edit Transform Limits  
button in the process diagram.

2 In the Transform dialog, examine the band 1 (visible blue) histogram. 
Notice the actual input limits are 80-255, so no values occur on the lower 
end of the possible 0-255 dynamic range. This gap between zero and the 
actual minimum value is considered to be the approximate contribution of 
atmospheric scattering to the signal received by the satellite sensor.

View histograms and minimum values for other bands
1 Choose B2:0.56_um from the Band Selection list in the process diagram.

2 The histogram for TM band 2 (visible green) appears. Notice that its 
minimum value (about 27) is less than band 1, but still offset from zero.

3 Choose B3:0.66_um from the Band Selection list.

4 The histogram for TM band 3 (visible red) appears, and its minimum value 
is 22.

5 Choose B4:0.83_um from the Band Selection list.

approximation of brightness added
to band 1 values by scattering in
the atmosphere
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6 The histogram for TM band 4 (near infrared) appears, and its minimum 
value is closer to zero (about 11).

7 Atmospheric scattering in the visible wavelengths increases brightness in 
TM bands 1, 2 and 3. TM 1 (blue) is most affected because it senses the 
shortest wavelengths. (This is effect also noticeable in the blue band of 
natural color airphotos.) In contrast, the pixel values of the longer 
wavelength bands (near and mid-IR bands 4, 5 and 7) are reduced by 
absorption so their minimum values are at or near zero. In general, the 
shorter the wavelength band, the greater the offset from a pixel value of 
zero.

8 Choose B1:0.485_um from the Band Selection list.

9 By subtracting the minimum value from each band, you can perform a first-
order correction for the effects of atmospheric scattering.

Add a formula to automatically subtract the minimum value
One way to subtract the minimum value from all pixels in an image band is to use a 
formula such as input1 - 40 (which subtracts 40 from each pixel value). 
However, this requires that you manually determine the minimum value, and type 
in the number, which will be different for each band. Here you will use a formula 
that simplifies this by subtracting the minimum value automatically.

1 Click the Edit Formula  button in the process diagram to open the 
Formula Editor dialog.

2 Edit the formula text to read:

input1 - RMIN(,R1,I1)

This formula tells ER Mapper to take the minimum value for band 1 and subtract it 
from all pixels in the image. (‘RMIN’ is the region minimum function that gets the 
minimum value of the image from statistics stored in the ‘.ers’ file. The ‘R1’ and 
‘I1’ designations refer to a region and a band.)

3 Click the Apply changes button to verify the formula syntax.

4 Click the Inputs button (above the Relations window), and select 
B1:0.485_um from the ‘INPUT1’ list (if it is not already selected).

5 Click the Regions button (above the Relations window), and select All from 
the ‘REGION1’ list (if it is not already selected).

6 These settings tell the RMIN function to use the minimum value from band 1 
calculated from statistics for the entire image (the ‘All’ region).

7 In the Transform dialog, notice that the band 1 histogram has shifted left to 
the origin, and the actual input limits are now 0-175. By subtracting the 
minimum value (80) from all pixels, you shift the histogram left so zero 
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values now occur in the image data. This minimizes the effects of 
atmospheric scattering.

Note: Before you can use this formula, you must have calculated statistics for your image, 
otherwise you will receive an error message. You can do this using Process /
Calculate Statistics. It is recommended that you use a subsample setting of 1 so 
statistics are calculated from every pixel in the image (to ensure the true minimum 
value is recorded in the statistics).

8 Click Close on the Formula Editor dialog.

Delete the transform and label the layer
1 From the Edit menu (on the Transform dialog), select Delete this 

transform.

2 ER Mapper deletes the post-formula transform from the layer. (This ensures 
that the new histogram adjusted data range will be saved with the Virtual 
Dataset.)

3 Click Close on the Transform dialog.

4 Change the label of the ‘Pseudo Layer’ to TM1 histo adjusted and 
press Enter or Return.

Duplicate the layer five times

1 On the Algorithm dialog, click the Duplicate  button five times to 
create five copies of the original layer.

You now have five additional layers to perform the same histogram adjustment 
processing on Landsat bands 2-5 and 7. (You will skip TM band 6 since it is often 
not used.) Since they were copied from the first one, they already contain the 
adjustment formula and have the transform deleted.

original histogram (min = 80) adjusted histogram (min = 0)
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Change the band and label for the copied layers
1 Select the second layer, choose B2:0.56_um from the Band Selection list 

in the process diagram, then change the label to TM2 histo adjusted.

2 Select the third layer, choose B3:0.66_um from the Band Selection list, 
then change the label to TM3 histo adjusted.

3 Select the fourth layer, choose B4:0.83_um from the Band Selection list, 
then change the label to TM4 histo adjusted.

4 Select the fifth layer, choose B5:1.65_um from the Band Selection list, 
then change the label to TM5 histo adjusted.

5 Select the sixth layer, choose B7:2.215_um from the Band Selection list, 
then change the label to TM7 histo adjusted.

6 Click the ‘[Ps]:Surface 1’ icon in the layer list to show process diagrams for 
all six layers (if needed, make the Algorithm dialog taller to see all six.)

Your algorithm should look like this:

Save the algorithm as a Virtual Dataset

1 On the main menu, click the Save As  button.

2 In the Files of Type: field, select ‘ER Mapper Virtual Dataset (.ers)’.

3 From the Directories menu, select the \examples path.

4 Open the ‘Miscellaneous’ directory.

appropriate layer labels correct band to match label transforms deleted
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5 Open the ‘Tutorial’ directory.

6 In the Save As: text field, enter your initials followed by the text 
TM_hist_adjust_VDS and separate each word with an underscore (_). 

7 Click OK to save the Virtual Dataset, and Yes to removing the output 
transforms.

8 Bands 1-5 and 7 of the Landsat image have a histogram adjustment 
performed and are saved in a Virtual Dataset.

Open a new window and load the VDS
1 Select New from the File menu to open a new, empty image window.

2 Drag it below the first one.

3 On the Algorithm dialog, click the Load Dataset  button in the process 
diagram. 

4 From the Directories menu, select the \examples path.

5 Open the ‘Miscellaneous\Tutorial’ directory, then double-click on your 
‘TM_hist_adjust_VDS.ers’ image to load and display it.

6 Click the Surface tab, select greyscale from the ‘Color Table’ list, then click 
the Layer tab again.

View the haze corrected band 1 histogram

1 On the Algorithm dialog, click the post-formula Edit Transform Limits  
button in the process diagram.

2 In the Transform dialog, notice the band 1 histogram is shifted left to the 
origin and the band 1 minimum value is zero (in ‘Actual Input Limits’).

3 Select different bands to see their histograms and minimum values.

All bands should now have minimum values of zero, so they have had a first-order 
adjustment for the effects of atmospheric scattering. (A minimum value of zero 
may not always appear due to subsampling the data to the image window size, 
however the operation is still being performed correctly.)

Tip: You can use your histogram adjustment algorithm as a template to quickly apply 
the same processing to any other Landsat TM image. Just calculate stats for the TM 
image, load it into the algorithm, make sure the correct bands are selected, and save 
as a VDS.
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Close the image windows and Algorithm dialog
1 Close both image windows using the window system controls:

• Click the  Close button in the upper-right window corner.

2 Click Close on the Algorithm dialog.

Only the ER Mapper main menu should be open on the screen.

• Prepare an algorithm to be saved as a Virtual Dataset 

• Compute a Tasseled Cap formula transform on an image, and save the resulting 
images in a “virtual” Tasseled Cap dataset 

• Create a mosaic of three images, and save the algorithm as “virtual” image mosaic 

• Create a Virtual Dataset referencing two images with different spatial resolutions, 
and use it to merge the two images

• Create a Virtual Dataset that performs a simple haze correction, so it can be used as 
input for subsequent quantitative or change detection processing

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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14

3-D perspective
viewing

This chapter explains how to view and manipulate images in 3D perspective to gain 
a better understanding of terrain features, relationships, and other aspects of your 
data. ER Mapper lets you quickly change between 2D and 3D views of your data, 
stack multiple surfaces in a single view, set transparency between surfaces, and 
many other features.
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About perspective viewing

Viewing images in three-dimensional perspective is a valuable tool that helps 
increase understanding of features and relationships in images. Many types of earth 
science images can be integrated to create 3D scenes that show features and 
anomalies much more clearly than traditional two dimensional views. To create a 
3D view, you simply add a Height layer to your 2D algorithm that contains an 
elevation image (such as a digital terrain model), then change the View Mode to 3D 
perspective or 3D flythrough.

ER Mapper’s 3D viewing capabilities are extensive and easy to use, including:

• view any image in 3D, and quickly switch between 2D and 3D views

• use static 3D perspective or real-time “flythrough” modes

• stack multiple surfaces in a single view

• set transparency between surfaces to view underlying features

• incorporate vector data in 3D, such as roads or cultural data

• generate top quality, high resolution 3D hardcopy prints

Hands-on exercises
These exercises give you practice setting up algorithms for 3D viewing, and 
manipulating the images using the viewing and display controls in ER Mapper’s 
3D perspective viewer.

What you will 
learn...

After completing these exercises, you will know how to perform these tasks in 
ER Mapper:

Two-dimensional (planimetric) view Three-dimensional perspective view
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• Prepare an algorithm for 3D viewing by adding a Height layer

• Change the viewpoint, zoom level, and other 3D view parameters

• Use the 3D Flythrough viewing mode

• Stack multiple surfaces in a 3D view and set surface offset and transparency

• Merge separate algorithms into surfaces in a single algorithm

1: 3D viewing basics

Open a Landsat TM RGB algorithm

1 On the main menu, click the Open  button.

An image window and the Open dialog appear.

2 From the Directories menu (on the Open dialog), select the \examples 
path.

3 Double-click on the ‘Applications’ directory to open it.

4 Open the ‘Land_Information’ directory, then double-click on the algorithm 
‘Landsat_TM_23Apr85_rgb_541.alg’ to open it.

This algorithm displays a Landsat TM satellite image of a large area of San Diego, 
California. Bands 5, 4 and 1 are displayed in RGB so vegetation appears in various 
shades of green and brown.

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objective Learn to prepare an algorithm for 3D viewing by adding a Height layer that 
contains the desired elevation data. Also learn to use 3D perspective view mode, 
and control the viewpoint and display parameters of the 3D scene.

click to open
algorithm
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Zoom in to the upper-right portion of the image

1 Click the ZoomBox Tool  button on the main menu.

2 Drag a zoom box in the image to zoom in on the upper-right portion of the 
image indicated below.

This is the area you will display in 3D perspective. (You can select a subset of an 
area to display in 3D simply by zooming in on it.)

Add a Height layer and load the DTM image
1 On the main menu, select Algorithm from the View menu.

2 From the Edit menu (on the Algorithm dialog), select Add Raster Layer, 
then Height.

ER Mapper adds a new, empty Height layer to the algorithm. The layer is crossed 
out because you are currently viewing the image in 2D view mode.

3 With the ‘Height Layer’ selected, click the Load Dataset  button in the 

process diagram.

4 From the Directories menu (on the Raster Dataset dialog), select the 
\examples path.

5 Open the ‘Shared_Data’ directory, then double-click on the image 
‘Digital_Terrain_Model_20m.ers’ to load it.

zoom in on upper-right
area defined by box
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This is a digital terrain model (DTM) image of the northern San Diego area with a 
20-meter grid resolution (or posting). The image values are in meters above sea 
level. This is the image you will use to add a height component to the algorithm to 
enable the Landsat image to be viewed in 3D perspective.

Note: In the Algorithm dialog, notice that the Height layer has a “Histogram only”  

post-formula transform. This is automatically inserted for new Height layers 
because it forces use of the entire range of values in the DTM and prevents the data 
from being rescaled. (Using a transform will skew the data, for example a 99% 
autoclip on a Height layer will usually create flat spots in the highs and lows of the 
3D image. If you duplicate an existing layer and change it to Height, delete the 
transform to use the full range of data for the elevation component.

Select 3D Perspective mode to view the image in 3D
1 From the ‘View Mode’ menu (on the Algorithm dialog), select 3D 

Perspective.

ER Mapper displays a message that the image is being processed, then displays a 
3D perspective view of the Landsat image in color. The message “Regenerating 
Terrain” appears in the image window as ER Mapper performs iterations to 
increase the resolution (detail) in the 3D image.

The perspective view provides clear definition of the topography of the area, which 
can add valuable information to aid interpretation of satellite and other types of 
images.

Tip: If your algorithm does not contain a Height layer, ER Mapper automatically uses 
an Intensity layer (if one is present) as a Height layer when you switch to 3D 
Perspective view mode.

Turn off the Lighting (artificial illumination) option
1 In the Algorithm dialog, select the 3D View tab.

The 3D View tab page provides draw mode, terrain detail, lighting, and other 
options.

2 Turn off the Lighting option.

The image redraws without illumination from a light source.
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Tip: When displaying images that contain natural shadows (such as airphotos or optical 
satellite images like Landsat), the 3D image appears more natural when the 
Lighting option is turned off. (Lighting is discussed more later.)

Tilt the image forward or backward
1 Point to lower edge of the 3D image and drag slightly downward.

The image moves into a more overhead perspective, and regenerates detail when 
you release the mouse button. 

2 Point to lower edge of the image and drag slightly upward.

The image moves into a flatter, side view perspective. Dragging the image up or 
down tilts the 3D model forward or backward (rotates it around its X axis).

Tip: If you accidently change the 3D view too much, click the 3D View tab in the 
Algorithm dialog, then click the Reset View button. This resets the the image to 
a standard default view.

Rotate the image around its center point
1 Point to lower edge of the image and drag slightly to the right.

The image rotates to the right around its center point.

2 Point to lower edge of the image and drag slightly left.

The image rotates to the left around its center point. Dragging the image left or 
right lets you view it from a side angle (rotate around the Z axis).

Zoom the image in and out
1 Drag the image window corner to make it 50% larger.

The 3D view remains the same size within the window.

2 Point to the center of the image. Then press right mouse button and drag 
slightly upward.

As you drag, ER Mapper zooms out so the image redraws at a smaller size.

3 Point to the image center again, press right mouse button and drag slightly 
downward.

ER Mapper zooms in so the image redraws at a larger size.
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Right-dragging up or left reduces the image (zooms out); right-dragging down or 
right magnifies the image (zooms in).

4 Right-drag to set the zoom extents for the image so it fills as much of the 
window as possible.

Rotate the image side to side
1 Point to the center of the image. First depress the left mouse button, then 

the right button (hold down both), then drag slightly to the right.

ER Mapper rotates the image to the right.

2 Point to the image center again, depress the left then the right mouse 
buttons, and drag slightly to the left.

The image rotates left. Pressing the left then the right mouse buttons and dragging 
left or right is how you rotate the image side to side (around its Y axis).

Pan (scroll) the image within the window
1 Point to the center of the image. First depress the right mouse button, then 

the left button (hold down both), then drag slightly upward.

ER Mapper pans (or scrolls) the image upward without changing the perspective.

2 Point to the image center again, depress the right then the left mouse 
buttons, and drag around inside the window.

The image repositions as you drag. Panning in 3D is useful when want to reposition 
the image in the window without changing the zoom factor or viewing perspective.

Summary of 3D movement procedures
• To tilt the image backward or forward, press left mouse button and drag toward the 

top of the image window (to tilt backward) or bottom (to tilt forward).

• To tilt the image side to side, press left mouse button followed by right mouse button 
and drag to the left (to tilt left) or right.

• To the zoom the image in or out, press right mouse button and drag toward the 
bottom of the image window (to zoom in) or top (to zoom out).

• To rotate the image around it center axis, press left mouse button and drag the left 
or right side of the image (or bounding box) toward the edge of the image window.

• To move (or pan) the entire image within the window (without changing size or 
perspective), press right mouse button followed by left mouse button and drag to the 
desired location in the image window.
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Increase the vertical exaggeration of the image
1 With the 3D View tab selected (in the Algorithm dialog), click the Reset 

View button.

The 3D image perspective is reset to the initial default size and viewpoint.

2 In the Algorithm dialog, select the Surface tab.

The Surface tab contains controls that apply to the entire surface (such as Color 
Mode), and also controls for 3D perspective views.

3 Move the Z scale slider bar right to about it mid-point.

The image redisplays with increased vertical exaggeration, so high and low 
elevations in the image become more apparent. 

4 Try different vertical exaggerations by moving the Z scale slider bar left or 
right.

5 Change the value in the Zscale field to 300, then press Enter/Return.

The 3D image redraws at 3 times normal vertical exaggeration.

Note: ER Mapper interprets height values to be in the same units as X and Y distances. 
For example, if your X and Y distances are measured in meters (as in this case) and 
you set Z scale(%) to 100, a DTM value of 10 is interpreted as 10 meters (so 
elevation is true to geographic scale). However, much greater vertical exaggeration 
is often needed to clearly bring out subtle topographic details in low relief areas 
such as this part of San Diego.

slide bar right to increase
vertical exaggeration,
left to decrease (flatten)

change to 300
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Apply different rendering modes for the 3D image
1 Select the 3D View tab in the Algorithm dialog.

The 3D View tab page provides draw mode, terrain detail, lighting, and other 
options. These settings affect the entire 3D image (which can contain multiple 
surfaces as you will see later).

2 From the Draw Mode drop-down list, select WireFrame.

ER Mapper redisplays the image as a mesh connected grid lines. Wireframe is the 
fastest rendering mode, so the image regenerates quickly.

3 For Draw Mode, select Textured.

ER Mapper redisplays the image in blocks using a texture algorithm. (If your 
computer’s graphics adapter has built-in hardware texturing, ER Mapper uses this 
capability to render the image quickly. If it does not, this mode requires the most 
calculations and may take some time for large images.)

4 For Draw Mode, select Smooth Shaded again.

ER Mapper redisplays the image with a smooth, solid fill.

Use the Lighting and Bounding Box options
1 Turn on the Lighting option.

The image redraws with artificial illumination from a light source, so it has a 
“shiny” quality to it.

2 Turn the Lights option off again.

The image redraws without shading effects from a light source. (Lighting is 
recommended when displaying geophysical or digital terrain images in color layers 
because they have no natural shadowing.)

Tip: You can control the amount of shininess and the material qualities used for the 
Lights option by selecting the 3D Properties tab.

3 Turn on the Bounding Box option.

The image redraws with a bounding box surrounding it. The box shows the extents 
of the image in the X, Y and Z (vertical) directions.

4 Turn off the Bounding Box option.
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Adjust the amount of Terrain Detail
1 Move the Terrain Detail slider to the right until it reads “3 Mb of memory 

required for 509 x 509 terrain detail” under the slider bar.

The image redraws with increased detail in the terrain.

2 Move the Terrain Detail slider all the way to the left.

The image redisplays with the lowest detail (128 x 128).

Terrain Detail refers to the resolution, or amount of detail, at which the image will 
be rendered. As you increase the detail, the rendering time, number of regeneration 
iterations, and amount of system memory needed also increase. It is recommended 
that you start at low detail settings, then slowly increase the detail to get a more 
accurate, high resolution image. This setting can also be important when printing 
3D images to hardcopy, where you may want to use higher settings to get more 
detailed images.

Save the 3D algorithm
1 Adjust the viewpoint of the image to a pleasing position.

2 In the Algorithm dialog, change the Description field text to:

San Diego Landsat RGB=541 in 3D perspective

3 On the main menu, click the blue Save As  button.

4 In the Files of Type: field (on the Save As dialog), select ‘ER Mapper 
Algorithm (.alg)’.

5 From the Directories menu, select the \examples path.

6 Open the ‘Miscellaneous’ and then the ‘Tutorial’ directory.

7 In the Save As: text field, enter your initials followed by the text 
Digital_terrain_3D and separate each word with an underscore (_). 

8 Click OK to save the algorithm.

Your 3D perspective algorithm is now saved to an algorithm file on disk. The next 
time you open it, the image automatically displays in 3D with the same viewpoint 
and rendering parameters.
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2: 3D flythrough basics

In 3D Flythrough mode, it is as though the ground is stationary and you move 
around it, exploring the terrain. You depress the mouse button to begin your flight 
through the image, and the area where you position the mouse cursor controls the 
direction and speed of your flight.

Open a standard 3D view algorithm

1 On the main menu, click the Open  button.

2 From the Directories menu (on the Open dialog), select the \examples 
path.

3 Double_click on the ‘Functions_And_Features’ directory to open it, then 
open the ‘3D’ directory.

4 Double-click on the algorithm ‘Landsat_over_DTM.alg’ to open it.

This algorithm displays smaller Landsat TM satellite image of San Diego in 3D 
perspective (with Lights on).

Select 3D Flythrough mode to move through the image in 3D
1 From the ‘View Mode’ menu (on the Algorithm dialog), select 3D 

Flythrough.

The image re-renders from a side view.

Fly through at different directions and speeds
To fly through the image, depress the left mouse button and point to an area of the 
image window to control the direction and speed of the flight. As you fly through 
the image, the terrain will appear to move in the opposite direction of your motion.

1 Point to the lower center of the image window and depress the left mouse 
button.

You fly backward away from the image, and the detail regenerates when you 
release the mouse.

2 Point to the upper center of the image and depress the left button.

You fly forward toward the image.

Objective Learn to view an image in 3D Flythrough mode, and control the viewpoint and 
flight parameters.
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3 Point to the right center of the image and depress the left button.

You fly toward the right side of the image.

4 Point to the left center and depress the left button.

You fly back toward the left side of the image.

5 Point to the lower-right corner of the window and depress the left button.

You fly backward and to the right away from the image.

6 Point slightly above the center point of the window and depress the left 
button.

You fly forward slowly into the image. 

Tip: To fly slowly, point near the window center. To fly faster, point further out toward 
the window edges.

Change the viewing altitude
1 Point to the center of the image, depress the right mouse button and drag 

slightly upward.

Your altitude increases, so you look more down on the 3D image. 

2 With the right button depressed, drag slightly downward.

Right-dragging up or down lets you change viewing altitude.

Tip: With a little practice, you can become very good at precisely controlling your flight 
path and altitude. If you become lost while flying around, click the Reset View 
button to return to the default viewpoint again.

Summary of 3D Flythrough controls
• To fly forward or backward, press the left mouse button in the top half of the image 

window (to fly backward) or bottom half (to fly forward).

• To fly left or right, press the left mouse button in the left half of the image window 
(to fly left) or right half (to fly right).

• To the change viewing altitude, press the right mouse button and drag up or down.

• To control the speed of flight, point close to the center of the window for slow speed, 
and further out toward the window edges for progressively faster speeds.
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Note: In 3D Flythrough mode, you can also add “fog” to the image display by selecting 
the 3D Properties tab. Fog is only available in 3D Flythrough mode.

Add Fog to your 3D flythrough view
The fog options are set on the 3D Properties tab in the Algorithm dialog.

1 In the algorithm dialog select the 3D Properties tab. This tab will be active 
only when you are in the 3D Flythrough mode

2 Set the color of the fog. Click on Fog Color and use the normal ER Mapper 
Color Chooser to select the color. 

3 Select a fog type:

4 Set the Fog Density.

5 Select the Fog checkbox to turn the fog on.

The image is displayed with the selected fog.

3: Point profiling in 3D
You can use a 3D cursor to roam the 3D image and read the coordinates 
corresponding to points on a surface.

1 In the main ER Mapper toolbar click on the Pointer Tool button. 

2 Point the cursor over the image and press the mouse button. Move the 
cursor around.

The cursor will become a 3D cross hair, shaped to the terrain, and moving over the 
terrain as you move the cursor. One leg of the crosshair has an arrow which points 
to grid north for registered images. With multiple surfaces there is a vertical line 
through the center of the cursor so you can line up features on different surfaces.

Default Creates a blanket of fog which covers the entire 
window.

Linear Creates fog conditions that increase gradually with 
distance. The fog is thicker in the background than 
in the foreground.

Exponential Increases fog tenfold with distance.
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Note: The image must finish regenerating completely before the 3D cursor will appear.

3 Make sure the Height layer is the current layer in the Algorithm dialog.

4 From the ER Mapper main View menu, select Cell Coordinate.... As you 
point and click your cursor over the image read the value of the Height layer 
in the Terrain Height display. 

5 To change the color of the 3D cursor, select the 3D View Tab In the 
Algorithm dialog and click the 3D Cursor button.

4: Viewing multiple surfaces in 3D

Up until now, you have created algorithms that contained only one surface. In a 
sense, you can think of each surface as a separate image, or a separate view of your 
data. Since you use an algorithm to create a certain type of image, you can copy or 
merge different types of algorithms as separate surfaces in a single algorithm and 
stack the images in a single 3D view. Stacking multiple surfaces into a single 3D 
view lets you quickly see relationships between images in 3D. 

Open a DTM 3D color algorithm

1 On the main menu, click the Open  button.

2 From the Directories menu (on the Open dialog), select the \examples 
path.

3 Double_click on the ‘Functions_And_Features’ directory to open it, then 
open the ‘3d’ directory.

4 Double-click on the algorithm ‘Digital_Terrain_Map_Colordrape.alg’ to open 
it.

This algorithm displays a DTM of the San Diego downtown area. The same image 
is used in both the Height and Pseudo layers, so the DTM data is shown as relief 
and also color coded (reds are high elevations, blues are lows).

Objective Learn to view two or more surfaces in 3D perspective, and control the offset, 
transparency, and other parameters of the view.
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Tip: You can use any type of data in the Height layer of an algorithm. For example, a 
vegetation index image would create high elevations in the 3D image where 
vegetation was most abundant.

Open a Landsat 3D algorithm as a second surface
You can easily add a surface to an existing algorithm by opening another algorithm 
into it as a separate surface (transfer its layers to the current algorithm).

1 On the main menu, select Open into New Surface from the File menu.

The Open into New Surface dialog opens.

2 From the Directories menu, select the \examples path.

3 Open the ‘Functions_And_Features’ directory, then open the ‘3D’ directory.

4 Double-click on the algorithm ‘Landsat_over_DTM.alg’ to open it.

ER Mapper loads the algorithm into a second surface and renders the image 
underneath the 3D color DTM image. The new algorithm shows Landsat TM bands 
5, 4 and 1 in RGB. Your algorithm now has two surfaces:

Notice that the two surfaces have different color modes (indicated in the surface 
name–[Ps] for Pseudocolor and [RGB] for Red Green Blue). Each surface can have 
its own color mode, color table or other settings independent of others.

Change the Z Offset to shift the surface in 3D space

1 Click the Hand Tool  button (if needed), then tilt the 3D image up 
slightly to view it more from the front side (so that the gap between surfaces 
is more apparent).

first surface (from
original DTM color

second surface (added
from Landsat 3D

algorithm)

algorithm)
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2 On the Algorithm dialog, select the lower Landsat surface ([RGB:Landsat 
TM]) icon in the data structure diagram, then select the Surface tab.

3 Move the Z Offset slider all the way to the right.

The Landsat image created by the lower surface slides up above the DTM image.

4 Move the Z Offset slider to the far left.

The Landsat image slides below the color DTM image again. To move a surface 
relative to other surfaces in an algorithm, select the surface in the data structure 
diagram, then move the Z Offset slider. (You could also select the top surface and 
move up or down it relative to the lower surface’s image if desired.)

Change the transparency of the top surface
1 Tilt the 3D image downward slightly until the top surface mostly covers the 

one below.

2 Select the top surface ‘[Ps]:Default Surface’ in the data structure diagram.

3 Move the Transparency slider right to its midpoint.

The color DTM image becomes semi-transparent, so some of the color of the 
Landsat image below shows through.

The Transparency setting ranges from 0-100 to specify how the image is 
“blended” with other surfaces in the image window. Zero displays the full image, 
50 creates 50% transparency, and 100 makes the image invisible. Each surface can 
have it own transparency setting independent of others.

4 Move the Transparency slider to the far left to make the image fully visible.

select surface, click Surface tab
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Turn individual surfaces on and off
1 Right-click on the icon for the top surface, and select Turn Off.:

ER Mapper renders only the lower surface (the Landsat image).

2 Turn the top surface on again.

Both surfaces are again rendered.

Delete the lower surface from the algorithm
1 Select the lower surface in the data structure diagram, then click the Cut 

 button (above the diagram) to delete it.

ER Mapper renders only the color DTM image.

Open a second image window and algorithm

1 On the main menu, click the New  button.

right-click and
select Turn Off

select surface, then Cut
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Drag the new window down below the first one.

2 On the main menu, click the Open  button.

3 From the Directories menu, select the \examples path.

4 Open the ‘Functions_And_Features’ directory, then open the ‘3d’ directory.

5 Double-click on the algorithm ‘Landsat_over_DTM.alg’ to open it.

This is the same algorithm as that you used earlier.

Copy and paste the surface into the first algorithm
1 Select the surface icon in the Landsat 3D algorithm, then click the Copy 

 button (above the data structure diagram).

The surface and its layers are copied into the clipboard.

2 Activate the color DTM 3D image window.

3 Click the Paste  button.

The surface and its layers are pasted into the DTM algorithm as a second surface.

(In this case the Z Offset settings are such that the lower levels of the DTM image 
are hidden by the Landsat data.)

Tip: To add surfaces to an existing algorithm, you can choose Open into New 
Surface from the File menu, or copy and paste surfaces between image windows. 
You can also copy and paste layers or surfaces within the same algorithm and 
modify them as desired, or a new empty surface and load images and specify 

processing as needed (using Add New Surface or  on the Algorithm 

dialog).

Close both image windows and the Algorithm dialog
1 Close both image windows using the window system controls:

• Click the  Close button in the upper-right window corner.

2 Click Close on the Algorithm dialog.
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Only the ER Mapper main menu should be open on the screen.

• Prepare an algorithm for 3D viewing by adding a Height layer

• Change the viewpoint, zoom level, and other 3D view parameters

• Use the 3D Flythrough viewing mode

• Stack multiple surfaces in a 3D view and set surface offset and transparency

• Merge separate algorithms into surfaces in a single algorithm

General information on 3D viewing and printing

Notes about 3D rendering speed
ER Mapper can render very large image files quickly in 3D due to it’s progressive 
rendering technology (i.e., starting with a low resolution view and progressively 
increasing detail with subsequent processing iterations). However, large files can 
take much longer to render, especially at higher Terrain Detail settings and using 
Textured draw mode. The speed at which the image renders in 3D is proportional to 
the processing speed of your computer and the 3D capabilities of your graphics 
display card.

ER Mapper’s 3D viewer features are designed take full advantage of the latest 3D 
graphics hardware rendering technologies. If your graphics card has 3D 
acceleration, images will render much faster when using ER Mapper’s 3D view 
modes. Be sure to turn on 3D acceleration if your graphics card supports it.

Height layer data area of coverage
If the image in your Height layer covers only part of the area of the color layers, 
there will be no relief in those areas of the color image (they will be flat). If the 
Height image covers a larger area than the color image, the height data outside the 
extents of the color image is not used in the 3D image.

Printing 3D images
ER Mapper has the ability to print very crisp, high resolution 3D images that are 
much better than can usually be viewed on a screen display. To print a 3D image, 

simply choose File/Print or click the Print  button while the image is 

displayed in the active window. Higher Terrain Detail settings produce more detail 

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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in your output print and is usually desirable when printing very large images to get 
the full detail possible in the data. However, high Terrain Detail settings are 
sometimes not necessary and do increase the print time significantly.

When to use Lights option
For perspective views of geophysical data (such as magnetics or radiometrics) and 
digital terrain data, best results are obtained using Lights turned on. This is because 
these images have no inherent shadows, so artificial lighting enhances detail. 
Satellite images or airphotos look best with Lights off because these images have 
natural shadows inherent in the data.

Annotation of 3D images
You cannot draw annotation directly on an image in 3D Perspective or 3D 
Flythrough modes. Here are two options:

• Save the 3D view as an algorithm, then display the 3D image as an embedded 
algorithm map object on another image using the map composition feature. 

• Print the 3D image to an ER Mapper file, then display the resulting 3-band image in 
an RGB algorithm. For ‘Output Name’ on the Print dialog, select ‘ER_Mapper.hc’ 
in the ‘\hardcopy\Graphics’ directory. Once displayed in an RGB algorithm, you can 
then draw on the image but cannot change the perspective view.
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15

Composing
maps

This chapter explains how to use ER Mapper’s Page Setup and Map Composition 
tools to create top quality cartographic image maps. You will learn about setting up 
a page size and extents for your map, how to add map objects such as coordinate 
grids, scale bars, north arrows, and considerations for printing to hardcopy devices. 

About map composition
ER Mapper provides a complete set of map composition tools that let you easily 
transform images into top quality image maps. Your maps can include common 
map objects such as coordinate grids, scale bars, classification legends, north 
arrows, and more. You can use the annotation tools to draw lines, text, shaded 
polygons, and other vector objects. Your maps can also include other layers to add 
vector data from GIS systems, tabular data, or other external data. 

ER Mapper’s map composition also has an open design and is user-extendable 
customizable. You can add your own Postscript map objects to ER Mapper's map 
object library, such as company logos or north arrows, include external files and 
text, and many other types of data. You can also modify the default attributes of 
map objects and save them under your own unique names for later use.
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The following diagram shows the general procedure for creating and printing a map 
in ER Mapper:

Hands-on exercises
These exercises give you practice setting up an algorithm to create a map, defining 
Page Setup parameters, and composing the map by adding map objects and other 
annotation.

• Define Page Setup parameters for an algorithm

• Display GIS vector data over a raster backdrop image

• Add an Annotation/Map Composition layer to an algorithm

• Draw annotation objects (lines, text, polygons, etc.) on your map

What you will 
learn...

After completing these exercises, you will know how to perform these tasks in 
ER Mapper:

Image

Page

Compose

Save

Print

Create the desired image using algorithm

Compose the map by dragging and dropping the map

Save the vector map composition file, then save

Print the map on your printer or plotter, or

processing

Specify page setup parameters for the

processing, and any dynamic link vector
or tabular overlays to be included.

setup
algorithm to define its position on an output
page; margins, background color etc.

map objects, specifying object attributes, and
drawing annotation such as lines and text.

algorithm
the algorithm containing the annotation/map
composition layer and raster layers.

map save it to an external file format (TIFF, CGM etc.)
Comprehensive ER Mapper Training Workbook 247



Chapter 15 Composing maps ●  1: Setting up the page
• Place map objects (grids, scale bars, etc.) on your map

• Specify color and other attributes for annotation and map objects

1: Setting up the page

ER Mapper provides you with two ways of setting up a page. You can either use the 
Page Setup dialog box or the Page Setup Wizard. Both methods achieve the 
same results, but the Page Setup Wizard leads you sequentially through the 
required parameters. Both methods are described.

Display a Landsat/SPOT IHS merge algorithm

1 Click on the Open  toolbar button. 

An image window and the Open dialog box appear.

2 From the Directories menu, select the path ending with the text \examples.

3 Double_click on the ‘Functions_And_Features’ directory to open it.

4 In the ‘Data_Fusion’ directory, open the algorithm named 
‘Landsat_TM_and_SPOT_Pan_IHS_merge.alg.’

This algorithm displays bands 3, 2 and 1 of a Landsat TM image merged with a 
high resolution SPOT Pan image as an RGB “natural color” composite. The image 
covers the San Diego, California area. This is the image you will use as the basis 
for your map.

Tip: ER Mapper performs the IHS (Intensity-Hue-Saturation) merge technique 
interactively, so you can easily “fine tune” the image saturation or intensity in real-
time using the post-formula transforms for those algorithm layers. (This technique 
is also known as HSI.)

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to use ER Mapper’s Page Setup options to define the position of an image 
on an output page, and specify other options such as scaling parameters and 
background color.
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Open the Page Setup dialog box
If you would rather use the Page Setup Wizard, go directly to “Open the Page Setup 
wizard” on page 251.

1 From the File menu, select Page Setup.... 

The Page Setup dialog box opens. This dialog provides controls for you to 
position your image on an output page, specify map scaling, background color and 
more.

The white area shows the size of the output print area in red (the “page extents”), 
and the size and position of the image on the page in blue (the “contents extents”).

Specify how the page or map can be scaled
The Constraints drop-down list lets you specify how map objects are scaled 
relative to the output page. For any map, there are three constraints that will affect 
how your map looks.

These are:

• Page size for your final map

• Scale of the main imagery in your map

• Border size between the main imagery in your map and the edges of the page 

It follows that if you wish to specify any two of these, then the third value will be 
automatically updated by ER Mapper to ensure it fits. For example, if you use a 
8.5"x11" page size, and have settled on a 1:100,000 image scale, then there can be 
only one size of borders that will match these requirements.

So, in ER Mapper's page setup, you specify which of the three constraints are to be 
autovaried (that is, calculated automatically) by ER Mapper. You control the other 
two constraints.

• If you know the output page size, and the scale you wish to print, select Auto 
Vary:Borders.

• If you know the scale you wish to print, and the size of the borders you wish to have, 
select Auto Vary:Page.

• If you know the border size you want to have, and the output page size, select Auto 
Vary:Scale.

Typically you need to decide which parameters are most important for your map: a 
fixed page size, fixed borders, or a fixed map scale.

1 From the Constraints drop-down list, select Auto Vary:Borders.
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This tells ER Mapper that it can automatically change the size of page margins to 
accommodate any changes in map scale or page size. You will use this setting to 
create a 1:100,000 scale map on a US Letter size (8.5 x 11 inches) page. (Other 
Constraints options will automatically change page size or map scale if other 
parameters are changed.)

Snap Shot the current algorithm extents
1 Click the Snap Shot button.

ER Mapper updates the values in the Contents Extents fields. For example if 
you had zoomed in or out in your algorithm, Snap Shot updates the contents 
extents to match the current display extents of your algorithm.

Tip: You should typically use Snap Shot even if you have not zoomed or panned the 
image to make sure the page contents extents match the current extents of the 
algorithm. 

Specify the output page size
1 From the Size drop-down list, select US Letter.

ER Mapper enters the corresponding values in the Page Width and Height fields, 
and updates the new margin sizes. 

Also notice that the shape of the page extents (in red) matches the proportions of a 
US Letter size page. The contents extents (in blue) are positioned in the upper-left 
part of the page by default.

Specify the output map scale
1 In the Scale - 1: text field, enter the value 100000 then press Enter or 

Return to validate.

ER Mapper sets the page contents (the physical size of the image on the page) to 
print at 1:100,000 map scale and updates the relative size of the contents on the US 
Letter size page proportionally.

Position the contents on the page
1 Click the Horz Center button.

ER Mapper centers the page contents horizontally on the page.

2 Click the Vert Center button.
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ER Mapper centers the page contents vertically on the page. The image is now set 
to print in the exact center of the output page.

3 In the Border area of the dialog, edit the value in Top: field to read 50, then 
press Enter or Return to validate.

ER Mapper shifts the page contents upward slightly on the page. You can adjust the 
Border values to position your image as desired when creating your map.

Set the background color to white
1 Select the text in the Background Color field, type white, and press Enter 

or Return to validate.

ER Mapper sets the page background color to white (the areas of the page 
surrounding the page contents). If you will be printing on a device that has a white 
background, it is often helpful to set the background color to white while you are 
composing the map to get a better idea of the final output. (You can use the Set 
Color button as well to choose any arbitrary background color.)

Save the algorithm with the Page Setup parameters
1 Click OK on the Page Setup dialog to save your settings and close it.

2 From the File menu, select Save As... to save the algorithm under your own 
name.

3 Select ER Mapper Algorithm (.alg) for the Files of Type: field.

4 From the Directories menu, select the path ending with the text \examples. 

5 Double-click on the directory ‘Miscellaneous’ to open it.

6 Double-click on the directory ‘Tutorial’ to open it.

7 In the Save As: text field, type a name using your initials at the beginning, 
followed by the text ‘San_Diego_map.’ Separate each word with an 
underscore (_). For example, if your initials are “JR,” type in the name:

JR_San_Diego_map

8 Click OK to save the algorithm, which now includes your Page Setup 
parameters.

Open the Page Setup wizard
This is an alternative method of setting up the page. If you have already set up the 
page using the Page Setup dialog box, as described above, you can go directly to 
“2: Defining annotation objects” on page 255.

1 From the File menu, select Page Setup Wizard.... 
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2 Select the Algorithm displayed in current image window option on the 
wizard ’Introduction’ page, and click on the Next> button.

3 On the ‘Use a template’ page, select Define new values with this wizard 
and click on the Next > button.

Set the background color to white
1 Select the text in the Background Color field, type white.

ER Mapper sets the page background color to white (the areas of the page 
surrounding the page contents). If you will be printing on a device that has a white 
background, it is often helpful to set the background color to white while you are 
composing the map to get a better idea of the final output. (You can use the Set 
Color button as well to choose any arbitrary background color.)

2 Set the units to Metric (mm) and click on the Next > button.

Set the contents extents
1 Select Snapshot from current zoom, and click on the Next > button.

ER Mapper updates the contents extents to match the current display extents of 
your algorithm.

Tip: You should typically use Snapshot even if you have not zoomed or panned the 
image to make sure the page contents extents match the current extents of the 
algorithm. 

Set autovary parameter
The Set autovary parameter wizard page lets you specify how map objects are 
scaled relative to the output page. 

For any map, there are three constraints that will affect how your map looks.

These are:

• Page size for your final map

• Scale of the main imagery in your map

• Border size between the main imagery in your map and the edges of the page 

It follows that if you wish to specify any two of these, then the third value will be 
automatically updated by ER Mapper to ensure it fits. For example, if you use a 
8.5"x11" page size, and have settled on a 1:100,000 image scale, then there can be 
only one size of borders that will match these requirements.
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So, in ER Mapper's page setup, you specify which of the three constraints are to be 
calculated automatically by ER Mapper. You control the other two constraints.

• If you know the scale you wish to print, and the size of the borders you wish to have, 
select Set scale and borders (page size varies).

• If you know the output page size, and the scale you wish to print, select Set scale 
and page size (borders vary).

• If you know the border size you want to have, and the output page size, select Set 
borders and page size (scale varies).

Typically you need to decide which parameters are most important for your map: a 
fixed page size, fixed borders, or a fixed map scale.

1 Select Set scale and page size (borders vary), and click on the Next > 
button.

This tells ER Mapper that it can automatically change the size of page margins to 
accommodate any changes in map scale or page size. You will use this setting to 
create a 1:100,000 scale map on a US Letter size (8.5 x 11 inches) page. (Other 
options will automatically change page size or map scale if other parameters are 
changed.)

Specify the output page size
1 Select Choose from standard portrait sizes, and click on the Next > button.

2 From the Size drop-down list, select US Letter, and click on the Next > button 

Position the contents on the page
1 Select Center Horizontally.

ER Mapper centers the page contents horizontally on the page.

2 Select Center Vertically, and click on the Next > button. 

ER Mapper centers the page contents vertically on the page. The image is now set 
to print in the exact center of the output page.

Specify the output map scale
1 Select Type in the scale, and click on the Next > button.

2 In the Scale - 1: text field, enter the value 100000 and click on the Next > 
button.

ER Mapper sets the page contents (the physical size of the image on the page) to 
print at 1:100,000 map scale and updates the relative size of the contents on the US 
Letter size page proportionally.
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Add a vector layer to overlay a road network file
1 Select Add a vector layer.

2 Click on the Vector File: Load Dataset  button. 

The Select File dialog box opens to let you load a vector format file.

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Shared_Data’ directory to open it.

Notice that filenames displayed have ‘.erv’ file extension. This indicates that these 
files are in ER Mapper vector format (in contrast with raster files that have a ‘.ers’ 
file extension).

5 Scroll to view the file ‘San_Diego_roads.erv’ then double-click on it to load it 
into the vector layer.

ER Mapper adds a new layer labelled ‘Annotation Layer’ to the algorithm. 

Save the algorithm with the Page Setup parameters
1 Select Save algorithm to disk.

2 Click on the Save as: Load Dataset  button.

3 From the Directories menu, select the path ending with the text \examples. 

4 Double-click on the directory ‘Miscellaneous’ to open it.

5 Double-click on the directory ‘Tutorial’ to open it.

6 In the Save As: text field, type a name using your initials at the beginning, 
followed by the text ‘San_Diego_map.’ Separate each word with an 
underscore (_). For example, if your initials are “JR,” type in the name:

JR_San_Diego_map

7 Click OK to save the algorithm, which now includes your Page Setup 
parameters.

8 Click on the Finish button to close the Page Setup Wizard.
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2: Defining annotation objects

Open the Geoposition dialog box
1 Set the View Mode in the Algorithm dialog to Page Layout.

The image window displays the whole page with the image in Page Layout 
mode. If you select the Normal View Mode, it only displays the image.

2 From the View menu, select Geoposition....

The Algorithm Geoposition Extents dialog box opens. Move it to the lower-
right portion of the screen.

3 Select the Zoom tab to display buttons for zooming and panning.

Zoom to the Page Extents and Page Contents
1 On the Geoposition dialog, click the Page Extents button.

The image zooms out to the proportional extents of the page defined for the 
algorithm, and the image (the page contents) appears on a white background. 
Notice that there is some empty area on the right side (the stippled white pattern) 
because the US Letter page is taller than it is wide.

2 Expand the image window size to make it about twice as tall and 50% wider 
(so the shape approximately matches the shape of the white page extents 
area).

You will use this display later for placing map objects on the page.

3 On the Geoposition dialog, click the Page Contents button.

The image zooms in to the extents of the page contents (the extents of the image 
itself). You will first draw some annotation on the image in this display mode.

Add a vector layer to overlay a road network file

1 Click the Edit Algorithm  toolbar button to open the Algorithm window. 

Note: If you used the Page Setup Wizard to set up the page, as described above, you have 
already added the vector layer. Therefore you can go directly to step 7. 

Objectives Learn to use ER Mapper’s Annotation tools to display vector data from GIS 
systems, and draw annotation objects such as lines, polygons, and text. Also learn 
to zoom the image in or out to the page extents or page contents.
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2 On the Algorithm window, click on the Edit/Add Vector Layer button to 
display its list, then select Annotation/Map Composition.

ER Mapper adds a new layer labelled ‘Annotation Layer’ to the algorithm. Note 
that this layer has only three buttons in the process stream since it is designed to 
display and edit vector data, not perform image processing on raster images.

3 In the Algorithm window, click on the Load Dataset  button in it’s 
process diagram. 

The Load Annotation dialog box opens to let you load a vector format file.

4 From the Directories menu, select the path ending with the text \examples.

5 Double-click on the ‘Shared_Data’ directory to open it.

Notice that filenames displayed have ‘.erv’ file extension. This indicates that these 
files are in ER Mapper vector format (in contrast with raster files that have a ‘.ers’ 
file extension).

6 Scroll to view the file ‘San_Diego_roads.erv’ then double-click on it to load it 
into the vector layer.

7 In the Algorithm window, click the Edit Layer Color  button in the 
process diagram of the annotation layer. 

8 Pick a light blue color, then click OK to close the color chooser.

ER Mapper draws the vector file of roads as a blue overlay.

9 Change the layer description of the vector layer from ‘Annotation Layer’ to 
‘Downtown roads’ and press Enter or Return.

This is a simple example of displaying vector data from an external system in 
ER Mapper. (This image of roads was imported and translated into an ER Mapper 
format vector file using the menu command Utilities/Import Vector and GIS 
Formats.) ER Mapper also has direct links to many common vector GIS formats.

Tip: To edit the vectors (roads in this case), you could click on the Open Annotation 

editor  button in the layer’s process diagram. (Use of these tools is described 

in the next section.)

Add a second vector layer for map annotation
1 From the Edit menu (on the main menu), select Annotate Vector Layer.... 

The Open Map Composition dialog box opens and indicates that the algorithm 
already has a vector layer (displaying the roads image). You could choose to edit 
this layer, or add a new annotation layer.
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2 In the Open Map Composition dialog, click the New button.

The New Map Composition dialog opens to let you choose which type of vector 
annotation you want to create or work with.

3 Click the Vector File option under ‘Mode,’ then click OK on the New Map 
Composition dialog to close it.

ER Mapper opens the Tools palette dialog box containing your vector annotation 
and map composition tools. Also notice that a second vector layer titled 
‘Annotation Layer’ has been added to the layer list in the Algorithm window. This 
is the layer you will use to add your own annotation and map composition items to 
the image.

4 Click Close on the Algorithm window (you will not need it for the remainder 
of this exercise).

Draw two polylines on the image

1 On the Tools dialog, click on the Polyline  button.

2 Point to a linear feature inside the image (such as a road). Then draw a line 
to trace the feature by clicking once at each point, then double-clicking to 
end the line.

A blue line appears on your image to highlight the linear feature. (The default line 
color of blue comes from the annotation layer color.) Note that markers appear on 
the line at each node to indicate that the line is “selected.”

3 Point to another linear feature inside the image and draw a second line by 
clicking once at each point, then double-clicking to end the line.

A second blue line appears, and it is now selected.

Modify the attributes of the polylines

1 On the Tools dialog, double-click on the Polyline  button.

The Line Style dialog box opens to let you choose attributes for your polylines.

2 Click the Set Color button, choose a bright red color, then click OK to close 
the Color Chooser dialog.

The line color on your image changes to red.

3 Choose 2.0 from the Width drop-down list to increase the line width.

4 Click on a dashed line style under Line Pattern to select a line style.

The attributes for your selected polyline change interactively.
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5 On the Tools dialog, click on the Select/Edit Points Mode  button, then 
click on the first (blue) polyline on the image to select it.

Notice that the contents of the Line Style dialog change to show the attributes of 
the currently selected line (a color of blue and so on).

6 Click Close on the Line Style dialog.

7 Draw a third polyline on the image (it is selected when you finish).

8 In the Tools dialog, click the Delete Object  button.

The polyline object disappears from the image. Selecting an object and clicking 
Delete Object is how you delete any annotation object.

Tip: To create smooth, rounded curves from polylines made of straight line segments, 
you can apply a spline function to the line by turning on the Curved attribute after 
first drawing it. This is especially helpful when tracing roads and other smoothly 
varying linear features.

Draw a shaded polygon around the island

1 On the Tools dialog, click on the Polygon  button.

2 Point to the large island in the lower part of the image. Then draw a polygon 
around the island by clicking once at each point, then double-clicking to 
close the polygon.

The polygon object appears surrounding the island, and it is selected by default. (If 
your polygon is not selected, select it now.) Now you will change its color and 
specify a shade pattern to fill it.

3 On the Tools dialog, double-click on the Polygon  button.

The Line Style dialog box opens to let your set polygon attributes.

4 Click the Set Color button, choose a bright yellow color, then click OK to 
close the Color Chooser dialog.

5 Under Fill Pattern, click on one of the diagonal line fill patterns.

The pattern you choose appears in the Current Fill window on the dialog. The 
polygon becomes yellow and is filled with a diagonal shade pattern.

6 Click Close on the Line Style dialog.
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Draw a shaded oval and move and resize it

1 On the Tools dialog, click on the Oval  button.

2 Point anywhere inside the image, drag an oval shape and release.

A shaded yellow oval appears. By default, the oval is selected (blue handles appear 
at the four corners that define the oval extents).

3 On the Tools dialog, click the Select and Move/Resize Mode  button.

Select and Move/Resize Mode lets you move and/or resize the selected object. 
Notice that the oval’s selection handles change–now there are eight handles colored 
yellow.

4 Point inside the oval, and drag it to a new location.

By dragging the object (not by a handle), you can move it on the image.

5 Point to one of the rectangle’s corner handles and drag it to increase the 
rectangle size proportionally.

6 Point to one of the rectangle’s side handles and drag it to stretch or 
compress the oval.

Draw, modify and position text strings

1 On the Tools dialog, click the Text Object  button.

The Text Style dialog box opens.

2 Click in the dark area near the lower-left part of the image (ocean).

A small box with four selection handles appears–this is where your text will appear 
on the image.

3 In the Text Style dialog, click in the Text field at the bottom to position the 
cursor, then type Pacific Ocean. Press Return or Enter to validate.

The text appears on the image as you type.

4 In the Text Style dialog box, select the following text attributes:

corner handles - use to resize
the object proportionally

side handles - use to stretch
or compress object
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Size: 14.0

Color: choose any bright color

Font: Helvetica-Bold

Notice that the text object automatically updates as you change the attributes.

5 Click in the dark ocean area on the lower-right of the image.

6 In the Text Style dialog, click in the Text field to position the cursor, then 
type San Diego Bay. Press Return or Enter to validate.

7 From the Angle (deg) drop-down list, select 315.0.

The “San Diego Bay” text rotates 315 degrees counter-clockwise, so it now points 
down toward the lower right.

8 On the Tools dialog, click the Select and Move/Resize Mode  button.

9 Point to the text block, and drag it to an appropriate position inside the dark 
bay area on lower-right of the image.

You have now learned to draw and modify simple annotation objects such as lines, 
polygons, and text. Next you will add map objects to your page.

Tip: Text drawn as annotation can be set to always print at an exact point size (the 
Fixed Text option), or to scale up or down with the page when it is printed (the 
Page Relative option).

3: Defining map objects

Zoom to the Page Extents to view the entire map page
1 On the Geoposition dialog, click the Page Extents button.

The image zooms out to the extents of the page defined for the algorithm, and the 
annotation objects are redrawn at their proportional size. You can now add map 
composition objects to your page.

2 Click Close on the Algorithm Geoposition Extents dialog to close it.

3 On the Tools dialog, click on the Map Rectangle  button.

Objectives Learn to use ER Mapper’s Map Composition tools to place and modify map 
objects such as scale bars, coordinate grids, north arrows, and others.
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The Map Object Select and Map Object Attributes dialog boxes open on the 
right side of the screen.

These dialog boxes let you drag and drop map objects onto the page in your image 
window, and specify attributes for the objects.

Layout the types and positions of map objects
Before creating your map, it is a good idea to determine which types of map objects 
you want to use, and their relative sizes and positions on the page. In this exercise, 
you will create simple map with the following objects:

You will define these objects on the page in two ways:

• draw a bounding box and drag-and-drop the object into it; or

• drag-and-drop the object onto the page and resize the bounding box afterward

Use the diagram above as a guide for the size and position of bounding boxes for 
map objects you are asked to create in the next sections.

Add a scale bar centered below the image
1 Point to the area below the image on the page, and drag a short, wide 

bounding box centered below it (refer to the previous diagram for the size 
and position).

When you release the mouse, the box is selected and handles appear at the corners. 
This box will define the extents of your scale bar object on the page. (The box 
appears in the color you chose for the vector layer earlier.)
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2 In the Map Object Select dialog, select Scale Bar from the Category drop-
down list.

A list of icons representing various types of scale bar map objects appears. The 
name of the object is shown in the status line at the bottom of the dialog when you 
point to it.

3 Point to the icon titled Scale_Bar/Tick, drag it into the bounding box you 
defined in the image window, and release.

The scale bar object is “dropped” into the bounding box and it draws a few seconds 
later. The extents of your bounding box are now indicated by the yellow selection 
handles. The default attributes for the scale bar appear in the Map Object 
Attributes dialog box.

4 On the Map Object Attributes dialog, change the following attributes for 
your scale bar:

Start Scale at Zero: Yes

Number of Divisions: 4 (press Enter or Return afterward)

Show Scale: No

Left Align Scale Bar: No

Notice that the scale bar object automatically updates as you change the attributes. 
Turning off the left alignment centers the scale bar within your box.

Add a compass north arrow on the lower-right
1 In the Map Object Select dialog, select North Arrow from the Category 

drop-down list.

A list of icons representing various types of north arrows appears.

2 Point to the compass north arrow (North_Arrow/Compass), and drag it to 
a position just right of your scale bar.

The north arrow object drops onto the page and draws a few seconds later at a 
default size. If desired, make the arrow smaller by dragging the lower-right handle 
to resize the bounding box. 

Tip: ER Mapper’s north arrows are “smart” and will always point to north on a rectified 
image.
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Add a company logo on the lower-left
1 In the Map Object Select dialog, select Logo from the Category drop-

down list.

A list of icons showing some sample company logos appears.

2 Point to the ER Mapper logo icon, and drag it into a position left of the scale 
bar.

The logo object drops onto the page.

Tip: You can add your own company logos as Postscript files and access them from the 
standard Logos category used here.

Add a main title above the image
1 Drag a bounding box centered at the top of the image window (leave some 

space below it, refer to the previous diagram for the size and position).

2 In the Map Object Select dialog, select Title from the Category drop-
down list.

3 Point to the icon titled Title/Outline, drag it into the bounding box you 
defined above the image.

4 On the Map Object Attributes dialog, change the following text and 
attributes for your title:

Title: San Diego Image Map (press Enter or Return afterward)

Font Color: red

The title object automatically updates as you change the attributes.

Define an Eastings/Northings grid over the image
1 In the Map Object Select dialog, select Grid from the Category drop-down 

list.

2 Point to the Grid/EN icon, drag it onto the image.

The grid map object draws with a default position and attributes on the page.

3 On the Map Object Attributes dialog, click the Fit Grid button.

ER Mapper resizes and positions the grid to fit exactly to the extents of the image 
on the page. (If desired, you could resize and position it manually.)

4 On the Map Object Attributes dialog, turn on the Fast Preview option.
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Fast Preview tells ER Mapper not to update the object interactively as you 
change the attributes. (Since the grid is a complex object, you will change all the 
desired attributes first, then refresh the object all at once to save time.)

5 On the Map Object Attributes dialog, change the following attributes for 
your grid (use defaults for all others):

Grid Style: Full Grid

Grid Spacing X: 2,500 meters (2.5 km)

Grid Spacing Y: 2,500 meters (2.5 km)

Top labels orientation: Horizontal Right

6 On the Map Object Attributes dialog, turn off the Fast Preview option.

The grid map object is rendered using the attributes you defined.

Adjust the size or position of any object
If desired, you can easily resize or position any map object by moving or resizing 
the bounding box that contains it.

1 In the Tools palette dialog, click the Select and Move/Resize Mode  
button.

2 Click on any map object to select it (the handles will appear), and drag the 
bounding box to reposition it or change the size by dragging a handle.

Save the annotation/map composition file to disk

1 On the Tools palette dialog, click the Save As  button. 

The Map Composition Save As dialog box opens.

2 Select Vector File for the Save As option and click on the File Chooser 

 button to open the Save Map Composition File dialog.

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the directory named ‘Miscellaneous’ to open it.

5 Double-click on the directory named ‘Tutorial’ to open it.

6 In the Save As: text field, enter a name using your initials at the beginning, 
followed by the text ‘map_composition.’ Separate each word with an 
underscore (_). For example, if your initials are "KG," type in the name:

KG_map_composition

7 Click OK to save the annotation file to disk.
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The annotation file contains all the objects you defined–the vector lines, text and 
polygons you drew on the image, as well as the map composition objects, their 
attributes, and position and size on the page.

8 Click Close on the Map Object Attributes, Map Object Select, and Tools 
dialogs to close them.

Save the algorithm to update the changes
1 On the main menu, click the Save toolbar button.

2 When asked to confirm the overwrite, click OK.

Your algorithm can now be printed using the Print  toolbar button or by 

selecting Print from the File menu. 

Note: It is important to remember to save your algorithm after defining map objects. 
Otherwise the annotation file will not be part of the algorithm when you attempt to 
print it later.

Additional features of Map Composition
The preceding simple example covered only the basics of using ER Mapper’s Map 
Composition, and following are some additional features. Refer to the chapter on 
creating maps in the ER Mapper User Guide for complete information.

• If you drag an object into a bounding box that already contains an object, the old 
object is replaced by the new one. This is an easy way to try several north arrows, 
for example.

• Objects that are dragged and dropped to replace a current object automatically 
inherit any common attributes from the previous object. For example, if you have a 
red north arrow in a bounding box and then drag in a scale bar object, the scale bar 
automatically inherits the red color (since both objects have the “Color” attribute in 
common).

• You can modify the default attributes of map objects and save them under your own 
names (using Save As on the Map Object Attributes dialog).

• You can draw other image processing algorithms you’ve created as map objects on 
the page (using the Category: Algorithm on the Map Object Select dialog).

• You can plot objects from external files like TIFF, EPS, or Targa (using the 
Category: Image on the Map Object Select dialog)

• You can import text directly from ASCII text files and plot it on your map page 
(using the Category: Text on the Map Object Select dialog)
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Page Relative and Map Unit Relative map objects
The vector map objects you defined in this exercise have their position and size 
specified relative to the page, rather than to map units (such as Latitude Longitude). 
This allows you to create standard map sheets with objects that remain in a fixed 
size and position on the page, regardless of how the page is scaled or the extents of 
the images used in the page contents are changed.

You can also specify the position of map objects in geographic coordinate units. 
The position of each object is tied to a particular geographic location and map sheet 
size.

To specify a map object as map unit relative, turn off the Page Relative option on 
the Map Object Attribute dialog box. The page relative attribute can be assigned 
either before or after the object is dragged-and-dropped onto the page. See the 
ER Mapper User Guide for more information.

Printing your map
When you want to print your final map algorithm (using File/Print or the Print 

 button), ER Mapper asks for the name of the algorithm. When the print 

operation begins, ER Mapper automatically locates, processes and renders all the 
images used in the algorithm into one final print image. In this case, your map 
algorithm uses four images–a Landsat raster image, a SPOT raster image, a vector 
roads image, and a vector map annotation image (which you created).

Since the map algorithm is made of several layers (and images), you can easily 
change it. For example, to print the image without the road network overlay, simply 
turn off that layer in the algorithm, resave it, and print it.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.
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2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Define Page Setup parameters for an algorithm

• Display GIS vector data over a raster backdrop image

• Add an Annotation/Map Composition layer to an algorithm

• Draw annotation objects (lines, polygons, etc.) on your map

• Place map objects (grids, scale bars, etc.) on your map

• Specify color an other attributes for annotation and map objects

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Thematic raster
overlays

This chapter explains how you can create raster overlays in ER Mapper to display 
thematic data as solid or translucent colors over backdrop images. You will learn to 
use formulas, Classification layers, and other features. You can use these simple 
examples as the basis for developing more complex raster spatial modelling 
applications in ER Mapper.

About thematic overlays
ER Mapper’s algorithm processing approach allows you to interactively extract or 
derive data from multiple image bands (or from multiple images) and display the 
result in color over another image used as a backdrop. This type of display is 
commonly used to highlight areas meeting certain criteria in the context of a 
backdrop image used to show an overall view of an area. You can also define 
regions on scattergrams and highlight those pixels in color on an image.

The data for the color overlay can be derived interactively from a single image, or 
from multiple images when virtual datasets are used. For example, you could derive 
a sensitivity index based on slope and aspect from a DEM image and vegetation 
cover/type from a Landsat image, and display the result in color over a SPOT 
Panchromatic greyscale image used as backdrop. Any of the parameters can then be 
adjusted to modify the criteria and display the updated image.
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Hands-on exercises
These exercises give you practice using Classification and other raster layer types 
to display color overlays of thematic data. The thematic data can be extracted from 
one or more raster images using formulas, filters, and other means.

• Display raster thematic data in solid color over images

• Display raster thematic data in translucent color over images

• Use formulas to define criteria for displaying thematic color overlays

• Define a region of data values in a scattergram and highlight them on the image

• Display the three type of classes in three surface

1: Simple threshold overlays

Display a Landsat TM RGB algorithm

1 On the Standard toolbar, click on the Open  button. 

An image window and the Open Algorithm dialog box appear.

2 From the Directories menu, select the path ending with the text \examples.

3 Double_click on the ‘Data_Types’ directory to open it.

4 In the directory named ‘Landsat_TM,’ load the algorithm named 
‘RGB_321.alg.’

This algorithm displays an RGB color composite of bands 3, 2 and 1 of a Landsat 
TM image covering a portion of the San Diego, California metropolitan area. The 
dark areas in the lower portion are ocean.

What you will 
learn...

After completing these exercises, you will know how to perform these tasks in 
ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to add a Classification layer to an algorithm to display a feature defined by 
a threshold in one band of an image, or data derived from multiple bands such as 
a band ratio. In this case, you will derive thematic information on water and 
vegetation areas in a Landsat TM image and highlight them as color overlays.
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5 Click on the Edit Algorithm  button to open the Algorithm window. 

Add a Classification layer and load the Landsat image
1 On the Algorithm window, select Classification from the Edit/Add Raster 

Layer menu.

A Classification layer is added to the layer list.

2 Click the Load Dataset  button in the process stream diagram for the 
new layer to open the file chooser dialog. 

3 From the Directories menu, select the path ending with the text \examples.

4 In the directory named ‘Shared_Data’, load the image named 
‘Landsat_TM_year_1985.ers’.

This is the same image loaded in the RGB layers of the algorithm. You will use a 
formula to define a threshold one band of the image and display the result as a color 
overlay.

5 Turn off the classification layer by right-clicking on it and selecting Turn Off.

The classification currently covers the image with an all white layer. Turn it off for 
the moment to make the image visible.

Determine the threshold value for ocean areas
Next you will use traverse extraction to determine a data threshold between land 
and ocean areas of the image using band 5 of the Landsat data. You will use this 
information to highlight the ocean areas in color using the Classification layer.

1 From the View menu, select Traverse....

New Map Composition and Traverse dialog boxes appear.

2 On the New Map Composition dialog, be sure the Vector File option is 
selected, then click OK.

An ER Mapper warning dialog and the annotation Tools palette dialog appear. 
You will use the vector annotation tools to draw traverse lines on the image.

3 Click Close on the ER Mapper warning dialog to close it. (When using 
annotation tools for other purposes the default Fixed Page mode is not 
recommended, but it is fine for this exercise.)

4 On the Tools dialog, click the Annotation: Poly Line  button.

5 As shown in the following diagram, define a traverse line starting from the 
dark ocean area at the bottom and extending through to the land areas 
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beyond. (Click once at the start point, click once at the end point, then 
double-click to end the line definition.)

A profile line for band 1 appears inside the ER Mapper Traverse dialog. 

6 On the ER Mapper Traverse dialog, click the Bands:  button.

7 On the Traverse Band Selection dialog, press the Ctrl key on your 
keyboard, then click on B5:1.65_um in the list to select it.

8 Click OK on the Traverse Band Selection dialog.

A single profile for band 5 appears. Notice that the value in band 5 dips to less than 
20 in all areas of ocean, and jumps up to greater than 20 in land areas. TM band 5 
records middle infrared reflectance, which is typically very low in water areas due 
to strong absorption of infrared light. You will use this value of 20 as the threshold 
in your formula to highlight ocean areas.

Tip: You could also use the Cell Values Profile feature under the View menu to 
determine this threshold.

9 Click Close on the ER Mapper Traverse dialog to close it, then click Close 
on the Tools dialog to close it also.
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10 When asked to save the current annotation, click No.

Define a formula to mask water from land
1 Turn on the Classification layer by right-clicking on it and selecting Turn On.

2 With the Classification layer selected, click the Edit Formula  button in 
the process stream to open the Formula dialog box.

3 In the Generic formula window, edit the formula text to read:

if input1 < 20 then 1 else null

This formula tells ER Mapper “if the image data values in the selected band are less 
than 20, then set the value to 1, else set it to null.” Any pixels with a value less than 
20 are considered water, and 20 or greater are considered land.

4 Click the Apply changes button to validate the formula.

5 In the Relations window, select B5:1.65_um from the INPUT1 drop-down 
list.

The threshold formula now references band 5 of the Landsat image.

6 Click Close on the Formula Editor dialog to close it.

Choose an overlay color and name and display the image

1 In the process diagram, click the Edit Layer Color  button.

2 Choose a blue color, then click OK to close the Color Chooser dialog.

3 In the Classification layer’s text description field (on its left side), type the 
description text water areas and press Enter or Return.

The areas of ocean in the image are highlighted in a blue mask (areas where band 5 
values meet the criteria of being less than 20). Other areas that do not meet that 
criteria are assigned the value null by the formula, so the color composite image 
created by the RGB layers “shows through” the blue mask in those areas. 

Note: You may add additional Classification layers to display overlays in other colors 
meeting other criteria. Classification layers on top of the layer list take display 
priority over others below them. For example, if two Classification layers would 
cover overlapping areas, the color of the layer on top covers the color in the layer 
below it where the two overlap. The color of the lower layer is only visible where 
there is no overlap. (Classification layers always cover other raster layer types, 
regardless of their position among the other layer types.)
Comprehensive ER Mapper Training Workbook  272



Chapter 16 Thematic raster overlays ●  2: Translucent color overlays
2: Translucent color overlays

The concepts here are very similar to using Classification layers, but the color 
overlays can be translucent instead of opaque. This technique is based on the 
concept of colordraping (covered in another chapter) except that you are only 
showing color in areas that meet a certain criteria.

Display the SPOT Panchromatic greyscale algorithm in a new (second) 
surface

1 Click the right mouse button on the first surface.

A short-cut menu appears

2 On the Short-cut menu select the Turn Off option and turn off the first 
surface

3 On the main window, select Open into New Surface from the File menu.

4 The Raster Dataset dialog box appears.

5 From the Directories menu, select the path ending with the text \examples.

6 Double_click on the ‘Data_Types’ directory to open it.

7 In the directory named ‘SPOT_Panchromatic,’ load the algorithm named 
‘Greyscale.alg.’

This algorithm displays a high resolution SPOT Panchromatic satellite image of the 
San Diego area as a greyscale image.

Contrast stretch the SPOT Pan image
1 On the Algorithm window, click the post-formula Edit Transform Limits 

 button.

2 On the Transform dialog, click the Gaussian Equalize  button.

ER Mapper applies a Gaussian equalize contrast stretch to the data, so more detail 
appears in darker areas and the image appears lighter overall.

3 Click Close on the Transform dialog to close it.

Objectives Learn to use Intensity layers along with Red, Green, Blue, or Pseudocolor layers 
to create translucent color overlays that allow features underneath to show 
through the color (as opposed to the solid color overlays you used earlier). 
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Change the Pseudocolor layer to Intensity
1 Click the right mouse button on the Pseudo Layer.

A short-cut menu appears

2 On the Short-cut menu select Intensity 

The Pseudocolor layer changes to an Intensity layer. You will use this layer to 
create a greyscale backdrop image for your translucent color overlays.

The image does not change because displaying data in an Intensity layer by itself 
looks exactly the same as displaying the image in Pseudocolor with a greyscale 
lookup table.

Change the Color Mode to Red Green Blue
1 Click on the Surface tab 

The setting of the second surface appears

2 From the Color Mode drop-down list, select Red Green Blue.

You will be adding a Green layer next, so you will need to use Red Green Blue 
color mode to make it active (since Green layers are not valid with Pseudocolor 
color mode).

Add a Green layer and load the same Landsat image
1 On the Algorithm window, select Green from the Edit/Add Raster Layer 

menu.

A Green layer is added to the layer list.

2 Click the Layer tab on the Algorithm window

The process stream diagram of the layer appears

3 Click the Load Dataset  button in the process stream diagram for the 
new layer to open the file chooser dialog. 

4 From the Directories menu, select the path ending with the text \examples

5 In the directory named ‘Shared_Data’, load the image named 
‘Landsat_TM_year_1985.ers.’

6 In the Green layer’s text description field, type the description text green 
vegetation and press Enter or Return.
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Define a formula to highlight vigorous green vegetation

1 With the Green layer selected, click the Edit Formula  button in the 
process stream to open the Formula dialog box.

2 From the Ratios menu, select Landsat TM NDVI.

ER Mapper loads the Normalized Difference Vegetation Index (NDVI) formula for 
Landsat TM data into the Generic formula window.

3 In the Generic formula window, edit the formula text to read:

if (i1 - i2)/(i1 + i2) > threshold then 1 else null

This formula tells ER Mapper “if the data values generated by the NDVI formula 
are greater than a variable named ‘threshold,’ then set the value to 1, else set it to 
null.” You can now set the value to be used for the ‘threshold’ variable.

4 Click the Apply changes button to validate the formula.

5 Above the Relations window, click the Variables button.

The value currently assigned to the variable named ‘threshold’ (zero) displays in 
the Relations window.

6 Edit the value in the ‘threshold’ text field to read 0.4 and press Return or 
Enter.

Display the image with the translucent color overlay
The areas with NDVI values exceeding 0.4 are highlighted in a translucent green 
color. Areas with high NDVI values are generally parks, golf courses, or other areas 
with irrigated grass or other vigorous vegetation. 

Notice that the surface features show through the colored areas, so you still see 
underlying structure. This type of display technique can be valuable for 
highlighting features in color and still be able to analyze areas of interest 
underneath them. It is sometimes less distracting or more visually pleasing to 
identify features using translucent color than by using solid colors.

Tip: When using this technique, dark features underlying colored areas will not be as 
visible as brighter features. You may want to adjust the transform of the Intensity 
image to increase the brightness and visibility of these features.

Decrease the NDVI threshold variable in the formula
1 In the Formula Editor dialog, edit the value in the ‘threshold’ text field to 

read 0.3 and press Return or Enter.
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The areas with NDVI values exceeding 0.3 are highlighted this time, so more fringe 
areas and areas with less vigorous natural scrub vegetation are also displayed in 
green. Although this example is simple, it gives you an idea of how using variables 
can help you interactively test and develop raster spatial modelling applications.

2 Try other threshold values between zero and 0.5 if desired.

3 Click Close on the Formula Editor dialog to close it.

3: Slope and aspect overlays

Load a DTM image into a new (third) surface
1 Click the right mouse button on the second surface.

A short-cut menu appears

2 On the Short-cut menu select the Turn Off option and turn off the second 
surface

3 On the Algorithm window, click on the Add New Surface  button and 
add a new surface.

4 Click on the + sign of the new surface.

5 An inactive Pseudo Layer appears. 

6 Click on the inactive Pseudo Layer. 

7 Click the Load Dataset  button in the process stream diagram for the 
new layer to open the file chooser dialog.

8 From the Directories menu, select the path ending with the text \examples

9 In the ‘Shared_Data’ directory double click the file named 
‘Digital_Terrain_Model.ers’ and load the DTM image into the Pseudo Layer.

ER Mapper displays the DTM image of San Diego.

Create a colordrape image
1 Duplicate the Pseudo Layer of the ‘Digital_Terrain_Model.ers’ image by 

clicking the Duplicate  button on the Algorithm window.

Objectives Learn to create overlays that highlight specific ranges of slope and aspect in a 
digital terrain model (DTM). Also learn to use filters to generate slope and aspect 
images.
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2 Click your right mouse button on the duplicated Pseudo Layer.

3 The short-cut menu appears.

4 Select Intensity on the short-cut menu to change the Pseudo Layer to 
Intensity.

The Pseudocolor layer changes to an Intensity layer. You will use this layer to 
create a colordrape image.

5 Highlight the Intensity Layer.

6 On the Algorithm window, click the Edit Realtime Sunshade  button in 
the process stream.

The Edit Sun Angle dialog box opens to let you specify shaded relief effects for 
the Intensity layer.

7 Turn on the Do sun-shading option.

ER Mapper displays the colordrape image of the ‘Digital_Terrain_Model.ers’ San 
Diego DTM image.

Sun Angle shading is now active for the Intensity layer, and the Edit Realtime 

Sunshade button in the process diagram changes  to indicate this. 

Add a Classification layer and load the DTM image
1 On the Algorithm window, select Classification from the Edit/Add Raster 

Layer menu.

A Classification layer is added to the layer list.

click to turn
shading on/off

drag icon to
change sun
azimuth and
elevation

type in values
or click arrow
to increment

diagram showing
sun position
relative to horizon
(outer circle) or
overhead (center)
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2 Click the Load Dataset  button in the process stream diagram for the 
new layer to open the file chooser dialog.

3 From the Directories menu, select the path ending with the text \examples.

4 In the directory named ‘Shared_data’, load the image named 
‘Digital_Terrain_Model.ers’ by clicking the OK this layer only button on the 
Raster Dataset file chooser dialog. 

This is the same image loaded in the Pseudocolor and Intensity layers of the 
algorithm. Next you will load a filter to calculate slope from the San Diego DTM 
data, and then use a formula to display a specific range of slopes as a color overlay.

Load a filter to calculate slope in degrees
1 With the Classification layer selected, click on the pre-formula Edit Filter 

(Kernel)  button in the process stream diagram. (The pre-formula filter 
button is on the left side of the Formula button.)

2 From the File menu (on the Filter dialog), select Load.... 

The Load filter file chooser dialog box appears.

3 From the Directories menu, select the path ending with the text \kernel.

4 Double-click on the ‘filters_DEM’ directory to open it.

5 Double-click on the filter ’slope_degrees.ker’ to load it.

The filter settings are displayed in the dialog box fields. As indicated, this 3 by 3 
filter is written in C code, not using a weighted convolution array.

Slope is a measure of steepness of terrain, or the change in the vertical component 
of the DTM data. This slope filter generates data values in degrees from the 
horizontal, so the slope values range from 0 (flat terrain) to 90 degrees (vertical 
terrain). (ER Mapper also provides a filter to calculate slopes in percent.)

6 Click Close on the Filter dialog to close it.

Since your slope calculation is generated with a pre-formula filter, you can now use 
a formula to isolate a specific range of slopes for your thematic overlay.

Enter a formula to show slopes more than 30 degrees

1 Click the Open Formula editor  button in the process stream to open 
the Formula dialog box.

2 In the Generic formula window, edit the formula text to read:

if i1 > slope then 1 else null
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This formula tells ER Mapper “if the data values calculated by the slope filter are 
more than a variable named ‘slope,’ then set the value to 1, else set it to null.”

3 Click the Apply changes button to validate the formula.

4 Above the Relations window, click the Variables button.

5 Edit the value in the ‘slope’ text field to read 30 and press Return or Enter.

6 Click Close on the Formula Editor dialog to close it.

Specify a layer color and name and display the image

1 In the process diagram, click the Edit Layer Color  button.

2 Choose a yellow color, then click OK to close the Color Chooser dialog.

3 In the Classification layer’s text description field (on its left side), type the 
description text slopes > 30 degrees and press Enter or Return.

The surrounding areas of the San Diego with slopes more than 30 degrees are 
highlighted in yellow. (These are the steepest areas of terrain such as scarps.) Note 
that this image is 15 m resolution, so estimates of slope are generalized.

4 If desired, try different values between zero and 90 for your ‘slope’ variable 
in the formula to highlight different slope ranges.

Add a Classification layer to show south facing aspects
1 With the Classification layer selected, click the Duplicate button on the 

Algorithm window.

A copy of the first Classification layer is added to the layer list.

2 Click the Edit Layer Color  button, choose a red color, then click OK to 
close the color chooser.

3 Change the layer description text to read SE-SW aspects.

Load a filter to calculate aspect 
1 With the Classification layer selected, click on the pre-formula Edit Filter 

(Kernel)  button on the left side of the process stream diagram.

2 From the File menu (on the Filter dialog), select Load.... 

The Load filter file chooser dialog box appears.

3 From the Directories menu, select the path ending with the text \kernel.

4 Double-click on the ‘filters_DEM’ directory to open it.
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5 Double-click on the filter ’aspect.ker’ to load it.

The filter settings are displayed in the dialog box fields. As indicated, this 3 by 3 
filter is also written in C code.

Aspect is a measure of the compass direction a surface slope faces. This aspect filter 
generates data values in degrees clockwise from north, so aspect values range from 
0 to 360 degrees (a value of 361 degrees is also generated for a flat surface with no 
aspect). East-facing slopes have an aspect of 90 degrees, south facing slopes 180 
degrees, and west-facing slopes 270 degrees. (Aspect is similar to the term azimuth 
but refers directly to the orientation of slopes.)

6 Click Close on the Filter dialog to close it.

Enter a formula to show southeast to southwest facing slopes

1 Click the Edit Formula  button in the process stream to open the 
Formula dialog box.

2 In the Generic formula window, edit the formula text to read:

if i1 > aspect1 and i1 < aspect2 then 1 else null

This formula tells ER Mapper “if the data values calculated by the aspect filter are 
greater than a variable named ‘aspect1’ and less than a variable named ‘aspect2,’ 
then set the value to 1, else set it to null.”

3 Click the Apply changes button to validate the formula.

4 Above the Relations window, click the Variables button.

5 Edit the value in the ‘aspect1’ text field to read 135 and press Return or 
Enter, and edit the ‘aspect2’ value to read 225 and press Return or Enter.

The values 135 and 225 correspond to southeast and southwest on the zero to 360 
aspect scale, so the formula displays any slopes facing between those two compass 
directions.

6 Click Close on the Formula Editor dialog to close it.

7 Turn off the other Classification layer displaying the slopes.

0

90

180

270

225
(SW)

135
(SE)
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The algorithm now includes your color aspect overlay.

The surrounding areas of the San Diego with southeast to southwest facing slopes 
are highlighted in red. As you can see, these types of overlays and formulas provide 
very powerful and flexible tools for spatial modelling applications.

8 If desired, try different threshold values between zero and 360 for the 
‘aspect’ variables in the formula to highlight different aspect ranges.

4: Displaying algorithms on multi-surfaces 
and applying transparency

1 Click your right mouse button on the first surface

The short-cut menu appears

2 On the short-cut menu select the Turn On option and turn on the first 
surface.

3 Click your right mouse button on the second surface

The short-cut menu appears

4 On the short-cut menu select the Turn On option and turn on the second 
surface.

5 Click your right mouse button on the third surface

The short-cut menu appears

6 On the short-cut menu select the Turn On option and turn on the third 
surface.

Note: All the three surfaces are turned on.

7 Select the first surface and click on the surface tab

The settings in the first surface appear

8 Adjust the transparency to 50% for the first surface

The image in the first surface with 50% transparency is displayed on the image of 
the second surface. Adjust the Transparency(%) and see the affect of the 
transparency on first and second surfaces.

Objective Learn to use the transparency option and apply it on different surfaces
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5: Scattergram region overlays

Open a Landsat TM RGB algorithm

1 Click on the Open  toolbar button. 

2 From the Directories menu, select the path ending with the text \examples.

3 In the ‘Data_Types’ directory named ‘Landsat_TM’, load the algorithm 
named ‘RGB_321.alg.’

This algorithm displays bands 3, 2 and 1 of an Landsat TM satellite image of the 
San Diego area as a color composite image.

View a scattergram of the image data
1 From the View menu, select Scattergrams....

The Scattergram dialog box and New Map Composition dialog boxes open.

(If the algorithm page setup mode is ‘fixed page,’ you may see a third dialog 
warning about annotation in this mode. If so, click Close to close it.)

2 Click Cancel on the New Map Composition dialog to close it (you do not 
need it for this exercise).

The Scattergram dialog automatically references the image in the active image 
window (‘Landsat_TM_year_1985’). By default, the band 1 data values are shown 
on the X axis, and band 2 values on the Y axis.

Revise the scattergram bands and limits
1 In the Scattergram dialog, click the Setup... button.

The Scattergram Setup dialog opens.

2 From the Y Axis drop-down list, select B5:1.65_um.

3 Click the Limits to Actual button to set the X and Y axis limits to the actual 
limits of the band 1 and 2 data ranges.

The scattergram is redisplayed to fill the window. TM bands 1 and 5 are not 
strongly correlated, as indicated by the wide dispersion of points.

Objectives Learn to define a cluster of data values in a scattergram to highlight those pixels 
in a color overlay on a corresponding image window.
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Draw a region box on the scattergram to highlight ocean
Notice that the scattergram shows a dense cluster of data values near the axis 
origins in the lower-left corner–these represent the ocean areas on the image. Ocean 
areas typically have lower reflectance than land areas, and there is a dense cluster 
here because this image contains significant areas of ocean.

1 In the Scattergram dialog, point to the dense cluster and drag to define a 
small box around it.

When you release the mouse, ER Mapper runs the algorithm again and then draws 
a solid color over pixels in the image window whose data values fall within the box 
limits you defined on the scattergram. By default, the overlay is drawn in red.

Also notice in the Algorithm window that ER Mapper has added a Classification 
layer to the algorithm titled ‘Scatter region.’ It added this automatically and entered 
a formula to define the data limits you specified by dragging the box.

Refine the region box on the scattergram
Notice that the small box on the Scattergram dialog is selected (it has “handles” 
at the four corners). You can move or resize the box using the mouse.

1 In the Scattergram Setup dialog, turn on the Defer Display option. 

This tells ER Mapper to delay updating the scattergram until you finish changing 
the desired options (moving or resizing the region box in this case).

2 On the Scattergram dialog, resize your region box by dragging a handle, or 
move the box by pointing inside it and dragging to a new location.

3 After revising the box, click the Display button in the Scattergram Setup 
dialog. 

drag a box over
dense cluster
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ER Mapper redraws the box and updates the color overlay on the image to reflect 
the new pixels falling within the box’s data limits.

4 Change the box location or size to highlight other clusters of pixels in the 
scattergram, then click Display to highlight them on the image window.

Delete the scattergram region
1 With the region box selected, click Delete Region on the Scattergram 

Setup dialog.

ER Mapper deletes the region box from the scattergram, and deletes the 
Classification layer from the algorithm.

Close the scattergram dialogs
1 Turn off the Defer Display option.

2 Click Cancel on the Scattergram Setup dialog to close it, then click 
Cancel to close the Scattergram dialog.

3 When asked whether to delete the scattergram layers from the current 
algorithm, click Yes.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Display raster thematic data in solid color over images

• Display raster thematic data in translucent color over images

• Use formulas to define criteria for displaying thematic color overlays

• Display algorithms on multi-surfaces and applying transparency on upper surface/s

• Define a region of data values in a scattergram and highlight them on the image

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Creating image
mosaics

This chapter explains how to create algorithms to display and process two or more 
separate image datasets as a mosaic. You will learn how ER Mapper approaches the 
concept of mosaicing and how to build an image mosaic algorithm. 

ER Mapper 6.0 introduced the Image Display and Mosaicing Wizard and the 
Color Balancing Wizard for Airphotos which simplified image mosaicing to a 
large extent. The exercises in this chapter show you how to mosaic and balance 
images manually and by using the wizards. The manual exercises are included to 
give you background knowledge and can be skipped over.

About creating mosaics 
In the context of remote sensing, a mosaic is an assemblage of two or more 
adjacent or overlapping images to create a continuous representation of the area 
covered by the images. You might, for example, create a mosaic of several 
overlapping satellite scenes or aerial photos to cover a larger geographic area. The 
process of creating image mosaics is very simple in ER Mapper once the images 
are rectified to the same coordinate space. Any number of co-registered images 
used in the same processing algorithm are automatically displayed in their correct 
geographic positions relative to each other. 
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Image requirements for creating mosaics
In order for ER Mapper to create a mosaic, each of the images must have the 
following in common:

• they must be registered to the same geographic datum 

• they must be registered to the same map projection 

• they must be rotated the same amount from north (if rotation is used). 

You will learn how to rectify images to datums and map projections later. 

ER Mapper mosaic capabilities 
Other than having a common datum and map projection, you can create mosaics 
that contain very different types of data. An image mosaic can be built with datasets 
that have:

• different numbers of bands (i.e., seven for Landsat TM versus three for SPOT XS)

• different data formats (i.e., byte format versus floating point format) 

• different resolutions or cell sizes (i.e., 30 meter versus 10 meter). 

Image display priority
By changing the order of the algorithm layers containing the separate image 
datasets, you can control dataset display priority (that is, which images appear on 
top of others in the event of overlap). Images loaded into the uppermost layer of 
any type always appear on top of any other images in layers below where overlap 
occurs between them. 

Images loaded into the lowest layer of any type always have the lowest display 
priority and will only be visible in areas where there is no overlap from datasets in 
layers above them. For example, if you are mosaicing a high resolution image with 
one of lower resolution, you can display the entire extents of the high resolution 
image by putting its layer(s) on top in the algorithm layer list.

Note: Layer priority only applies to raster layers; vector layers always appear on top of 
raster layers regardless of their position in the algorithm layer list. 
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Hands-on exercises
These exercises show you how to create greyscale and RGB image mosaic 
algorithms, and how to use histogram matching and feathering to help balance 
image contrast and blend seam lines between images.

• Create an image mosaic by building an algorithm containing two or more sets of 
layers of the same type 

• Specify different processing for each image in the mosaic

• Specify image priority for the mosaic (which images appear on top of others in the 
event of overlap)

• Use histogram matching and feathering to minimize seams in mosaics

1: Creating a greyscale image mosaic

Note: The sample images used in the following exercise were previously rectified to the 
same map projection, so they can be displayed together in a mosaic.

Select files to display and mosaic
1 On the Common Functions toolbar, click the Image Display and 

Mosaicing Wizard  button.

The Select files to display and mosaic page of the Image Display and 
Mosaicing Wizard opens

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how display several overlapping images in different Pseudo layers to create 
an image mosaic, and learn to specify image priority in areas of overlap.
Comprehensive ER Mapper Training Workbook  288



Chapter 17 Creating image mosaics ●  1: Creating a greyscale image mosaic
2 Click the Load Image  button.

The Select File dialog opens.

3 From the Directories menu (on the Select File dialog), select the 
\examples path. 

4 Double_click on the ‘Applications’ directory to open it.

5 Double_click on the ‘Airphoto’ directory.

6 Open the ‘3_Balancing’ directory.

7 Double-click on the image dataset ‘ADAR_Del_Mar_1.ers’ to select it.

This dataset is a high resolution image covering a portion of Del Mar, California 
near San Diego. This dataset is a multispectral image acquired by the ADAR 5000 
system mounted on an aircraft. The data values represent reflectance of light in 
three different wavelengths (similar to a multispectral satellite image). 

8 Select the following options on the wizard page:

9 Click on the Next> button to go to the next wizard page.

Display image in 2D Image will be displayed in a 2D mode.

Manually set display method Enables you to set how the image is to be 
displayed. If you do not select this option, 
the wizard will set the display method.

Mosaic all files of this type The wizard will search for files of the 
same type and automatically mosaic them.

Manually set mosaic method Enables you to set how the images are to 
be mosaiced. If you do not select this 
option, the wizard will set the mosaicing
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Select file types to mosaic
This page allows you to specify the characteristics and location of image files that 
the wizard must search for to mosaic with the image already selected. 

1 Select the Manually set mosaic properties option. Do not select the other 
options on the page. 

The images to be mosaiced all have the same cell sizes, data types and number of 
bands. They are also in the same directory.

2 Click on the Next> button to go to the next wizard page.

Select mosaic properties
This page allows you to specify properties of the mosaiced image. 

1 Select the Feather blend mosaic between images options. Do not select 
the other two options.

To simplify the exercise, we will not be defining and using stitch regions.

2 Click on the Next> button to go to the next wizard page.

Select display method
This page allows you to specify how you want the mosaiced image to be displayed. 
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1 Select the Greyscale display option and Manually select display method 
properties.

2 Click on the Next> button to go to the next wizard page.

Select display band
This page allows you to select the image band to display as a greyscale. 

1 Select band B1 from the drop-down menu.

2 Click on the Next> button to go to the next wizard page.

Mosaic and display the images
The wizard searches the current directory and mosaics and displays the following 
images:

• ADAR_Del_Mar_1.ers

• ADAR_Del_Mar_2.ers

• ADAR_Del_Mar_3.ers

1 For the moment, leave the Image wizard has finished page open.

2 Drag the lower border of the image window downward about 50%.

3 Right-click in the image window, select Quick Zoom, then Zoom to All 
Datasets.

ER Mapper zooms out to show the full extents of all three ADAR images. 

Since this image mosaic is taller than it is wide, increasing the window’s width 
would have created a large unfilled area on the right side. This is an example of 
shaping the window to best fit a particular image display.
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4 On the main menu, click the Edit Algorithm  button.

The Algorithm dialog box opens.

You now have a algorithm that displays band 1 of each dataset as a greyscale image 
mosaic.

5 If necessary, use the Move Up and Move Down  buttons to 
arrange the layers so that they are as shown in the diagram above.

Turn the center image on and off 
1 Right-click on the middle ‘Pseudo Layer’ and select Turn Off.

Only the top and bottom images display (since the center image is turned off).

2 Right-click on the middle ‘Pseudo Layer’ and select Turn On.

The center image redisplays in its appropriate geographic position again. Any 
images in a mosaic can be displayed or not displayed by turning their layers on or 
off.

Zoom in to the geographic extents of any image dataset
1 Widen the image window

2 Select the top ‘Pseudo Layer’ (‘ADAR_Del_Mar_1’) in the algorithm.

3 Right-click in the image window, select Quick Zoom, then Zoom to 
Current Dataset.
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ER Mapper zooms in to the full extents of the ‘ADAR_Del_Mar_1’ dataset (but 
also displays part of the lower dataset that occupies the same extents).

Zoom to Current Dataset lets you instantly zoom in or out to the extents of any 
raster image dataset(s) in the currently selected layer, so it is very useful for mosaic 
algorithms.

2: Creating an RGB image mosaic

We use the Image Display and Mosaicing wizard to re-display the existing 
greyscale mosaiced image as an RGB image.

The final page of the wizard should still be open from the previous exercise.

Change the image display method
1 Select the Back to Change display method button from the still open 

Image Wizard has finished wizard page.

2 On the Select display method page, select the Red Green Blue option.

3 Click on the Next> button to go to the next wizard page.

4 Select RGB 123 as the Red Green Blue display mode type. 

This option allocates band 1 to Red. band 2 to Green and Band 3 to Blue.

Objectives Learn how display several overlapping images in different sets of red, green, and 
blue raster layers to create an RGB image mosaic. 
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5 Click on the Next> button to mosaic and display the images, and to go to 
the final wizard page.

The wizard will now display the mosaiced image in RGB mode.

6 Click on the wizard Finish button to exit the wizard. Do not close the image 
window yet.

3: Color balancing the mosaic

Open the Image Balancing Wizard for Airphotos

1 Click on the Image Balancing Wizard for Airphotos  button on the 
Common Functions toolbar to open the wizard.

The wizard processes the currently active image window which you left open after 
the previous exercise

2 Click on the Next> button to go to the next wizard page.

Objectives Learn how to use the Color Balancing Wizard for Airphotos to color balance 
mosaiced images so that they interface seamlessly with one another.
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Analyze images for balancing
The wizard requires the images to be analyzed before it can do the balancing. The 
analysis information is stored in the image dataset header files. If the images have 
not yet been analyzed, the wizard will now do so.

1 Click on the Next> button for the wizard to analyze the images.

The wizard will calculate the statistics for the three ADAR images and write the 
information into their respective header files.

2 Click on the Next> button to go to the next wizard page.

Select how to balance the images
In addition to color balancing, you also have a number of options for clipping the 
image. These are described below:

Original Remove any color balancing and display the 
unbalanced images.
The white boxes in the diagram show the extents 
of the individual images with their edges 
removed.

Balanced Display the balanced images but do not clip 
edges.

Balanced 
with no 
black/
white 
edges

Display the balanced images and remove the 
black or white edges. 
It is preferable not to select this option when 
balancing images that have very dark water, near 
the edges of the image. The color balancing 
wizard for airphotos may select too much of the 
image as dark edges to be removed. 
Note: Some images are supplied with their 
black edges already removed, in which case it is 
not necessary to select this option.
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1 Select the Balanced with clip regions option.

2 Click on the Next> button for the wizard to balance the images and go to 
the Color matching page.

The wizard will balance and clip the image. It will then display it in the image 
display window as the temp-balance algorithm.

Balanced 
with clip 
regions

When mosaicing images, compute clip regions 
to hide the edges between images. 
Clip regions are areas of overlap that are 
trimmed off to create a seamless join. The 
wizard re-computes the clip regions every time 
you run it.
By default, the wizard turns feathering ON for 
when balancing with clip regions, and OFF in all 
other cases.

Correct 
for water 
areas.

If your image has large areas with low contrast, 
such as water, they could be discolored by the 
balancing process. Select this option to prevent 
this happening.

Show clip 
regions as 
a vector 
overlay

Create a vector layer which outlines the clip 
regions.
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Color matching the image
You can choose whether you want the wizard to match the colors to the whole 
mosaiced image or to one of the images that are art of the mosaic. Alternatively you 
can skip the color matching altogether. For this exercise we will match the color to 
the ‘ADAR_Del_Mar_3.ers’ image.

1 Select the Match colors to individual file option, and then click on the 
Next button.

2 Use the file chooser button to select the image to which the colors are being 
matched. In this case we will select ‘ADAR_Dek_Mar_3.ers’. 

3 Select the Apply 99% clip option to improve the contrast and click on the 
Next button.

Caution: Do not select the Apply 99% clip option if you are going to compress 
the image. You will not be able to reverse it when the image is decompressed.

The wizard will display the status of the color matching. This can take some time to 
finish. It will then display the final balanced and matched image in temporary 
algorithm.

4 Click on the Finish button to exit the Color Balancing Wizard for Airphotos.
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Close the image window and Algorithm dialog
1 On the main menu, select Close from the File menu to close the image 

window.

2 Click Close on the Algorithm dialog.

Only the ER Mapper main menu should be open on the screen.

• Create an image mosaic using the Image Display and Mosaicing Wizard

• Use the Color Balancing Wizard for Airphotos to balance the mosaiced images.

4: Creating a greyscale image mosaic 
manually

The rest of the exercises in this chapter involve using manual methods for 
mosaicing images instead of using the wizards. We do recommend that you use the 
wizards where possible. These exercises have been included for background 
information, and you can skip over them if you so desire.

Note: The sample images used in the following exercise were previously rectified to the 
same map projection, so they can be displayed together in a mosaic.

Open a new image window and the Algorithm dialog

1 On the main menu, click the Edit Algorithm  button.

An image window and the Algorithm dialog box open.

2 Click the Surface tab (in the Algorithm dialog), and select greyscale from 
the ‘Color Table’ list.

3 Click the Layer tab again to display the process diagram.

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:

Objectives Learn how display several overlapping images in different Pseudo layers to create 
an image mosaic, and learn to specify image priority in areas of overlap.
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Load a dataset into the Pseudo layer

1 In the Algorithm dialog, click the Load Dataset  button in the process 
diagram.

The Raster Dataset dialog opens–move it below the image window (so the 
image window and Algorithm dialogs are visible).

2 From the Directories menu (on the Raster Dataset dialog), select the 
\examples path. 

3 Double_click on the ‘Applications’ directory to open it.

4 Double_click on the ‘Airphoto’ directory.

5 Open the ‘3_Balancing’ directory.

6 Click once on the dataset ‘ADAR_Del_Mar_1.ers’ to select it, then click the 
Apply button.

ER Mapper loads the dataset into the Pseudo layer and leaves the Raster Dataset 
dialog open (you will use it later load additional datasets).

This dataset is a high resolution image covering a portion of Del Mar, California 
near San Diego. This dataset is a multispectral image acquired by the ADAR 5000 
system mounted on an aircraft. The data values represent reflectance of light in 
three different wavelengths (similar to a multispectral satellite image). Band 1 of 
the three band dataset is displayed by default.

Create a mosaic by adding a second adjacent dataset

1 In the Algorithm dialog, click the Duplicate  button.

A copy of the Pseudo layer is added to the layer list.

2 In the Raster Dataset dialog, click once on the dataset 
‘ADAR_Del_Mar_2.ers’ to select it, then click the Apply this layer only 
button.

ER Mapper loads the dataset into only the selected Pseudo layer and leaves the 
Raster Dataset dialog open.

Duplicate button
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Note: Since the two Pseudo layers initially contained the same dataset, Apply or OK 
would have loaded the ‘Del_Mar_2’ dataset into both layers. When duplicating 
layers, use Apply this layer only to load into only the selected layer.

A portion of the second image displays below the first one. 

Zoom out to view the extents of both images
1 Right-click in the image window, select Quick Zoom, then Zoom to All 

Datasets.

ER Mapper zooms out to show the full extents of both ADAR images. 

Tip: When building image mosaics, Zoom to All Raster Datasets lets you zoom out 
to view the full extents of all images comprising the mosaic. To zoom to the extents 
of specific dataset in a mosaic, select the dataset’s layer then use Zoom to 
Current Dataset.

Add a third dataset to the mosaic

1 In the Algorithm dialog, click the Duplicate  button.

A copy of the second Pseudo layer is added to the layer list.

2 In the Raster Dataset dialog, click once on the dataset 
‘ADAR_Del_Mar_3.ers’ to select it, then click the OK this layer only button.

ER Mapper loads the dataset into only the third Pseudo layer and closes the Raster 
Dataset dialog.

Tip: As shown here, if you plan to load multiple datasets into an algorithm, it is often 
easier to leave the Raster Dataset dialog open until you are finished. This saves 
the time of opening the file chooser each time.

3 Drag the lower border of the image window downward about 50% so the 
image mosaic fits into the window.

Since this image mosaic is taller than it is wide, increasing the window’s width 
would create a large unfilled area on the right side. This is an example of shaping 
the window to best fit a particular image display.
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You now have a algorithm that displays band 1 of each dataset as a greyscale image 
mosaic.

Turn the center image on and off 
1 Right-click on the middle ‘Pseudo Layer’ and select Turn Off.

Only the top and bottom images display (since the center image is turned off).

2 Right-click on the middle ‘Pseudo Layer’ and select Turn On.

The center image redisplays in its appropriate geographic position again. Any 
images in a mosaic can be displayed or not displayed by turning their layers on or 
off.

Brighten the center image to enhance the seam lines
1 Select the middle ‘Pseudo Layer’ containing the ‘ADAR_Del_Mar_2’ 

dataset. 

2 Click the post-formula Edit Transform Limits  button in the process 
diagram.

3 On the Transform dialog, click the Histogram equalize  button. 

The center image in the mosaic displays with more contrast between light and dark 
areas than the top and bottom images, and the seam lines become clearly visible. 
(This is helpful for understanding image display priority in the next section.)

4 Click Close on the Transform dialog.
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Change the display priority of the center image
1 Select the middle ‘Pseudo Layer’ (‘ADAR_Del_Mar_2’), then click the Move 

Up  button. 

The layer containing the ‘ADAR_Del_Mar_2’ dataset moves up, so it is now the 
top layer (and has display priority over datasets in layers below it).

The center image ‘ADAR_Del_Mar_2’ displays on top of the other two datasets 
where overlap occurs.

2 Point to the top ‘Pseudo Layer’ (‘ADAR_Del_Mar_2’), and drag it to the 
bottom of the layer list. 

The layer containing the ‘ADAR_Del_Mar_2’ dataset now has the lowest display 
priority.

The center image ‘ADAR_Del_Mar_2’ displays underneath the other two datasets 
where overlap occurs. 

Note: When displaying two or more images in a mosaic algorithm, the image in the top 
layer in the Algorithm dialog appears on top of the others when the algorithm is 
processed. The image in the lowest layer has the lowest priority and will only be 
visible in areas where there is no overlap from other datasets in layers above it. By 
adjusting to order of layers, you can set which datasets appear on top of others in 
areas where they overlap.

Zoom in to the geographic extents of any image dataset
1 Select the top ‘Pseudo Layer’ (‘ADAR_Del_Mar_1’) in the algorithm.

2 Right-click in the image window, select Quick Zoom, then Zoom to 
Current Dataset.

ER Mapper zooms in to the full extents of the ‘ADAR_Del_Mar_1’ dataset (but 
also displays part of the lower dataset that occupies the same extents).

Zoom to Current Dataset lets you instantly zoom in or out to the extents of any 
raster image dataset(s) in the currently selected layer, so it is very useful for mosaic 
algorithms.
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5: Creating an RGB image mosaic manually

When creating a mosaic algorithm in Red Green Blue (RGB) Color Mode, the 
order of layers becomes slightly more complex but still works the same way as the 
single Pseudo layers you used earlier. In this case, the RGB layers act together as a 
set, so you normally want to keep them grouped together in the layer list in the 
Algorithm dialog. 

Load the template RGB algorithm

1 On the main menu, click the Open  button.

2 From the Directories menu, select the \examples path.

3 Open the ‘Miscellaneous’ directory.

4 Open the ‘Templates’ directory, then open the ‘Common’ directory.

5 Double-click on the algorithm ’RGB.alg’ to open it.

This algorithm is a template for displaying datasets in Red Green Blue (RGB) 
Color Mode. The existing dataset is an airphoto of San Diego.

Load an ADAR image into the RGB layers

1 In the Algorithm dialog, click the Load Dataset  button in the process 
diagram.

2 From the Directories menu (on the Raster Dataset dialog), select the 
\examples path. 

3 Double_click on the ‘Applications’ directory to open it.

4 Double_click on the ‘Airphoto’ directory.

5 Open the ‘3_Balancing’ directory, then double-click on the dataset 
‘ADAR_Del_Mar_1.ers’ to load it.

Objectives Learn how display several overlapping images in different sets of red, green, and 
blue raster layers to create an RGB image mosaic. 

click to open
algorithm
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ER Mapper loads the ‘ADAR_Del_Mar_1’ dataset into all three layers. (Since all 
three initially contained the same airphoto dataset, double-clicking, OK or Apply 
loads the new dataset into all three automatically.) By default, band 1 is loaded into 
the Red layer, band 2 in the Green, and band 3 in the Blue.

This ADAR dataset is the same image you displayed earlier, but is now displayed 
as an RGB false color composite. Dataset band 1 (near infrared reflectance) is 
displayed in the red layer, band 2 (red reflectance) in the green channel, and band 1 
(green reflectance) in blue. Vegetation appears red, buildings appear blue or green, 
and barren ground appears white. 

Add a second group of new RGB layers
1 Select the ‘Red Layer’ in the layer list.

2 From the Edit menu (on the Algorithm dialog), select Add Raster Layer, 
then Blue.

ER Mapper adds a new Blue layer below the Red layer. (Since no dataset is loaded, 
the layer is turned off.)

3 From the Edit menu, select Add Raster Layer, then Green.

4 From the Edit menu, select Add Raster Layer, then Red.

Now you have a second set of RGB layers you can use to add a second image to 
your RGB mosaic algorithm.

Load an adjacent ADAR dataset into the new RGB layers

1 With new Red (lowest) layer selected, click the Load Dataset  button in 
the process diagram.

2 From the Directories menu (on the Raster Dataset dialog), select the 
\examples\Application\Airphoto path. 

3 Open the ‘3_Balancing’ directory, then double-click on the dataset 
‘ADAR_Del_Mar_2.ers’ to load it.

The ‘ADAR_Del_Mar_2’ dataset is loaded into all three new RGB layers. (If a set 
of RGB layers has no dataset, they are treated the same as a set that has the same 
dataset when loading data.)

4 Turn on the new Green and Blue layers by right-clicking them and selecting 
Turn On. 

When loading a dataset into a new set of RGB layers that do not already have one, 
only the selected layer (Red in this case) is turned on by default. You must turn the 
other layers on as shown here.
Comprehensive ER Mapper Training Workbook  304



Chapter 17 Creating image mosaics ●  5: Creating an RGB image mosaic manually
Select bands for the new Green and Blue layers
All three of the new RGB layers contain band 1 of the dataset since that band is 
always chosen by default when loading a new dataset into an empty layer.

1 Select the Green layer containing the ‘ADAR_Del_Mar_2’ dataset, then 
select B2:0.650_um from the Band Selection list in the process diagram.

2 Click on the Blue layer containing the ‘ADAR_Del_Mar_2’ dataset, then 
select B3:0.550_um from the Band Selection list.

You now have two groups of Red, Green, and Blue layers. Each group contains a 
different dataset but the same assignments of band numbers to layer types (i.e., 
band 1 is loaded into both Red layers, band 2 in both Green, and so on.)

3 Right-click in the image window, select Quick Zoom, then Zoom to All 
Datasets.

ER Mapper zooms out to display the full extents of both images in the RGB 
mosaic. You could continue this process to add additional RGB layers for other 
datasets in your color composite mosaic algorithm.

Creating multiple sets of RGB layers
There are several alternative ways to add additional sets of RGB layers to an 
algorithm. Three of these alternatives are:

• Add a new Blue layer (Edit/Add Raster Layer/Blue), load the new dataset into 
it, then duplicate it twice and change the duplicate layers to Green and Red layers. 

• Ctrl-click three RGB layers containing the same dataset to select them, click Copy 

, then click Paste . This creates a new set of RGB layers within the same 

surface that contain the original dataset, so you can then load the new one.

• Use File/Add into Current Surface to add the layers from an existing RGB 
algorithm into the selected surface of the current algorithm.

select band 2 for second
Green layer
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6: Using histogram matching 

Histogram matching is the process of automatically modifying the transform line(s) 
for one or more datasets to force their output histograms to match the output 
histogram of a reference dataset. This is a standard technique used to balance 
brightness across a mosaic of datasets to help minimize seams and make them 
appear to be one continuous image. 

Look at the RGB mosaic you created in part 2 and notice the color difference 
between the two images. This is due to the slightly different range and distribution 
of data values in the two datasets. You will use histogram matching to alter the 
transforms of the layers containing the ‘ADAR_Del_Mar_1’ dataset to match the 
output histograms of the layers containing the ‘ADAR_Del_Mar_2’ dataset.

Open the Transform dialog box
1 Select the lowest Red layer in the algorithm (for ‘ADAR_Del_Mar_2’).

2 Click the post-formula Edit Transform Limits  button in the process 
diagram.

The histogram for the Red layer of the ‘ADAR_Del_Mar_2’ dataset is displayed.

If needed, move the Transform dialog so it does not overlap with the Algorithm 
dialog or image window.

Histogram match the Red layers

1 In the Transform dialog, click the Histogram match  button.

A dialog appears explaining the effects of the histogram match function and asking 
you to confirm that you want to proceed. 

2 Click Yes to proceed with the histogram match operation.

Objectives Learn how to use ER Mapper’s histogram matching feature to help balance 
contrast between multiple images in a mosaic. 

Histogram match button
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3 Click the Move to next red layer  button on the Transform dialog.

The next Red layer (for band 1 of ‘ADAR_Del_Mar_1’) is selected and its 
histogram is displayed. Notice that it has a complex piecewise transform line–this 
was automatically created by ER Mapper to make the output histogram match the 
output histogram of the Red layer of the ‘ADAR_Del_Mar_2’ dataset.

Histogram match the Green layers
1 In the Algorithm dialog, select the Green layer for ‘ADAR_Del_Mar_2’ 

dataset (the lower of the two Green layers).

Its histogram appears in the Transform dialog.

2 In the Transform dialog, click the Histogram match  button.

The transform line for the other Green layer is modified to match the output 
histogram for the current Green layer. Notice the shape of the output histogram 
(same as the input or solid green histogram in this case since the default linear 
transform line is used).

3 Click the Move to next green layer  button on the Transform dialog.

The Green layer for ‘ADAR_Del_Mar_1’ is selected. Notice the shape of the 
output histogram (the outline histogram) approximately matches the shape of the 
output histogram in the other Green layer. This is what histogram matching tries to 
accomplish.

Histogram match the Blue layers
1 In the Algorithm dialog, select the Blue layer for ‘ADAR_Del_Mar_2’ 

dataset (the lower of the two Blue layers).

Its histogram appears in the Transform dialog.

2 In the Transform dialog, click the Histogram match  button.

The transform line for the other Blue layer is modified to make its output histogram 
match the output histogram of the current Blue layer.

3 Click the Move to next blue layer  button on the Transform dialog.

The histogram for the ‘ADAR_Del_Mar_1’ layer and its modified transform line 
are displayed.
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The brightness differences between the two datasets are minimized and they appear 
much closer in color and contrast. This same technique can be used to histogram 
match many different images to a reference image. In this case, 
‘ADAR_Del_Mar_2’ was the reference image, and the transforms of the 
‘ADAR_Del_Mar_1’ layers were histogram matched to it.

4 Click Close on the Transform dialog.

You can apply other contrast stretching options such as autoclipping or Histogram 
Equalization to your reference layers first, and then use histogram matching to 
modify the other layers to match them. This is likely to be desirable in most cases. 
(In this case the default linear transform was used for the reference layers to 
simplify explanation.)

Note: Histogram matching affects all layers contained in the same surface. For example, 
if you have six sets of RGB layers, the other five Red layers will be matched to the 
reference Red layer. Histogram matching does not affect layers in other surfaces in 
an algorithm.

7: Using mosaic seam feathering

Feathering is the process of blending the data values in areas where two datasets 
overlap so they gradually transition (or “feather”) from one to the other. Feathering 
can help to reduce the visual effect of seams between two or more images and helps 
them appear to be one continuous image. Feathering is an option on the Algorithm 
dialog. It is only available when you have more than one of the same layer type in 
your algorithm (which is necessary to create an image mosaic). 

Load the mosaic of four datasets algorithm

1 On the main menu, click the Open  button.

2 From the Directories menu, select the \examples path.

3 Open the ‘Functions_And_Features’ directory, then open the ‘Data_Mosaic’ 
directory.

4 Double-click on the algorithm ‘Interactive_mosaic_of_4_datasets.alg.’

Objectives Learn how to use ER Mapper’s mosaic feathering feature to help blend areas of 
overlap to smooth seam lines between images in a mosaic. 
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This algorithm is a greyscale mosaic of four datasets with different spatial 
resolutions–a Landsat TM image, a SPOT XS image, and SPOT Pan image, and a 
digitized aerial photograph.

Zoom in on a seam line between two datasets

1 Click the ZoomBox Tool  button on the main menu.

2 Drag a zoom box in the image to zoom in on the vertical seam between the 
Landsat and SPOT XS images in the mosaic (see below):

You should clearly see the seam line and difference in spatial resolution between 
the two images (the SPOT XS image on the left has higher resolution).

Turn on the mosaic feathering option
Feathering works by blending, or averaging, the data values between two images in 
the zone where they overlap:

zoom in on area where
images overlap

100%
image A

100%
image B

50/50 average
of images A & B

Image A Image B

zone
of

overlap
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1 On the Algorithm dialog, turn on the Feather option.

The seam line between the two images is blended to create a smooth transition 
between them. Feathering works by progressively blending the data values in the 
two datasets in the area where overlap occurs. Since the feathering computations 
occur in a left to right direction, it works best on vertical seams such as in this case. 

Feathering can also be effective to hide small misalignments between features on 
adjacent images. (However gross misalignments will create a blurred look, and you 
should consider rectifying one or both images again to improve this.) 

turn on Feather option

feathering off feathering on
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Close the image window and Algorithm dialog
1 On the main menu, select Close from the File menu to close the image 

window.

2 Click Close on the Algorithm dialog.

Only the ER Mapper main menu should be open on the screen.

• Create an image mosaic by building an algorithm containing two or more sets of 
layers of the same type 

• Specify different processing for each image in the mosaic

• Specify image priority for the mosaic (which images appear on top of others in the 
event of overlap)

• Use histogram matching and feathering to minimize seams in mosaics.

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Unsupervised
classification

This chapter explains how use ER Mapper’s ISOCLASS unsupervised 
classification feature to group multispectral image data into thematic information 
classes. You will learn to define clustering parameters, perform an unsupervised 
classification, and assign feature categories and colors to the classes. 

About unsupervised classification
Unsupervised classification is one of two methods used to transform multispectral 
image data into thematic information classes (supervised classification being the 
other). This procedure typically assumes that imagery of a specific geographic area 
are gathered in multiple regions of the electromagnetic spectrum, for example 
Landsat TM or SPOT XS multispectral satellite imagery. (Classification can also be 
effective for other types of imagery. Please refer to an appropriate reference text for 
complete information on classification.) 

With unsupervised classification, the classification program searches for natural 
groupings or clusters of the spectral properties of pixels, and assigns each pixel to a 
class based on initial clustering parameters you define. Typically, you ask 
ER Mapper to group the image data into a specific number of spectral classes and 
give it parameters for when classes are to be split or merged as it searches for 
groupings in the image data. After the classification is completed, you assign each 
“spectral” class to a thematic information or feature class (such as water, urban, 
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etc.) and a color for the class display. ER Mapper uses the ISOCLASS algorithm to 
perform clustering of the image data during an unsupervised classification. For 
information on how the ISOCLASS program works, refer to Chapter 24, 
“Supervised and Unsupervised Classification” in the ER Mapper User Guide. 

A typical procedure for performing an unsupervised classification is as follows:

Hands-on exercises
These exercises give you practice using ER Mapper’s ISOCLASS Unsupervised 
Classification feature.

• Specify clustering parameters and perform an unsupervised classification

• Assign colors and feature class names to the classified image

• Display a classified image using a Class Display layer

• Compare a classified image to a reference image

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Run the ISOCLASS program to cluster the

Display the output classified image and

Cluster
the image

data

Assign
class names
and colors

Evaluate
classification

accuracy

image data into a user-defined number
of spectral classes

assign each spectral class a name and
color corresponding to a thematic class

Evaluate the accuracy of the classification
by overlaying classes or using statistical
means, merge classes if needed, etc.
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1: Clustering the image data

Display the Landsat image to be classified

1 Click the Open  button. 

An image window and the Open file chooser appear.

2 From the Directories menu, select the \examples path.

3 Open the ‘Data_Types’ directory, then open the ‘Landsat_TM’ directory.

4 Double-click on the algorithm ‘RGB_741.alg’ to open it.

This displays bands 7, 4 and 1 of the Landsat TM image on which you will perform 
the unsupervised classification. (It is not necessary to display the image you want 
to classify, but you will use it for comparison later.)

Open the Unsupervised Classification dialog box
1 From the Process menu, select Classification, then select ISOCLASS 

Unsupervised Classification.

The Unsupervised Classification dialog box opens. This dialog lets you 
specify the input raster image and bands to be used, the output image name, starting 
classes to be used, and parameters for clustering the image data.

Specify the input image and bands to be used

1 Click the ‘Input Dataset’  chooser button.

2 From the Directories menu, select the \examples path.

3 Open the ‘Shared_Data’ directory, then double-click on the image 
‘Landsat_TM_year_1985.ers’ to load it.

4 Click the ‘Bands to use’  chooser button.

The Band Selection dialog box appears to let you choose which bands in the 
image to use for the clustering operation.

5 Drag through all seven bands listed to select them, then Ctrl-click on the 
band labelled 6:11.45_um to deselect it.

Objectives Learn how to use ER Mapper’s ISOCLASS unsupervised classification feature to 
group or cluster multispectral image data into several spectral classes in an output 
image.
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Bands 1-5 and 7 should now be selected. (Since Landsat TM band 6 contains data 
in the thermal wavelengths, it is often not included in classifications.) 

6 Click OK to close the Band Selection dialog.

Bands 1-5 and 7 now appear in the ‘Bands to use’ field.

Specify a name for the output classified image

1 Click the ‘Output Dataset’  chooser button.

2 From the Directories menu, select the \examples path.

3 Open the ‘Miscellaneous’ directory.

4 Open the ‘Tutorial’ directory.

5 In the Save As field, type your initials followed by the text 
10_class_ISOCLASS and separate each word with an underscore (_).

6 Click OK to validate the filename.

Specify the ISOCLASS clustering parameters
1 In the ‘Maximum number of classes field,’ enter the value 10 and press 

Return or Enter.

This tells ER Mapper to cluster the image data into a maximum of 10 spectral 
classes. (Note that this example is simplified, and you would typically choose a 
larger number of classes.) 

All other default values on the dialog are appropriate for this simple exercise. 
ER Mapper will use bands 1-5 and 7 in the image, and will generate one starting 
class automatically (you could also use classes from another classified image to 
start with if desired). The clustering will finish when a maximum of 10 classes are 
created (although fewer are possible) and 98% of the clusters remain unchanged.

Perform the unsupervised classification
1 Click OK on the Unsupervised Classification dialog to start the clustering 

process.

The Processing Status dialog box appears to show the progress. ER Mapper 
runs through several iterations to cluster the image data into classes, and splits and 
merges classes as specified by the parameters you entered. 

When the 98% unchanged parameter has been reached, the classification finishes 
with 10 classes. ER Mapper then generates multivariate statistics for each class. 

2 When the dialog appears indicating successful completion, click OK. 
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3 Click Cancel on the Unsupervised Classification dialog to close both.

The output of the classification is a single band image. Each pixel in the image has 
a value ranging from 1 to 10 (the number of classes that were generated). Next you 
will display the output image and assign class colors and names.

Note: If statistics have not already been generated for your input raster image, they will 
be generated first when you start the classification (which may take a few minutes 
depending on the image size).

2: Assigning colors and class names

Open a template algorithm to display a classified image

1 On the main menu, click the New  button. 

An new image window appears-drag it below the other window.

2 Click the Open  button. 

3 From the Directories menu, select the \examples path.

4 Open the ‘Miscellaneous’ directory.

5 Open the ‘Templates’ directory, then open the ‘Common’ directory.

6 Double-click on the algorithm ‘Classified_data.alg’ to open it.

A classified image of San Diego displays. This is a template algorithm you will use 
to display the classified image you generated.

Load the classified image you created

1 Click the Edit Algorithm  button.

On the Algorithm dialog, notice that this algorithm has one layer of the type 
‘Class Display.’ The Class Display layer is designed to display images created with 
ER Mapper’s classification functions.

2 Click the Load Dataset  button in the process diagram.

3 From the Directories menu, select the \examples path.

Objectives Learn how to view a classified image in a Classification Display layer, and assign 
colors and feature names to class numbers.
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4 Open the ‘Miscellaneous’ directory.

5 Open the ‘Tutorial’ directory, then double-click on your 
‘10_class_ISOCLASS’ image to load it.

The image initially displays in various shades of grey by default. Next you will 
create a color scheme for the classified image.

6 Click Close on the Algorithm dialog.

Auto-generate a color scheme for the classes
1 From the Edit menu, select Edit Class/Region Color and Name....

The Edit Class/Region Detail dialog box opens. This dialog lists each class in 
the image by number, and provides text fields for assigning names and a button to 
choose colors. 

2 Enlarge the dialog until all 10 classes can be viewed at once.

3 Click the Auto-gen colors... button.

The Auto-generate colors dialog box opens. This dialog lets you automatically 
generate a color scheme for the classified image that simulates the colors of an 
RGB image display. By default, an RGB=321 band combination is chosen, but you 
will change it to an RGB=741 band combination.

4 Change the ‘Red Band’ value to 7, and the ‘Green Band’ value to 4.

5 Click the Auto-gen button. 

The new color assignments for each class appear in the Set color... buttons next to 
the class number in the Edit Class/Region Details dialog.

6 Click Save on the Edit Class/Region Details dialog, and when asked to 
overwrite the file click Yes.

The new color scheme for the classified image is now stored in the image header 
(‘.ers’) file.

7 Reload the image by clicking the Refresh Image  button on the 
Standard toolbar.

click to reload
image
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Note that the class color assignments make the image appear similar to the 
RGB=741 image in the other window. You can use the Auto-gen colors option to 
simulate the color scheme of any typical RGB band combination.

8 Click Close on the Auto-generate colors dialog.

Note: In order to display changes to the color scheme, you must save the changes and 
then reload the image (to re-read the updated header file with the new colors). The 

fastest way to reload the image is to click the Refresh Image button on the 

Standard toolbar.

Close the Landsat TM RGB image window
1 Close the ‘RGB_741’ image window using the window system controls:

• Click the  Close button in the upper-right window corner.

2 Move the ‘Classified_data’ image window to the upper-left on the screen.

Find the class representing ocean and color it blue
1 From the View menu, select Cell Values Profile.

The Cell Values Profile dialog box appears. This will help you determine the 
class number of pixels in various areas of the classified image. 

2 Turn on only the Values option.

3 On the main menu, click the Pointer Tool  button.

4 Drag the mouse through the dark areas near the bottom of the classified 
image, and note the values appearing in the Cell Values Profile dialog.

These are ocean areas that were generally grouped into class 1. 

5 In the Name field for class 1 (on the Edit Class/Region Details dialog), 
change the text ‘1: unlabelled’ to Ocean/water. 

pixel value current class label
(class number)
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6 Click the Set color... button for class 1, choose blue, then click OK.

As shown above, you can also set the class color by entering a color name and 
clicking Enter or Return.

7 Click Save on the Edit Class/Region Details dialog, and when asked to 
overwrite the file click Yes.

8 Reload the image by clicking the Refresh Image  button on the 
Standard toolbar.

The pixels assigned to class 1 (which you interpreted as ocean) are colored blue. 

Assign names and colors to the other nine classes
1 Assign names and colors as desired to the other nine classes in the image 

using the previous steps 4 through 6 (use the guide on the next page). 

Generally you should use the Cell Values Profile dialog to determine the class 
number of a specific feature type on the image, and then fill in a name for the class 
and choose the desired color. This requires some subjective interpretation, and you 
should pan and zoom on different areas as needed.

Another way to do this is to pick a bright color for a class, save it, then see which 
areas are highlighted. This may help determine what feature class name to assign in 
the context of the other classes. 

Tip: To zoom using the mouse, remember to set the mouse to Zoom Tool  to zoom, 

and back again to Pointer Tool  to view cell values. 

define class color bydefine label for class number
entering color name or Set Color
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As a shortcut, the following class assignments are generally correct for this image 
(colors are purely subjective choices, choose any you prefer):

Tip: The current color values (numbers) are RGB values that represent a specific color. 
You can quickly change them to the colors above by typing the color name and 
pressing Return or Enter (without using the Set Color button).

2 When finished, click Save on Edit Class/Region Details, then Yes to 
overwrite the file.

3 Reload the image by clicking the Refresh Image  button on the 
Standard toolbar.

4 Click Close on the Cell Values Profile dialog.

5 Click Close on the Edit Class/Region Details dialog.

Class Name Color

1 Ocean/water blue

2 Beach/sandy soils tan

3 Urban/industrial magenta

4 Natural vegetation dark green

5 Residential 1 red

6 Residential 2 pink

7 Mixed vegetation light green

8 Parks/golf courses green

9 Asphalt/tarmac brown

10 Cement/barren land white
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3: Overlaying classification results

Open the Landsat TM 321 algorithm into a new surface
1 From the View menu, select Algorithm to open the Algorithm dialog.

2 From the File menu (on the main menu), select Open into New Surface.

3 From the Directories menu, select the \examples path.

4 Open the ‘Data_Types’ directory, then open the ‘Landsat_TM’ directory.

5 Double-click on the algorithm ‘RGB_321.alg’ to open it.

An algorithm (and it layers) are added as a second surface in the current algorithm. 
(This displays the Landsat TM image in “natural color, “ or RGB=321.)

Set transparency for the classified image
1 Select the top surface ‘[RGB]:Default Surface’ in the algorithm.

Since the classified image is on top of the RGB image, you must set transparency 
for it to see the RGB image underneath.

2 Click the Surface tab.

3 Set the ‘Transparency’ slider to its mid-point.

The two images are blended so colors from both are visible.

4 Adjust the ‘Transparency’ slider to various settings.

By shifting the transparency back and forth to different levels, you can quickly see 
how the natural color image underneath corresponds to the classes and colors of 
your classified image. This can be an effective way to compare the results of your 
classification to a reference image.

Add a Classification layer to the Landsat image surface
1 Click the Layer tab in the Algorithm dialog to display the process diagram.

2 Right-click on the top surface ‘[RGB]:Default Surface,’ and select Turn Off.

The classified image’s surface is off, so it will not be displayed.

3 Select the lower surface ‘[RGB]:Landsat TM’ in the algorithm.

4 On the Algorithm dialog, open the Edit menu, select Add Raster Layer, 
then Classification.

Objectives Learn how to display a Classified image using transparency over a reference 
image, and to use a formula and Classification layer to display individual classes.
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A Classification layer is added to the algorithm layer list.

5 Click the Load Dataset  button in the process diagram.

6 From the Directories menu, select the \examples path.

7 Open the “Miscellaneous” directory.

8 Open the ‘tutorial’ directory, then double-click on your 
‘10_class_ISOCLASS.ers’ image to load it.

9 In the process diagram, click the Edit Layer Color  button.

10 Choose a yellow color, then click OK on the Color chooser dialog.

Add a formula to display pixels in individual classes

1 On the Algorithm dialog, click the Edit Formula   button in the process 
diagram.

2 In the Generic formula window, edit the formula text to read:

if input1=1 then 1 else null

This formula tells ER Mapper “if pixels have a value of 1 (class 1) in the image, 
assign them a value of 1 for display, else assign them a value of null.”

3 Click the Apply changes button to validate the formula.

The ocean areas (class 1) display in yellow over the backdrop RGB image.

Display other classes over the backdrop image
1 In the Generic formula window, edit the formula text to read:

if input1=4 then 1 else null

This will display class 4 in yellow.

2 Click the Apply changes button to validate the formula.

The natural vegetation areas (class 4) display in yellow over the backdrop RGB 
image. This is another way to help identify the feature class represented by a 
particular cluster (class number), or assess the accuracy of a classification. 

3 (Optional.) If desired, edit the formula to display any other class number by 
changing input1=x to a value 1-10. Choose any color desired.
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Close the image window and Algorithm dialog
1 Close the image window using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm dialog.

Only the ER Mapper main menu should be open on the screen.

• Specify clustering parameters and perform an unsupervised classification

• Assign colors and feature class names to the classified image

• Display a classified image using a Class Display layer

• Compare a classified image to a reference image

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Supervised
classification

This chapter explains how to use ER Mapper’s supervised classification features to 
transform multispectral image data into user-defined thematic information classes. 
You will learn to choose define training regions, perform a supervised 
classification, and assign colors to the classes.

About supervised classification
Supervised classification is one of two methods used to transform multispectral 
image data into thematic information classes (unsupervised classification being the 
other). This procedure typically assumes that imagery of a specific geographic are 
gathered in multiple regions of the electromagnetic spectrum, for example Landsat 
TM or SPOT XS multispectral satellite imagery. (Classification can also be 
effective for other types of imagery. Please refer to an appropriate reference text for 
complete information on classification.) 

In supervised classification, the identity and location of feature classes or cover 
types (urban, water, wetland, etc.) are known beforehand through field work, 
analysis of aerial photographs, or other means. You typically identify specific areas 
on the multispectral imagery that represent the desired known feature types, and 
use the spectral characteristics of these known areas to “train” the classification 
program to assign each pixel in the image to one of these classes. Multivariate 
statistical parameters such as means, standard deviations, and correlation matrices 
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are calculated for each training region, and each pixel is evaluated and assigned to 
the class to which it has the most likelihood of being a member (according to rules 
of the classification method chosen).

 A simplified procedure for performing a supervised classification is as follows:

Select
training
regions

Calculate
region
statistics

Evaluate
class
signatures

Classify
the image

Display and
evaluate
classification

Use annotation tools to draw polygons
defining training regions in image (areas
of known feature types or cover classes)

Calculate statistics for pixels in each
training region (minimum, maximum,
mean values, standard deviation, etc.)

View and evaluate statistics for training regions
in tabular format or graphical format using
histograms or scattergrams

Select a classification type (decision rule),
and perform the classification to assign
each pixel to one of the feature classes

Display the output classified image, assign
colors to classes, and overlay classes or use
statistical means to assess accuracy
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Hands-on exercises
These exercises give you practice defining training regions and using ER Mapper’s 
Supervised Classification features to perform a classification.

• Draw polygons to define training regions for a supervised classification

• View statistics, histograms, and scattergrams for each training region

• Perform a supervised classification

• Display a classified image using a Class Display layer type

1: Defining training regions

About regions: Regions are vector polygons that define an area of interest in an 
image. Regions can be used to process or display parts of an image separately from 
others, mask out parts of an image for mosaicing, define training sites as you will 
do here, and other purposes. The definition of each region is stored in the header 
file for the raster image.

Create a practice image

1 Click the Edit Algorithm  toolbar button. 

An image window and the Algorithm window appear.

2 On the Algorithm window, click the Load Dataset  button in the 
process stream diagram to open the file chooser. The Raster Dataset 
dialog box which is the file chooser appears.

3 From the Directories menu, select the path ending with the text \examples

4 In the directory ‘Shared_Data’, load the image named 
‘Landsat_MSS_notwarped.ers.’

What you will 
learn...

After completing these exercises, you will know how to perform these tasks in 
ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to use ER Mapper’s vector annotation tools to define training regions 
(polygons) representing feature or land cover classes in an image.
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5 MSS band 1 (MSS1) will be loaded into the Pseudo Layer.

If the image is very dark, do not do anything about it at this stage.

6 On the Algorithm window click the duplicate button  three times and 
duplicate the Pseudo Layer with MSS1 three times. You have now 4 Pseudo 
Layers with MSS1 band.

7 Use the process stream diagram  Band Chooser  for each layer on the 
Algorithm window to load MSS1 (B1:0.55_um) in the first Pseudo Layer, 
MSS2 (B2:0.65_um) in the second Pseudo Layer, MSS3 (B3:0.75_um) in 
the third Pseudo Layer and MSS4 (B4:0.95_um) in the fourth Pseudo Layer.

8 By turning off three layers at a time, display each band individually.

9 Edit the band descriptions and type in for band 1 (B1:0.55_um), for band 2 
(B2:0.65_um), for band 3 (B3:0.75_um) and for band 4 (B4:0.95_um).

10 Turn on all the four layers. 

11 From the File menu on the main menu select Save As.... Select 
ER Mapper Raster Dataset (.ers) as the file type and save it in the 
examples\Miscellaneous\Tutorial directory as ‘Landsat_practice.ers’.

Tip: To maintain the original dynamic range of the image, select the delete transforms 
option when saving it.

Load the practice image and display it as a RGB composite

1 On the Algorithm window, click the Load Dataset  button in the 
process stream diagram to open the file chooser. 

2 From the Directories menu, select the path ending with the text \examples.

3 Open the ‘Miscellaneous’ directory.

4 In the directory ‘tutorial,’ double-click on the image named 
‘Landsat_practice.ers’.

5 On the main menu click on the Image Display and Mosaicing Wizard  

button.

The Image Display and Mosaicing Wizard dialog box opens.
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6 Select Change display in this window, and click on the Next> button.

7 Select Red Green Blue, and click on the Next> button.

A status window will display the progress as the ‘Landsat_practice’ image is 
displayed as RGB composite.

8 Click on the Finish button to close the Image Wizard.

9 Drag the image window by the lower-right corner to make it about 50% 
larger.

10 Right-click on the image and select Zoom to All Datasets from the Quick 
Zoom menu.

ER Mapper will redraw the image to fit into the enlarged window. 

You will next draw polygons to define several feature classes in the image.

Add a vector layer for region definition to your algorithm
1 From the Edit menu, select Edit/Create Regions.... 

The New Map Composition dialog box opens.

2 In the New Map Composition dialog, notice that the Raster Region option 
is selected. 

Note: The Raster Region option tells ER Mapper that the annotation layer will be used 
to create regions for a raster image (for use in training site selection in this case).

3 Click OK on the New Map Composition dialog box. 

4 ER Mapper opens the Tools palette dialog box containing your vector 
annotation tools. Also notice that a new vector layer titled ‘Region Layer’ 
has been added to the layer list in the Algorithm window.

5 From the File menu (on the main menu), select Save As... to save the 
algorithm under your own name with the new page extents information.

6 In the Files of Type: field, select ’ER Mapper Algorithm (.alg)’.

7 From the Directories menu, select the path ending with the text \examples. 

8 Double-click on the directory ‘Miscellaneous’ to select it.
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9 Double-click on the directory ‘Tutorial’ to open it.

10 In the Save As: text field, type a name using your initials at the beginning, 
followed by the text ‘land_use_regions.’ Separate each word with an 
underscore (_). For example, if your initials are “KA,” type in the name:

KA_land_use_regions

11 Click OK or Save to save the algorithm, which now includes your Page 
Setup parameters.

12 Click Close on the Algorithm window to close it.

Open the Geoposition dialog box
1 From the View menu, select Geoposition....

The Algorithm Geoposition Extents dialog box opens. Move it to the right 
side of the screen.

2 Select the Zoom option to display buttons for zooming and panning.

You will use these options to help zoom in and out of areas as you define your 
training region polygons.

Define training regions on the image
1 Use the following diagram as a guide to help locate training regions in the 

image. You are asked to define these regions in the next steps.
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Define a region to represent ocean areas

1 On the Tools palette dialog, click the ZoomBox Tool  button.

2 Zoom in on the lower-left quarter of the image.

The large portion of dark blue area is ocean in this scene.

3 On the Tools palette dialog, click on the Polygon  button.

4 Point to an area of ocean and draw a polygon by clicking once at each 
point, then double-clicking to close the polygon. (Make your polygon fairly 
large to get a good sample.)

natural vegetation

barren
land

urban
areas

ocean
areas

grass &
parks

residential
areas
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The polygon is selected by default when you close it. Since it is selected, you can 
now add a color and text attribute to give the polygon a name.

5 On the Tools dialog, double-click the Polygon  button to open the Line 
Style dialog box.

6 On the Tools dialog, click the Display/Edit Object Attributes  button to 
open the Map Composition Attribute dialog box

Position the Line Style and Map Composition Attribute dialogs in a 
convenient position on the screen. You will leave these dialogs open while you 
define regions so you can assign a color and name to each region as you go. (The 
colors you assign becomes the default class colors in the output classified image.)

7 In the Line Style dialog, click the Set Color button, choose a blue color, 
and click OK to close the color chooser.

8 In the Map Composition Attribute dialog, enter the text Ocean in the text 
field at the bottom, then click the Apply button.

The text “Ocean” is now defined as a the name or text attribute of the polygon.

You have now defined a training region representing ocean areas in the image. 
When you calculate statistics for this image later, the statistics for pixels inside this 
region will be used as a “signature” to classify other areas of ocean in the image.

Define a region to represent natural vegetation
1 On the Geoposition dialog, click All Datasets to zoom back out.

2 On the Tools palette dialog, click the ZoomBox Tool  button.

3 Zoom in on the upper-right quarter of the image.

The dark brown areas at the top of the image are natural vegetation.

4 Click on the Polygon  button.

5 Draw a polygon to define a large area of natural vegetation (click once at 
each point, then double-click to close the polygon).

The polygon becomes selected when you close it.

6 In the Line Style dialog, click Set Color, choose a dark green color, and 
click OK to close the color chooser.

7 In the Map Composition Attribute dialog, enter the text Natural 
vegetation in the text field at the bottom, then click the Apply button.

You have now defined a training region representing natural vegetation.
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Define a region to represent grass and park areas
1 On the Geoposition dialog, click All Datasets to zoom back out.

2 On the Tools palette dialog, click the ZoomBox Tool  button.

3 Zoom in on one of the small, bright red areas (there is one in the river valley 
running east to west). Zoom in far enough so the bright red area fills most of 
the image window.

These are parks, golf courses, or other irrigated artificial vegetation.

4 Click on the Polygon  button and digitize a polygon around the border 
of the bright red park area.

5 In the Line Style dialog, click Set Color, choose a bright green color, and 
click OK to close the color chooser.

6 In the Object Attribute dialog, enter the text Grass and parks in the 
text field at the bottom, then click the Apply button.

You have now defined a training region representing grass and park areas.

Define a region to represent urban areas
1 On the Geoposition dialog, click All Datasets to zoom back out.

2 On the Tools palette dialog, click the ZoomBox Tool  button.

3 Zoom in on the grey areas near the center of the image.

These are developed urban areas.

4 Click on the Polygon  button and digitize a polygon around the border 
of the grey urban area (do not include red vegetated areas on the edges).

5 In the Line Style dialog, click Set Color, choose a grey color, and click OK 
to close the color chooser.

6 In the Map Composition Attribute dialog, enter the text Urban areas in 
the text field at the bottom, then click the Apply button.

You have now defined a training region representing urban areas.

Define a region to represent residential areas
1 On the Geoposition dialog, click All Datasets to zoom back out.

2 On the Tools palette dialog, click the ZoomBox Tool  button.
Comprehensive ER Mapper Training Workbook  332



Chapter 19 Supervised classification ●  1: Defining training regions
3 Zoom in on one of the pink area in the northern part of the peninsula as 
shown in the previous diagram.

This area is primarily residential housing, so it has both buildings (houses) and 
vegetated areas (grass and trees).

4 Click on the Polygon  button and digitize a polygon around the pink 
areas described.

5 In the Line Style dialog, click Set Color, choose a pink color, and click OK 
to close the color chooser.

6 In the Map Composition Attribute dialog, enter the text Residential 
areas in the text field at the bottom, then click the Apply button.

Define a region to represent barren land areas
1 On the Geoposition dialog, click All Datasets to zoom back out.

2 On the Tools palette dialog, click the ZoomBox Tool  button.

3 Zoom in on the lower-right quarter of the image.

There are several areas of barren land here that appear white on the image (since 
they have high reflectance in all three MSS bands).

4 Click on the Polygon  button and digitize a polygon around the border 
of one of the barren white areas (do not include other areas on the edges).

5 In the Line Style dialog, click Set Color, choose a light brown color, and 
click OK to close the color chooser.

6 In the Map Composition Attribute dialog, enter the text Barren land/
cement in the text field at the bottom, then click the Apply button.

You have now defined training regions representing ocean, natural vegetation, 
grass/parks, urban and residential areas, and barren land areas.

Tip: To define multiple polygons to be used as a single statistical region, assign all the 
polygons the same text attribute name. ER Mapper combines statistics for any 
regions with the same name automatically.

Save the regions to the Landsat MSS practice image

1 On the Tools palette dialog, click the Save As  button.

The Map Composition Save As chooser dialog appears.
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2 From the Directories menu, select the path ending with the text \examples.

3 Double-click on the directory ‘Miscellaneous’ to open it.

4 Double-click on the directory ‘Tutorial’ to open it.

5 Click on the image named ‘Landsat_practice’ to select it, then click OK.

6 When asked to confirm the overwrite, click OK to proceed. After the next 
dialog indicates all your new regions were added, click Close to close it.

The regions definitions and names are saved to the header file of the 
‘Landsat_practice’ image. You can now calculate statistics for the pixels in each 
region.

7 Click Close on the Tools palette and Geoposition dialogs to close them.

Calculate statistics for the new regions
1 From the Process menu, select the Calculate Statistics.

The Calculate Statistics dialog box appears.

The ‘Landsat_practice’ image should be chosen by default because it is the image 
used in the current algorithm. (If it is not chosen, load it from the ‘tutorial’ 
directory).

2 Set the Subsampling Interval to 1.

3 Select the Force Recalculate stats option (to calculate statistics again in 
case they have previously been calculated).

4 Click OK to start the statistics calculation.

5 When the calculation is finished, click OK in the dialog indicating successful 
completion, then close the other statistics dialogs with Close or Cancel.

2: View training statistics

View tabular statistics for the training regions
1 From the View menu, select the Statistics, then select Show Statistics.

The Statistics Report dialog box appears. The ‘Landsat_practice’ image should 
be selected by default. You can choose to view statistics for selected regions or 
bands in the image, or for all regions and bands.

Objectives Learn to view statistics for training regions in tabular format, view histograms of 
data values in the training class regions, and view class means and 95% 
probability ellipses over a scattergram.
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2 Click OK to display statistics for the all the regions you defined.

The display image Statistics dialog opens showing statistics for all your regions in 
all four Landsat MSS image bands.

3 Scroll through the list to view statistics for your training regions (make the 
dialog larger if needed).

(The last region listed named ‘All’ is the entire image. This region is present in 
every image header file.)

4 When finished viewing statistics, click Cancel on the Statistics Report 
dialog to close both dialogs.

Add a Classification layer and load the Landsat image

1 Click the Edit Algorithm  toolbar button to open the Algorithm window. 

2 Click on the ‘Region Layer’ layer to select it, then click Delete to delete the 
layer. (You no longer need it for this exercise.)

3 From the Edit/Add Raster Layer menu, select Classification.

A Classification layer is added to the algorithm layer list.

4 In the process diagram, click the Edit Layer Color  button.

5 Choose a bright yellow color, then click OK to close the color chooser.

6 In the process diagram, click the Load Dataset  button.

7 From the Directories menu, select the path ending with the text \examples

8 Double-click on the ‘Miscellaneous’ directory to open it.

9 Double-click on the ‘Tutorial’ directory to open it.

10 Double-click on the image ‘Landsat_practice’ to load it.

You can now use the Classification layer to display a training region in yellow on 
the image and show its histogram in any band.

Enter a formula to display a region

1 Click the Edit Formula  button in the process diagram to open the 
Formula Editor dialog.

2 In the Generic formula window, edit the formula text to read:

if inregion(region1) then input1 else null
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This formula tells ER Mapper to process and display the data inside the region 
chosen as region 1 in yellow on the image.

3 Click the Apply changes button.

Notice that the Inputs and Regions buttons above the Relations window are now 
active. Image band 1 is assigned to generic input1 by default.

4 Click the Regions button, select Grass/Parks from the drop-down list next 
to ‘REGION1.’

Your Grass/Parks region is displayed in yellow over the RGB image.

View the histograms for the Grass/Parks region

1 Click on the post-formula Edit Transform Limits  button to open the 
Transform dialog box. Move it so it does not overlap with the image window 
or Formula dialog.

2 From the Limits menu, select Limits to Actual.

The histogram for the pixels in band 1 of the training region ‘Grass/Parks’ appears 
in the histogram window.

3 In the Formula dialog, click the Inputs button, then select B3:0.75_um 
from the ‘INPUT1’ drop-down list.

4 From the Limits menu, select Limits to Actual.

Note: Since the data range is different for each band and region, you need to use Limits 
to Actual each time you change the band or region. Otherwise the new histogram 
may not fully display due to the limits set for the previous one.

The histogram for the pixels in band 3 of the training region ‘Grass/Parks’ appears 
in the histogram window. By changing the assignments in the Relations window, 
you can view a histogram for any band and region combination in the image. The 
histogram provides important information about the distribution and range of data 
values in your training regions.

5 If desired, view histograms for other region and/or band combinations using 
the steps listed previously.

6 When finished, click Close on the Formula Editor dialog, and Close on the 
Algorithm window.

View a scattergram for the MSS image
1 From the View menu, select Scattergrams....
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The Scattergram dialog box and New Map Composition dialog boxes open. 
Notice that the New Map Composition dialog already has Raster Regions 
selected and the name of your image entered.

2 Click OK on the New Map Composition dialog.

The annotation Tools dialog opens and the Scattergram dialog automatically 
references the image in the active image window (‘Landsat_practice’). Notice also 
that your region polygons are shown on the image in their assigned color.

Set the scattergram bands and limits
1 In the Scattergram dialog, click the Setup... button.

2 In the Scattergram Setup dialog, select band 2 for the X Axis field, and 
band 4 for the Y Axis field.

3 Click the Limits to Actual button to set the X and Y axis limits to the actual 
data ranges of bands 2 and 4.

The scattergram for image bands 2 (red light) and 4 (near infrared light) is 
redisplayed to fill the window. The wide dispersion of points in the scattergram 
indicates that the information in these two bands is not strongly correlated.

Display mean and probability ellipses for training regions
1 In the Scattergram Setup dialog, turn on the From current selection 

option.

This tells ER Mapper that you want to display the mean value and 95% probability 
ellipse for the currently selected region polygons in the image.

2 On the Tools dialog, click the Select and Edit Points Mode  button.

3 In the image, select the grey polygon defining your ‘urban’ class training 
region (click on a line segment).

A grey ellipse appears over the scattergram showing the 95% probability threshold 
and mean value (the ellipse center point) for the ‘urban’ class in bands 2 and 4. 
(The ellipse extents represent the probability that an unknown pixel is a member of 
that class at the 95% confidence level.)

4 In the image, select the green polygon defining your ‘grass’ class training 
region.

A green ellipse appears on the scattergram. As indicated, green vegetation shows a 
strong response in MSS band 4 (near infrared), but low response in band 2. 

5 Hold down the Shift key, then click on the dark green ‘natural vegetation’ 
polygon in the image.
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Ellipses for both the ‘grass’ and ‘natural vegetation’ regions appear on the 
scattergram, so you can easily compare them. Comparing region means and ellipses 
in an excellent way to evaluate the separability of your class signatures.

Tip: To select multiple polygons, hold down the Shift key while clicking.

Close the scattergram dialogs
1 Click Close on the annotation Tools dialog to close it.

2 Click Cancel on the Scattergram Setup dialog to close it, then click 
Cancel to close the Scattergram dialog.

3: Classifying the image

Open the Supervised Classification dialog box
1 From the Process menu, select Classification, then select Supervised 

Classification. 

The Supervised Classification dialog box opens. The ‘Landsat_practice’ 
image is already chosen as the default input image.The dialog also lets you choose 
which bands of the image to use for the classification, and the type of classification 
(or decision rule) to use.

Objectives Learn how to use the training region statistics to perform a supervised 
classification on the entire image that assigns each pixel to one of the six feature 
classes you defined.

‘grass’ region

‘natural vegetation’
region
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2 Click the Output Dataset  chooser button.

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Miscellaneous’ directory to open it.

5 Double-click on the ‘Tutorial’ directory to open it.

6 In the Save As field, type a name using your initials at the beginning 
followed by the text ‘max_like_class,’ and separate each word with an 
underscore (_). For example, if your initials are “KA,” type in the name:

KA_max_like_class

7 Click OK or Save to validate the name and close the file chooser dialog.

Setup the classification type and parameters
1 Click the Classification Type drop-down to see the list.

ER Mapper provides Maximum Likelihood Enhanced, Minimum Distance, 
Minimum Distance with a standard deviation, Parallelopiped, and Mahalanobis 
classifiers.

2 From the Classification Type/Maximum Likelihood Enhanced menu, 
select Maximum Likelihood Standard.

3 Click the Setup button.

The Supervised Classification Setup dialog box opens. This dialog allows 
you to setup the options used for the classification, including which training regions 
to use (from this or other images), assigning class probabilities, and other options. 
By default, the five regions in your practice image are displayed.

4 Click the Close button to close the Supervised Classification Setup 
dialog box.

Classify the image
1 Click the OK button to start the classification.

2 When asked to confirm the successful completion, click OK. Then click 
Close and Cancel on the other two dialogs to close them.

The output of the classification is a single band image. Each pixel in the image is 
has a value ranging from 1 to 6 (the number of training regions you specified).

Open a second window and template algorithm

1 Click the New  toolbar button. 
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An image window appears.

2 Drag the new window down below the one displaying the Landsat image.

3 Click the Open  toolbar button. 

4 From the Directories menu, select the path ending with the text \examples.

5 In the directory ‘Miscellaneous\Templates\Common’, load the algorithm 
named ‘Classified_data.alg.’

A classified image of San Diego displays. This is a template algorithm you will use 
to display your classified image.

Load the classified image you created earlier

1 Click the Edit Algorithm  toolbar button.

Notice that this algorithm has one layer of the type Class Display. The Class 
Display layer is designed to display images created with ER Mapper’s 
classification functions.

2 In the process diagram, click the Load Dataset  button. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Miscellaneous’ directory to open it.

5 In the directory ‘Tutorial,’ double-click on the image ‘max_like_class’ you 
created earlier to load it.

Each pixel in the original Landsat image is assigned to one of the six training 
classes you defined earlier. The class colors are those you defined for the training 
region polygons.

6 From the Edit menu (on the main menu), select Edit Class/Region Color 
and Name. 

The Edit Class/Region Details dialog opens showing the name and color assigned 
to each class. If desired, you could change them here.

7 Click Cancel on the Edit Class/Region Details dialog to close it.

Close all image windows and dialog boxes
1 Click Close on the Algorithm window to close it.

2 Close all image windows using the window system controls:

• Select Close from the window control-menu.

3 Click Close on the Algorithm window to close it.
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Only the ER Mapper main menu should be open on the screen.

4: Generating Confusion Matrices

Overview
The ER Mapper Confusion Matrix facility tests a classified image against a 
reference dataset, and then generates the following types of matrices:

• Row counts

• User’s accuracy

• Producer’s accuracy

It also displays the Overall accuracy and the Kappa statistics.

All of these can give a good indication of the classification accuracy. For more 
information on these matrices refer to Chapter 24, “Supervised and Unsupervised 
Classification” in the ER Mapper User Guide.

Obviously, the reference data is crucial in creating the matrices. One method of 
obtaining this reference data is to establish sample “ground truth” points on the 
image, and then to physically go to where the points are located in the field to 
verify the actual class to which they belong. The information from these points can 
then be collated into an ASCII XYZ text file in which each line represents a single 
sample point. The information for each point includes the X and Y coordinates of 
the location of the point, and the number and label of the class to which the point 
belongs. This file can be imported as an ER Mapper vector dataset via the Utilities 
/ Import Vector and GISformats / ASCII Points with Attributes menu 
option. You can then enter this vector file as the reference dataset to generate 
confusion matrices. This reference should be very accurate because the sample 
points been physically verified in the field. The accuracy of the confusion matrices 
depends on the number of sample points and how they are distributed over the 
classes.

Another source of reference data is the actual training regions that were used to 
classify the image under test. This will provide you with a very good indication of 
how accurate the classification was, and the effectiveness of the training regions. 
The ER Mapper Confusion Matrix facility accepts only classified images or vector 
images with points and attributes as reference datasets. Training regions are neither 
of these, so it is necessary to create a classified image that includes only the areas 
within the training regions. This exercise describes how this is done.

Objectives Learn how to use the ER Mapper Confusion Matrix facility to test the accuracy of 
the Supervised Classification, using the original training regions as a reference.
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Load and display the practice image

1 On the ER Mapper Standard Toolbar, click the Open  button to open 
the file chooser. 

2 From the Directories menu, select the path ending with the text \examples.

3 Open the ‘Miscellaneous’ directory.

4 In the directory ‘tutorial,’ double-click on the image named 
‘Landsat_practice.ers’.

The original Landsat MSS practice image will be displayed with Bands 1, 2 and 3 
in Blue, Green and Red bands respectively.

5 If necessary, you can click on the 99% Contrast Enhancement button  
to make the image visible.

6 Click the Edit Algorithm  toolbar button to open the Algorithm window.

Add a formula to each layer
We will add a formula to each layer that excludes those parts of the image that do 
not fall within the training regions that were previously added to this image.

1 On the Algorithm window, click on the Red layer to highlight it.

2 Click the Edit Formula  button in the process diagram to open the 
Formula Editor dialog.

3 In the Generic formula window, edit the formula text to read:

if inregion(region1) or inregion(region2) or 
inregion(region3) or inregion(region4) or  
inregion(region5) or inregion(region6) then INPUT1 else 
null

This formula tells ER Mapper to process and display the image data inside the 
regions. Areas that fall outside the regions are not displayed.

4 Click the Apply changes button.

Notice that the Inputs and Regions buttons above the Relations window are now 
active. Image band 3 is assigned to generic INPUT1 by default.

5 Click the Regions button, select different Region names from the drop-
down list next to ‘REGION1’, ‘REGION2’ etc.

The formula will cause ER Mapper to display in the Red layer only the parts of 
Band 3 that fall within the regions.
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6 On the Formula Editor dialog, click on the Green layer  button to edit the 
formula in the Green Layer.

7 In the Generic formula window, edit the formula text to read:

if inregion(region1) or inregion(region2) or 
inregion(region3) or inregion(region4) or  
inregion(region5) or inregion(region6) then INPUT1 else 
null

This formula tells ER Mapper to process and display the image data inside the 
regions.

8 Click the Apply changes button.

Notice that the Inputs and Regions buttons above the Relations window are now 
active. Image band 2 is assigned to generic INPUT1 by default.

9 Click the Regions button, select a different Region names from the drop-
down list next to ‘REGION1’, ‘REGION2’ etc.

The formula will cause ER Mapper to display in the Green layer only the parts of 
Band 2 that fall within the regions.

10 On Formula Editor dialog, click on the Blue layer  button to edit the 
formula in the Green Layer.

11 In the Generic formula window, edit the formula text to read:

if inregion(region1) or inregion(region2) or 
inregion(region3) or inregion(region4) or  
inregion(region5) or inregion(region6) then INPUT1 else 
null

This formula tells ER Mapper to process and display the image data inside the 
regions.

12 Click the Apply changes button.

Notice that the Inputs and Regions buttons above the Relations window are now 
active. Image band 1 is assigned to generic INPUT1 by default.

13 Click the Regions button, select a different Region names from the drop-
down list next to ‘REGION1’, ‘REGION2’ etc.

The formula will cause ER Mapper to display in the Blue layer only the parts of 
Band 2 that fall within the regions.

14 Close the Formula Editor by clicking on the Close button.
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Save as a Virtual Dataset
We now save the algorithm as a virtual dataset, so that it can be used to create a 
classified image.

1 On the Standard toolbar, click on the Save As  button.

2 In the Files of Type: field, select ’ER Mapper Virtual Dataset (.ers)’.

3 From the Directories menu, select the path ending with the text \examples. 

4 Double-click on the directory ‘Miscellaneous’ to select it.

5 Double-click on the directory ‘Tutorial’ to open it.

6 In the Save As: text field, type a name using your initials at the beginning, 
followed by the text ‘land_use_region_vds.’ Separate each word with an 
underscore (_). For example, if your initials are “KA,” type in the name:

KA_land_use_regions_vds

7 Click OK or Save to save the virtual dataset.

8 Answer Yes to the “Delete final transforms for virtual dataset?” query.

Add the Region layer to the virtual dataset
We now need to add the region layer from the ‘Landsat_practice.ers’ dataset to the 
newly created virtual dataset.

1 On the Algorithm window, select Edit / Add Vector Layer / Region Layer.

This will add a new Region Layer to the algorithm.

2 In the Region layer process diagram, click the Load Dataset  button. 

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Miscellaneous’ directory to open it.

5 In the directory ‘Tutorial,’ double-click on the image ‘Landsat_practice’ to 
load it.

The Regions will now be displayed over the image. The areas of the image 
displayed should be bounded by the Region polygons. 

6 In the process diagram, click the Annotate Vector Layer  button to 
open the Tools dialog.

7 On the Tools dialog, click on the Save As  button.

This will open the Map Composition Save As dialog.

8 In the Save As box, select Raster Region.
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9 Click on the file chooser button in the Save To File: field.

10 From the Directories menu, select the path ending with the text \examples. 

11 Double-click on the directory ‘Miscellaneous’ to select it.

12 Double-click on the directory ‘Tutorial’ to open it.

13 Select the name of the virtual dataset you created; e.g. 
‘KA_land_use_regions_vds’ and click OK.

14 Click OK on the Map Composition Save As dialog to save the region layer 
to the Virtual Dataset.

15 Answer Yes to overwriting the file.

The ER Mapper Message Window will indicate that it is adding new regions to the 
virtual dataset.

Close all image windows and dialog boxes
1 Click Close on the Message Window to close it

2 Click Close on the Tools dialog to close it.

3 Click Close on the Algorithm window to close it.

4 Close all image windows using the window system controls:

Open the Supervised Classification dialog box
1 From the Process menu, select Classification, then select Supervised 

Classification. 

The Supervised Classification dialog box opens. 

2 Click the Input Dataset  chooser button.

3 From the Directories menu, select the path ending with the text \examples.

4 Double-click on the ‘Miscellaneous’ directory to open it.

5 Double-click on the ‘Tutorial’ directory to open it.

6 Double-click on the name of the virtual dataset you created; e.g. 
‘KA_land_use_regions_vds’.

7 Click the Output Dataset  chooser button.

8 From the Directories menu, select the path ending with the text \examples.

9 Double-click on the ‘Miscellaneous’ directory to open it.

10 Double-click on the ‘Tutorial’ directory to open it.
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11 In the Save As field, type a name using your initials at the beginning 
followed by the text ‘land_use_regions_vds_class,’ and separate each word 
with an underscore (_). For example, if your initials are “KA”, type in the 
name:

KA_land_use_regions_vds_class

12 Click OK or Save to validate the name and close the file chooser dialog.

13 Click the Classification Type drop-down to see the list.

14 From the Classification Type/Maximum Likelihood Enhanced menu, 
select Maximum Likelihood Standard.

15 Click the OK button to start the classification.

16 When asked to confirm the successful completion, click OK. Then click 
Close and Cancel on the other two dialogs to close them.

The output of the classification is a single band image of the training regions. Each 
pixel in the image has a value ranging from 1 to 6 (the number of training regions 
you specified).

Generate Confusion Matrices
Here we will use the newly classified image as a reference to test the previously 
classified image Every cell in the reference image becomes a sample point to test 
the classified image.

1 In the ER Mapper View menu, highlight Statistics, and then click on 
Confusion Matrix... to select it.

The Confusion Matrix Setup dialog box will open.

2 In the Matrix Type: field, select ‘Row Counts’

3 Click on the Reference Dataset file chooser  button.

4 From the Directories menu, select the path ending with the text \examples.

5 Double-click on the ‘Miscellaneous’ directory to open it.

6 Double-click on the ‘Tutorial’ directory to open it.

7 Double-click on the name of the classified dataset you created; e.g. 
‘KA_land_use_regions_vds_class’.

8 Click on the Classified Dataset file chooser  button.

9 From the Directories menu, select the path ending with the text \examples.

10 Double-click on the ‘Miscellaneous’ directory to open it.

11 Double-click on the ‘Tutorial’ directory to open it.
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12 Double-click on the name of the classified dataset you originally created; 
e.g. ‘KA_max_like_class’.

13 Click OK to generate the matrix.

The Confusion Matrix Display window will display a matrix where the rows 
show how the image under test has classified the areas within the regions, and the 
columns show how the reference dataset has classified the same areas.

Depending on how your PC is set up, the display might not be easy to see. You can 
save it as a text file to view with a text editor.

14 Click on the Print/Save... button to open the Print dialog.

15 On the Print dialog, select File as the Destination, and Report for the 
Format.

16 Click on the file chooser button and select a suitable file name for the text 
file.

17 Click OK to save the text file.

18 Open the text file in a text editor. You may have to do some editing to make 
it clearer.

An example matrix display (after editing) is shown below:

Raw Count Confusion matrix for:
Reference Dataset  - KA_land_use_regions_vds_class.ers
Classified Dataset - KA_max_like_class.ers

Overall Accuracy: 99.287% from 20618 observations

Kappa statistic: 0.966

------------------------------------------------------------------------------------
Classified File\Reference File
------------------------------------------------------------------------------------

Barren 
land

Residential 
areas

Urban 
areas

Grass 
and 
parks

Natural 
vegetation

Ocean

Barren land/cement 77 0 0 0 0 0

Residential areas 0 453 8 0 15 0

Urban areas 0 13 426 0 0 0

Grass and parks 0 0 0 83 0 0

Natural vegetation 0 13 1 0 1186 45

Ocean 0 0 0 0 52 18246
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From the above, we can see that the reference dataset provided 20,618 sample 
points (cells). Of these 99.287% were classified correctly in the classified image. 
The Kappa statistic of 0.966 indicates that the classification is 96.6% better than 
that expected if we had randomly assigned a class to each image pixel in the 
classified image.

The ‘Barren land’ classification appears to be accurate because, of the 77 points on 
the training regions, all were classified correctly in the classified image. The 
training region for ‘Natural vegetation’ was somewhat larger, providing 1253 
sample points. Of these, the classified image classified 15 as ‘Residential areas’ 
and 52 as ‘Ocean’. 

19 On the Confusion Matrix Setup dialog box select User’s Accuracy as the 
Matrix Type, and click OK.

The Confusion Matrix Display window will display a matrix showing the 
User’s Accuracy in classification. This is the percentage of sample points that the 
classified image predicts to be in particular class with which the reference data 
concurs. 

Depending on how your PC is set up, the display might not be easy to see. You can 
save it as a text file to view with a text editor.

20 Click on the Print/Save... button to open the Print dialog.

21 On the Print dialog, select File as the Destination, and Report for the 
Format.

22 Click on the file chooser button and select a suitable file name for the text 
file.

23 Click OK to save the text file.

24 Open the text file in a text editor. You may have to do some editing to make 
it clearer.

An example matrix display (after editing) is shown below:

Raw Count Confusion matrix for:
Reference Dataset  - KA_land_use_regions_vds_class.ers
Classified Dataset - KA_max_like_class.ers

Overall Accuracy: 99.287% from 20618 observations

Kappa statistic: 0.966

------------------------------------------------------------------------------------
Classified File\Reference File
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------------------------------------------------------------------------------------

From the above, we can see that ‘Barren land’ had 100% User’s accuracy value, 
indicating that all the sample points were classified correctly. 

25 On the Confusion Matrix Setup dialog box select Producer’s Accuracy 
as the Matrix Type, and click OK.

The Confusion Matrix Display window will display a matrix showing the 
Producer’s Accuracy in classification. This is the percentage of sample points in a 
particular class in the reference data, that were correct in the classified image. 

Depending on how your PC is set up, the display might not be easy to see. You can 
save it as a text file to view with a text editor.

26 Click on the Print/Save... button to open the Print dialog.

27 On the Print dialog, select File as the Destination, and Report for the 
Format.

28 Click on the file chooser button and select a suitable file name for the text 
file.

29 Click OK to save the text file.

30 Open the text file in a text editor. You may have to do some editing to make 
it clearer.

An example matrix display (after editing) is shown below:

Raw Count Confusion matrix for:
Reference Dataset  - KA_land_use_regions_vds_class.ers
Classified Dataset - KA_max_like_class.ers

Overall Accuracy: 99.287% from 20618 observations

Kappa statistic: 0.966

------------------------------------------------------------------------------------
Classified File\Reference File

Barren 
land

Residential 
areas

Urban 
areas

Grass 
and 
parks

Natural 
vegetation

Ocean

Barren land/cement 100.0% 0.000% 0.000% 0.000% 0.000% 0.000%

Residential areas 0.000% 95.168% 1.681% 0.000% 3.151% 0.000%

Urban areas 0.000% 2.961% 97.039% 0.000% 0.000% 0.000%

Grass and parks 0.000% 0.000% 0.000% 100.000% 0.000% 0.000%

Natural vegetation 0.000% 1.044% 0.080% 0.000% 95.261% 3.614%

Ocean 0.000% 0.000% 0.000% 0.000% 0.284% 99.716%
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------------------------------------------------------------------------------------

From the above, we can see that ‘Ocean’ had 99.754% Producer’s accuracy value, 
indicating that not all the sample points in the reference were classified correctly. 

Close all windows and dialog boxes
1 Click Cancel on the Confusion Matrix display window to close it.

2 Click Cancel on the Confusion Matrix Setup dialog to close it.

• Draw polygons to define training regions for a supervised classification

• View statistics, histograms, and scattergrams for each training region

• Perform a supervised classification

• Display a classified image using a Class Display layer type

• Prepare Training Regions to be used as the reference to generate Confusion Matrices

• Generate and display Confusion Matrices to determine the classification accuracy.

Barren 
land

Residential 
areas

Urban 
areas

Grass 
and 
parks

Natural 
vegetation

Ocean

Barren land/cement 100.0% 0.000% 0.000% 0.000% 0.000% 0.000%

Residential areas 0.000% 94.572% 1.839% 0.000% 1.197% 0.000%

Urban areas 0.000% 2.714% 97.931% 0.000% 0.000% 0.000%

Grass and parks 0.000% 0.000% 0.000% 100.000% 0.000% 0.000%

Natural vegetation 0.000% 2.714% 0.230% 0.000% 94.653% 0.246%

Ocean 0.000% 0.000% 0.000% 0.000% 4.150% 99.754%

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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20

Change
Detection

This chapter discusses change detection techniques that can be applied to new road 
development, urban development, crop and forest monitoring, land degradation and 
any application that requires change detection.

About monitoring landuse
With the availability of multi-temporal images, be they Airborne, Satellite or 
Airphotos, monitoring landuse using image processing becomes viable. The 
application of change detection techniques on multi-temporal images is also easy, 
reliable and effective. By applying change detection techniques on multi-temporal 
images changes in land cover can be monitored and determined. It also enables 
organisations to maintain the integrity of the data that they manage. Multi-temporal 
imagery can be processed to highlight changes in pixel spectral response between 
image dates. Such information can be used in the decision making process, or used 
to monitor changes over time as an aid to updating information databases.

Change detection techniques are used to highlight new road development, urban 
development, crop and forest monitoring, land degradation and any application that 
requires change detection.
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Reliable result
To obtain reliable results from processing multi-temporal imagery using change 
detection methods, the imagery of different dates should be rectified to the same 
co-ordinate system. (This is covered in the chapter on image rectification). The 
more accurate the image rectification is, the better and more reliable your result 
will be. The second important factor is the compatibility of the dynamic range of 
the imagery of the different dates. Since multi-temporal images are taken at 
different dates, the atmospheric effects will be different on the images. Hence 
atmospheric correction is necessary. A simple way to rectify the atmospheric 
problem is to apply dark pixel correction to the temporal images prior to carrying 
out change detection on the multi-temporal images.

Standardising atmospheric effects using Dark Pixel Correction
The aim of standardising atmospheric effects using dark pixel correction is to 
reduce atmospheric effects on imagery and normalise scenes for comparison. Dark 
Pixel Correction technique involves subtracting the pixel value of the darkest pixel 
over water from all pixel values in the same image. This is a quick and easy 
technique and assumes that the atmosphere has affected each pixel in the dataset 
equally. This cannot always be assumed, and care should be taken.

The standardising atmospheric effects using dark pixel correction technique is 
made easier by opening up two windows, one with each dataset, and geolinking 
them so that, at all times, they show the same ground area. It is best to select an area 
of the image where pixel values are relatively uniform such as a waterbody. By 
using the Cell Values Profile window, you can determine corresponding pixel 
responses in each dataset, and build up a table that will allow you to work out if one 
dataset exhibits brighter or darker responses on average. You should sample at least 
20 pixels across the entire image in order to establish an appropriate pattern. If, on 
average, the pixels in image A are brighter or darker than image B by a constant 
amount, then you can standardise the images by altering the formula of one image 
to read Input1 + (or) - (some constant value). You will need to save this as a new 
dataset in order to carry out any further processing.

Hands-on exercises
These exercises give you practice using formula to carryout change detection on 
multi-temporal images. The multi-temporal images used are TM images of 
SanDiego taken in 1985 and 1991. The datasets are in the ‘\examples\Shared_Data’ 
directory and the dataset names are ‘Landsat_TM_year_1985.ers and 
Landsat_TM_year_1991.ers’. Both datasets have been rectified..

What you will 
learn...

After completing these exercises, you will know how to perform these tasks in 
ER Mapper:
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• Eliminate seasonal and atmospheric effects 

• Create Virtual Dataset containing of multi-temporal images 

• Red Green difference change detection method

• Image Differencing change detection method

• Band Ratioing change detection method

• Principal Components Analysis change detection method

1:Eliminating seasonal and atmospheric 
effects

Open an image window and the Algorithm window to load 
Landsat_TM_year_1985 image

1 On the Standard toolbar, click on the View Algorithm for Image Window 

 button.

An image window and the Algorithm window appear.

2 Click on the Layer tab to view the settings for the layer. 

3 On the Algorithm window, click the Load Dataset  button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

4 From the Directories menu, select the path ending with \examples. 

The scrolling list in the center now shows a list of directories containing example 
images supplied with ER Mapper (such as ‘application...’ and others).

5 Double-click on the directory named ‘Shared_Data.’

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to reduce the difference in the atmospheric effects on the two temporal 
images using dark pixel correction technique.

Before you 
begin...

Before beginning this exercise, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.
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A list of raster images is displayed. Note that each has a “.ers” file extension. This 
is the file extension associated with raster files in ER Mapper format. 

6 Scroll down to view the image named ‘Landsat_TM_year_1985.ers,’ then 
double-click on it to load it.

The file chooser dialog box closes, and the image is loaded into the Pseudocolor 
layer. Note that the layer now shows the name of the image loaded 
(‘Landsat_TM_year_1985’), and the button left of the name is now selected 
(indicating that the layer is turned on).

ER Mapper renders the image in the image window. The image (band one) is 
displayed in a range of colors because the color table named Pseudocolor is 
chosen.

7 On the Algorithm window click on the surface tab. By default the Color 
Mode is in Pseudocolor. If not, change it to Pseudocolor mode. From the 
Color Table drop down list choose ‘greyscale’.

8 Click 99% Contrast Enhancement button to display the band 1 of the 
dataset.

View lowest cell values in the image for all bands of Landsat_TM_year_1985 
dataset

1 From the View menu, select Cell Values Profile....
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2 The Cell Values Profile dialog box appears. Drag it by its title bar next to the
image window. This dialog has three display windows, any of which can be turned
on or off at any time

3 By default, the Values option is selected. (If this has been changed, turn on 
Values and turn off Signature and Neighbors.)

4 Select the Average option on the Cell Values Profile dialog box

5 On the main menu, click the Pointer Tool  toolbar button.

Set Pointer mode tells ER Mapper that you want to use the mouse pointer to view 
data values. (The other mode, Zoom mode, sets the pointer for use as a zoom and 
pan tool.)

6 Point inside the image window, and drag the mouse pointer through the 
water area around the island at the bottom part of the image.

Average
option

Signature
window

Neighbors
window

Values
window
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The Cell Values Profile dialog displays the average data values of water in all 
seven bands in the Landsat image for the all the cells (pixel) locations that you 
dragged your cursor along. The average data values are updated as you drag the 
mouse to new locations.

7 Note down the average cell values of water for all 7 bands.

Open an image window and the Algorithm window to load 
Landsat_TM_year_1991 image

1 On the Standard toolbar, click on the New  button.

A new image window appears.

2 The existing Algorithm window becomes a new Algorithm window for the 
new window. If you have closed the Algorithm window, on the Standard 

toolbar, click on the Edit Algorithm  button.

3 The Algorithm window appears.

4 Click on the Layer Tab to view the settings for the layer. 

5 On the Algorithm window, click the Load Dataset  button  on the left 
side of the process stream diagram.

Drag the cursor
along the water
area
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The Raster Dataset file chooser dialog box appears.

6 Select the path ending with /examples/Shared_Data’.

7 Double-click on the dataset named ‘Landsat_TM_year_1991.ers’ to load 
the dataset.

Band one of the dataset is loaded into the Pseudocolor layer. 

8 On the Algorithm window click on the surface tab. By default the Color 
Mode is in Pseudocolor. If not, change it to Pseudocolor mode. From the 
Color Table drop down list choose ‘greyscale’.

9 Click 99% Contrast Enhancement button to display the band 1 of the 
dataset.

View lowest cell values in the image for all bands of Landsat_TM_year_1991 
dataset

1 From the View menu, select Cell Values Profile....

2 The Cell Values Profile dialog box appears. Drag it by its title bar next to the
image window. This dialog has three display windows, any of which can be turned
on or off at any time.

Average
option

Signature
window

Neighbors
window

Values
window
Comprehensive ER Mapper Training Workbook  358



Chapter 20 Change Detection ●  1:Eliminating seasonal and atmospheric effects
3 By default, the Values option is selected. (If this has been changed, turn on 
Values and turn off Signature and Neighbors.)

4 Select Average on the Cell Values Profile dialog box

5 On the main menu, click the Pointer Tool  toolbar button.

Set Pointer mode tells ER Mapper that you want to use the mouse pointer to view 
data values. (The other mode, Zoom mode, sets the pointer for use as a zoom and 
pan tool.)

6 Point inside the image window, and drag the mouse pointer through the 
same water area around the island at the bottom part of the image as you 
did for the ‘Landsat_TM_year_1985.ers’ image.

The Cell Values Profile dialog displays the average data values of water in all 
seven bands in the Landsat image for all the cells (pixel) locations that you dragged 
your cursor over. The average data values are updated as you drag the mouse to new 
locations.

7 Note down the average cell values of water for all 7 bands.

8 Check the differences in the average cells values of water for corresponding bands
1 to 7 of the two temporal images. (You will notice that
‘Landsat_TM_year_1991.ers’ dataset has values higher than those in
‘Landsat_TM_year_1985.ers’ dataset: The differences are approximately 11 (99-
88) for Band 1, 8 (35-27) for Band 2, 9 (31-22) for Band 3, 5 (16-11) for Band4, 2
(122-120) for Band 6 and 5 (9-4) for Band 7.

Reducing the differences in the atmospheric effects between the two 
temporal images

1 On the Algorithm window for the ‘Landsat_TM_year_1991.ers’ dataset, 

make sure band 1 is displayed. Click on the Edit Formula  button in the 
process stream diagram. 

The Formula Editor dialog box opens.

Note that the generic formula window contains the text “INPUT1” by default, and 
that INPUT1 is assigned to dataset band 1 in the Relations window.

2 In the Generic formula window, edit the formula text to read:

INPUT1 - 11
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Note: You are subtracting 11 from the DN value of each pixel of band 1of the 
‘Landsat_TM_year_1991.ers’ dataset so as to reduce the difference in the 
atmospheric effects between band 1 of the ‘Landsat_TM_year_1985.ers’ and 
‘Landsat_TM_year_1991.ers’ datasets.

3 Click the Apply changes button on the Formula Editor dialog box.

4 Click 99% Contrast Enhancement button to display band 1 of the 
dataset adjusted for atmospheric effects.

5 Click your left hand mouse button on the Pseudo Layer. A text field will 
appear. In the text field change the band description to B1-1991.

Correcting atmospheric effects for bands (2-7)

1 On the Algorithm window click on the Duplicate button  and duplicate 
band 1 of the dataset. 

2 Turn off the first Pseudo Layer.

3 Click on the second Pseudo Layer and make it the active layer.

4 On the Algorithm window from the band selection , 
select band 2 of the ‘Landsat_TM_year_1991.ers’ dataset for the second 
Pseudo Layer. 

5 Click on the Edit Formula  button in the process stream diagram. 

The Formula Editor dialog box opens.

6 In the Generic formula window, edit the formula text to read:

INPUT1 - 8

Note: You are subtracting 8 from the DN value of each pixel of band 2 of the 
‘Landsat_TM_year_1991.ers’ dataset so as to reduce the difference in the 
atmospheric effects between band 2 of the ‘Landsat_TM_year_1985.ers’ and 
‘Landsat_TM_year_1991.ers’ datasets.

7 Click the Apply changes button on the Formula Editor dialog box.
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Note: On the Formula Editor dialog box check the relationship window (middle part of 
the Formula Editor dialog box) and see that band 2 of the dataset is selected before 
clicking on the Apply changes button.

8 Click 99% Contrast Enhancement button to display band 2 of the 
dataset adjusted for atmospheric effects.

9 Click your left hand mouse button on the Pseudo Layer. A text field will 
appear. In the text field change the band description to B2-1991.

10 Repeat the process for all the other bands (3-7) with the formula for band 3 
(INPUT1 - 9), for band 4 (INPUT1 - 5),for band 5 (INPUT1 - 4),for band 6 
(INPUT1 - 2) and for band 7 (INPUT1 - 5).

11 Edit the band description for each band. Change the description for band 3 
to (B3-1991), for band 4 to (B4-1991), for band 5 to (B5-1991), for band 6 
to (B6-1991) and for band 7 to (B7-1991).

12 Turn on all the 7 pseudocolor layers of ‘Landsat_TM_year_1991.ers’ which 
have been adjusted for the atmospheric effects to match the atmospheric 
effects of ‘Landsat_TM_year_1985.ers’ dataset.

13 Delete the transform from each of the 7 layers.

Note: Deleting the transform from each of the layers maintains the dynamic range of the 
atmospheric adjusted data value of the 7 bands without scaling or clipping.

14 On the Standard toolbar, click the Save As  button.

The Save As... dialog box appears. This dialog lets you specify a path and name 
for your output disk file, and options for creating the new dataset.

15 On the Save As ... dialog, select the path ending with the text /examples/
Miscellaneous/Tutorial.

16 In the Save As: text field, type in a name for the disk file. Use your initials at 
the beginning, followed by the text ‘Atmospheric_adjusted_TM_1991’ and 
separate each word with an underscore (_). For example, if your initials are 
"DH," type in the name:

DH_Atmospheric_adjusted_TM_1991

17 Click OK or Save to close the file chooser dialog.

Your name appears as the Output Dataset name with a ‘.ers’ extension. 
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Note: It is necessary to save the atmospheric affect adjusted data as a dataset for further 
processing. If you save the dataset as Virtual Dataset you will not be able to access 
the adjusted cell values. 

2:Creating Virtual Dataset of the two 
temporal imagery

Loading the first dataset

1 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

2 Click on the Layer Tab to view the settings for the layer. 

3 On the Algorithm window, click the Load Dataset  button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

4 Select the path ending with /examples/Shared_Data. 

5 Double-click on the dataset named ‘Landsat_TM_year_1985.ers’ to load 
the dataset.

Band one of the dataset is loaded into the Pseudocolor layer. 

6 On the Algorithm window click on the Surface Tab. By default the Color 
Mode is Pseudocolor. If not, change it to Pseudocolor mode. From the 
Color Table drop down list choose greyscale color.

7 Click 99% Contrast Enhancement button to display the band 1 of the 
dataset.

8 Click your left mouse button on the Pseudo Layer. A text field will appear. In 
the text field change the band description to B1-1985

Objectives Learn to create a Virtual dataset of two rectified temporal images.

Before you 
begin...

Before beginning this exercise, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.
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9 On the Algorithm window click on the Duplicate button  and duplicate 
band 1 of the dataset. 

10 Turn off the first Pseudo Layer.

11 Click on the second Pseudo Layer and make it the active layer.

12 On the Algorithm window from the band selector , select 
band 2 of the ‘Landsat_TM_year_1991.ers’ dataset for the second pseudo 
layer. 

13 Click 99% Contrast Enhancement button to enhance and display the 
band 2 of the dataset.

14 Click your left mouse button on the Pseudo Layer. A text field will appear. 
In the text field change the band description to B2-1985

15 Repeat the process for all other bands (3-7): duplicate the last band, turn off 
the second-last Pseudo Layer, activate the last Pseudo Layer, change the 
last Pseudo Layer to band 3,4,5,6 or 7 of the dataset from the band selector 
on the Algorithm window, enhance and display it with 99% Contrast 
Enhancement button and change the band description to B3-1985, B4-
1985, B5-1985, B6-1985 and B7-1985.

Loading the second dataset with the atmospheric effects adjusted

1 On the Algorithm window click on the Duplicate button  and duplicate 
band 7 of the ‘Landsat_TM_year_1985.ers’ dataset. 

2 Turn off the second last Pseudo Layer which is band 7 of the 
‘Landsat_TM_year_1985.ers’ dataset..

3 Click on the last Pseudo Layer which is the duplicated layer of the band 7 of 
the ‘Landsat_TM_year_1985.ers’ dataset and make it the active layer.

4 Click the Load Dataset  button in the process stream diagram for the 
last layer to open the file chooser dialog. 

5 Select the path ending with the text ‘examples/Miscellaneous/Tutorial,’ and 
load the dataset named ‘Atmospheric_adjusted_TM_1991.ers’ 

6 On the Raster Dataset file chooser click on OK this layer only button. 

Note: By clicking the OK this layer only button, you load the 
‘Atmospheric_adjusted_TM_1991.ers’ into the last Pseudo Layer only. If you click 
the OK button you load the ‘Atmospheric_adjusted_TM_1991.ers’ into all the 
Pseudo Layers which you do not want to do in this particular instance.
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Band one of the ‘Atmospheric_adjusted_TM_1991.ers’ dataset is loaded into 
the last Pseudo layer (eight Pseudo Layer). 

7 Click the 99% Contrast Enhancement button to display band 1 (B1-
1991) of the ‘Atmospheric_adjusted_TM_1991.ers’ dataset.

8 Click on the Pseudo Layer. A text field will appear. In the text field change 
the band description to B1-1991

9 On the Algorithm window click on the Duplicate button  and duplicate 
band 1 of the ‘Atmospheric_adjusted_TM_1991.ers’ dataset. 

10 Turn off the eight Pseudo Layer.

11 Click on the ninth Pseudo Layer and make it the active layer.

12 On the Algorithm window from the band selector , select 
band 2 of the ‘Atmospheric_adjusted_TM_1991.ers’ dataset for the ninth 
Pseudo Layer 

13 Click the 99% Contrast Enhancement button to display the band 2 of 
the ‘Atmospheric_adjusted_TM_1991.ers’ dataset.

14 Click your left hand mouse button on the Pseudo Layer. A text field will 
appear. In the text field change the band description to B2-1991

15 Repeat the process for all other bands (3-7) of the 
‘Atmospheric_adjusted_TM_1991.ers’ dataset, duplicating the last band, 
turning off the second-last Pseudo Layer, activate the last Pseudo Layer, 
change the last Pseudo Layer to band 3,4,5,6 or 7 of the 
‘Atmospheric_adjusted_TM_1991.ers’ dataset from the band selector on 
the Algorithm window, display it with 99% Contrast Enhancement button 
and change the band description to B3-1991, B4-1991, B5-1991, B6-1991 
and B7-1991.

16 Turn on all the 14 Pseudo Layers of ‘Landsat_TM_year_1985.ers’ and 
‘Atmospheric_adjusted_TM_1991.ers’ which have been adjusted for the 
atmospheric affect to match the atmospheric affect of 
‘Landsat_TM_year_1985.ers’ dataset.

17 Delete the transform of all the 14 layers

Note: Deleting the transform from each of the layers maintains the dynamic range of the 
data value of the 14 bands without scaling or clipping.

18 On the Standard toolbar, click the Save As  button.
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The Save As ... dialog box appears. This dialog lets you specify a path and name 
for your output disk file, and options for creating the new dataset.

19 On the Save As dialog, select the path ending with the text ‘/examples/
Miscellaneous/tutorial.

20 In the Save As: text field, type in a name for the disk file. Use your initials at 
the beginning, followed by the text ‘TM_1985_Atm_Adj_TM_1991_VDS’ 
and separate each word with an underscore (_). For example, if your initials 
are ‘DH’ type in the name:

DH_TM_1985_Atm_Adj_TM_1991_VDS

21 Click OK or Save to close the file chooser dialog.

Your name appears as the Output Dataset name with a ‘.ers’ extension. 

Note: You have saved the ‘Landsat_TM_year_1985.ers’ and 
‘Atmospheric_adjusted_TM_1991.ers’ datasets as a Virtual Dataset and you are 
ready to perform the change detection between the TM imagery of the two dates 
(1985 & 1991). 

3:Change Detection

(1) Red Green difference change detection method

The production of a red/green difference image is a widely used technique, and is 
particularly useful for interactive viewing of change areas. This technique involves 
displaying simultaneously one dataset in green and one dataset in red. The resultant 
combined image contains mainly shades of yellow (indicating the same response 
between dates), but areas which have changed appear as green or red. Red areas 
tend to have more contrast than green areas, therefore it is suggested that the most 
current image uses the red layer if increases in pixel brightness are of importance 
and vice versa. A viewing scale of 1:20 000 or larger is ideal for panning across the 

Objectives Learn a simple change detection method displaying compatible bands of imagery 
of different dates in Red and Green color layers in RGB color mode.

Before you 
begin...

Before beginning this exercise, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.
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image to delineate areas of interest. This technique is most effective where the 
magnitude of the areas to be found is anticipated to be quite large, such as cleared 
fields or changes in crop growth.

1 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

2 Click on the Layer Tab to view the settings for the layer. 

3 On the Algorithm window, click the Load Dataset  button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

4 From the Directories menu, select the path ending with ‘/examples/
Miscellaneous/tutorial’.

5 Double-click on the dataset named 
‘TM_1985_Atm_Adj_TM_1991_VDS.ers’ to load the dataset.

Band one (B1-1985) of the dataset is loaded into the Pseudocolor layer. 

6 On the Algorithm window click on the Surface Tab. By default the Color 
Mode is Pseudocolor. Change it to ‘Red Green Blue’ color mode. 

7 The Pseudo Layer is now with a red cross because it is incompatible with 
the ‘Red Green Blue’ color mode. Click your right mouse button on the 
Pseudo Layer. The short-cut menu appears. Choose ‘Red’ from the short-
cut menu and change the Pseudo Layer.

8 On the Algorithm window click on the Duplicate button  and duplicate 
band 1 (B1-1985) of the ‘TM_1985_Atm_Adj_TM_1991_VDS.ers’ dataset. 

9 Click your right mouse button on the duplicated Red layer. The short-cut 
menu appears. From the short-cut menu change the layer color to ‘Green’.

10 On the Algorithm window from the band selector , select 
the eight band of the ‘TM_1985_Atm_Adj_TM_1991_VDS.ers’ dataset 
which is band 1 of the ‘Atmospheric_adjusted_TM_1991.ers’ dataset .

11 Click 99% Contrast Enhancement button to display band 1 (B1-1985) 
of the ‘Landsat_TM_year_1985.ers’ in the Red layer and band 1 (B1-1991) 
of the ‘Atmospheric_adjusted_TM_1991.ers’ dataset in the Green layer.

12 You will notice that all the areas that have been changed in band 1 of 
TM_1991 imagery are highlighted in green and changed areas in band 1 of 
TM_1985 imagery are shown in red. Areas with no change are displayed in 
yellow.
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13 On the Algorithm window click on the Copy Window and Algorithm 

button  and duplicate both the image window and the Algorithm.

14 Change the bands to band 2 (B2-1985) for the Red layer and band 2 (B2-
1991) for the Green layer. 

15 Click 99% Contrast Enhancement button to display the band 2 (B2-
1985) of the ‘Landsat_TM_year_1985.ers’ in the Red layer and band 2 (B2-
1991) of the ’Atmospheric_adjusted_TM_1991.ers’ dataset in the Green 
layer.

16 Repeat the process and display Red Green change detection images of 
band 1-5&7 between ‘Landsat_TM_year_1985.ers’ and 
‘Atmospheric_adjusted_TM_1991.ers’ datasets. Compare the Red Green 
change detection images of the corresponding 1-5&7 bands of the imagery 
of the two dates.

Note: Due to slightly longer wavelength of band 7 (2.215_um) compared to band 1 
(0.485_um), band 7 has better penetration into clouds and thus producing thinner 
clouds in the band 7 change detection image. Thermal Infrared (TIR) band 
(11.45_um) (TM6) measures composite temperature of each pixel of the target area 
and provides different spectral reflectance information than wavelengths in VIS, 
NIR & SWIR. Hence TM6 is excluded in the exercise. The different reflection of 
different surface materials at different wavelengths should be taken into 
consideration when interpreting the change detection images. 

(2) Image Differencing change detection method

Image differencing is perhaps the most simple of all change detection methods. It is 
based upon the principle that by subtracting the pixel responses in one image from 
the corresponding pixel responses in another image, any negative value in the 
output image represents an increase or decrease in pixel response depending on the 
order of subtraction. For example, if the response from the latest image was 
subtracted from the response from the older image then all negative values in the 
output image would indicate an increase in pixel brightness.

Objectives Learn a simple change detection method of subtracting compatible bands of 
imagery of different dates and displaying the result as a greyscale or pseducolor 
image.

Before you 
begin...

Before beginning this exercise, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.
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All increases in scene brightness would cause negative pixel values in the output 
image but this is not to say that all negative values indicate significantly `changed' 
pixels. The histogram of the resultant dataset needs to be manipulated to isolate 
areas of increase or decrease that are significant. 

1 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

2 Click on the Layer Tab to view the settings for the layer. 

3 On the Algorithm window, click the Load Dataset  button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

4 From the Directories menu, select the path ending with ‘/examples/
Miscellaneous/tutorial’ to open it.

5 Double-click on the dataset named 
‘TM_1985_Atm_Adj_TM_1991_VDS.ers’ to load the dataset.

Band 1 (B1-1985) of the dataset is loaded into the Pseudocolor layer. 

6 On the Algorithm window click on the Surface Tab. By default the Color 
Mode is Pseudocolor. If not, change it to Pseudocolor mode. From the 
Color Table drop down list choose ‘greyscale’.

7 Click 99% Contrast Enhancement button to display the band 1 (B1-
1985) of the dataset.
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8 On the Algorithm window click on the Edit Formula button . The 
Formula Editor dialog box appears. 

9 In the Generic formula area type in ( i1 - i2 ) and click on Apply changes 
button on the Formula Editor dialog box.

10 In the Relations area for INPUT 1 select B1:B1-1985 which is the band 1 
(B1-1985) of the ‘Landsat_TM_year_1985.ers’ dataset and for INPUT 2 
select B8:B1-1991 which is the band 1(B1-1991) of the 
‘Atmospheric_adjusted_TM_1991.ers’ dataset .

11 Click the 99% Contrast Enhancement button to display the band 
differenced image of (B1:B1-1985) - (B8:B1-1991) which is the band 
differenced image of band 1 of ‘Landsat_TM_year_1985.ers’ and band 1 of 
‘Atmospheric_adjusted_TM_1991.ers’.

12 You will notice that the changed areas between the imagery of the two 
dates are highlighted, with positive values shown as bright areas and 
negative values shown as dark areas. The areas that haven’t changed are 
displayed as middle greyscale areas.

13 On the Algorithm window click on the Edit Transform Limits button  .

Generic

Formula

Relations

area

Specific

formula

(Type in text

or load from

file)

(assign inputs

to bands,

regions, etc)

menu bar to load

standard formula
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14 The Transform dialog box appears. 

15 On the Transform dialog box adjust thelower limit of X-axis transform as the 
change threshold to approximately 30 (the actual input limits range from -
156 to 142). 

Note: The DN value 30 is the threshold of the changed areas of the positive values of the 
dynamic range of the change detection image. Threshold values will depend on the 
type of application and imagery used and the dynamic range of the band 
differenced change detection image. 

Note: The areas of greatest change are found in the two ends - low and high DN - of the 
transform. Only changes in the high end of DN in the transform are defined in the 
above excercise.

Note: Only the changed areas of the high DN values are highlighted. 
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16 Change the color from greyscale to pseudocolor from the Color Table 
dropdown list on the Surface Tab and view the changed areas in 
pseudocolor. The changed areas are now shown in red.

Save the band differenced change detection image as a Virtual Dataset
1 Save the change detection image (Transform with threshold ~30) as a 

Virtual Dataset 

2 On the Standard toolbar, click the Save As  button.

3 From the Files of Type drop down list select ER Mapper Virtual 
Dataset(.ers).

4 Select the path ending with the text ‘/examples/Miscellaneous/tutorial’.

5 In the Save As : text field, type in a name for the disk file. Use your initials at 
the beginning, followed by the text ‘B1_difference_clipped_VDS’ and 
separate each word with an underscore (_). For example, if your initials are 
‘DH’ type in the name:

DH_B1_difference_clipped_VDS

6 Click OK to close the file chooser dialog.

Your name appears as the Output Dataset name with a ‘.ers’ extension. 

Calculate the statistics of the changed area 
1 On the main menu click the Process menu and from the dropdown list 

select Calculate Statistics. The Calculate Statistics dialog box appears.

2 On the Calculate Statistics dialog box load the 
‘B1_difference_clipped_VDS.ers’ dataset from the ‘tutorial’ directory.

3 You can choose the default Subsampling Interval as 4 which will calculate 
statistics quickly taking every fourth value or you can take subsampling 
interval of 1 for more accurate statistics calculation. 

Note: Do not select Force Recalculate stats: since it is the first time you calculate the 
statistics of this dataset.

4 Click the OK button on the Calculate Statistics dialog box to start 
calculating the statistics of the dataset.

5 After it has successfully calculated the staististics of the dataset, from the 
View menu on the main menu, select the Statistics option from the 
dropdown list and choose Show Statisitcs.. (View --> Statistics --> Show 
Statistics..)
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6 The Statistics Report dialog box appears.

7 Load the B1_difference_clipped_VDS.ers dataset from the ‘tutorial’ 
directory and click OK button to view the statistics of the changed areas. 

Note: Notice the Null Cells number and Non-Null Cells numbers. The Non-Null Cells 
numbers are for the changed areas. You can calculate the area extent or percent 
covered for the changed areas. 

Note: You have performed change detection for the higher end of the transform (high DN 
values from the ((band 1 of Landsat_TM_year_1985) - (band 1 of 
Atmospheric_adjusted_TM_1991)) band differenced image). For changes in the 
lower end of the transform (low DN values) to be highlighted, repeat the procedure 
mentioned above but use the formula ((band 1 of 
Atmospheric_adjusted_TM_1991) - (band 1 of Landsat_TM_year_1985)). 

Tip: To highlight the lower end of the transform of the ((band 1 of 
Landsat_TM_year_1985) - (band 1 of Atmospheric_adjusted_TM_1991)) band 
differenced image, click the Edit Formula button on the Algorithm window. The 
Formula Editor dialog box appears. Insert minus sign (-) in front of the formula. 
Apply changes and display the image. The transform is now inverted and previous 
lowest DN is now the highest DN. Apply a threshold to the inverted transform and 
define the changed areas of the inverted image - differenced change detection 
image. Save that as a Virtual Dataset

Note: After you have saved the two Virtual Dataset for the changes detected in the high 
and low ends of the transform of the image - differenced change detection image, 
use the Raster Cells to Vector Polygons option from the Process menu on the main 
menu window and convert them to vector format. Display a greyscale band 1 image 
of the Landsat_TM_year_1985.ers and overlay ontop of it the two vector layers 
of the changed areas detected for high and low ends of the transform of the image - 
differenced change detection image. Assign each vector layer a different color. 
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(3) Image ratioing change detection method

The technique of image ratioing involves dividing the spectral response value of a 
pixel in one image with the spectral value of the corresponding pixel in another 
image. This is done in order to suppress similarities between bands. The nature of 
band ratioing is that every pixel that has the same spectral response between input 
bands will have a value of 1 in the output image; deviations from 1 indicate 
progressively different initial spectral values. Areas of greatest change are found in 
the tails of the resultant histogram. Production of a change image involves 
thresholding the image histogram to suppress those areas where little or no change 
has occurred. 

1 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

2 Click on the Layer tab to view the settings for the layer. 

3 On the Algorithm window, click the Load Dataset  button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

4 From the Directories menu, select the path ending with ‘/examples/
Miscellaneous/Tutorial’.

5 Double-click on the dataset named 
‘TM_1985_Atm_Adj_TM_1991_VDS.ers’ to load the dataset.

Band one (B1-1985) of the dataset is loaded into the Pseudocolor layer. 

6 On the Algorithm window click on the surface tab. By default the Color 
Mode is Pseudocolor. If not, change it to Pseudocolor mode. From the 
Color Table drop down list choose ‘greyscale’.

7 Click 99% Contrast Enhancement button to display the band 1 (B1-
1985) of the dataset.

8 On the Algorithm window click on the Edit Formula button . The 
Formula Editor dialog box appears. 

Objectives Learn the image ratioing change detection method of dividing corresponding 
bands of imagery of different dates and display it as a greyscale or pseducolor 
image

Before you 
begin...

Before beginning this exercise, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.
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9 In the Generic formula area type in ( i1 / i2 ) and click on Apply changes 
button on the Formula Editor dialog box.

10 In the Relations area for INPUT 1select B1:B1-1985 which is the band 1 
(B1-1985) of the ‘Landsat_TM_year_1985.ers’ dataset, and for INPUT 2 
select B8:B1-1991 which is the band 1(B1-1991) of the 
‘Atmospheric_adjusted_TM_1991.ers’ dataset .

11 Click the 99% Contrast Enhancement button to display the band ratio 
image of (B1:B1-1985) / (B8:B1-1991) which is the band ratio of band 1 of 
‘Landsat_TM_year_1985.ers’ and band 1 of 
‘Atmospheric_adjusted_TM_1991.ers’.

12 You will notice that the changed areas between the imagery of the two 
dates are highlighted, with high values shown as bright areas and low 
values shown as dark areas.The areas without changes will be displayed as 
middle greyscale areas (The dynamic range of a band ratioed image is 
usually small and falls in the range of 0 to 10. That small dynamic range is 
scaled to 255 grey levels).

13 On the Algorithm window click on the Edit Transform Limits button  .

14 The Transform dialog box appears. 

15 On the Transform dialog box adjust thelower limit of X-axis transform as the 
change threshold to approximately 1.26 (the actual input limits range from 
0.361 to 2.327) 

Note: Only the changed areas of the high DN values are highlighted. 

16 Change the color from greyscale to pseudocolor using the Color Table on 
the Surface Tab and view the changed areas in pseudocolor. The changed 
areas are now shown in red.

Save the band ratioed change detection image as a Virtual Dataset
1 Save the changed areas highlighted in the band differenced image 

(Transform with threshold approximately at 1.26) as a Virtual Dataset.

2 On the Standard toolbar, click the Save As  button.

The Save As ... dialog box appears. This dialog lets you specify a path and name 
for your output disk file, and options for creating the new dataset.

3 On the Save As ...dialog box select the path ending with the text ‘examples/
Miscellaneous/Tutorial’.
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4 In the Save As: text field, type in a name for the disk file. Use your initials at 
the beginning, followed by the text ‘B1_ratio_clipped_VDS.ers’ and 
separate each word with an underscore (_). For example, if your initials are 
‘DH’ type in the name:

DH_B1_ratio_clipped_VDS

5 Click OK to close the file chooser dialog.

Your name appears as the Output Dataset name with a ‘.ers’ extension. 

Calculate the statistics of the changed area 
1 On the main menu click the Process menu and from the drop-down list 

select Calculate Statistics. The Calculate Statistics dialog box appears.

2 On the Calculate Statistics dialog box load the 
‘B1_ratio_clipped_VDS.ers’ dataset from the ‘tutorial’ directory.

3 You can choose the default Subsampling Interval as 4 which will calculate 
statistics quickly taking every fourth value or you can take subsampling 
interval of 1 for more accurate statistics calculation. 

Note: Do not select Force Recalculate stats: since it is the first time you calculate the 
statistics of this dataset.

4 Click the OK button on the Calculate Statistics dialog box to strart 
calculate the statistics of the dataset.

5 After ER Mapper has successfully calculated the statistics of the dataset, 
from the View, select the Statistics option from the drop-down list and 
choose Show Statistics.

6 The Statistics Report dialog box appears.

7 Load the ‘B1_ratio_clipped_VDS.ers’ dataset from the ‘tutorial’ directory 
and click OK button to view the statistics of the changed areas. 

Note: Notice the Null Cells number and Non-Null Cells numbers. The Non-Null Cells 
numbers are for the changed areas. You can calculate the area extent or percent 
covered for the changed areas. 
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Note: You have performed change detection for the higher end of the transform (high DN 
values from the ((band 1 of Landsat_TM_year_1985) / (band 1 of 
Atmospheric_adjusted_TM_1991)) band ratioed image). For changes in the 
lower end of the transform (low DN values) to be highlighted, repeat the procedure 
mentioned above but use the formula ((band 1 of 
Atmospheric_adjusted_TM_1991) / (band 1 of Landsat_TM_year_1985)). 

Tip: To highlight the lower end of the transform of the ((band 1 of 
Landsat_TM_year_1985) / (band 1 of Atmospheric_adjusted_TM_1991)) band 
ratioed image, click the Edit Formula button on the Algorithm window. The 
Formula Editor dialog box appears. Insert a minus sign (-) in front of the formula. 
Apply changes and display the image. The transform is now inverted and previous 
lowest DN is now the highest DN. Apply a threshold to the inverted transform and 
define the changed areas of the inverted image - band ratioed change detection 
image. Save the result as a Virtual Dataset.

Note: After you have saved the two Virtual Dataset for the changes detected in the high 
and low ends of the transform of the band ratioed change detection image, use the 
Raster Cells to Vector Polygons option from the Process menu on the main menu 
window and convert them to vector format. Display a greyscale band 1 image of the 
Landsat_TM_year_1985.ers and overlay on top of it the two vector layers of the 
changed areas detected for high and low ends of the transform of the band ratioed 
change detection image. Assign each vector layer a different color. 

(4) Principal Component Analysis change detection method

Objectives Learn the Principal Component Analysis change detection method by applying 
Principal Component Analysis on 6 bands of the images of the two dates 
(excluding band 6 which is Thermal Infrared (TIR) band):

• subtracting or ratioing the Principal Component 1 of 
Landsat_TM_year_1985.ers and Principal Component 1 
of the Atmospheric_adjusted_TM_1991.ers and 

• display the Principal Component Analysis change detection 
images as greyscale or pseducolor images
Comprehensive ER Mapper Training Workbook  376



Chapter 20 Change Detection ●  3:Change Detection
Principal Components Analysis (PCA) is a technique employed in image 
processing to reduce the correlation between bands of data and enhance features 
that are unique to each band. A characteristic of PCA is that information common 
to all input bands (high correlation between bands) is mapped to the first Principal 
Component (PC) whilst subsequent PCs account for progressively less of the total 
scene variance. The advantage of PCA principle is that you will obtain all common 
information of the six bands applied in the PCA, in the Principal Component 1. 
After accumulating all information common to the six bands in PC1 for both the 
multi-temporal imagery you perform either the band differencing or band ratioing 
change detection methods using the two PC1 of the multi-temporal imagery. The 
areas of greatest change are found in the tails of the image histogram. Though 
information common to the bands applied in the PCA of the multi-temporal 
imagery is used, precautions should be taken in applying Principal Component 
Analysis change detection method.

Calculate the statistics of the dataset

Note: In performing Principal Component Analysis, the dataset’s statistics should be 
calculated first. 

1 On the main menu, click on the Process menu and select Calculate 
Statistics.

The Calculate Statistics dialog box appears.

2 Load the ‘TM_1985_Atm_Adj_TM_1991_VDS.ers’ dataset from the 
‘tutorial’ directory.

3 You can choose the default Subsampling Interval as 4 which will calculate 
statistics quickly taking every fourth value or you can take subsampling 
interval of 1 for more accurate statistics calculation. 

Note: Do not select Force Recalculate stats: since it is the first time you calculate the 
statistics of this dataset.

4 Click the OK button on the Calculate Statistics dialog box to start 
calculating the statistics of the dataset.

5 After ER Mapper has successfully calculated the statistics of the dataset a 
small status window will appear and the message ‘Calculate Statistics 
finished successfully’ will be displayed.

Before you 
begin...

Before beginning this exercise, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.
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Load the dataset

1 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

2 Click on the Layer tab to view the settings for the layer. 

3 On the Algorithm window, click the Load Dataset  button  on the left of 
the process stream diagram.

The Raster Dataset file chooser dialog box appears.

4 Select the path ending with ‘examples/Miscellaneous/tutorial’.

5 Double-click on the dataset named 
‘TM_1985_Atm_Adj_TM_1991_VDS.ers’ to load the dataset.

Band one (B1-1985) of the dataset is loaded into the Pseudocolor layer. 

6 On the Algorithm window click on the Surface Tab. By default the Color 
Mode is in Pseudocolor. If not, change it to Pseudocolor mode. From the 
Color Table drop-down list choose ‘greyscale’.

7 Click 99% Contrast Enhancement button to display the band 1 (B1-
1985) of the dataset.

8 On the Algorithm window click on the Edit Formula button . The 
Formula Editor dialog box appears. 

9 On the Formula Editor dialog box, from the Principal Components menu 
select the PC1 generic. 

10 In the Generic Formula area the Principal Componet Analysis formula 
will be loaded for you. The PC1 generic formula is (SIGMA(I1-I7|I? * 
PC_COV(,R1,I?,1))

11 Change the formula to (SIGMA(I1-I6|I? * PC_COV(,R1,I?,1))

Note: You have changed the formula to calculate PC1 from 6 bands instead of from 7 
bands. 

12 In the relations area on the Formula Editor dialog box , select (B1-1985) to 
(B5-1985) and (B7-1985) which are band 1 to 5 and band 7 of the 
‘Landsat_TM_year_1985.ers’ dataset. 

Note: Band 6 is in the Thermal Infrared (TIR) electromagnetic spectrum region and is not 
used.
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13 Click the 99% Contrast Enhancement button to display the PC1 of 
‘Landsat_TM_year_1985.ers’.

14 Click your left mouse button on the Pseudo Layer. A text field will appear. In 
the text field change the band description to PC1-1985

15 On the Algorithm window click on the Duplicate button  and duplicate 
the PC1-1985 layer of the ‘Landsat_TM_year_1985.ers’.

16 Turn off the first PC1-1985 Pseudo Layer.

17 Click on the duplicated Pseudo Layer and make it the active layer

18 On the Algorithm window click on the Edit Formula button . The 
Formula Editor dialog box appears. 

19 On the Formula Editor dialog box, click on the Principal Components 
menu and select PC1 generic. 

20 In the Generic Formula area the Principal Componet Analysis formula will 
be loaded for you. The PC1 generic is (SIGMA(I1-I7|I? * 
PC_COV(,R1,I?,1))

21 Change the formula to (SIGMA(I1-I6|I? * PC_COV(,R1,I?,1))

Note: You have changed the formula to calculate PC1 from 6 bands instead of from 7 
bands. 

22 In the Relations area on the Formula Editor dialog box, select (B1-1991) to 
(B5-1991) and (B7-1991) which are band 1 to 5 and band 7 of the 
‘Atmospheric_adjusted_TM_year_1991.ers’ dataset. In the 
‘TM_1985_Atm_Adj_TM_1991_VDS.ers’ dataset they are (B8:B1-1991) to 
(B12:B5-1991) and (B14:B7-1991).

Note: Band 6 is in TIR electromagnetic spectrum region and is not used.

23 Click 99% Contrast Enhancement button to display the PC1 of 
‘Atmospheric_adjusted_TM_year_1991.ers’ dataset.

24 Click your left mouse button on the Pseudo Layer. A text field will appear. In 
the text field change the band description to PC1-1991

25 Turn on the first Pseudo Layer (PC1-1985).

26 Delete the transforms of both Pseudo Layers.
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Save the PC1-1985 and the PC1-1991 images as a Virtual Dataset

1 On the Standard toolbar, click the Save As  button.

The Save As ... dialog box appears. This dialog lets you specify a path and name 
for your output disk file, and options for creating the new dataset.

2 On the Save As dialog, select the path ending with the text ‘examples/
Miscellaneous/Tutorial’.

3 In the Save As : text field, type in a name for the disk file. Use your initials at 
the beginning, followed by the text ‘PC1_1985_PC1_1991_VDS.ers’ and 
separate each word with an underscore (_). For example, if your initials are 
‘DH’ type in the name:

DH_PC1_1985_PC1_1991_VDS

4 Click OK or Save to close the file chooser dialog.

Your name appears as the Output Dataset name with a ‘.ers’ extension. 

Apply band differencing change detection method to the PC1 of the multi-
temporal images

1 Follow the procedure of the band differencing change detection method and 
perform change detection on the ‘PC1_1985_PC1_1991_VDS.ers’ dataset.

Apply band ratioing change detection method to the PC1 of the multi-
temporal images

1 Follow the procedure of the band ratioing change detection method and 
perform change detection on the PC1_1985_PC1_1991_VDS.ers dataset.

Note: Compare the images and statistics of the threshold applied change detection images 
of Band Differencing, Band Ratioing and Principal Component Analysis change 
detection methods. You will notice that the Principal Component Analysis change 
detection method detects the greatest change. In comparing the change detection 
images of different methods it is best to Geolink the windows and compare them. 
Care should be taken in applying different change detection methods and accuracy 
should be assessed.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, select Close from the window control-menu.
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• For Unix systems, select Close or Quit from the window control menu in the 
upper-left corner (for systems with both options, select Quit). 

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Reduce atmospheric effects on images

• Create Virtual Dataset of multi-temporal images

• Perform Red Green Difference change detection method

• Perform Band Differencing change detection method

• Perform Band Ratioing change detection method

• Perform Principal Component Analysis change detection method

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Raster to vector
conversion

This chapter introduces you to the concept of raster to vector conversion and gives 
you practice using ER Mapper’s raster to vector conversion features.

About raster to vector conversion
Raster to vector conversion, sometimes called vectorization, allows you to convert 
data from a raster data structure to a vector data structure. For example, features or 
thematic classes defined by processing a satellite image can be converted to 
polylines and polygons, and then imported directly into a vector-based GIS product 
or used for further processing of raster data. Raster to vector conversion is an 
especially valuable feature for extracting timely information from satellite images 
to quickly update vector-based information stored in GIS products.

In raster to vector conversion, ER Mapper analyzes the boundaries of the features 
you specify in a raster image, then traces polylines or closed polygons around the 
features. Typically you first need to perform some type of image processing to 
extract the features you are interested in, such as classification or thresholding to 
mask or highlight a particular feature. After vectorizing the features of interest, the 
output polylines or polygons can be saved to an ER Mapper format vector file, 
regions in a raster file, an ARC/INFO GIS coverage, or exported to other vector 
formats such as DXF.
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Hands-on exercises
These exercises give you practice creating algorithms to highlight a feature in a 
raster image, and then converting the feature to a vector representation. In this case, 
you will create vector polygons from classes in a previously classified image, and 
generate a binary land/water image and create a vector representation of the 
coastline.

• Apply smoothing to a classified image to remove isolated pixels

• Extract classes from a classified image and convert them to vector polygons

• Process a satellite image to create a binary land/water image

• Vectorize the binary image to extract polylines tracing the coastline

1: Vectorizing a feature class

Display a classified Landsat image

1 Click on the Open  toolbar button.

An image window and the Algorithm dialog box appear.

2 From the Directories menu, select the path ending with the text \examples.

3 Double_click on the ‘Functions_And_Features’ directory to open it.

4 In the directory ‘Classification,’ open the algorithm 
‘ISOCLASS_Landsat_TM_year_1985.alg.’

What you will 
learn...

After completing these exercises, you will know how to perform these tasks in 
ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to prepare an algorithm displaying a classified image to extract and 
vectorize a feature class of interest, and perform the raster to vector conversion.
Comprehensive ER Mapper Training Workbook 383



Chapter 21 Raster to vector conversion ●  1: Vectorizing a feature class
ER Mapper runs an algorithm displaying a classified image of the San Diego, 
California area. This image was previously generated from a 1985 Landsat TM 
image of same area using ER Mapper’s ISOCLASS Unsupervised 
Classification feature. There are 10 feature classes in this image representing 
water, vegetation, barren land areas, and other feature classes.

Zoom in on the park area near the image center
1 Slightly to the right of the image center there is a nearly rectangular area 

containing mostly vegetation (shades of green and light green). This area is 

San Diego’s Balboa Park. Click the ZoomBox Mode  toolbar button 
and drag a zoom box surrounding the green areas defining the park 
borders.

Your zoomed image should show mostly green and light green pixels (vegetation) 
with possibly some magenta pixels (urban areas) along the outer borders. You will 
create a vector representation of the vegetation areas.

Apply a median filter to generalize the classification
Notice that the classification contains many small, isolated groups of pixels within 
the larger single color areas. It is generally a good idea to incorporate these isolated 
pixels into the larger feature classes before performing a raster to vector 
conversion. That way, you vectorize only the major features in the image and 
minimize the number of very small polygons that will be created.

1 In the process diagram, click the pre-formula Edit Filter (Kernel)  
button. (Be sure to choose the button left of the Formula button.)

2 On the Filter dialog, click the Filter filename  chooser button.

3 From the Directories menu, select the path ending with the text \kernel.

4 In the directory ‘filters_ranking,’ load the filter ‘median_5x5.ker.’

This is a 5 by 5 filter that assigns the center pixel the median values of all pixels in 
the 5 by 5 window. This and other filters such as ‘majority.ker’ are commonly used 
to generalize classified images.

5 ER Mapper runs the algorithm with the median smoothing filter.

Notice that most of the smaller, isolated pixels or clusters are merged into the 
surrounding dominant feature classes, giving the image smoother look.

6 Click Close on the Filter dialog to close it.
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Enter a formula to aggregate the two vegetation classes
Notice that there are two vegetation classes in this part of the image represented in 
green and light green (the light green areas are a golf course and darker green are 
other vegetation types). For this exercise, you will aggregate these into one 
common class representing all vegetation before vectorizing them. (You could also 
vectorize each into its own polygons if desired.)

1 Click the Edit Formula  button in the process stream diagram.

2 In the Generic formula window, edit the formula text to read:

if input1=3 or input1=5 then 5 else input1

This formula tells ER Mapper “if pixels have a value of 3 (class 3) or 5 (class 5) in 
the image, assign them both a value of 5, else do not change them.”

3 Click the Apply changes button to validate the formula.

ER Mapper runs the algorithm and aggregates the two classes.

Both vegetation classes are assigned the same value (5), so they both appear in the 
light green color. This light green area is portion of the image you will convert to a 
vector representation.

4 Click Close to close the Formula Editor dialog.

Save the algorithm as a Virtual Dataset
To run the raster to vector conversion, you need to save the algorithm as a Virtual 
Dataset (VDS). The VDS will contain all your processing, including the zoomed 
area, the smoothing filter, and the class aggregation formula.

1 From the File menu, select Save as....

2 Select ER Mapper Virtual Dataset (.ers) for the Files of Type: field.

3 From the Directories menu, select the path ending with the text \examples. 

4 Double-click on the directory named ‘Miscellaneous’ to open it.

5 Double-click on the directory named ‘Tutorial’ to open it.

6 In the Save As: text field, type a name using your initials at the beginning, 
followed by the text ‘raster_classes_VDS,’ and separate each word with an 
underscore (_). For example, if your initials are "CJ," type in the name:

CJ_raster_classes_VDS

7 Click OK to save the Virtual Dataset.

8 Click on the Yes button on the Delete output transforms... dialog box.
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Convert the raster cells to vector polygons
1 From the Process menu, select Raster Cells to Vector Polygons....

The Raster to Vector Conversion dialog box opens. This dialog contains 
options to vectorize specific bands or cells values in an image, to create polygons, 
polylines, or filled polygons, and to smooth (interpolate) vectors.

2 Click the Input Raster Dataset  chooser button.

3 From the Directories menu, select the path ending with the text \examples 
Then open the ‘Miscellaneous\Tutorial’ directory and load the 
‘raster_classes_VDS.ers’ image you just created.

4 Turn on the Fill Polygons option (to create polygons instead of polylines)

Tip: To smooth rugged edges of the polygons turn on Smooth option.

5 Click the Output Vector Dataset  chooser button.

6 From the Directories menu, select the path ending with the text \examples. 
Then open the ‘Miscellaneous\Tutorial’ directory and type a name in the 
Save As: text field as follows, then click OK to close the chooser. For 
example, if your initials are "JT," type in the name:

JT_vegetation_polygons

7 Edit the value in the Cell Value field to read 5 then press Enter or Return.

This tells ER Mapper to vectorize all pixels (cells) with the value 5 in the Virtual 
Dataset (the vegetation areas from the classification). By default, ER Mapper will 
create vector polygons.

8 Click OK to start the raster to vector conversion.

ER Mapper displays a status dialog indicating the progress, then displays a 
confirmation dialog when the conversion is complete.

9 Click OK to close the confirmation dialog, then click Close and Cancel to 
close the other two raster to vector dialogs.

You have now created a vector file containing polygons representing the areas of 
vegetation on the classified image.

Display the vector polygons over the classified image
1 In the Algorithm window, select Annotation/Map Composition from the 

Edit/Add Vector Layer menu.

A new annotation layer is added to the algorithm.
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2 Click the Edit Layer Color  button in the process stream diagram to 
choose a color for displaying the vectors. 

3 Select a red color, and click OK to close the Color Chooser.

4 Click the Load Dataset  button in the process steam diagram. 

5 From the Directories menu, select the path ending with the text \examples.

6 In the directory ‘Miscellaneous\Tutorial,’ double-click on the 
‘vegetation_polygons.erv’ image you created to load it.

ER Mapper first processes the raster data, then draws the vector polygons in red. 
Notice that the vectors closely follow the outlines of the green areas on the image.

Display the vector polygons alone
1 Turn off the Class Display layer containing the ISOCLASS image.

ER Mapper draws the vector polygons in red over an empty (black) backdrop 
image so your can see them more clearly. As you can see, vectorizing raster data in 
this way can save hours or days of digitizing feature outlines by hand, so it is 
especially valuable for updating vector information for use in GIS products.

2: Vectorizing a binary image

Display a greyscale Landsat algorithm

1 Click the Open  toolbar button. 

2 From the Directories menu, select the path ending with the text \examples.

3 Double_click on the ‘Data_Types’ directory to open it.

4 In the directory ‘Landsat_TM,’ open the algorithm ‘Greyscale.alg.’

ER Mapper runs an algorithm displaying band 1 of a Landsat TM satellite image of 
the San Diego, California area. This image contains a significant area of ocean in 
the lower portion, and artificial recreational bay in the upper-left (Mission Bay). 
You will create a binary image to separate the land from the water, then vectorize 
the image to trace the coastline.

Objectives Learn to prepare an algorithm that creates a binary image (land and water in this 
case), and perform the raster to vector conversion to extract a polyline defining 
the coastline.
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Enter a formula to mask land from water
Binary images are often created in earth science image processing to mask or 
isolate major features from each other. Land/water binary images are especially 
common because analysts are often only interested in working with one of the two 
features, and wish to mask out the other. A simple way to do this, when possible, is 
to define a data threshold to separate one feature from the other.

1 Click the Edit Formula  button in the process stream diagram.

2 In the Generic formula window, edit the formula text to read:

if input1 < 20 then 1 else 2

This formula tells ER Mapper “if pixels in the band selected for input1 have a value 
less than 20, assign them a value of 1, else assign all other a value of 2.” After this 
formula each pixel in the image will be reassigned a data value of 1 or 2 (a binary 
image).

3 Click the Apply changes button to validate the formula.

4 In the Relations window, click on the ‘INPUT1’ drop-down list and select 
B5:1.65_um.

Now your formula uses a threshold of 20 in band 5 (mid infrared) to separate land 
from water. Infrared bands are useful for separating land from water because water 
absorbs nearly all incident infrared radiation. 

Note: The threshold value of 20 for this image was determined in an earlier exercise using 
ER Mapper’s Traverse Extraction feature. This value would typically be 
different for each image.

Initially the image appears black because the Transform limits need to be adjusted.

5 Click Close to close the Formula Editor dialog.

Adjust the Color Table and Transform for the binary image
1 From the Color Table drop-down list, select unique.

‘Unique’ is a special lookup table with widely different colors in slots next to each 
other (so it is good for emphasizing small differences in data values).

2 Click the post-formula Edit Transform Limits  button to open the 
Transform dialog box. 

3 On the Transform dialog, click the Create default linear transform  
button to reset the transform line.
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4 From the Limits menu, select Limits to Actual.

The image is displayed in two colors–grey for the water areas (a value of 1) and red 
for the land areas (a value of 2). The land and water are generally well separated 
from each other.

Save the binary algorithm as a Virtual Dataset
1 Click Close to close the Transform dialog.

2 From the File menu, select Save as....

3 Select ER Mapper Virtual Dataset (.ers) for the Files of Type: field.

4 From the Directories menu, select the path ending with the text \examples. 

5 Double-click on the directory named ‘Miscellaneous’ to open it.

6 Double-click on the directory named ‘Tutorial’ to open it.

7 In the Save As: text field, type a name using your initials at the beginning, 
followed by the text ‘binary_image_VDS,’ and separate each word with an 
underscore (_). For example, if your initials are “BP,” type in the name:

BP_binary_image_VDS

8 Click OK to save the Virtual Dataset.

9 Answer Yes to the Delete output transforms for virtual dataset query.

You adjusted the transform so the binary image could be displayed onscreen. 
Before vectorizing the binary image, you need to delete the transform so the 1-2 
data range is not transformed to 0-255.

Convert the raster cells to vector polylines
1 From the Process menu, select Raster Cells to Vector Polygons....

The Raster to Vector Conversion dialog box opens. 

2 Click the Input Raster Dataset  chooser button.

3 From the Directories menu, select the path ending with the text \examples. 
Then open the ‘Tutorial’ directory and load the ‘binary_image_VDS.ers’ 
image you just created.

4 Click the Output Vector Dataset  chooser button.

5 From the Directories menu, select the path ending with the text \examples. 
Then open the ‘Miscellaneous\Tutorial’ directory and type a name in the 
Save As: text field as follows, then click OK to close the chooser. For 
example, if your initials are “MJ,” type in the name:
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MJ_vector_coastline

6 Edit the value in the Cell Value field to read 1 then press Enter or Return.

This tells ER Mapper to vectorize all pixels (cells) with the value 1 in the Virtual 
Dataset (the water areas in the image).

7 Turn on the Polylines option (to create polylines instead of polygons).

8 Click OK to start the raster to vector conversion.

ER Mapper displays a status dialog indicating the progress, then displays a 
confirmation dialog when the conversion is complete.

9 Click OK to close the confirmation dialog, then click Close and Cancel to 
close the other two raster to vector dialogs.

You have now created a vector file containing polylines representing the coastline 
(land/water boundary) in the Landsat TM image.

Display the vector polylines over the Landsat image

1 Click the Open  toolbar button. 

2 From the Directories menu, select the path ending with the text \examples.

3 Double_click on the ‘Data_Types’ directory to open it.

4 In the directory ‘Landsat_TM,’ open the algorithm ‘Greyscale.alg.’

This is the same Landsat TM image you used to create the binary VDS.

5 In the Algorithm window, select Annotation/Map Composition from the 
Edit/Add Vector Layer menu.

A new annotation layer is added to the algorithm.

6 Click the Edit Layer Color  button in the process stream diagram to 
choose a color for displaying the vectors. 

7 Select a yellow color, and click OK to close the Color Chooser.

8 Click the Load Dataset  button in the process stream diagram. 

9 From the Directories menu, select the path ending with the text \examples.

10 In the directory ‘\Miscellaneous\Tutorial,’ double-click on the 
‘vector_coastline.erv’ image you created to load it.

ER Mapper first processes the raster data, then draws the vector polylines in 
yellow. Notice that the vectors closely follow the land/water boundary in the image.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Apply smoothing to a classified image to remove isolated pixels

• Extract classes from a classified image and convert them to vector polygons

• Process a satellite image to create a binary land/water image

• Vectorize the binary image to extract polylines tracing the coastline

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Vector and
tabular data

This chapter explains how to use ER Mapper to add overlays of vector and tabular 
data from external products and sources.

About vector data and Dynamic Links
In addition to drawing your own annotation using ER Mapper’s drawing tools, you 
can also display vector data imported from other applications, and link directly to 
data in external formats without translation. These functions can be useful for 
overlaying geological interpretations stored in vector format, or linking to and 
displaying tabular data (such as well locations) or vector data (such as lease 
boundaries) in external formats.

Vector data can come from GIS products or external file formats such as DXF or 
Postscript. Typical uses for vector Dynamic Links include displaying subsurface 
geological structure interpretations, surface geology, or cultural data such as lease 
boundaries or road networks.

Tabular data can come from database products or tabular data files. ER Mapper can 
display tabular (point) data as colored circles of varying sizes. This capability is 
useful for applications such as plotting the locations of wells, drill sites, sample 
sites, and so on.
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Hands-on exercises
These exercises introduce you to the basic features for displaying vector and tabular 
data in ER Mapper.

Note: These exercises use a satellite image as the reference raster image for overlaying 
vector and tabular data, but the same concepts apply to using seismic or other 
geophysical data.

• Add annotation layers to display and edit vector data stored in ER Mapper format.

• Add Tabular Data layers to display data stored in tabular format

• Add layers to display data stored in an external vector GIS format

1: Overlaying vector data

Load a greyscale satellite image algorithm

1 Click the Edit Algorithm  toolbar button.

An image window and the Algorithm dialog box appear.

2 Click the Open  toolbar button. 

3 From the Directories menu, select the path ending with the text 
\examples\Data_Types.

4 Double-click on the directory named ‘SPOT_Panchromatic’.

5 Double-click on the algorithm named ‘Greyscale.alg.’

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn to add a layer to an algorithm to display vector data imported from an 
external format. In this case you will overlay vectors for a road network 
previously imported using ER Mapper’s vector import utilities.
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The algorithm displays a satellite image of the San Diego, California area in the US 
from the SPOT satellite system. The image is 10 meter resolution, so it provides 
good detail and is often used for base mapping applications.

Add an Annotation layer and load a vector roads image
1 On the Algorithm window, select Annotation/Map Composition from the 

Edit/Add Vector Layer menu.

An Annotation layer is added to the algorithm layer list.

2 Click the Load Dataset  button in the process stream diagram for the 
new layer to open the file chooser dialog. 

3 From the Directories menu, select the path ending with the text \examples.

4 In the directory named ‘Shared_Data’, load the file named 
‘San_Diego_roads.erv.’

This is a vector image of roads in the greater San Diego area. It was previously 
imported from a Digital Line Graph (DLG) file format using the ER Mapper import 
utilities that converted it to an ER Mapper format vector file (with an “.erv” file 
extension).

5 In the process diagram, click the Edit Layer Color  button.

6 Choose a red color, then click OK to close the Color Chooser dialog.

ER Mapper runs the algorithm again and displays the vector road network as a red 
overlay. If desired, you can edit the vectors to add, delete or modify them. (Use of 
the annotation tools is covered in the chapter on Map Composition.)

7 In the Annotation layer’s text description field, type the new description text 
San Diego roads and press Enter or Return.

2: Overlaying tabular data

Turn off the vector roads layer
1 In the Algorithm window, turn off the vector ‘San Diego roads’ layer by 

right-clicking on the layer name and selecting Turn Off.

(This will make it easier to see the tabular data where there is overlap.)

Objectives Learn to add a layer to an algorithm to display point data stored in a tabular 
format. (The examples used here are fire station locations, but they could just as 
easily be well locations on an interpreted time surface.)
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Add a Tabular Data layer and load sample data
1 From the Edit/Add Vector Layer menu (on the Algorithm window), select 

Tabular Data, then select Table of data shown as Outline Circles.

A Table of Data layer is added to the algorithm layer list.

2 With the Table of Data layer selected, click the Load Dataset  button in 
the process diagram. 

3 From the Directories menu, select the path ending with the text \examples.

4 In the directory named ‘Data_Types\Spot_Panchromatic’, load the file 
named ‘San_Diego_Fire_Stations.tbl.’

This is a tabular dataset containing the locations of fire fighting stations in the 
greater San Diego area.

5 In the process diagram, click the Edit Layer Color  button.

6 Choose a cyan (light blue) color, then click OK to close the Color Chooser 
dialog.

ER Mapper runs the algorithm again and displays the location of each fire station 
as a cyan circle. (To display the circles, ER Mapper is accessing data in an external 
file with an Easting and Northing value for each location and other information.)

7 In the Annotation layer’s text description field, type the new description text 
fire stations and press Enter or Return.

3: Overlaying GIS vector data

Turn off the Tabular Data layer
1 In the Algorithm window, turn off the tabular ‘fire stations’ layer by right-

clicking on the layer name and selecting Turn Off.

(This will make it easier to see the GIS data where there is overlap.)

Add an ARC/INFO layer
1 From the Edit/Add Vector Layer menu (on the Algorithm window), select 

ARC/INFO Coverage.

Objectives Learn to add a layer to an algorithm to display vector data stored in an external 
GIS product format (ARC/INFO in this case). In this case, you will display a 
network of roads stored in an ARC/INFO format coverage file.
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An ARC/INFO layer is added to the algorithm layer list.

2 With the ARC/INFO layer selected, click the Dynamic Link Chooser  
button in the process diagram.

The ARC/INFO Chooser dialog box opens to let you choose the coverage you 
want to link. (Note that the button is different from the Load Dataset button 
because you are not loading an ER Mapper format raster or vector file, but linking 
directly to a file that is not in ER Mapper format.)

3 On the ARC/INFO Chooser dialog, click the Workspace  button. 

The ARC/INFO Workspaces dialog opens to let you specify the location of the 
ARC/INFO coverage files on your system.

4 From the Directories menu, select the path ending with the text 
examples\Shared_Data.

5 Click once on the directory named ‘arc_info_workspace’ to select it, then 
click the Select button.

The ARC/INFO Chooser dialog now shows the selected workspace, and the 
Coverage drop-down list shows the available GIS vector coverages.

Choose a coverage, line width and line color
1 On the ARC/INFO Chooser dialog, select lajollards from the Coverage 

drop-down list.

This coverage file contains the road network for the La Jolla area of San Diego 
(covering the northern portion of this SPOT satellite image).

2 Select 1.0 from the Line Width drop-down list.

3 Click OK on the ARC/INFO Chooser dialog to close it.

ER Mapper runs the algorithm again and displays a large area network of roads in 
the La Jolla area. This data was accessed directly from an ARC/INFO coverage file, 
so no file translation was needed to display it. (You can also edit ARC/INFO 
coverages and save them back to coverage format.)

4 Click the Edit Layer Color  button in the ARC/INFO layer’s process 
diagram.

5 Choose a yellow color, then click OK to close the Color Chooser dialog.

IER Mapper runs the algorithm again and displays the network in yellow.

6 n the Annotation layer’s text description field, type the new description text 
La Jolla roads and press Enter or Return.
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Turn on all three color layers
1 Turn on all three of the color layers by right-clicking on their names and 

selecting Turn On.

Note: Vector layers always appear on top of any raster layers in an algorithm, regardless 
of their position in the layer list. Relative to each other, the uppermost vector or 
tabular layer has display priority where there is spatial overlap with other vector or 
tabular layers.

2 Click on the ‘fire stations’ layer to select it, then click the Move Up button 

.

The ‘fire stations’ tabular layer moves above the other two vector layers, so it now 
has the highest display priority.

The circles representing fire station now appear on top of the vector roads overlays.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Add annotation layers to display and edit vector data stored in ER Mapper format.

• Add Tabular Data layers to display data stored in tabular format

• Add a layer to display data stored in an external vector GIS format

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Gridding
The ER Mapper Gridding Wizard uses irregularly spaced data to create a gridded 
raster image. It does this by laying a regularly spaced grid over the whole area and 
calculating a value for each cell in the grid. The accuracy of these calculations 
depends on the method used and the density and spacing of the input data.

The ER Mapper Gridding Wizard extracts regularly gridded raster files from a 
combination of any or all of the following types of data.

• Random line data 
• Contour data, with faults, streamlines, ridgelines, and breaklines
• Random point data 
• Regular line data
• Regularly gridded raster file 

The output data is a raster (.ers) file with single or multiple bands containing 
regularly spaced grids.

ER Mapper supports two gridding techniques:

• Triangulation

• Minimum Curvature Under Tension

These are described in Chapter 38, “Gridding”, in the ER Mapper User Guide.
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Creating a gridded raster image
You can use the ER Mapper Gridding Wizard to generate a single or multiband 
raster image file from one or more input data sources. The input sources can be any 
of the following formats:

• Generic ASCII XYZ

• DXF

• USGS contour format (DLG-3)

• Any raster formats directly readable by ER Mapper (including .ers) 

• ER Mapper .erv format

Hands-on exercise
These exercises give you practice in using the Gridding Wizard to create a gridded 
raster image. 

1: Create a gridded image from text files

Open the Gridding Wizard

1 Click the Gridding Wizard button on the Common Functions toolbar. 

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.
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The Gridding Wizard dialog opens with the 1)Introduction tab selected. 

2 Select the New grid project option.

Notice that the Grid project file: field is grayed out. This is because you are 
creating a new project file. Therefore, you do not have to specify an existing one.

3 Click on the Next> button or select the 2) Data Sources tab.

Both actions will take you to the next step by opening the Data Sources tab
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Select the input data source.

This tab allows you to enter one or more data sources for gridding. The data 
sources can be from the same or adjacent areas. For this example we are going to 
choose a number of text files as data sources. 

The list of data sources should be empty because we have not yet entered any.

1 Click on the Add... button to enter a data source.

A file chooser dialog should open.

2 In the chooser dialog Files of Type field, select AsciiXYZtext(.txt).

3 From the Directories menu, select the path ending with the text \examples

4 Double-click on the directory named ‘Functions_And_Features’ and then on 
the ‘Gridding’ directory.

The directory has four text files, supplied with the permission of the Geological 
Survey of Western Australia, that list geochemical sample readings at locations 
specified by Easting/Northing coordinates. An extract from the 
‘Peak_Hill_Al203.txt’ file listing aluminum oxide sample readings is shown below

#Easting Northing Al203

679346 7186699 11

675848 7182842 10.4

675882 7180203 7.22

680312 7182703 8.76

Data source
list
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The information contained in the file is known as ASCIIXYZ data. The X Y 
components are the Easting/Northern coordinates of the locations, and the Z 
component is the aluminum oxide reading at each of the X Y locations. 

The other three files are ‘Peak_Hill_CaO.txt’, ‘Peak_Hill_Fe203.txt’ and 
‘Peak_Hill_MgO.txt’ which list traces of calcium oxide, copper oxide and 
magnesium oxide respectively.

In this exercise we will use the Gridding Wizard to create a gridded raster image 
with separate bands each showing overall concentrations of aluminum oxide, 
calcium oxide, copper oxide and magnesium oxide.

5 Click on the file named ‘Peak_Hill_Al203.txt, and then click Apply.

The Ascii Projection Details dialog box should open.

6 Check that the projection details are as shown above and then click on the 
OK button to return to the data source chooser.

If the projection details are not as shown above, use the file chooser buttons  
on the Geodetic datum and Geodetic projection fields to select ‘AGD66’ for 
the datum, and ‘TMAMG50’ from the ‘tranmerc’ projection list. Set Coordinates 
to ‘Easting/Northing’.

7 Repeat steps 5 and 6 to add the following files to the data source list:

• Peak_Hill_CaO.txt

• Peak_Hill_Fe203.txt

• Peak_Hill_MgO.txt

Click OK instead of Apply after selecting the last file.
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The file names will appear in the source list box.

8 Click on the Next> button to go to the 3) Output Bands tab.

Define the output bands

The output gridded raster image can have one or more bands of information. The 
“Output Bands’ tab allows you to specify how the input sources are to be mapped 
to these output bands. There are three main options:

Create a separate band 
from each data source

Each input source is allocated to a separate band. 
This creates an output gridded image with multiple 
bands as thematic overlays.
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1 Select the default option Create a separate band from each data source.

The list box will show:

You will not be able to edit the entries in the list box.

2 Click on the Next> button to go to the 4) Grid Type tab.

Mosaic all data sources 
into a single band

All the input sources are allocated, i.e. mosaiced, 
into a single band. This creates a single band output 
gridded image.

Custom Enables the toolbar buttons for you to customize the 
output. You can specify the number of output bands 
and their descriptions, and then allocate individual 
or combinations of input sources to the output 
bands.

Output band
Gridded Data:1
Gridded Data:2
Gridded Data:3
Gridded Data:4

Data source
Peak_Hill.Al203.txt, Band:1
Peak_Hill.MgO.txt, Band:1
Peak_Hill_Fe203.txt, Band:1
Peak_Hill.CaO.txt, Band:1
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Select the gridding method

There are two gridding methods available, viz. Triangulation and Minimum 
Curvature. Triangulation is simpler and works best with evenly distributed data. 
Minimum Curvature has a number of parameters which you can adjust to suit the 
input data. 

The ‘Grid Type’ tab allows you to set the gridding method for the output bands 
collectively or individually.

We will set all the bands to Triangulation.

1 Click on the All Triangulation (TIN) button to set the gridding method to 
Triangulation.

You could also have selected Triangulation from the drop-down list next to each 
band description.

Notice that the Advanced... buttons are grayed out. This is because you do not 
have to set any further parameters for Triangulation.

2 Click on the Next> button to go to the 5) Create Grid tab.
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Create the gridded image

The Create Grid tab allows you to specify the file name and define the Extents, 
Projection and Cell attributes of the output gridded file. You can also select how 
you want the gridded image to be displayed.

1 Click on the File Chooser  button to open the Gridding Wizard Output 
File chooser dialog box.

2 From the Directories menu, select the path ending with the text \examples

3 Double-click on the directory named ‘Miscellaneous’.

4 Double-click on the directory named ‘Tutorial.’

5 Enter ‘minerals_triangulated_grid_<your initials>’ in the chooser Save as: 
field, and click on the OK button.

The name with its path and a ‘.ers’ extension will be inserted in the File: field of 
the ‘Create Grid’ tab. When you create the gridded image it will be saved to that 
file name.
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6 Click on the Set Projection... button to open the Grid Output Coordinate 
Space dialog.

This dialog allows you to select a Geodetic datum, Geodetic projection and 
Coordinate type for the output gridded image. For this example we will use default 
values.

7 Click on the Defaults button to select the default values.

8 Click on the OK button to return to the Gridding Wizard.

9 Click on the Edit Extents... button to open the Grid Output Extents dialog 
box.

This dialog box allows you to specify the area to be included (extents) in the output 
gridded image. If you select the Maximum extents option, the output image will 
include the full extents of all the data sources. If you select the Custom extents 
option, you can then enter the top left and bottom right coordinates of the gridded 
image in the units you specified in the Grid Output Coordinate Space dialog. 
Generally this is in Eastings/Northings Longitude/Latitude or meters. This enables 
you to limit the extents of the gridded image to an area of interest.

10 Select the Maximum extents option.

11 Click on the OK button to return to the Gridding Wizard.
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12 Check that the number of cells and lines in the Cell attributes box show 
reasonable values. 

13 If the size of the output file is larger than 12 Mb, increase the Cell size X: 
and Cell Size Y: values until the size is less than 12Mb.

Note: In practice you would probably not do this because it decreases the resolution of the 
output gridded image. It is done here to save time and conserve disk space.

Cell size values of 150 should result in the file size shown below

14 Select the following  display option:

• Display gridded image with input overlaid as points

You could also have selected the following options but, for the purpose of this 
exercise, we will just select the one:

• Display gridded image

• Display gridded image with sunshading

15 Select the Save Grid Project File button the open the chooser dialog.

All the grid data sources and settings you entered are stored in a project file which 
you can save and re-use.

16 From the Directories menu, select the path ending with the text \examples

17 Double-click on the directory named ‘Miscellaneous’.

18 Double-click on the directory named ‘Tutorial.’

19 Enter ‘grid_project_1_<your initials>’ in the chooser Save as: field, and 
click on the OK button.

The project file is saved to the file name with a ‘.egp’ extension.

20 Click on the Finish button to generate the gridded image and close the 
Gridding Wizard

A Status dialog will indicate the progress of the gridding. On completion, 
ER Mapper will display an image window displaying the following algorithm;

• The gridded image in a pseudo layer and a grid datasource points vector layer.
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21 Click on the Close button to close the Status dialog.

View an algorithm with the gridded image
1 Click on the image window title bar to make it active.

2 Open the Algorithm dialog by clicking on the Edit Algorithm button  on 

the Common Functions toolbar.

The algorithm has a surface with Pseudo and a Grid Datasource Points vector layer. 

3 Select the Pseudo layer

This layer contains band B1 Gridded Data:1 of the raster image you created. This 
displays the overall traces of aluminum oxide gridded from the 
‘Peak_Hill_Al203.txt’ data source

4 Select bands B2 to B4.

The image window will display the gridded trace of mineral associated with the 
band.

5 Select the Grid Datasource Points layer.

Notice that this layer is a Dynamic Link to the Project File you created. It shows 
point locations for the layer 1 (aluminum oxide) sample readings.

6 Click on the Dynamic Link Chooser  button in the layer process 
diagram to open the Display grid datasource points dialog box.

7 Select ‘Gridded Data:2’ from the Grid Layer drop-down list, and click on the 
Finish button to exit the dialog.

The image window will now show the point locations for the layer 2 (calcium 
oxide) sample readings.1

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:
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• Select Close from the window control-menu.

Only the ER Mapper main menu should be open on the screen.
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2: Create a gridded image using Minimum 
Curvature

In this exercise, we will create the same gridded image as we did previously. 
Instead of using Triangulation for all the bands we will now use Minimum 
Curvature for two of them. We will also gave the bands more meaningful names.

Open the Gridding Wizard

1 Click on the Gridding Wizard  button on the Common Functions 
toolbar. 

The Gridding Wizard dialog opens with the 1)Introduction tab selected. 

2 Select the Existing grid project option.

3 Select your previously saved ‘grid_project_1_<your initials>.egp’ project file 
from the ‘\examples\Miscellaneous\Tutorial’ directory.

4 Click on the Gridding Wizard Next> button or select the 2) Data Sources 
tab.

Both actions will take you to the next step by opening the ‘Data Sources’ tab

5 The list of data sources should show the four ‘Peak_Hill’ text files you 
selected in the previous exercise.

Leave the data sources unchanged.

6 Click on the Next> button to go to the 3) Output Bands tab.
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Define the output bands

1 Select the option Custom.

This should already be the default selection because we are using an existing 
Project File. The toolbar buttons will now be visible. 

We want to give the output bands more meaningful names.

2 Select the ‘Gridded Data:1’ entry under Output band.

3 Click on the Edit output band description  button.

The Edit band description dialog will open.

4 In the Band description field, enter the text “Al203 - triangulated”. Make 
sure that the ‘Peak_Hill_Al203.txt’ data source is allocated to this output 
band. If not, change the name accordingly.

5 Click on the OK button to return to the Gridding Wizard.

The Output band name will have changed to “Al203 - triangulated”.

6 Repeat the previous two steps and rename the other bands, “CaO - 
triangulated”, “Fe203 - MinC” and “MgO - MinC”.
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You should now have the following entries in the list:

7 Click on the Next> button to go to the 4) Grid Type tab.

Select the gridding method

We will set two bands to Triangulation, and the others to Minimum Curvature.

1 Select Triangulation from the drop-down list next to ‘Al203 - triangulated’ 
and ‘CaO - triangulated’.
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2 Select Minimum Curvature from the drop-down list next to ‘Fe203 - MinC’ 
and ‘MgO - MinC’.

3 Click on the Advanced... button next to the ‘Fe203 - MinC’ entry to open the 
Minimum Curvature Parameters dialog.

4 Use the sliders to set the Boundary tension(%) and Interior tension(%) to 
25.

Note: Leave the other settings at their default values. It is advisable not to change them 
unless you have a good reason for doing so and you know what you are doing. See 
“Gridding methods” on page 582 of the ER Mapper User Guide for more 
information on these parameters.

This will create the ‘Fe203 - MinC’ band with Minimum Curvature under tension, 
and the ‘MgO - MinC’ band with Minimum Curvature.

5 Click on the OK button to close the dialog and return to the Gridding 
Wizard.

6 Click on the Next> button to go to the 5) Create Grid tab.
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Create the gridded image

The ‘Create Grid’ tab allows you to specify the file name and define the Extents, 
Projection and Cell attributes of the output gridded file. You can also select how 
you want the gridded image displayed.

1 Click on the File Chooser  button to open the Gridding Wizard Output 
File chooser dialog box.

2 From the Directories menu, select the path ending with the text \examples

3 Double-click on the directory named ‘Miscellaneous’ and then select the 
‘Tutorial’ directory.

4 Enter ‘minerals_MinC_grid_<your initials>’ in the chooser Save as: field, 
and click on the OK button.

The name with its path and a ‘.ers’ extension will be inserted in the File: field of 
the ‘Create Grid’ tab. When you create the gridded image it will be saved to that 
file name.

5 Select all the display options:

• Display gridded image

• Display gridded image with sunshading

• Display gridded image with input overlaid as points

The image will be displayed in three separate image windows.

6 Select the Save Grid Project File... button to open the chooser dialog.
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All the grid data sources and settings you entered are stored in a project file which 
you can save and re-use.

7 From the Directories menu, select the path ending with the text \examples

8 Double-click on the directory named ‘Tutorial.’

9 Enter ‘grid_project_2_<your initials>’ in the chooser Save as: field, and 
click on the OK button.

The project file is saved to the file name with a ‘.egp’ extension.

10 Click on the Finish button to generate the gridded image and close the 
Gridding Wizard

A status dialog will indicate the progress of the gridding. 

On completion, ER Mapper will display three image windows displaying the 
following algorithms;

• The gridded image in a pseudo layer

• The gridded image in a pseudo layer and an intensity layer with sunshading on.

• The gridded image in a pseudo layer and a grid datasource points vector layer.;

View an algorithm with the gridded image
1 Click on the ‘pseudo layer’ image window title bar to make it active.

2 Open the Algorithm dialog by clicking on the Edit Algorithm button  on 

the Common Functions toolbar.

The algorithm has a surface with Pseudo layer. 

3 Select the Pseudo layer

This layer contains band B1:Al203 - triangulated of the raster image you created. 
This displays the overall traces of aluminum oxide gridded from the 
‘Peak_Hill_Al203.txt’ data source.

4 Select the B3:Fe203 - MinC band from the drop -down list.

The image window will now display the overall iron oxide traces gridded from the 
‘Peak_Hill_Fe302.txt’ data source using the Minimum Curvature method.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

Only the ER Mapper main menu should be open on the screen.

• Use the Gridding Wizard to create a multi-band gridded image from text files.

• Select some of the output bands to use Triangulated gridding, and others to use 
Minimum Curvature and Minimum Curvature under tension.

What you 
learned...

After completing these exercises, you know how to perform the following task in 
ER Mapper:
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Contours
The ‘Contours’ dynamic link analyses raster data and draws contours from the 
values. For example, you may wish to generate contours from digital terrain data, 
or magnetics or seismic data. You can view the contours on screen in 2D and print 
them. You can also save them as a separate vector file if you want to view them in 
3D or export the file to another application.

ER Mapper contouring has the following features:

• images, algorithms and virtual images can be contoured

• you need only select the data source (image) and the band, and ER Mapper will 
automatically create the contours

• you can let ER Mapper set the parameters or you can specify them yourself

• you can see contour start value and interval, contour labels and contour color, line 
style and line width 

• you can add contours to the entire image or to a part of an image. 

Adding and setting up a contours layer
Contours are added to an algorithm using a Contours dynamic link layer. Any 
number of Contours dynamic link layers can be included in an algorithm. 
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Hands-on exercise
These exercises give you practice contouring a magnetics image (images, 
algorithms and virtual datasets can be contoured)

1: Draw Contours on an image 

Open an image window and the Algorithm window

1 Click the Edit Algorithm  button  on the Common Functions toolbar. 

An image window and the Algorithm dialog open. 

2 On the Algorithm window, click the Load Dataset button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

3 From the Directories menu, select the path ending with \examples. 

4 Double-click on the directory ‘Shared_Data’ to open it.

5 Double-click on the image named ‘Newcastle_Magnetics.ers’ to load it.

The image is loaded into the Pseudocolor layer. 

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.
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6 From the Edit menu in the Algorithm dialog, select the Add Vector Layer 
submenu and click on Contours. 

7 A Contours layer is added to the data structure diagram in the left panel of 
the Algorithm dialog. 

To start the Contouring Wizard

1 In the Algorithm dialog, click the Chooser button. 

The Contouring Wizard dialog opens. 
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2 In the File: field on the Contouring Wizard dialog select 
‘Newcastle_Magnetics.ers’ file in the ‘\examples\Shared_Data’ directory

Note: Virtual datasets and algorithms can also be contoured.

3 Choose the band to contour. (Newcastle_Magnetics.ers has only one band)

4 Select the Make contours multi-color and Label contours options.

5 Click on the Next > button to go to the Set contours style wizard page.

Set contours style.

1 Select elevation from the drop-down list in the Multi-color table field.

2 Enter 10 for the First contour level, 30 for the Contour interval, and a 
Contour line width of 0.5 points.

3 Enter 4 for Every Nth contour is a primary contour.

Band: Choose the image band to contour. Band 1 is chosen 
by default.

Make contours multi-
color

Select this option for the contour lines to have 
colors from a specified color table. Otherwise they 
will have a single color.

Label contours Select this option if you want the contour lines to be 
labelled.
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Chapter 24 Contours ●  1: Draw Contours on an image
4 Select the Make primary contours thicker option.

5 Select Secondary contour style number 17 from the list.

Every fourth contour line will be solid and thicker than the other lines, which will 
be dotted.

Note: If you leave the options as they are the default options will be used.

6 Click Next to go to the Set labels style wizard page.

First contour level The value at which the first contour is drawn. If you 
leave the value as 0, ER Mapper will automatically 
choose a value. 

Contour interval The distance between contours. If you leave the 
value as 0 the step between contours will be 
automatically chosen by ER Mapper.

Contour line width Specify the width of the contour lines in points. The 
default is 0.5 points.

Every Nth contour is a 
primary contour

The contour lines at the specified interval will be 
primary contours which you can specify to be 
thicker. Leave at the default value of 0 or 1 for no 
primary contours. 

Make primary contours 
thicker

Select this option for primary contour lines to be 
thicker than the width specified in the Contour line 
width field.
This option has no effect if there are no primary 
contours; i.e you entered 0 or 1 in the Every Nth 
contour is a primary contour field.

Secondary contour style Select the line style for secondary contours from the 
list.
Please note that you will only have secondary 
contours if you elected to have primary contours. 
Therefore ER Mapper will not use the secondary 
contour style if you entered a 0 or 1 in the Every 
Nth contour is a primary contour field.
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Set labels style

1 Select the Label contours option.,

The Label contours option should already be checked because you selected it in the 
first page of the wizard.

2 Leave the Label font color, Label font size and Label font style to the 
default values of red, 10 and Helvetica respectively.

3 Set Label every Nth contour line: to 2 so that every second line is 
labelled.

4 Click on Finish to exit the Contouring Wizard.

ER Mapper will redraw the image with contour lines. 

Note: You could also have used the Save as... button in the Contouring Wizard to save 
the contours as an ER Mapper Vector Dataset (.erv) file. This is only necessary if 
you want to use the contours in some other applications. The ER Mapper 
Contours layer will re-draw the contours every time you run the algorithm.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Use the ER Mapper Contouring Wizard to define and draw contours on an image.

What you 
learned...

After completing these exercises, you know how to perform the following task in 
ER Mapper:
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Creating Lookup
Tables

This chapter explains how to create lookup tables that will transform digital values 
of raster images to colors in pseudocolor layers.

About Lookup Tables
The lookup table files are text files, each holding an array of 256 lines of four 
entries each. The first entry is the pixel lookup value and runs from 0 to 255 down 
the array. The other three entries are the Red, Green and Blue values in the 0-65535 
range (16 bit) that will be used to display that pixel value.

A variety of lookup tables is supplied with ER Mapper. In addition, you can create 
your own tables tailored to your needs.

Color Lookup Table files are held in the ‘lut’ directory. Add any new lookup tables 
in this directory so that they will appear in the Color Table menu in ER Mapper's 
Algorithm dialog box.

To select a Lookup Table
1 In the Algorithm dialog box, select the Surface tab.

2 Select ‘Pseudocolor' from the Color Mode drop-down list. 
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Chapter 25 Creating Lookup Tables ●  To create a new linear Color Lookup Table
3 Select the desired Lookup Table from the Lookup Table drop down list. 

To create a new linear Color Lookup Table
To include the lookup table in the lookup table menu, make sure the file is in the 
‘lut’ directory and has a `.lut' extension.

If your color lookup table is to consist of a linear gradation from one color to 
another, you can use the `makelut' utility supplied with ER Mapper to help you 
generate it. `makelut' creates a Color Lookup Table which adjusts one specified 
value to another, and outputs the Color Lookup Table to the `makelut' standard 
output path.

To generate a Color Lookup Table:
1 PC - Bring up a command prompt window.

2 Type in the CLUT utility command at the \bin\win32> prompt:

makelut -n "CLUT_name" iR iG iB nR nG nB > 
ERMAPPER\lut\CLUT_filename.lut

Where:

-n "CLUT_name" is the name of lookup table that will be mentioned in the 
CLUT_filename.lut file.

iR iG iB are the Red Green Blue values of initial lookup table

nR nG nB are the Red Green Blue values of new lookup table

ERMAPPER\lut is the ER Mapper Color Lookup Table directory. The created 
CLUT_filename.lut lookup table file will be stored in that directory.

CLUT_filename is the file name of color lookup table and will be displayed 
(without the .lut extension) in the Color Table drop-down list on the Algorithm 
window.

The pixel lookup values are specified in the range 0-255 in the first column, and the 
`makelut' utility correctly generates the RGB values in the 0-65535 range (16 bit) in 
the 2nd, 3rd and 4th columns.

Tip: To find out the values of the colors in the lookup table, load the CLUT_filename.lut 
file into any Text Editor. The CLUT_filename.lut file will display all the variations 
of Red Green Blue and the corresponding unit values.
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Hands-on exercises
These exercises teach you to create 2-color and multi-color lookup tables.

• Create 2-color and multi-color lookup tables

• Select combinations of Red Green Blue values of any color you would like to use in 
the color lookup table that you are going to create

• Create a combination of colors and grey scale lookup table

• Apply the created lookup tables to the raster images

1: Creating a 2-color lookup table

Display an image in Pesudocolor mode

1 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

2 Click on the Layer tab to view the settings for the layer. 

3 On the Algorithm window, click the Load Dataset button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

4 From the Directories menu, select the path ending with \ examples. 

5 Double-click on the directory ‘Shared_Data’ to open it.

6 Double-click on the image named ‘Landsat_TM_year_1985.ers’ to load it.

Band one of the image is loaded into the Pseudocolor layer. 

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn to create a 2-color lookup table and use it to display a raster image
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7 On the Algorithm window click on the surface tab. By default the Color 
Mode is in Pseudocolor. If not, change it to Pseudocolor mode. From the 
Color Table drop down list choose ‘pseudocolor’.

The image window displays band 1 of the image with the ‘pseudocolor’ lookup 
table.

Finding the combination of Red Green Blue values for a particular color
1 On the main menu click on the File menu and from the drop-down list select 

Page Setup...

2 Page Setup dialog box appears.

3 On the Page Setup dialog box select Set Color... button.

4 Color dialog box appears. 

5 From the Basic colors: choose bright blue color and note down the values 
Red = 0, Green = 0 and Blue =255.

6 From the Basic colors: choose bright red color and note down the values 
Red = 255, Green = 0 and Blue =0.

Creating a blue_red color lookup table
1 Bring up a MS-DOS Prompt window. At the \bin\win32> prompt type in the 

following

makelut -n “blue->red" 0 0 255 255 0 0> C:\ERMAPPER\lut\blue_red.lut

Note: The following procedure assumes that C:\ERMAPPER is where ER Mapper is 
installed. Change the command to suit your environment.

makelut command to make lookup table

-n switch to include the name “blue->red” in 
the blue_red.lut file

“blue->Red” Name of the lookup table appears in the 
blue_red.lut file

0 0 255  Red, Green, Blue values of Blue color

255 0 0  Red, Green, Blue values of Red color
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2 The blue_red.lut lookup table file is created and is saved in the 
C:\ERMAPPER\lut directory.

Display an image using your blue_red.lut color lookup table.
1 Exit from ER Mapper and restart it again.

Note: To enable the ER Mapper to recognize the created lookup table file you have 
created, it is necessary to exit from ER Mapper and restart it.

2 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

3 Click on the Layer tab to view the settings for the layer. 

4 On the Algorithm window, click the Load Dataset button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

5 From the Directories menu, select the path ending with \ examples. 

6 Double-click on the directory ‘Shared_Data’ to open it.

7 Double-click on the image named ‘Landsat_TM_year_1985.ers’ to load it.

Band one of the image is loaded into the Pseudocolor layer. 

8 On the Algorithm window click on the surface tab. By default the Color 
Mode is in Pseudocolor. If not, change it to Pseudocolor mode. 

9 From the Color Table drop down list choose ‘blue_red’ - the color lookup 
table you have created.

The image window displays band 1 of the image with the blue_red color lookup 
table you have created.

> create the blue_red.lut file in the defined 
directory

C:\ERMAPPER\lut\blue_red.lut The defined directory path and the file 
name to be saved
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2: Creating a multi-color lookup table

Finding the combination of Red Green Blue values for five colors
1 Display an raster image in Pseudocolor mode.

2 On the main menu click on the File menu and from the drop-down list select 
Page Setup...

3 Page Setup dialog box appears.

4 On the Page Setup dialog box select Set Color... button.

5 Color dialog box appears. 

6 From the Basic colors: choose black color and note down the values Red 
= 0, Green = 0 and Blue =0.

7 From the Basic colors: choose bright blue color and note down the values 
Red = 0, Green = 0 and Blue =255.

8 From the Basic colors: choose bright green color and note down the 
values Red = 0, Green = 255 and Blue =0.

9 From the Basic colors: choose bright red color and note down the values 
Red = 255, Green = 0 and Blue =0.

10 From the Basic colors: choose white color and note down the values Red 
= 255, Green = 255 and Blue =255.

Creating a Black_blue_green_red_White color lookup table
1 Bring up a MS-DOS Prompt window. At the \bin\win32> prompt type in the 

following and press enter.

makelut -n "Black->Blue->Green->Red->White" 0 0 0 0 0 255 0 255 0 255 0 0 255 
255 255 > C:\ERMAPPER\lut\blk_blu_gr_rd_wht.lut
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Note: The following procedure assumes that C:\ERMAPPER is where ER Mapper is 
installed. Change the command to suit your environment.

2 The blk_blu_gr_rd_wht.lut lookup table file is created and is saved in the 
C:\ERMAPPER\lut directory.

Note: Bring up a Text Editor and open the blk_blu_gr_rd_wht.lut file. Check how the 
color changes gradually from Black to Blue to Green to Red to White from the 
pixel lookup value (the first column) 0 to 64 to 128 to 192 to 255 down the array. 

Display an image using your blk_blu_gr_rd_wht.lut color lookup table.
1 Exit from ER Mapper and restart it again.

makelut command to make lookup table

-n  switch to include the name 
“Black->Blue->Green->Red-
>White” in the red_blue.lut file

“Black->Blue->Green->Red->White”  Name of the lookup table appears 
in the blk_blu_gr_rd_wht.lut file

0 0 0 Red, Green, Blue values of Black 
color

0 0 255 Red, Green, Blue values of Blue 
color

0 255 0 Red, Green, Blue values of Green 
color

255 0 0  Red, Green, Blue values of Red 
color

255 255 255  Red, Green, Blue values of White 
color

>  create the blk_blu_gr_rd_wht.lut 
file in the defined directory

C:\ERMAPPER\lut
\blk_blu_gr_rd_wht.lut 

 The defined directory path and the 
file name to be saved
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Note: To enable the ER Mapper to recognize the created lookup table file you have 
created it is necessary to exit from ER Mapper and restart it.

2 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

3 Click on the Layer tab to view the settings for the layer. 

4 On the Algorithm window, click the Load Dataset button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

5 From the Directories menu, select the path ending with \ examples. 

6 Double-click on the directory ‘Shared_Data’ to open it.

7 Double-click on the image named ‘Landsat_TM_year_1985.ers’ to load it.

Band one of the image is loaded into the Pseudocolor layer. 

8 On the Algorithm window click on the surface tab. By default the Color 
Mode is in Pseudocolor. If not, change it to Pseudocolor mode. 

9 From the Color Table drop down list choose ‘blk_blu_gr_rd_wht’ - the color 
lookup table you have created.

The image window displays band 1 of the image with the blk_blu_gr_rd_wht color 
lookup table you have created.

Note: View the blk_blu_gr_rd_wht color lookup table from the vertical color scale bar in 
the transform window.

3: Creating a combination of multi-color 
and greyscale lookup table

Creating a Greyscale color lookup table
1 Bring up an MS-DOS Prompt window. At the \bin\win32> prompt type in the 

following and press enter.

makelut -n "Black->White" 0 0 0 255 255 255 > 
C:\ERMAPPER\lut\_black_white.lut
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Note: The following procedure assumes that C:\ERMAPPER is where ER Mapper is 
installed. Change the command to suit your environment.

2 The black_white.lut lookup table file is created and is saved in the 
C:\ERMAPPER\lut directory.

3 Bring up a Text Editor and open the black_white.lut file. Check how the color 
changes gradually from Black to White from the pixel lookup value (the first 
column) 0 to 255 down the array. 

4 Edit the first 20 pixel values (0-19 of the first column) to 0 0 65535 (Blue) 
and the last 20 pixel values (236 to 255 of the first column) to 65535 65535 
0 (Yellow).

5 Save the file as blue_grey_yellow.lut.

Display an image using your blue_grey_yellow.lut color lookup table
1 Exit from ER Mapper and restart it again.

Note: To enable the ER Mapper to recognize the created lookup table file you have 
created it is necessary to exit from ER Mapper and restart it.

2 On the Standard toolbar, click on the Edit Algorithm  button.

An image window and the Algorithm window appear.

3 Click on the Layer tab to view the settings for the layer. 

makelut command to make lookup table

-n switch to include the name “Black-
>White” in the black_white.lut file

“Black->White” Name of the lookup table appears in the 
black_white.lut file

0 0 0 Red, Green, Blue values of Black color

255 255 255 Red, Green, Blue values of White color

> create the black_white.lut file in the 
defined directory

C:\ERMAPPER\lut\black_white.lut  The defined directory path and the file 
name to be saved
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4 On the Algorithm window, click the Load Dataset button  on the left 
side of the process stream diagram.

The Raster Dataset file chooser dialog box appears.

5 From the Directories menu, select the path ending with \ examples. 

6 Double-click on the directory ‘Shared_Data’ to open it.

7 Double-click on the image named ‘Landsat_TM_year_1985.ers’ to load it.

Band one of the image is loaded into the Pseudocolor layer. 

8 Select Thematic Mapper band 5 (TM5) from the band selection drop-down 
list on the Algorithm window.

Note: DN value of water in TM5 is less than 20. You are going to display the water region 
in TM5 in blue color using your blue_grey_yellow.lut lookup table.

9 In the Algorithm window click on the surface tab. By default the Color 
Mode is in Pseudocolor. If not, change it to Pseudocolor mode. 

10 From the Color Table drop down list choose ‘blue_grey_yellow’ - the color 
lookup table you have created.

The image window displays band 1 of the image with the blue_grey_yellow color 
lookup table you have created.

Note: View the blue_grey_yellow color lookup table from the vertical color scale bar in 
the transform window.

11 Click the 99% Contrast Enhancement  button.

The water region is displayed as blue with some areas displayed as black. It is 
because the transformation has been clipped to 99%.

12 On the Algorithm window click the Edit Transform Limits  button.

13 The Transform window appears.

14 On the Transform window, on the X axis type in the first value 0 instead of 
4 as displayed (which was clipped) and press enter.

15 The image is displayed with the water region as blue and without black 
areas.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Create 2-color and multi-color lookup tables

• Create a combination of multi-color and greyscale lookup table

• Apply the created color lookup tables to images.

What you 
learned

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Image geocoding
This chapter explains how to use ER Mapper to geometrically correct raw image 
data and rectify it to real world coordinate systems and map projections.

Note: The exercises in this chapter require the ‘Landsat_practice.ers” image file to be in 
‘examples\Miscellaneous\Tutorial’ directory. This file was also used Chapter 19, 
“Supervised classification”.

About image geocoding
Whenever accurate area, direction and distance measurements are required, raw 
image data must usually be processed to remove geometric errors and rectify the 
image to a real world coordinate system. With satellite imagery, for example, these 
errors are introduced by factors such as roll, pitch and yaw of the satellite platform 
and curvature of the earth. In order to overlay or mosaic two images in ER Mapper, 
the images must be in the same coordinate system. The common coordinate system 
can be “raw” (uncorrected), or a real world map projection system.

A ground control point (GCP) is a point on the earth’s surface where both image 
coordinates (measured in rows and columns) and map coordinates (measured in 
degrees of latitude and longitude, meters, or feet) can be identified. Rectification is 
the process of using GCPs to transform the geometry of an image so that each pixel 
corresponds to a position in a real world coordinate system (such as Latitude/
Longitude or Eastings/Northings). This process is sometimes called “warping” or 
“rubbersheeting” because the image data are stretched or compressed as needed to 
align with a real world map grid or coordinate system.
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Orthorectification is a more accurate form of rectification because its takes into 
account sensor (camera) and platform (aircraft) characteristics. It is specifically 
recommended for airphotos. Orthorectification is covered separately in Chapter 26, 
“Image orthorectification”.

Registration is simply aligning two images so they can be overlaid or superimposed 
for comparison. In this case, the images do not have to be rectified to a map 
projection (they can both be in a “raw” coordinate system).

ER Mapper’s Rectification utilities are commonly used to perform four different 
types of operations:

• Image to map rectification–using polynomial (control point) or linear geocoding 
to rectify an image to a datum and map projection using GCPs.

• Image to image rectification–using polynomial (control point) or linear geocoding 
to rectify one image to another using GCPs.

• Map to map transformation–transforming a rectified image from one datum/map 
projection to another.

• Image rotation–rotating an image any number of degrees.

In this exercise, you will use the Geocoding Wizard to perform an image-to-image 
rectification. A typical procedure for performing an image-to-image rectification is 
as follows:

Identify common features in both images

Rectify the “raw” image to the new

Define
control
points

Rectify the
image 

Evaluate
registration
accuracy

(ground control points) using the mouse

coordinate space (map projection an datum)
of the corresponding rectified image

Evaluate the accuracy of the rectification
using simple overlays or other techniques

to build a transformation model
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Hands-on exercises
These exercises give you practice using ER Mapper’s Geocoding Wizard.

• Choose common ground control points (GCPs) between two images

• Use options to modify the GCP display and edit GCPs

• Rectify a “raw” image to the chosen datum and map projection

• Evaluate registration accuracy using a simple image overlay method

Note: It is very important to adhere to the following procedures exactly as written. 
Choosing GCPs can be a fairly complex procedure, and you will learn the basics 
best by following these exact steps the first time.

1: Choosing ground control points

Create the FROM algorithm (the “raw” image)
Before performing an image-to-image rectification, you must first create an 
algorithm that displays the “raw” image you want to rectify.

1 Click the Image Display and Mosaicing Wizard  toolbar button. 

An Image Wizard dialog box appears.

2 In the Image Wizard Select files to display window, click the file chooser 

 button in the File to display: field to open the file chooser. 

3 In the directory ‘examples\Miscellaneous\Tutorial’, double-click on the 
image named ‘Landsat_practice.ers’.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn how to use ER Mapper’s Geocoding Wizard to identify common features 
in the two images, edit the points, and modify the GCP display.
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Note: You should have created the "Landsat_practice.ers" image in the 
‘examples\Miscellaneous\Tutorial’ directory in an earlier exercise. If you have not 
done so, you can create it now by copying files ‘Landsat_MSS_notwarped’ and 
Landsat_MSS_notwarped.ers’ from the ‘examples\Shared_Data\’ directory and 
renaming them to ‘Landsat_practice’ and ‘Landsat_practice.ers’ respectively.

4 Select Display image in 2D and Manually set display method, and click 
on the Next > button.

5 In the Select display method window, select Red Green Blue.

6 Check the Manually select display method properties box.

7 Click on the Next > button.

8 In the display mode properties box Type: field, select RGB 321 from the list.

9 Click on the Next > button.

10 The RGB composite with MSS1 (Blue), MSS2 (Green) and MSS3 (Red) is 
displayed.

11 Click on the Finish button to close the Image Wizard.

12 Click the Save As  toolbar button. 

13 In the Files of Type: field, select ‘ER Mapper Algorithm (.alg)’.

14 From the Directories menu, select the path ending with \examples.

15 Open the ‘Miscellaneous\Tutorial’ directory, and save the algorithm with the 
name ‘Landsat_FROM_algorithm’ (use your initials at the beginning).

16 Close the image window using the window system controls:

• Select Close from the window control-menu.

Remove existing Ground Control Points from the practice image
1 From the Process menu (on the main menu), select Geocoding Wizard.
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The Geocoding Wizard dialog box will open with the Start tab selected.

2 Click the Load Algorithm or Dataset  button in the Input file: field to 
open the file chooser. 

3 From the Directories menu, select the path ending with the text \examples.

4 In the directory ‘Miscellaneous\Tutorial,’ double-click on your previously 
saved algorithm, ‘Landsat_FROM_algorithm’.

5 Select Polynomial in the Geocoding Type box.

6 Select the GCP Edit tab.

7 Click the Delete all GCPs  button and, when asked to confirm the 
delete, click Yes.

8 Click on the Save button to save the changes to the practice image. If asked 
to confirm saving GCPs to disk click Yes.

Set the Polynomial Order
1 Select the Geocoding Wizard Polynomial Setup tab.

2 Select Linear in the Polynomial Order box.
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Specify an image-to-image rectification and algorithm name
1 Select the Geocoding Wizard GCP Setup tab.

The GCP Setup tab lets you specify the name of a geocoded reference image.

2 In the GCP Picking Method box, select Geocoded image, vectors or 
algorithm option.

This tells ER Mapper you plan to pick corresponding points between two images 
on the screen (an “image-to-image” rectification).

3 Click the Load Corrected Algorithm or Dataset  button.

4 From the Directories menu on the file chooser dialog, select the path 
ending with the text \examples.

5 Double-click on the ‘Data_Types’ directory to open it.

6 Double-click on the ‘Landsat_MSS’ directory to open it, then double-click on 
the algorithm ‘RGB_321.alg’ to load it.

This algorithm will be used to display the ‘CORRECTED’ image, which is the 
already rectified image containing coordinate information.

Setup parameters for the image rectification
The To geodetic datum, To geodetic projection and To Coordinates, 
fields in the Output Coordinate Space box show the datum, projection and 
coordinate type for the output rectified file you will create. These parameters are 
included automatically from the ‘CORRECTED’ (rectified) Landsat image.

1 Click on the Change... button to open the Geocoding Wizard Output 
Coordinate Space dialog.

2 Click on the Projection  chooser button.

The Projection Chooser dialog opens showing available map projections 
(ER Mapper includes over 700 projections and you can add your own as well).

3 Click Cancel on the Projection Chooser dialog to close it.
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4 Click Cancel on the Geocoding Wizard Output Coordinate Space dialog 
to close it.

5 Select the Geocoding Wizard GCP Edit tab.

ER Mapper opens several image windows and dialog boxes. You should see a 
screen setup similar to this one:

Note: If your system does not position the windows automatically, rearrange them as 
shown above before proceeding.

Setup the image windows to pick the first four GCPs
When you first begin picking GCPs, your “raw” (unrectified) image contains no 
ground control points. You will begin by picking the first four control points using 
the CORRECTED and UNCORRECTED image windows. Once you have picked 
the first four GCPs, you can use the CORRECTED windows to quickly pick the 
remaining GCPs.

1 On the main menu, click the Edit Algorithm  button to open the 
Algorithm window.

2 Click inside the ’CORRECTED GCP ZOOM’ window to activate it.

3 In the Algorithm window, turn off the Smoothing option.

ER Mapper
main menu

Geocoding Wizard
dialog box

 

UNCORRECTED
GCP ZOOM
WINDOW

CORRECTED GCP
ZOOM WINDOW

UNCORRECTED
GCP (OVERVIEW
ROAM geolink)
WINDOW

CORRECTED GCP
(OVERVIEW ROAM
geolink) WINDOW
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4 Click your right mouse button inside the ‘CORRECTED GCP ZOOM’ 
window, and select Zoom to All Datasets from the Quick Zoom menu.

The ‘CORRECTED GCP ZOOM’ window zooms out to the full image extents.

5 Click inside the ‘UNCORRECTED GCP ZOOM’ image window to activate it.

6 In the Algorithm window, turn off the Smoothing option.

7 Click your right mouse button inside the ‘UNCORRECTED GCP ZOOM’ 
window, and select Zoom to All Datasets from the Quick Zoom menu.

The ‘UNCORRECTED GCP ZOOM’ window zooms out to the full image extents. 
You are now ready to pick your first GCP.

8 Click Close on the Algorithm window to close it.

Note: It is a good idea to turn off the Smoothing option on algorithms where you will 
pick ground control points. This makes it easier to see the locations of individual 
image pixels when you zoom in closely to areas.

Pick a GCP in the upper-left part of both images

Note: Make sure the main ER Mapper menu is not hidden by the image windows–move it 
slightly if needed so you can easily access the toolbars.

1 On the main menu, click the ZoomBox Tool  toolbar button. 

2 Point to the ‘UNCORRECTED GCP ZOOM’ image window, and zoom in on 
a small area in the upper-left part of the image with well defined features 
(drag a zoom box).

3 Move the pointer over the ‘CORRECTED GCP ZOOM’ image window 

(notice the pointer is a  icon), and click once to activate the window.

4 In the ‘CORRECTED GCP ZOOM’ image window, drag a box to zoom in on 
the same geographic area you have displayed in the ‘UNCORRECTED’ 
window.

You have now zoomed to a common area in both images to pick a GCP.

5 On the main menu, click the Pointer Tool  toolbar button. 

6 In the ‘CORRECTED GCP ZOOM’ window (which is active), click on a 
clearly identifiable feature in the image, such as a sharp boundary between 
red vegetation and white barren land.
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ER Mapper marks the control point with green cross hairs, and the geographic 
location of that point appears in the Easting and Northing fields on the Geocoding 
Wizard GCP Edit dialog. (This dialog has many options you will learn more about 
later.)

7 Click once inside the ‘UNCORRECTED GCP ZOOM’ window to activate it.

8 Click on exactly the same geographic feature in the ‘UNCORRECTED GCP 
ZOOM’ window. (It is important to be as accurate as possible).

ER Mapper marks the control point with cross hairs, and the image pixel location 
of that point in the raw image appears in the Cell X and Cell Y fields on the GCP 
Edit dialog. The location of each point is marked with a white “X” in each image 
with the number “1.” You have now picked the first GCP.

Pick a second GCP in the lower-left of both images
1 On the Geocoding Wizard GCP Edit tab, select Auto zoom.

The ZOOM windows will now automatically zoom into the point selected in the 
corresponding OVERVIEW ROAM windows.

2 On the Geocoding Wizard Edit GCP dialog, click the Add new GCP  

button.

3 Click on a well defined feature in the ‘UNCORRECTED GCP (OVERVIEW 
ROAM geolink)’ window to select it.

The ‘UNCORRECTED GCP ZOOM’ window will zoom ito the selected point

4 Click once in the ‘CORRECTED GCP (OVERVIEW ROAM geolink)’ window 
to activate it, then click on the same feature to select it as a GCP.

The ‘CORRECTED GCP ZOOM’ window will zoom ito the selected point

5 Use the two ZOOM windows to adjust the positions of the GCP.

You have now picked a second GCP in the image.

Pick two more GCPs in the upper- and lower-right
1 Following the steps from the previous section, pick a GCP near the upper-

right and lower-right corners of the images. 

Tip: When picking the first four GCPs, it is best to pick them in the four corners of the 
image (if this is possible). This will make the Calculate from point function you 
will use next as accurate as possible. (In this case there was ocean in the lower-left, 
so you picked a point in the closest area possible.)
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Pick additional GCPs using the Corrected GCP Overview window
Once you have picked the first four GCPs, notice that ER Mapper now displays 
values in the ‘RMS’ field on the GCP Edit dialog. The Root Mean Square (RMS) 
error is a measurement of the accuracy of the GCP in this image expressed in the 
image’s pixel size. (An RMS of 1.00 would be 80 meter positional error in the case 
of the Landsat MSS data used here.) If you have done an accurate job selecting the 
first four GCPs, the RMS should be one or less.

When an RMS can be calculated, ER Mapper can now use the coefficients 
generated from the first four points to “predict” the location of ‘UNCORRECTED’ 
(raw) points when you pick additional points in the ‘CORRECTED’ (rectified) 
image. This feature makes selection of the remaining points much faster and easier, 
and you will use it next.

1 On the main menu, click the Set Pointer mode  button (if needed).

2 If needed, activate the ‘CORRECTED GCP (OVERVIEW ROAM geolink)’ 
window by clicking in it.

3 On the Geocoding Wizard Edit GCP dialog, click the Add GCP  button.

4 In the ‘CORRECTED GCP (OVERVIEW ROAM geolink)’ window, click on a 
well defined feature near the center of the image.

ER Mapper marks the control point with cross hairs, and enters the geographic 
location of GCP #5 in the TO Easting and Northing fields. The ‘CORRECTED 
GCP ZOOM’ window zooms into the point for you to adjust its position.

5 In the Geocoding Wizard GCP Edit dialog, click the Calculate from point 

 button.

ER Mapper automatically enters values in Cell X and Cell Y fields–this is the 
“predicted” location of GCP #5 in the FROM image.

Notice that the new GCP #5 has an RMS error of zero. Since it’s location is 
computed from the existing points, it adds no new information to the rectification 
model (and is therefore not yet a true GCP). Next you need to “fine tune” the 
location of the point in the ZOOM windows to make it a true GCP.

6 Click once in one of the ZOOM windows to activate it, then click on the GCP 
in the image. Adjust its position if necessary.

ER Mapper repositions GCP #5 to the new position, and calculates an RMS value 
to display in the Geocoding Wizard GCP Edit dialog box.

You have now picked a fifth GCP using the “predict FROM points” technique.
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Tip: You can keep clicking in the UNCORRECTED AND CORRECTED ZOOM 
windows as many times as needed to refine the GCP location.

Pick several other points spread throughout the images
1 Using the procedure in steps 2-6 above, pick several other GCPs well 

spread throughout the image (pick at least 10).

Tip: If the default magnification level in the ZOOM windows is too great or small for 
your taste, activate each window and use the Zoom In or Zoom Out options in 
the Quick Zoom menu to change the zoom factor by a fixed amount in both 
windows. That zoom factor is retained for subsequent points. (If you make a 
mistake, you can select Previous Zoom to fix it.)

Try some other features on the Geocoding Wizard GCP Edit dialog
1 In the Geocoding Wizard GCP Edit dialog, click on any GCP number under 

the ‘Name’ column.

ER Mapper moves the crosshairs to highlight that point in all the ‘OVERVIEW 
ROAM’ and ‘ZOOM’ windows.

2 Turn off the Auto Zoom option at the bottom.

3 Click on any GCP number under the ‘Name’ column.

ER Mapper moves the crosshairs to highlight that point in the ‘OVERVIEW 
ROAM’ windows, but not the ‘ZOOM’ windows.

4 Click on the Zoom to current GCP  button.

ER Mapper zooms into the selected GCP in the “ZOOM’ windows.

5 Select the number text for a GCP under the ‘Name’ column, and type a 
short name.

You can give GCPs text labels as well as numbers to help identify them.

6 Click on the text ‘On’ in the second column for any GCP.

The text changes to ‘Off’ and all the RMS errors are recomputed without including 
that GCP. (This is an easy way to see how the positional error of any GCP 
influences the RMS of the others. For example, turning off a GCP with a large 
RMS often reduces the RMS of the others.) This can be important when choosing 
which GCPs will be used for the final image rectification.
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7 Turn off other GCPs to see the effect, but turn all on again when finished.

8 Click on the text ‘Edit’ in the third column for any GCP.

The text changes to ‘No’ and the “X” and number marking it in the image turns 
green. This effectively “locks” a GCP so it cannot be edited (that is, clicking in the 
image windows do not redefine it’s position). This is useful when you have several 
very good GCPs and you to lock them to avoid accidentally changing them.

9 Turn on the Errors option.

The magnitude and direction of the calculated positional error are shown 
graphically by a line for each GCP on the image. (If you have very small RMS 
errors you may not see the error line, even if you increase the line length by a factor 
of 10 using the x10 option.)

10 Turn on the Grid option.

A polynomial grid displays over all three image windows. This grid is a simple 
“preview” of the way in which the FROM (raw) image pixels will be reprojected 
onto the new coordinate grid of the TO image. (This grid is only an approximation, 
in reality the lines would be curved.)

11 Click Save on the Geocoding Wizard dialog. If asked confirm saving the 
GCPs to disk, click Yes.

2: Perform the image rectification

Specify output (rectified) image file
1 Select the Geocoding Wizard Rectify tab.

2 Click the file chooser  button in the Output Info box.

3 From the Directories menu, select the path ending with \examples. 

4 Double-click on the ‘Miscellaneous\Tutorial’ directory to open it.

5 Enter the filename ‘Landsat_MSS_rectified’ (start with your initials), then 
click OK.

6 In the Resampling: in the Cell Attributes box select ‘Nearest Neighbour’.

The Cell Attributes box also lets you resample the output image to a different cell 
size (Output Cell width and height), and specify a null cell value.

7 Select Display rectified image to display the image after it is rectified.

Objectives Learn how to use the ground control points you selected to rectify the image to 
the selected datum and map projection.
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Create the output rectified image on disk
1 Click on the Save file and start rectification button.

ER Mapper opens a status dialog to indicate the progress of the rectification.

2 When the operation finishes, click OK of the successful completion dialog. 

3 Click on the Close button to exit the Geocoding Wizard.

You have now rectified the uncorrected Landsat MSS image to correspond to the 
1927 North American Datum (NAD27) and UTM zone 11 (NUTM11) map 
projection.

Close all image windows and dialog boxes
1 Click on the Geocoding Wizard Close button.

2 Close all image windows using the window system controls:

• For Windows, select Close from the window control-menu.

• For Unix systems, press right mouse button on the window title bar, and select 
Close or Quit (for systems with both options, select Quit). 

3 Click Close on the Algorithm window to close it.

3: Evaluating image registration

Load an existing RGB algorithm

1 Click the Open  toolbar button. 

2 From the Directories menu, select the path ending with the text \examples

3 Double-click on the ‘Data_Types’ directory to open it.

4 In the directory ‘Landsat_MSS,’ load the algorithm named ‘RGB_321.alg.’

This algorithm displays the rectified Landsat MSS image of San Diego provided 
with ER Mapper as an RGB image. You will use only the Red and Green layers for 
the comparison with your rectified image.

5 On the main menu, click the Edit Algorithm  button to open the 
Algorithm window.

Objectives Learn a simple way to visually evaluate the registration of two images using an 
overlay technique. In this case, you will evaluate the registration of the raw image 
you rectified and the rectified MSS image supplied with ER Mapper.
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Load your rectified image into the Green layer
1 In the Algorithm window, click on the Blue layer to select it.

2 Click the Cut  button to delete the Blue layer.

3 Click on the Green layer to select it.

4 Click the Load Dataset  button in the algorithm process diagram.

5 From the Directories menu, select the path ending with \examples. 

6 Double-click on the ‘Miscellaneous’ directory to open it.

7 Double-click on the ‘Tutorial’ directory to open it.

8 Click once on the image ‘Landsat_MSS_rectified.ers’ to select it, then click 
OK this layer only button to load it into the Green layer. (The Red layer 
should still have the ‘Landsat_MSS_27Aug91’ image.)

9 Select B3:0.75_um from the Green layer’s Band Selection drop-down list.

(Band 3 is also loaded in the Red layer for the other image for direct comparison.)

Display the two images to evaluate registration

1 Click the 99% Contrast Enhancement  toolbar button.

This image combines two different images–one in the Red layer and one in the 
Green layer. If your images are well aligned the image appears yellow. If you see 
areas that are dominantly red or green, this indicates poor registration.

2 On the Algorithm window, turn off the Smoothing option.

3 On the main menu, click the ZoomBox tool toolbar button.

4 Drag a zoom box over a very small area of the image that contains land and 
water.

Errors in registration appear as either red or green pixels because this is where the 
two image do not align perfectly. This is a very simple way to evaluate the 
registration of two images. If the RMS errors of your GCPs were generally less 
than one, you should not see more that one pixel offsets or registration errors.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Choose common ground control points (GCPs) between two images

• Use options to modify the GCP display and edit GCPs

• Rectify a “raw” image to the chosen datum and map projection

• Evaluate registration accuracy using a simple image overlay method

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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Image
orthorectification

This chapter explains how to use the ER Mapper Geocoding Wizard to 
geometrically correct raw image data and orthorectify it to real world coordinate 
systems and map projections.

About orthorectification
Orthorectification corrects local and global distortions in an image by adjusting for 
camera characteristics, platform positions and terrain details. 

The camera characteristics, derived from a camera calibration report, are stored in a 
camera file for use by the Geocoding Wizard. 

The terrain details are supplied in the form of a DEM. If the terrain is relatively flat, 
you can use an average height value.

In the case of Advanced Orthorectification, the platform position is determined by 
exterior orientation values that describe the exact position of the aircraft at the time 
the image was taken, and how this relates to the image. The following parameters 
are specified:

Attitude omega The tilt angle (roll) of the aircraft; i.e. the rotation about 
the X axis (direction of travel).
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Attitude phi The swing angle (pitch) of the aircraft; i.e the rotation 
about the Y axis.

Attitude kappa The azimuth angle (yaw)of the aircraft; i.e the rotation 
about the Z axis.

Exposure center XYZ The co-ordinates of the exposure center of the image.

If the exterior orientation parameters are not known, you have to specify about 4 to 
6 GCPs for the Gridding Wizard to compute them.

To use Orthorectification you must have the following information available:

• Camera file containing camera calibration information

• DEM file (You can enter an average height if the terrain is relatively flat)

• Exterior orientation (Only for Advanced Orthorectification. Otherwise you must 
select GCPs)

• GCPs referenced by their XYZ coordinates.

The diagram below illustrates the required inputs for orthorectification.

Geocoding Wizard Orthorectification

Camera
Wizard

Camera FileDEM Roll
Pitch
Yaw
Exposure
Center

Exterior Orientation

Ground 
Control
Points

OR

Uncorrected
image (airphoto)

Corrected
image (airphoto)

OR average
height

Camera
Calibration
Report
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Hands-on exercises
These exercises give you practice using ER Mapper’s Geocoding Wizard to 
orthorectify an image.

• Use the Geocoding Wizard to orthorectify an airphoto

• Use the Camera Wizard to create a Camera File from a calibration report

• Locate fiducial marks on an airphoto

• Pick suitable Ground Control Points (GCPs)

In these exercises you will use the Geocoding Wizard to orthorectify an airphoto 
image of San Diego taken in 1997. The example images are used with permission 
from Aerial Fotobank.

1: Orthorectify an airphoto using GCPs

Open the Geocoding Wizard

1 Click on the Ortho and Geocoding Wizard  button in the Common 
Functions toolbar.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows are 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn how to use ER Mapper’s Geocoding Wizard to orthorectify an airphoto. 
Use the Camera Wizard to create a Camera File with given calibration 
parameters.
Select Ground Control Points
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The Geocoding Wizard will open with the 1) Start tab selected.

2 Click the Load Algorithm or Dataset  button in the Input file: field to 
open the file chooser. 

3 From the Directories menu, select the path ending with the text \examples.

4 Select the directory ‘Applications\,Airphoto\1_Geocoding’ and then double-
click on ‘San_Diego_Airphoto_34_not_rectified.ers’ to select it.

5 Select the Geocoding Wizard Orthorectify using ground control points 
option.

In this example, you do not have exterior orientation parameters which provide 
information on the position of the platform or aircraft. Instead, you will pick GCPs 
so that the wizard can compute the exterior orientation parameters. If these 
parameters were available, you would have chosen the Orthorectify using 
exterior orientation option.

6 Select the 2) Ortho Setup tab.
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Enter terrain and camera details

This tab allows you to enter the terrain details in the form of a DEM or as an 
average height value. Obviously, using a DEM would produce a more accurate 
result. However, if the terrain is relatively flat, you can enter an average value. In 
this example you will enter the name of a DEM file.

You supply the camera details to the Geocoding Wizard in the form of a camera 
file. If the applicable camera file does not exist, you can use the Camera Wizard to 
create one.

1 Select the Use a DEM file as height option in the DEM Setup box.

Notice that the DEM Setup box changes according to the option that you choose. 
Because you selected the Use a DEM file as height option, the DEM Setup box 
displays a file and a band chooser for you to select the DEM file and the required 
data band.

2 Click on the Load input DEM File  button to open the file chooser.

3 Select the file ‘San_Diego_DEM.ers’ from the 
‘examples\Applications\,Airphoto\1_Geocoding’ directory and click on the 
OK button to return to the Geocoding Wizard.

4 Click on the Camera Wizard  button to open the Camera Wizard 
dialog.
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Create a Camera file

The Camera Wizard creates a Camera file for the Geocoding Wizard to use. It does 
this by providing a number of dialog boxes for you enter camera calibration 
information. You normally get this information from a camera calibration report. If 
you do not have a valid calibration report for the camera that was used to take the 
image, you can use a generic report for that camera model. This could result in a 
some inaccuracies.

1 Click on the Create new option to create a new Camera File.

You could edit an existing Camera File, in which case the wizard provides you with 
the Camera file: field and chooser to enter the name of the existing file.

2 Click on the Next> button to go to the Camera identification page.
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The information you enter here is not used by the Geocoding Wizard. Therefore it 
can be omitted. It is, however, a good idea to include it because it is a means of 
identifying the camera and the calibration report in the future.

3 Enter the following information in the applicable fields:

Manufacturer: Wild

Model: RC20

Lens serial number: 13115

Date calibrated: Day: 31 Month:10 Year: 1998

4 Click on the Next> button to go to the ‘Camera attributes’ page.

Use this page to enter information on the focal length of the camera lens. The 
Camera Wizard uses this information, so it must be entered. In addition, you can 
enter information on the position of the Principal Point relative to the lens center as 
a measure of lens distortion. Any distortion in the lens would cause the principal 
point to be offset from the lens center.

5 Enter the following information in the applicable fields:

Focal length: 152.793

X offset to principal point:0

Y offset to principal point:0
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6 Click on the Next> button to go to the ‘Number of Fiducial points’ page

Aerial photography cameras insert Fiducial marks around the edges of the airphoto 
images. The Geocoding Wizard uses the positions of these marks to relate the 
image to the camera model. Different cameras insert these marks in different places 
on the image. Use this page to specify where the camera has placed the Fiducial 
marks. If you specify four Fiducial marks where the camera has, in fact, inserted 
eight, the Geocoding Wizard will only take into consideration the four you 
specified.

7 Select the All 8 option; indicating that the Fiducial points are on the four 
corners and the middle of edges of the image.

8 Click on the Next> button to got to the ‘Fiducial point offsets’ page.
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This page enables you to specify the positions of the fiducial points relative to the 
principal point. 

9 Enter the following values in the applicable fields:

Top left X:-105.99 Y:106.01

Middle top X: 0.011 Y: 110.01

Top right X:106.01 Y:106.02

Middle left X:-109.99 Y: 0.012

Middle right X:110.01 Y: 0.013

Bottom left X:-105.99 Y:-105.99

Middle bottom X: -0.005 Y: -109.99

Bottom right X:106.0l Y:-105.99

10 Click on the Next> button to go to the ‘Finish’ page.

11 Click the Save  button in the Camera file: field to open the file chooser 
to select a directory and file name to which to save the new camera file. 

12 From the Directories menu, select the path ending with the text \examples.

13 Select the directory ‘Miscellaneous\Tutorial,’ and then enter ‘camera_<your 
initials>’ in the Save as: field.

14 Click on the OK button to return to the Camera Wizard.

The file name and directory you entered should now be displayed in the Camera 
file: field.
Comprehensive ER Mapper Training Workbook  462



Chapter 27 Image orthorectification ●  1: Orthorectify an airphoto using GCPs
15 Click on the Finish button to return to the Geocoding Wizard.

16 Click the Load Camera File  button in the Geocoding Wizard Camera 
file: field to open the file chooser. 

17 From the Directories menu, select the path ending with the text \examples.

18 Select the directory ‘Miscellaneous\Tutorial,’ and then double-click on the 
‘camera_<your initials>’ file you saved.

19 Click on the 3) Fiducial Point Edit tab.

Edit the fiducial points

This wizard page enables you to enter the locations of the fiducial points on the 
image into ER Mapper. 
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ER mapper opens two image windows one in OVERVIEW ROAM mode, and the 
other in ZOOM mode.

1 Select the Auto zoom option. This causes the ZOOM window to 
automatically zoom to the selected fiducial mark.

2 Select the Pointer Tool  on the Standard toolbar.

3 On the table, select ‘Top Left’ in the ‘Name’ column.

4 In the OVERVIEW ROAM window, click on the Fiducial mark on the top left 
corner of the image. 

The image in the ZOOM window will automatically zoom to the selected fiducial 
mark. Use this to adjust the position of the cursor to the center of the red circle.

5 On the table, select ‘Top Right’ in the ‘Name’ column.

6 In the OVERVIEW ROAM window, click on the Fiducial mark on the top right 
corner of the image. 

The image in the ZOOM window will automatically zoom to the selected fiducial 
mark. Use this to adjust the position of the cursor to the center of the red circle.

7 On the table, select ‘Bottom Left’ in the ‘Name’ column.

8 In the OVERVIEW ROAM window, click on the Fiducial mark on the bottom 
left corner of the image. 

The image in the ZOOM window will automatically zoom to the selected fiducial 
mark. Use this to adjust the position of the cursor to the center of the red circle.

9 On the table, select ‘Bottom Right’ in the ‘Name’ column.

ZOOM OVERVIEW ROAM
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10 In the OVERVIEW ROAM window, click on the Fiducial mark on the bottom 
right corner of the image. 

The image in the ZOOM window will automatically zoom to the selected fiducial 
mark. Use this to adjust the position of the cursor to the center of the red circle.

11 On the table, select ‘Middle Left’ in the ‘Name’ column.

12 In the OVERVIEW ROAM window, click on the Fiducial mark on the middle 
of the left side of the image. 

The image in the ZOOM window will automatically zoom to the selected fiducial 
mark. Use this to adjust the position of the cursor to the center of the red circle.

13 On the table, select ‘Middle Right’ in the ‘Name’ column.

14 In the OVERVIEW ROAM window, click on the Fiducial mark on the middle 
of the right side of the image. 

The image in the ZOOM window will automatically zoom to the selected fiducial 
mark. Use this to adjust the position of the cursor to the center of the red circle.

15 On the table, select ‘Middle Top’ in the ‘Name’ column.

16 In the OVERVIEW ROAM window, click on the Fiducial mark on the middle 
of the top the image. 

The image in the ZOOM window will automatically zoom to the selected fiducial 
mark. Use this to adjust the position of the cursor to the center of the red circle.

17 On the table, select ‘Middle Bottom’ in the ‘Name’ column.

18 In the OVERVIEW ROAM window, click on the Fiducial mark on the middle 
of the bottom of the image. 

The image in the ZOOM window will automatically zoom to the selected fiducial 
mark. Use this to adjust the position of the cursor to the center of the red circle.

After selecting the fiducial markers, the table on the Fiducial Point Edit tab 
should be similar to what is shown below.

The RMS column should show values of less than 1.00. 
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The image window should now have all the fiducial points labelled.

19 If necessary, select the Errors option, and adjust the position of the 
selections in the direction of the indicated errors.

The x10 option enlarges the error markers for a more accurate indication.

20 Click on the 4) GCP Setup tab.

Setup Ground Control Points

The GCP Setup tab lets you specify the way that you want to choose control 
points. Control points may be entered manually, chosen from a reference image, 
chosen from a digitizing tablet, or chosen using a combination of these three 
methods.

In this exercise, you will use a previously orthorectified reference image to locate 
GCPs.

1 In the GCP Picking Method box, select Geocoded image, vectors or 
algorithm option.

This tells ER Mapper you plan to pick corresponding points between two images 
on the screen.
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2 Click the Load Corrected Algorithm or Dataset  file chooser button.

3 Choose ‘ER Mapper Raster Dataset (.ers)’ in the Files of Type: field.

4 From the Directories menu on the file chooser dialog, select the path 
ending with the text \examples.

5 Double_click on the ‘Applications’ directory to open it.

6 Double-click on the ‘Airphoto\1_Geocoding’ directory to open it, then 
double-click on ‘San_Diego_Airphoto_34_rectified.ers’ to load it.

This is the already rectified image containing coordinate information.

Setup parameters for the image rectification
The To geodetic datum, To geodetic projection and To Coordinates, 
fields in the Output Coordinate Space box show the datum, projection and 
coordinate type for the output rectified file you will create. These parameters are 
included automatically from the ‘CORRECTED’ (rectified) airphoto image.

7 Click on the Change... button to open the Geocoding Wizard Output 
Coordinate Space dialog.

8 If necessary, change the settings to what is displayed above. 

9 Click OK on the Geocoding Wizard Output Coordinate Space dialog to 
close it.

10 Select the Geocoding Wizard 5) GCP Edit tab.
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Edit Ground Control Points

ER Mapper opens several image windows and dialog boxes. You should see a 
screen setup similar to this one:

Note: If your system does not position the windows automatically, rearrange them as 
shown above before proceeding.

ER Mapper
main menu

Geocoding Wizard
dialog box

 

UNCORRECTED
GCP ZOOM
WINDOW

CORRECTED GCP
ZOOM WINDOW

UNCORRECTED
GCP (OVERVIEW
ROAM geolink)
WINDOW

CORRECTED GCP
(OVERVIEW ROAM
geolink) WINDOW
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Pick a GCP in the upper-left part of both images

Note: Make sure the main ER Mapper menu is not hidden by the image windows–move it 
slightly if needed so you can easily access the toolbars.

1 On the Geocoding Wizard GCP Edit tab, select Auto zoom.

The ZOOM windows will now automatically zoom into the point selected in the 
corresponding OVERVIEW ROAM windows.

2 Click on a well defined feature in the ‘UNCORRECTED GCP (OVERVIEW 
ROAM geolink)’ window to select it.

The ‘UNCORRECTED GCP ZOOM’ window will zoom ito the selected point

3 Click once in the ‘CORRECTED GCP (OVERVIEW ROAM geolink)’ window 
to activate it, then click on the same feature to select it as a GCP.

The ‘CORRECTED GCP ZOOM’ window will zoom ito the selected point

4 Use the two ZOOM windows to adjust the positions of the GCP.

You have now picked a GCP in the image.

Pick a second GCP in the lower-left of both images

5 On the Geocoding Wizard Edit GCP dialog, click the Add new GCP  

button.

6 Click on a well defined feature in the ‘UNCORRECTED GCP (OVERVIEW 
ROAM geolink)’ window to select it.

The ‘UNCORRECTED GCP ZOOM’ window will zoom into the selected point

7 Click once in the ‘CORRECTED GCP (OVERVIEW ROAM geolink)’ window 
to activate it, then click on the same feature to select it as a GCP.

The ‘CORRECTED GCP ZOOM’ window will zoom ito the selected point

8 Use the two ZOOM windows to adjust the positions of the GCP.

You have now picked a second GCP in the image.

9 Following the above steps, pick another four GCPs near the upper-right, 
lower-right and middle of the images. 

The more GCPs you pick the lower the possibility of errors. For orthorectification 
you need at least six.
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Try some other features on the Geocoding Wizard GCP Edit dialog
1 In the Geocoding Wizard GCP Edit dialog, click on any GCP number under 

the ‘Name’ column.

ER Mapper moves the crosshairs to highlight that point in all the ‘OVERVIEW 
ROAM’ and ‘ZOOM’ windows.

2 Turn off the Auto Zoom option at the bottom.

3 Click on any GCP number under the ‘Name’ column.

ER Mapper moves the crosshairs to highlight that point in the ‘OVERVIEW 
ROAM’ windows, but not the ‘ZOOM’ windows.

4 Click on the Zoom to current GCP  button.

ER Mapper zooms into the selected GCP in the “ZOOM’ windows.

5 Select the number text for a GCP under the ‘Name’ column, and type a 
short name.

You can give GCPs text labels as well as numbers to help identify them.

6 Click on the text ‘On’ in the second column for any GCP.

The text changes to ‘Off’ and all the RMS errors are recomputed without including 
that GCP. (This is an easy way to see how the positional error of any GCP 
influences the RMS of the others. For example, turning off a GCP with a large 
RMS often reduces the RMS of the others.) This can be important when choosing 
which GCPs will be used for the final image rectification.

7 Turn off other GCPs to see the effect, but turn all on again when finished.

8 Click on the text ‘Edit’ in the third column for any GCP.

The text changes to ‘No’ and the “X” and number marking it in the image turns 
green. This effectively “locks” a GCP so it cannot be edited (that is, clicking in the 
image windows do not redefine it’s position). This is useful when you have several 
very good GCPs and you to lock them to avoid accidentally changing them.

9 Turn on the Errors option.

The magnitude and direction of the calculated positional error are shown 
graphically by a line for each GCP on the image. (If you have very small RMS 
errors you may not see the error line, even if you increase the line length by a factor 
of 10 using the x10 option.)

10 Turn on the Grid option.

A polynomial grid displays over all three image windows. This grid is a simple 
“preview” of the way in which the FROM (raw) image pixels will be reprojected 
onto the new coordinate grid of the TO image. (This grid is only an approximation, 
in reality the lines would be curved.)
Comprehensive ER Mapper Training Workbook  470



Chapter 27 Image orthorectification ●  1: Orthorectify an airphoto using GCPs
11 Click the Add new GCP  button and select a point on the CORRECTED 

image. 

12 Click on the Calculate uncorrected point  button. The wizard will 
automatically position the corresponding GCP on the UNCORRECTED 
image. Use the ZOOM windows to adjust the GCP position.

This facility is available once you have positioned four points.

13 Click Save on the Geocoding Wizard dialog. When asked confirm saving 
the GCPs to disk, click Yes.

This will save the geocoding information into the header file of the 
UNCORRECTED image.

14 Select the Geocoding Wizard 6) Rectify tab.

Rectify the image

1 Click the file chooser  button in the Output Info box.

2 From the Directories menu, select the path ending with \examples. 

3 Double-click on the ‘Miscellaneous\Tutorial’ directory to open it.

4 Enter the filename ‘Airphoto_orthorectified’ (start with your initials), then 
click OK.
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5 Click on the Edit Extents... button to open the Geocode Output Extents 
dialog box.

This dialog allows you to specify how much of the orthorectified image you want to 
save. You have three main options:

Maximum extents: Saves the whole image including any portion not visible 
in the currently active image window.

Optimum extents: Automatically calculates the extents of airphotos to 
exclude the black edges around them.

Custom extents: Allows you to specify the top left and bottom right 
coordinates of the area to be included. If you click on the 
Snapshot button ER Mapper will automatically select 
the extents of the visible part of the image in the 
currently active image window.

6 Select the Optimum extents button to remove the black edges.

7 Click on the OK button to return to the Geocoding Wizard.

8 In the Resampling: in the Cell Attributes box select ‘Nearest Neighbour’.

The Cell Attributes box also lets you resample the output image to a different cell 
size (Output Cell width and height), and specify a null cell value.

9 Click on the Save button to save the orthorectification parameters in the 
‘San_Diego_Airphoto_34 _not_rectified.ers’ header file.

You will use this in the next exercise.
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10 Select Display rectified image to display the image after it is rectified.

11 Click on the Save file and start rectification button.

ER Mapper opens a status dialog to indicate the progress of the rectification.

12 When the operation finishes, click OK of the successful completion dialog. 

13 Click on the Close button to exit the Geocoding Wizard.

You have now rectified the uncorrected airphoto image to correspond to the 1927 
North American Datum (NAD27) and UTM zone 11 (NUTM11) map projection.

14 Do not close the image window with the orthorectified image

Evaluate the image orthorectification

1 On the main menu, click the Edit Algorithm  button to open the 
Algorithm window.

2 The Algorithm window shows the Red, Green and Blue layers of the 
orthorectified image ‘<your Initials>_Airphoto_orthorectified’

3 In the Algorithm window, click on the Blue layer to select it.

4 Click the Load Dataset  button in the algorithm process diagram.

5 From the Directories menu, select the path ending with \examples. 

6 Double-click on the ‘Applications’ directory to open it.

7 Double-click on the ‘Airphoto’ and then on ‘1_Geocoding’ directory to open 
it.

8 Click once on the image ‘San_Diego_Airphoto_34 _rectified.ers’ to select it, 
then click OK this layer only button to load it into the Blue layer. (The Red 
and Green layers should still have the ‘<your 
Initials>_Airphoto_orthorectified’ image.)

9 Select B3:Blue from the Blue layer’s Band Selection drop-down list.

Display the two images to evaluate registration

1 Click the 99% Contrast Enhancement  toolbar button.

This image combines two different images–one in the Red and Green layers and 
one in the Blue layer. If your images are well aligned the image appears normal. If 
you see areas that are dominantly yellow or blue, this indicates poor registration.

2 On the Algorithm window, turn off the Smoothing option.

3 On the main menu, click the ZoomBox tool toolbar button.
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4 Drag a zoom box over a very small area of the image that contains land and 
water.

Errors in registration appear as either blue or yellow pixels because this is where 
the two images do not align perfectly. This is a very simple way to evaluate the 
registration of two images. If the RMS errors of your GCPs were generally less 
than one, you should not see more that one pixel offsets or registration errors.

Close all windows
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.

2 Click Close on the Algorithm window to close it.
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2: Orthorectify an airphoto using Exterior 
Orientation

In this exercise you will orthorectify the same image as in the previous exercise. 
This time, instead of using Ground Control Points, you will enter Exterior 
Orientation parameters which have been obtained from a photogrammetry, aerial 
triangulation or geoposition system external to ER Mapper. In the previous exercise 
you saved orthorectification parameters in the 
‘San_Diego_Airphoto_34_not_rectified.ers’ file. This means that you will not have 
to re-enter them in this exercise.

Open the Geocoding Wizard

1 Click on the Ortho and Geocoding Wizard  button in the Common 
Functions toolbar.

The Geocoding Wizard will open with the 1) Start tab selected.

2 Click the Load Algorithm or Dataset  button in the Input file: field to 
open the file chooser. 

3 From the Directories menu, select the path ending with the text \examples.

4 Select the directory ‘Applications\,Airphoto\1_Geocoding’ and then double-
click on ‘San_Diego_Airphoto_34_not_rectified.ers’ to select it.

This is the same file as that you used in the previous exercise.

5 Select the Geocoding Wizard Orthorectify using exterior orientation 
option.

Objectives Learn how to use ER Mapper’s Geocoding Wizard to orthorectify an airphoto 
using Exterior Orientation parameters
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In this example, you enter exterior orientation parameters which provide 
information on the position of the platform or aircraft.

6 Select the 2) Ortho Setup tab.

The fields in the Ortho Setup page should contain the information that you entered 
in the previous exercise because it was saved to the header file of the image being 
orthorectified.

7 Click on the 3) Fiducial Point Edit tab.

The fields in the Fiducial Point Edit page should also contain the information you 
entered in the previous exercise.

8 Click on the 4) Exterior Orientation Setup tab.

Enter Exterior Orientation parameters

Exterior Orientation parameters contain information on the position of the platform 
or aircraft at the time the image was taken. You would have to obtain this data from 
a system external to ER Mapper. If these parameters are not available then you 
would use Ground Control Points as in the previous exercise.
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1 Enter the information in the relevant fields as shown in the table below:

2 Click on the Change... button to open the Geocoding Wizard Output 
Coordinate Space dialog.

3 Enter the Datum, Projection and Coord system type as shown below

Tip: NUTM11 is a UTM projection type.

4 Click on the 5) Rectify tab.

Field name Description Enter value

Attitude omega The tilt angle (roll) of the 
aircraft; i.e. the rotation 
about the X axis (direction of 
travel).

0.024233136466399

Attitude phi The swing angle (pitch) of 
the aircraft; i.e the rotation 
about the Y axis.

0.028555797949162

Attitude kappa The azimuth angle (yaw)of 
the aircraft; i.e the rotation 
about the Z axis.

0.0019776681959326

Exposure center X The X co-ordinate of the 
exposure center of the image.

483681.44788264

Exposure center Y The Y co-ordinate of the 
exposure center of the image.

3621463.0778646

Exposure center Z The Z co-ordinate of the 
exposure center of the image.

3182.9321414632

Scale The scale of the image 
expressed as a decimal value.

0.000048745007960398
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Rectify the image

1 Click the file chooser  button in the Output Info box.

2 From the Directories menu, select the path ending with \examples. 

3 Double-click on the ‘Miscellaneous\Tutorial’ directory to open it.

4 Enter the filename ‘Airphoto_orthorectified_advanced’ (start with your 
initials), then click OK.

5 Click on the Edit Extents... button to open the Geocode Output Extents 
dialog box.

This dialog allows you to specify how much of the orthorectified image you want to 
save. You have three main options:

Maximum extents: Saves the whole image including any portion not visible 
in the currently active image window.

Optimum extents: Automatically calculates the extents of airphotos to 
exclude the black edges around them.

Custom extents: Allows you to specify the top left and bottom right 
coordinates of the area to be included. If you click on the 
Snapshot button ER Mapper will automatically select 
the extents of the visible part of the image in the 
currently active image window.

6 Select the Optimum extents button to remove the black edges.

7 Click on the OK button to return to the Geocoding Wizard.

8 In the Resampling: in the Cell Attributes box select ‘Nearest Neighbour’.

The Cell Attributes box also lets you resample the output image to a different cell 
size (Output Cell width and height), and specify a null cell value.

9 Click on the Save button to save the orthorectification parameters in the 
‘San_Diego_Airphoto_34 _not_rectified.ers’ header file.

10 Select Display rectified image to display the image after it is rectified.

11 Click on the Save file and start rectification button.

ER Mapper opens a status dialog to indicate the progress of the rectification.

12 When the operation finishes, click OK on the successful completion dialog. 

13 Click on the Close button to exit the Geocoding Wizard.

You have now rectified the uncorrected airphoto image to correspond to the 1927 
North American Datum (NAD27) and UTM zone 11 (NUTM11) map projection.

14 Do not close the image window with the orthorectified image
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Evaluate the image orthorectification

1 On the main menu, click the Edit Algorithm  button to open the 
Algorithm window.

2 The Algorithm window shows the Red, Green and Blue layers of the 
orthorectified image ‘<your Initials>_Airphoto_orthorectified_advanced’

3 In the Algorithm window, click on the Blue layer to select it.

4 Click the Load Dataset  button in the algorithm process diagram.

5 From the Directories menu, select the path ending with \examples. 

6 Double-click on the ‘Applications’ directory to open it.

7 Double-click on the ‘Airphoto’ and then on ‘1_Geocoding’ directory to open 
it.

8 Click once on the image ‘San_Diego_Airphoto_34 _rectified.ers’ to select it, 
then click OK this layer only button to load it into the Blue layer. (The Red 
and Green layers should still have the ‘<your 
Initials>_Airphoto_orthorectified_advanced’ image.)

9 Select B3:Blue from the Blue layer’s Band Selection drop-down list.

Display the two images to evaluate registration

1 Click the 99% Contrast Enhancement  toolbar button.

This image combines two different images–one in the Red and Green layers and 
one in the Blue layer. If your images are well aligned the image appears normal. If 
you see areas that are dominantly yellow or blue, this indicates poor registration.

2 On the Algorithm window, turn off the Smoothing option.

3 On the main menu, click the ZoomBox tool toolbar button.

4 Drag a zoom box over a very small area of the image that contains land and 
water.

Errors in registration appear as either blue or yellow pixels because this is where 
the two images do not align perfectly. This is a very simple way to evaluate the 
registration of two images. If the RMS errors of your GCPs were generally less 
than one, you should not see more that one pixel offsets or registration errors.

Close all windows
1 Close all image windows using the window system controls:

• Select Close from the window control-menu.
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2 Click Close on the Algorithm window to close it.

Only the ER Mapper main menu should be open on the screen.

• Use the Camera Wizard to create a Camera File

• Select fiducial markers on an airphoto image

• Use options to modify the GCP display and edit GCPs

• Enter Exterior Orientation parameters for advanced orthorectification.

• Use the Geocoding Wizard to orthorectify a “raw” airphoto image to the chosen 
datum and map projection.

What you 
learned...

After completing these exercises, you know how to perform the following tasks in 
ER Mapper:
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System setup
This appendix describes the alternate steps needed to set up your system for 
students to perform the hands-on exercises in this manual. There are two tasks: 

• Installation of sample “tutorial” image and algorithm files

• Copying files for supervised classification and rectification exercises

In order to carry out the following instructions, you should have some basic 
knowledge of copying files and setting file permissions (if needed).

1: Installation of example images and 
algorithms

All of the hands-on exercises in this workbook require you to access sample images 
and algorithms supplied on the ER Mapper CD-ROM. The “Full” installation 
option installs ER Mapper with all the example directories and files. If you want to 
conserve hard drive space, you can select the “Typical” option which installs only 
the directories and files required to do the hands-on exercises. The “Compact” 
option does not install any of the required files or directories and thus precludes 
you from doing the hands-on exercises. 

See the Installation Manual for more information.

It is preferable to select either the “Typical” or “Full” installation option to ensure 
that the correct files and directories are installed. If you choose the “Custom” 
installation option, you must select at least the following example directories for 
installation.
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Application Examples Airphoto

Mineral_Exploration

Oil_and_Gas_Exploration

World_Topography

Land_Information

Data Type Examples Digital_Elevation

Ers1

Landsat_MSS

Landsat_TM

SPOT_Panchromatic

SPOT_xs

Functions and Features Examples
3D

Classification

Data_Fusion

Data_Mosaic

Geocoding

Gridding

Miscellaneous Templates

Test Patterns

2: Copying files to the ‘tutorial’ directory
The exercises for Supervised Classification and Image Rectification require a copy 
of the image “Landsat_MSS_notwarped” under the name “Landsat_practice” in 
ER Mapper’s ‘tutorial’ directory. (The ‘tutorial’ directory is created automatically 
during the ER Mapper installation.) Follow these steps to create a copy of the 
header file and data file.

Note: You must have read and write access to the practice image. Set the file 
permissions appropriately if needed.
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Copying files for Windows installations
1 Use Windows Explorer to copy and rename the following files in the 

‘examples\Shared_Data’ directory to the ‘examples\Miscellaneous\Tutorial’ 
directory as indicated:

Shared_Data\Landsat_MSS_notwarped.ers copy to 
Miscellaneous\Tutorial\Landsat_practice.ers

Shared_Data\Landsat_MSS_notwarped copy to 
Miscellaneous\Tutorial\Landsat_practice
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Reference texts
This appendix provides references to a range of excellent image processing and 
remote sensing textbooks. These books will be very helpful to those new to image 
processing, or those who want to learn more about image processing techniques for 
specific earth science applications. Also refer to the ER Mapper Applications 
Manual for examples and information about image processing for many earth 
science applications.

Avery, E. A., and G. L. Berlin. 1992. Fundamentals of Remote Sensing and 
Airphoto Interpretation, Macmillan Publishing Company, New York, N.Y, USA.

Cracknell, A. P., and L. W. B. Hayes. 1993. Introduction to Remote Sensing, Taylor 
& Francis Ltd, London, England.

Green, W. B. 1989. Digital Image Processing: A Systems Approach, Van Nostrand 
Reinhold, New York, N.Y., USA. 

Jensen, J. R. 1995. Introductory Digital Image Processing: A Remote Sensing 
Perspective, Prentice-Hall, Engelwood Cliffs, N.J, USA. 

Lillesand, T. M., and R. W. Kiefer. 1991. Remote Sensing and Image 
Interpretation, John Wiley and Sons, Inc. New York, N.Y, USA.

Rees, W. G. 1990. Physical Principles of Remote Sensing, Topics in Remote 
Sensing, vol 1. Cambridge University Press, Cambridge, England.
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Index
Symbols
.tab file reader 35

Numerics
3-D Algorithm Wizard 34
3D flythrough viewing 236

changing altitude 237
controlling direction/speed 236
summary of controls 237

3D perspective viewing 66, 226
bounding box 234
draw modes 230, 234
lighting 230, 234
multiple surfaces 239
panning the image 232
printing images 244
processing speed 244
resetting default view 231
rotating left/right 231
summary of movement controls 232
terrain detail 235
tilting forward/backward 231
tilting side to side 232
vertical (z-scale) exaggeration 233
Z Offset 241
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zooming in/out 231

A
Algorithm dialog

overview 56
Algorithm Geoposition Extents dialog box 179

Center option 182
Extents options 181
Geolink options 183
Zoom options 49

algorithm layers. See layers
algorithms

adding surfaces 243
basic concepts 27, 54
changing bands 60
changing lookup table 61
colordraping 118
commenting 65, 129
copy & paste layers/surfaces 243
creating automatically 55
creating manually 55
entering description 64
hue-saturation-intensity 132
mosaics 288, 294, 298
multiple surfaces 239
opening 46
output to disk file 196
printing 266
process diagram 57
saving 64, 129
simple example 62, 121, 136
stopping (STOP) 61
using as templates 56
viewing in 3-D perspective 227

Annotation layers
displaying vector data 394

annotation. See map composition
Application Examples 483
ARC/INFO coverages 32, 382, 395
arithmetic operations. See formulas
ASCII XYZ text file

Confusion Matrices 341
aspect calculations 155, 279
Autoclip transforms 109
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setting percent clip 109
using toolbar 110, 114

Auto-generate colors dialog box 317

B
binary images 388
boolean operations 167

C
Calculate Statistics dialog box 334
camera calibration report 454
Camera file 462
Camera Wizard 458

Camera attributes page 460
Camera identification page 459
Fiducial point offsets page 461
Focal length 460
Number of Fiducial points page 461
X offset to principal point 460
Y offset to principal point 460

Cell Values Profile dialog 86, 356, 358
centering images 182
Change Projection/Datum/Cell Size Wizard 34
Class Display layer type 316
classification

aggregating classes 385
class means/95% ellipses 337
filtering to generalize 384
supervised 324
unsupervised 312
vectorizing classes 383

Classification layers
creating with scattergrams 283
displaying classified data 322
displaying thematic data 270, 273, 276, 321

Color Balancing Wizard for Airphotos 34, 294
Color Mode

Hue Saturation Intensity 72
Pseudocolor 72
Red Green Blue 72
relation to layer type 73, 77

Color Tables
create a new linear table 427
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creating a 2-color table 428
creating a blue_red table 429
creating a combination table 433
creating a multi-color table 431
makelut command 427, 429, 431, 434

color thematic overlays 268
colordraping 118

HSI technique 132
tips 130
tips for HSI 142

combining images 119, 132
using Virtual Datasets 214

comments
defining 65, 129
for formulas 171
viewing 66

Common Geophysical Images Wizard 35
composing maps. See map composition
Confusion Matrices

ASCII XYZ text file 341
Kappa statistic 348
Producer’s Accuracy 349
reference dataset 341
Row Counts 346
User’s Accuracy 348

Contouring Wizard 34
features 418

contours
adding to an algorithm 418
band to contour 421
contour interval 421, 422
contour line width 421, 422
first contour level 421, 422
label contours 421
label font color 423
label font size 423
label font style 423
multi-color 421
primary contours 422
secondary contours 422

Contours dynamic link 418
contrast enhancement. See transforms
convolution filtering. See filters
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D
data fusion

using Virtual Datasets 213, 218
data inversion formulas 121
data structure diagram 56
Data Type Examples 483
density slicing. See transforms
dialog boxes 41

text entry 43
digital terrain datasets

aspect calculations 155, 279
slope calculations 155, 278, 280

digital terrain images
aspect calculations 155, 279
slope calculations 155, 278, 280

displaying datasets 59, 67, 120, 126, 135, 138, 354, 357, 362, 366, 368, 373, 378, 428, 430, 433, 435
displaying images 59, 67, 120, 126, 135, 138, 419, 428, 430, 433, 435
DXF files

linking to 32
Dynamic Links 32, 392

E
edge detection filters 149
Edit Sun Angle dialog box 122, 124, 136, 138, 277
ER Mapper

dialog boxes 41
file choosers 42
help system 43
introduction 24
main menu 40
raster datasets 29
raster images 29
toolbars 40
user interface 38
vector datasets 29
vector images 29

exponential transforms 112
exporting data 33

F
fast enhancements 175
feathering mosaic seams 308
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fiducial points 463
file chooser dialog boxes 42
Filter editor dialog box 150
filters

adjusting contrast for 153
appending 159
aspect calculations 155
basic concepts 148
C 150
creating 152
deleting 152, 161
edge detection 153
editing 152
high pass (sharpening) 152
loading 151, 157, 278
low pass (smoothing) 151
slope calculations 155, 278, 279
smoothing classified images 384
spatial frequency 149
using multiple in stream 154, 156, 158
viewing in other layers 157
viewing next in stream 160
viewing previous in stream 160

Formula Editor dialog box 163
formulas

applications 162
assigning relations 170
autoscaling data 114
basic concepts 162
boolean operations 167
checking syntax 166
display in process diagram 164
entering 166, 359, 360
entering comments 171
entering descriptions 171
inverting data values 121
masking data 272
merging images 216
NDVI 62, 275
Principal Components 174
ratios 169
relations concept 164
restoring default 167
saving to disk 171
specifications 164
Tasseled Cap 207
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thresholding 167, 270
using regions 172
using variables 168, 275

Functions and Features Examples 483

G
Gaussian equalization 110

setting std. dev. 111
GCP Edit dialog box 470
GCP Setup tab 466
Geocode Output Extents dialog 472, 478
geocoding 30

advanced orthorectification 454
camera calibration report 454
Compute FROM function 447
evaluating results 450
GCP display options 448
picking first 4 GCPs 444
picking points from overview 447
RMS errors 447

Geocoding Wizard 30, 454
Auto zoom 469
Auto Zoom option 448
Calculate from point button 447
Cell Attributes box 449
Errors option 449
Exterior Orientation Setup tab 476
Fiducial Point Edit tab 463, 476
GCP Edit tab 444, 446, 448, 467
GCP Setup tab 443, 466
Grid option 449
Ortho Setup tab 457, 476
Orthorectify using exterior orientation 457, 475
Output Coordinate Space dialog 467
Rectify tab 449, 471, 477
resampling 449
Use a DEM file as height 458
Zoom to current GCP button 448

geolinking
basic concepts 178
Overview Pan mode 179, 193
Overview Zoom mode 179, 190
Screen mode 179, 187
setting display center 182
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setting display extents 181
setting display resolution 183
unlinking windows 187
Window mode 179, 184

GIS systems
ARC/INFO coverages 32
linking to 32
vectorizing data for 382

graphics formats
exporting to 33
using in map composition 265

Gridding Wizard 34
ground control points

overview 438
picking 445

H
hardcopy printing 32
help system 43
high pass filters 149
histogram equalization 110, 125, 126
histogram matching 306
histograms. See transforms
HSI color mode 72
HSI merge technique 248
hue layers 137

I
IHS merge technique 248
image algebra. See formulas
Image Compression Wizard 34
Image Display and Mosaicing Wizard 33, 286, 288
image files. See raster images
image processing

applications 26
arithmetic operations 162
binary images 388
concepts 24
contrast enhancement 96, 426
enhancements 30
ER Mapper algorithms 27
general tasks 28
geocoding 438
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output to disk 196
rectification 438
traditional techniques 26
viewing data values 86, 357, 359

image rectification parameters 467
image windows

closing 53
linking 178
loading datasets 60, 67, 120, 126, 135, 138, 144, 354, 358, 362, 366, 368, 373, 378, 419, 428, 430, 433,

435
loading images 60, 67, 120, 126, 135, 138, 144, 419, 428, 430, 433, 435
measuring distances 88
moving 47
moving to front 52
opening 46
panning with buttons 49
resizing 48
selecting current 52
setting display resolution 183
setting exact size 183
setting geographic extents 181
shaping to fit image 291, 300
specifying center point 182
using multiple windows 51
viewing cell values 86, 355, 358
viewing coordinates 88
zooming with buttons 49
zooming with mouse 49

Intensity layer type 119, 134
ISOCLASS classification. See unsupervised classification

K
kernels. See filters

L
Landsat TM Wizard 35
Landsat Web Publishing Wizard 35
Layer tab 57
layers 57

adding 81
Annotation 394
Annotation/Map Composition 246
changing order 80
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changing type 82
Class Display 316
Classification 270, 276, 277, 322
controls 71
deleting 81
duplicating 82, 299
Intensity 119
labelling 63, 64
loading data into 78
loading filters 157
modifying 74
moving between 83
overview 70
raster types 73
Saturation 138
selecting 76
selecting bands 82
setting display priority 302
Tabular Data 395, 396
thematic overlays 268
turning on and off 76
vector types 74
with Color Mode 77

Level slice transform
setting levels 111

Line Style dialog box 257
linking windows. See geolinking
links to external data 32, 392
loading datasets 60, 67, 120, 126, 135, 138, 144, 354, 358, 362, 366, 368, 373, 378, 419, 428, 430, 433, 435
loading images 60, 67, 120, 126, 135, 138, 144, 419, 428, 430, 433, 435
Local Government Applications Wizard 35
logarithmic transforms 111
lookup tables 61
low pass filters 149

M
Magnetics Fourier Wizard 35
magnifying images. See zooming
map composition

basic concepts 246
drag and drop objects 262
drawing annotation 257
drawing map objects 260
importing graphics formats 265
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importing text 265
object attributes 265
page background color 251, 252
Page Relative option 266
polygon attributes 258
polyline attributes 257
resizing/positioning objects 264
saving to disk 264
selecting objects 258
setting map object attributes 262
setting up a page 248
special features 265
text attributes 259

map projections. See geocoding 438
map projections. See rectification 454
masking images 272

using data values 322
math operations. See formulas
measuring distances 88
mensuration 88
merging raster images

using Virtual Datasets 213
Miscellaneous 483
mosaicing

analyze images 295
capabilities 287
creating algorithms 294, 298
creating mosaiced image 288
display band 291
display method 290
feathering 296
feathering seam lines 308
file types 290
histogram matching 306
Image Display and Mosaicing Wizard 286
mosaic properties 290
requirements 287
RGB 123 293
setting display priority 287, 302
turning images on/off 292, 301
using RGB algorithms 303
using Virtual Datasets 210
zooming to all datasets 300

mouse buttons 39
mouse pointer

Hand mode 49
Comprehensive ER Mapper Training Workbook  498



Index
Pointer mode 86, 356, 359
shapes 39
Zoom mode 48, 356, 359
ZoomBox mode 48

multi-resolution merging
using IHS technique 248
using Virtual Datasets 213

multispectral data 25

O
Ortho and Geocoding Wizard 34
orthorectification 30

Attitude kappa 455, 477
Attitude omega 454, 477
Attitude phi 455, 477
Camera Wizard 458
Exposure center X Y Z 477
exterior orientation 455, 457, 476
fiducial points 464
Focal length 460
Optimum extents 478
Scale 477
X offset to principal point 460
Y offset to principal point 460

overlays. See thematic raster overlays 268

P
Page Setup dialog box 249
Page Setup Wizard 35
panning images

from master window 193
using linked windows 186, 193
with buttons 49
with mouse 49

perspective viewing. See 3D viewing
polygon attributes 258
polyline attributes 257
Postscript files

linking to 32
printing to 33
using in map composition 246

Principal Components
choosing bands 175
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choosing PC number 175
creating images 174
Landsat TM data 174

printing images 32, 266
process stream diagram 57
profiles across datasets 90
profiles of data. See Traverse 89
Pseudocolor color mode 61, 66, 72

R
Raster Dataset dialog 78

Apply button 79
Apply vs OK 79

raster datasets
description 24
haze removal 218
importing 29
merging 213, 248
mosaicing 286
output to disk 196
reading 29
rescaling data range 108, 114
viewing cell values 86, 357, 359
viewing information 202

raster images 25
description 24
haze removal 218
importing 29
merging 213, 248
mosaicing 286
output to disk 196
reading 29
rescaling data range 108, 114
viewing cell values 86
viewing information 202

raster layers
relation to Color Mode 73
types 73

raster to vector conversion
basic concepts 382
creating polygons 386
creating polylines 387
vectorizing classifications 383

ratio formulas 169
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rectification
Compute FROM function 447
evaluating results 450
GCP display options 448, 470
overview 438
picking first 4 GCPs 444
picking points from overview 447
RMS errors 447

Refresh Image button 47
Refresh Image with 99% clip button 114
regions

defining 326
masking on image 173
showing on scattergram 337
using in formulas 172

rescaling data
using transforms 108

RGB color mode 72

S
saturation layers 138
Save As Dataset dialog box 199, 361, 365, 374, 380
saving images 32
saving images to disk 196
Scattergram dialog box 282, 337
Scattergram Setup dialog box 93, 282, 337
scattergrams

changing bands 93
Defer button 94, 283
Display button 94
highlighting pixels on image 282
viewing 92
viewing class means/ellipses 337

seismic datasets
colordraping 124
HSI colordraping 132
sun angle shading 120, 135

shaded relief images 122, 124, 138, 277
shaded relief images. See sun angle shading
slope calculations 155, 278
spatial frequency 149
spatial modeling 268
spectral signatures

averaging 88
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viewing 87
statistics

calculating 334
showing on scattergram 337
viewing 334

sun angle shading
basic use 120
benefits 123
with colordraping 122, 124, 138, 277

supervised classification
basic concepts 324
calculating region statistics 334
defining training regions 326
displaying the classified image 339
generating confusion matrices

confusion matrices 341
running the classification 338
viewing signature histograms 335, 336
viewing signature statistics 334

Supervised Classification dialog box 338, 345
surfaces 57

copy/paste between algorithms 243
opening into algorithms 240
transparency 241
turning on/off 242

T
tab pages 57
tabular data display 395
tabular data links 32
Tasseled Cap transformation 205
template algorithms

for autoscaling data 114
for image output 202
for RGB displays 208
for Virtual Datasets 217

text attributes 259
Text Style dialog box 259
thematic raster overlays

solid color 269, 276, 354, 362, 365, 367, 373, 376
translucent color 273
using scattergrams 282

thresholding data 167
toolbars
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displaying 45
hiding 46
overview 40
using 45

Transform dialog box 97
transforms

adjusting line 101
appending 113
automatic options 109
automatically clipping on limits 114
deleting 113
exponential 112
Gaussian equalization 110
highlighting features 104
histogram clipping 109
histogram equalization 110
histogram matching 306
inserting 112
level slicing 111
linear 101
logarithmic 111
overview 96
piecewise 104
rescaling data with 108
setting input limits 106, 107
setting output limits 108
using multiple 112
viewing 100
viewing for other layers 83
viewing next in stream 113
viewing previous in stream 113

translucent color overlays 273
transparency

between 3D surfaces 241
Traverse dialog box 90
Traverse Extraction 89, 270

drawing traverse lines 89, 270
modifying traverse lines 91
selecting dataset bands 90

U
unsupervised classification

assigning class names/colors 316
auto-generating colors 317
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basic concepts 312
displaying the classified image 316
overlaying classes 321
specifying clustering parameters 314

Unsupervised Classification dialog box 314

V
variables in formulas 168
vector datasets

display color 256
displaying 254, 255
editing 256

vector images
display color 256
displaying 254, 255
editing 256

vector layers 74
vectorization. See raster to vector conversion
vegetation index formulas 62, 275
View Mode 57
viewing data values 84
Virtual Datasets

advantages 204
basic concepts 204
editing 217
loading 208, 211
saving 207
to detect changes 218
to merge images 213
to mosaic images 210
to simplify processing 205

W
warping images. See geocoding 438
warping images. See rectification 454
windows. See image windows

Z
zooming images

from master window 190
out to full extents 49, 50
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to page extents or contents 255
to specific dataset extents 293, 302
using linked windows 186
with buttons 50
with mouse 49
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